
CARIS HIPS and SIPS 8.1

User Guide



Copyright (c) 2013 CARIS All rights reserved.

The material in this manual is for information purposes only and is subject to change without notice. CARIS 
assumes no responsibility for any errors that may appear in this manual. CARIS hereby grants licensees of CARIS 
software the right to reprint this document for internal use.

Trademarks
CARIS, CARIS software and the CARIS logo are registered trademarks or trademarks of 
CARIS.
All other registered trademarks or trademarks are property of their respective owners. 
Data courtesy of the Shallow Survey Conference Common Data Set 2001 (CCOM - UNH).
Acknowledgements
The development of HIPS and SIPS as a modern and powerful bathymetric and side scan 
sonar processing system was made possible through the cooperation of several organizations:

• The Canadian Hydrographic Service (CHS)
• The Ocean Mapping Group of the University of New Brunswick
• The National Oceanic and Atmospheric Administration (NOAA) 
• University of New Hampshire

Cover images (from left to right):
Burrard Inlet Pockmarks: image courtesy of Kalman Czotter - Canadian Hydrographic 
Service.
Burns Harbour North Breakwater, Indiana: image courtesy of Alexander Unrein, David 
Somers - Ocean Surveys, Inc.
Shipwreck of GB Church: EM3002 data provided by University of New Brunswick Ocean 
Mapping Group.

CARIS 
(Global Headquarters)
115 Waggoners Lane
Fredericton, NB
Canada
E3B 2L4

Phone: 1 (506) 458-8533 
(English/French/Spanish)
Fax: 1 (506) 459-3849
Email: info@caris.com
Assistance: support@caris.com
Web site: www.caris.com

CARIS USA
415 N. Alfred Street
Alexandria, VA
United States
22314

Phone: 1 (703) 299-9712
Fax: 1 (703) 299-9715 
Email: carisusa@caris.com

CARIS bv
Mgr. van Oorschotstraat 13
PO Box 47 5473 ZG
Heeswijk, NETHERLANDS

Phone: +31 (0)413 296 010
Fax: +31 (0)413 296 012
Email: sales@caris.nl
Assistance: support@caris.nl

CARIS Asia Pacific
Level 3 Shell House, 172 North Terrace
Adelaide SA 5000
Australia

Phone: +61.(0).8.8231.9474
Email: info@caris.com

August 2013



3

Preface
This guide describes the workflow for processing data, using the multibeam 
to CUBE surface flow.
• “WORKFLOW IN HIPS AND SIPS” ON PAGE 15
• “CREATE VESSEL FILE” ON PAGE 25
• “CREATE A NEW PROJECT” ON PAGE 57
• “ CONVERT DATA” ON PAGE 77
• “SOUND VELOCITY CORRECTION” ON PAGE 133
• “CORRECT FOR TIDE” ON PAGE 143
• “COMPUTE TPU” ON PAGE 153
• “MERGE” ON PAGE 167
• “CREATE FIELD SHEETS” ON PAGE 173
• “CREATE BASE SURFACES” ON PAGE 187
• “CUBE PROCESSING” ON PAGE 247
• “DATA QC” ON PAGE 269
• “STATISTICAL SURFACE CLEANING” ON PAGE 311
• “CLEANING SWATH DATA” ON PAGE 323
• “PROCESS DATA IN SUBSETS” ON PAGE 337
• “CREATE PRODUCT SURFACES” ON PAGE 355
• “PROCESS IMAGERY DATA” ON PAGE 411
• “PROCESS WATER COLUMN DATA” ON PAGE 459
• “CREATE PUBLICATIONS” ON PAGE 475
• “EXPORT DATA” ON PAGE 479

For processing of single beam data, please see “PROCESS SINGLE BEAM 
DATA” ON PAGE 89 in the Editors Guide.
For processing of LIDAR data, please see “PROCESS LIDAR DATA” ON 
PAGE 27 of the Editors Guide.

Please be advised that some 64-bit versions of third-party libraries remain 
unavailable at this time.  Therefore, the following capabilities will not be 
available in the 64-bit version of HIPS and SIPS.

Navitronics format conversion 

Hawkeye waveform viewer 

If any of the above capabilities are required, you will need to use the 32-bit 
version of HIPS and SIPS.
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Workflow in HIPS and SIPS

The workflow described here uses multibeam data and CUBE to illustrate 
a way of processing data in HIPS and SIPS. This workflow will take you 
through the steps from raw data to the creation of a contoured product 
surface and the publishing or export of cleaned data.

In this chapter...
WORKFLOW DIAGRAM.................................................... 16
HIPS VESSEL FILES .................................................... 19
WORKING WITH PROJECTS............................................. 20
SESSION FILES ............................................................ 21
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Workflow in HIPS and SIPS: Workflow diagram

Workflow diagram
 

“OVERVIEW OF WORKFLOW STAGES” ON PAGE 17

Since some data does not require all processing steps and some 
data can require repetition of one or more steps to produce a 

Multibeam workflow with CUBE

Other workflows (in the HIPS and SIPS Editors guide) :

• “SIDE SCAN EDITOR WORKFLOW” ON PAGE 50 

• “SINGLE BEAM WORKFLOW” ON PAGE 90 

• “LIDAR DATA IN HIPS” ON PAGE 28 

In this User Guide:

• “PROCESS IMAGERY DATA” ON PAGE 411 (backscatter and sidescan 
imagery workflow)

• “PROCESSING WORKFLOW FOR WATER COLUMN DATA” ON PAGE 461 
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Workflow in HIPS and SIPS: Workflow diagram

final product, this general workflow can be adapted to specific 
situations and data types.
The order in which certain functions are performed is important, 
however, many of the functions can be automated with the Batch 
Processor (see “BATCH PROCESSING” ON PAGE 95).

Overview of workflow stages
• Create a Vessel File: Create or edit vessel information on 

sensor locations and uncertainties. See “CREATE A NEW HVF” ON 
PAGE 27

• Create a new project: Set up the Project - Vessel - Day data 
structure. See “DEFINE NEW PROJECT” ON PAGE 58

• Convert raw data: Convert data into HIPS data format using 
automated process. See “ CONVERT DATA” ON PAGE 77

• Save session: Save the current workspace (data and current 
view). See “SESSION FILES” ON PAGE 21

• [Optional] Sound Velocity Correction (SVC): Load and edit 
sound velocity profiles and apply the correction. See “SOUND 
VELOCITY CORRECTION” ON PAGE 136 

• Load tide: Load tide data from one or more tide stations to 
correct for tide variance. See “LOAD TIDE” ON PAGE 144

• Merge: Combine vertical and horizontal information to 
produce geo-referenced data. If changes are later made to the 
navigation and/or motion data during the QC process, the 
Merge process is re-applied. 

• Compute Total Propagated Uncertainty (TPU): Use 
uncertainty values entered in the HVF to compute the total 
propagated error of each individual sounding. See “COMPUTE 
TPU” ON PAGE 156

• Define new field sheets: Organize dataset into manageable 
areas with defined locations and map projection. See “CREATE A 
FIELD SHEET” ON PAGE 174 

• Generate a Bathymetry Associated with Statistical Error 
(BASE) Surface: Either a Swath Angle, Uncertainty or CUBE 
surface from data contained in field sheet. See “CREATE A BASE 
SURFACE” ON PAGE 193

• Generate a Combined Uncertainty and Bathymetry 
Estimator (CUBE) Surface: Use merged data to produce a 
CUBE surface. 

• Data QC: Examine and edit sensor data, such as navigation, 
gyro, heave, if problems have been identified in the BASE 
(CUBE) surface.
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Workflow in HIPS and SIPS: Workflow diagram

• Filtering: Use automated or manual tools to filter soundings 
using swath geometry and/or according to IHO survey order 
accuracies. Filter water column data for editing in Subset 
Editor.

• Process Data in Subsets: Using hypothesis editing, validate 
the CUBE surface and edit geo-referenced soundings. Add 
bathymetry from edited water column data. 

• Finalize BASE Surface: Update the validated CUBE Surface 
after data has been edited, and ensure designated soundings 
are carried through to bathymetric products.

• [Optional] Create Product Surface: Produce a generalized 
product surface from the BASE Surface, and add: 
• Contours: Use automated functions with either the BASE 

Surface or product surface to output contours. (Contours 
can also be generated manually from tiles.)

• Sounding Selection: Use a height source for selection of a 
representative sounding set.

• Plot Composer: publish HIPS and SIPS data and product 
surfaces. 

• Export Data: Soundings and surfaces can be exported to 
various formats for data transfer (e.g., S-57).

• [Optional] Process Imagery Data: backscatter or sidescan 
data can be processed in mosaics using Mosaic Editor.
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HIPS Vessel Files
All HIPS and SIPS projects must contain a HIPS Vessel File 
(HVF). The HVF describes the installation and calibration of 
equipment installed on the survey vessel. The information in the 
HVF is used in multiple processes including merging, 
mosaicking, and calculating sounding uncertainty. 
The HVF can be created or modified through the HIPS Vessel 
Editor. The Vessel Editor is a separate application that is 
launched from the HIPS interface. See “CREATE A NEW HVF” ON 
PAGE 27. 
 

A vessel file must exist prior to creating a new project in 
HIPS and SIPS.
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Working with Projects 
Every project in HIPS and SIPS is organized in a Project/Vessel/
Day/Line folder hierarchy. New projects are created with a 
wizard, which generates a HIPS Project File (*.hips).
Existing projects, saved as *.hpf files, are converted to *.hips 
when you first open them in HIPS and SIPS. 
A project can be created with new Project/Vessel/Day folders, or 
new Vessel/Day folders can be added to an existing project. Day 
and Line folders can be renamed, or taken out of the active 
project or deleted outright. (See “DEFINE NEW PROJECT” ON PAGE 58.)
Projects can also be archived. (See “ARCHIVE PROJECT” ON PAGE 74.)
All projects must contain a vessel file. (See “CREATE A NEW HVF” ON 
PAGE 27). If your raw data files are set up in a Project/Vessel/Day/
Line structure and a HIPS Vessel File already exists for that 
data, you can use the Conversion wizard to create the HIPS 
directory structure. (See “CONVERTING FILES TO HIPS/SIPS FORMAT” ON 
PAGE 78 and “RENAME DAY AND LINE FOLDERS” ON PAGE 73 for more 
information.)
You can be connected to more than one project repository at one 
time, using the commands from the right-click menu in either 
the New Project or Open Project dialog box. See “MULTIPLE DATA 
PATHS” ON PAGE 64.
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Session Files
Session files record the list of data layers open at the time the 
session was saved. The Session file also records the layer 
properties, drawing order, the on and off state of layers, and the 
last geographic extent of the data.
Session files enable you to re-opening all data that was being 
processed the last time the project was open. The data types that 
are recorded in the session file include:
• lines
• field sheets
• background data
• last geographic view extent of the Display window
All session files have an .hsf file extension and are stored by 
default in …\Hips\Session. The previous format of the session 
file (.ses) can be opened and automatically upgraded to the new 
session file format.

Save a session To save a session 
1. Select the Save Session command, or select the Save Session As 

command if the session has not been saved before, or if you want to 
save an existing session under a new name.
• If this is an already saved file, the program re-saves the existing .hsf 

file.
• If this is a new file, then the Save As dialog box is displayed. Select 

a folder where you want to save the .hsf file and type a name in the 
File Name text box.

If a project contains a large number of track lines, you can make 
data processing more manageable and reduce the time it takes 
to load data into the application by selecting specific track lines 
for a session file.
1. Select the track lines you want to save in the session file.

2. Choose the Save Session As command and select the 
Save Selected Lines Only check box.

3. Type a name for the session file and click Save.

The Session file is saved.
Open a session Open one or more saved sessions.

1. Select the Open Session command.

The Open Session File dialog box is displayed.
2. Select a session file.

3. Click Open.

M
en

u File > Save Session/
Save Session As

M
en

u

File > Open Session
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The data layers contained in the Session file are opened and 
listed in the Layers tab in the Control window.

Close a session 1. Select the Close Session command.

If you have made changes to the session since the last save, you 
are prompted to save the current changes.
2. Click OK.

M
en

u

File > Close Session
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Convert Survey Data
HIPS and SIPS files are created from survey data using the 
Conversion Wizard. The Conversion Wizard is a separate 
application that is launched from the HIPS and SIPS interface. 
Survey data converted to HIPS and SIPS format is in varying 
stages of completion, depending on the data format options. Data 
may or may not have been corrected for factors like heave/pitch/
roll or sound velocity.
All HIPS/SIPS data is organized in a Project/Vessel/Day/Line 
directory structure. If you organize the survey data according to 
this structure, you can convert line data from an entire Project 
or multiple Vessel and Day folders contained in a common 
Project folder. 
When entire project data has been converted, a Project/Vessel/
Day/Line directory is created for the converted data. If there is 
already a Project folder that is identical to the preprocess folder, 
then the line data in the existing folder is over-written with the 
new data. 
 

1. Select a Conversion Wizard command.

The Conversion Wizard is displayed.

For more information on how to use the Conversion Wizard, see 
“CONVERTING FILES TO HIPS/SIPS FORMAT” ON PAGE 78.

You must organize your raw data files in a HIPS and SIPS 
Project/Vessel/Day structure to convert complete Project, 
Vessel and/or Day data files.

M
en

u Import > Conversion 
Wizard

To
ol
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Generic Data Parser
HIPS can convert almost any single beam ASCII file through the 
Generic Data Parser. The parser can also add or replace any 
sensor data in an existing project — except swath and sweep 
bathymetry, and side scan imagery.
For example, if high-precision positions were obtained from a 
source other than the original raw data files converted into 
HIPS, this data could be loaded into an existing project to 
replace the original navigation data. The new position data must 
have a time stamp and be in ASCII format.
The Generic Data Parser is a separate program launched from 
the main HIPS and SIPS interface.
1. Select the Generic Data Parser command. 

The Generic Data Parser is displayed.
For more information see GENERIC DATA PARSER, in the Tools guide.

M
en

u Import > Generic Data 
Parser

To
ol
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Create Vessel File

The HIPS Vessel file (HVF) defines the offset configurations and 
associated error estimates for each of the sensors, which are necessary 
for creating final position and depth records for survey data. 

The HIPS and SIPS workflow begins with creating an HVF, and if 
necessary, editing the sensor configuration data. 

In this chapter...
VESSEL FILES.............................................................. 26
CREATE A NEW HVF................................................... 27
CREATE VESSEL SHAPE OUTLINE ................................... 35
SENSOR CONFIGURATION .............................................. 38
SENSORS ................................................................... 41
VESSEL COORDINATE SYSTEM........................................ 53
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Create Vessel File: Vessel Files

Vessel Files
The Vessel file (HVF) in HIPS and SIPS describes the location 
and calibration of sensor equipment installed on the survey 
vessel. Written in Extensible Mark-up Language (XML), it 
defines the offsets and any associated error estimates for each of 
the sensors.
For a description of the coordinate system upon which the vessel 
configuration is based, see “VESSEL COORDINATE SYSTEM” ON PAGE 53. 
The HVF is created in the HIPS Vessel Editor, and saved to the 
folder …\HDCS_Data\VesselConfig. 
If you create other data directories, the name of the VesselConfig 
folder must not be changed and it always has to be located inside 
the Raw Data directory on the same level as the project 
directories.

The HVF is divided into a number of distinct sections, each 
describing one type of sensor. The sections are time-tagged and 
multiple entries can be defined for different time periods. These 
entries can be edited in the Vessel Editor. 
During the Merge process, corrected sensor data is combined 
with the observed data to create a final position/depth record.

In previous versions of HIPS and SIPS, a text file called the 
Vessel Configuration File (VCF) was used. VCF files can still 
be opened in the Vessel Editor and edited, but when the file 
is re-saved, it is converted to HVF format.
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Create a New HVF
A vessel file is created in HIPS Vessel Editor, a separate 
application launched from the HIPS and SIPS interface. (For a 
description of the Vessel Editor and its properties, see “VESSEL 
EDITOR INTERFACE” ON PAGE 172.)
There are four main steps to creating and configuring a HIPS 
Vessel file in Vessel Editor:
• Open the HIPS and SIPS Vessel wizard to enter the 

parameters for the vessel file, based on the type of data being 
surveyed. (See “OPEN THE VESSEL WIZARD” ON PAGE 27.) 

• Enter sensor position data using a 3D outline for the vessel. 
(See “CREATE VESSEL SHAPE OUTLINE” ON PAGE 35.)

• Enter additional information such as the ellipsoid used in the 
survey. (See “DEFAULT ELLIPSOID” ON PAGE 55.)

• Enter and edit sensor configuration data. (See “SENSOR 
CONFIGURATION” ON PAGE 38.)

Open the Vessel Wizard 
1. Open Vessel Editor from the HIPS and SIPS interface.

In Vessel Editor: 
2. Select the New Vessel File command.

 The Vessel Wizard - Step 1 (Vessel Information) dialog box is 
displayed.

M
en

u

File > New

To
ol
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Vessel Information
 

The HVF is saved to the \VesselConfig folder in your data 
directory. 
1. Select the directory holding your data, from the drop-down list. 

2. Type a name to identify the vessel used in the survey. (The name must 
not include any spaces.)

3. Click the Calendar button to insert the year and day the survey began. 
The Vessel Date must be before the start of your data collection. 

4. Click Next to open the next dialog box: 

Type of Survey
This dialog box prompts you to enter the sonar type used in the 
survey.



CARIS HIPS and SIPS User Guide 29

Create Vessel File: Create a New HVF

There are four sonar types:
• Singlebeam 

• Multibeam

• Multi-transducer

• Side Scan Sonar

1. Select a sonar type by clicking the appropriate check box.

2. Click Next to go to the next step in the Vessel Wizard, 
or

if you selected Side Scan Sonar, click Finish.
(One or more dialog boxes will follow depending on the type of 
sonar selected in this dialog box.)
If you selected Singlebeam, go to: “MOTION SENSORS” ON PAGE 32

If you selected Multibeam, go to: “MULTIBEAM” ON PAGE 29

If you selected Multi-transducer, go to: “MULTI-TRANSDUCER” ON 
PAGE 30

Multibeam 
If you selected Multibeam in the Step 2 dialog box, Step 3 will 
ask you for information on the sonar model and number of 
transducers.
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1. Select the appropriate check box to indicate that one or two 
transducers were used in the survey.

2. Enter the number of beams in each transducer.

3. Select the sonar model from the drop-down list.

4. Click Next to continue to “MOTION SENSORS” ON PAGE 32

Multi-Transducer 
If you selected Multi-transducer in the Step 2 dialog box, you 
will now be asked for information on the number and types of 
transducers and for TPU specific parameters. 
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1. Enter the Number of Transducers on a boom.

2. Select Yes if the transducers are mounted to a fixed boom or to the hull 
of the vessel, or select No if the transducers are on a movable 
(decoupled) boom.

3. Type the default Alongtrack value of all the transducers relative to the 
ship's reference point.

4. Type the default Depth of all the transducers relative to the ship's 
Reference Point.

5. Select the sonar model from the Model drop-down list.

Parameters for navigation to boom and motion recording unit 
(MRU) to boom are necessary to calculate Total Propagated 
Uncertainty. 
6. Type the distances from the positioning system to the centre of the 

boom in the Navigation to Boom X-Y-Z fields.

7. Type the distance from the motion recording unit to the centre of the 
boom in the MRU to Boom X-Y-Z fields.

The Roll and Gyro misalignment values are needed for fixed-boom 
system. However, for a decoupled boom, only a Gyro 
misalignment value is needed.
The Squat and Heave percentage values are transducer responses 
to overall heave and squat. For fixed-boom transducers this 
should be 100% and less than 100% for decoupled-boom 
transducers.
8. Type a degree offset in the Roll and Gyro fields.

9. Type a percentage value in the Squat and Heave fields.

10.Click Next to open the dialog box for: “CONFIGURATION OPTIONS” ON 
PAGE 32. 
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Motion Sensors
This dialog box determines which attitude sensors are displayed 
in the HVF.

1. Create entries for any (or all) of the following sensors by clicking the 
appropriate box:
• heave
• pitch

• roll 

The Apply in Post Processing option means that the data is applied 
during the Merge process or during Sound Velocity Correction.
2. Click any of the check boxes if you want to apply the attitude sensor 

data in post processing.

3. Click Next to open the dialog box for: “CONFIGURATION OPTIONS” ON 
PAGE 32

Configuration Options
The Configuration Options dialog box is displayed
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Use this dialog box to enable any or all of three options:
• the SVP (Sound Velocity Profile) pole parameters
• dynamic draft values
• waterline height variation
1. To include sound velocity corrections, click the Define Parameters for 

Sound Velocity Corrections check box.

2. To apply dynamic draft values to vessel speeds, click the Apply Dynamic 
Draft check box.

A draft-versus-speed table is created in the Vessel Editor. You 
can enter values in this table once the vessel file is created.
3. If you want to apply long period variations in the waterline height in 

processing data, click the Define Vessel Waterline Height Variation check 
box.

4. Click the appropriate Apply in Post Processing check boxes, as needed.

5. If you selected the Define Parameters for Sound Velocity Corrections check 
box, click Next, or click Finish if you did not select this option.

Sound Velocity Corrections
The Sound Velocity Corrections dialog box is displayed only if 
you selected the Define parameters for sound velocity corrections 
check box in the Configuration Options dialog box.
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This dialog box records any transducer pole offsets.
Transducer head offsets must be taken into account when the 
SVP is applied to the data.
1. Select the 180-degree Azimuth box if the transducer is reverse 

mounted.

2. If the transducer is mounted with a large roll offset for use under 
wharves or along banks, then select the Roll Offset check box 

3. Type the amount of offset (in degrees) in the Roll Offset box.

4. If the transducer is mounted with a large pitch offset such that it is 
pointed forward or backwards, then select the Pitch Offset check box.

5. Type the amount of offset (in degrees) in the Pitch Offset box.

6. Repeat the above steps for the second transducer if there are two 
poles.

7. Click Finish.

A new HIPS Vessel File is created. You can now create an 
outline for the vessel (see “CREATE VESSEL SHAPE OUTLINE” ON PAGE 35). 
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Create Vessel Shape Outline
Use the Vessel Shape command to create a 3-D outline of the 
vessel, by entering measurements to define the length, width 
and height of the vessel, as well as the position of the reference 
point in the vessel.
You can also use the Vessel Shape command to revise an 
existing vessel outline.
1. Open the vessel file if it is not already open.

2. Select the Vessel Shape command.

The Plan View Shape dialog box is used for entering width and 
length of the vessel.

1. Enter a width for the vessel (port to starboard).

2. Enter a length for the vessel (stern to the base of the bow).

3. Enter a length for the vessel (stern to the tip of the bow).

4. Click Next.

The Plan View PR dialog box is displayed. It is used to set the 
position of the Reference Point (RP). 

M
en

u

Edit > Vessel Shape

To
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1. Type the distance from the stern to RP.

2. Type the distance from the starboard side to the RP.

3. Click Next.

The Profile View Shape dialog box is displayed.

To set the height measurements for the vessel,
1. Type the height of the vessel.

2. Type the height of the vessel RP from the keel.

3. Click Finish.
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The Vessel Editor displays the outline of the vessel. 

Negative values are used for these measurements:
• from the origin (crosspoint of the axes) to port on the X axis, 
• from the origin aft towards the stern on the Y axis, 
• from the origin point up, on the Z axis. 
Negative values on the axes are displayed with a “-” minus sign. 

Reference point

Time stampsSensor
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Sensor Configuration
The active sensors listed in the Vessel Editor are determined by 
the sensor parameters you selected when creating the vessel file. 
If you want to add data for a sensor not already included in the 
vessel file, you can add a sensor to the list and enter its data. 
You can also remove a sensor and its values from the vessel file. 
 

In general, if sensor offsets or calibration values have already 
been applied to logged data during data acquisition, then do not 
enter the same offsets and calibration parameters in the Vessel 
Editor. 
Also, if compensation for heave, pitch, and roll has already been 
made to the recorded sounding data during data acquisition, for 
example as in Simrad data, then it must not be applied again.

Active sensors
To add or remove sensors from the list of active sensors:
1. Select the Active Sensors command.

The Active Sensors dialog box is displayed.

Active 
sensors

Table of values related to the highlighted sensor.

M
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u

Edit > Active Sensors 
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If a box is checked, the sensor is included in the vessel file and 
displayed in the Editor table.
2. Make sure a sensor box is checked to enable the sensor, or cleared to 

remove the sensor.

3. Click OK.

The list is refreshed to show the selected active sensors.

Time Stamp
A vessel’s configuration changes over time. Different draft 
settings may be used in a survey, or the position of the 
transducers on a boom may change, or a different ellipsoid may 
be used. A time stamp is used to keep track of these changes. 
The time stamp records the time from which a configuration is 
valid and is recorded with each entry to the HVF. Below is an 
example of time stamps showing changes in vessel 
configuration.

new nav. 
antenna 
position

new draft 
error

new ellipsoid/
datum

new nav. 
antenna 
position

1999-127 
14:10:1

1999-263 
09:23:0

2000-149 
17:10:3

2000-170 
10:0:0



40 CARIS HIPS and SIPS User Guide

Create Vessel File: Sensor Configuration

Time Correction
In the HVF, most sensors have a Time Correction field that 
contains the time difference between the sensor clock and the 
reference clock. Sensors are time tagged and all clocks are 
compared to the reference clock so sensor readings can be 
synchronized.
The Time Correction field is specified in seconds and is positive 
if ahead of the reference clock:
Time Correction = Recorded Time - Reference Time

NOTE: Time in HIPS is based on the recorded reference 
time. No distinction is made for UTC.
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Sensors
Different sensors can require specific edits applied to the 
parameter data. The following sections explain the individual 
sensor data fields.

Transducer
The swath sonar, also known as multibeam, typically has beams 
that are formed in a fan shape, radiating from the centre of the 
transducer. 
1. Click Transducer1 in the Sensors list box so the selection is highlighted 

and the swath data fields are displayed.

2. Type data (as needed) in the following fields:
• Date: The year and Julian day of current swath time stamp.
• Time: The hour and minute of the current swath time stamp.
• Time Correction: The time correction value.

The X-Y-Z fields set the location of the transducer from the 
Reference Point (0).

• X: The athwart-ship distance of the transducer, positive to 
starboard.

• Y: The along-ship distance of the transducer, positive to the bow.
• Z: The vertical distance of the transducer, positive into the water.

The Pitch, Roll and Yaw fields refer to misalignment of the 
transducer, during mounting, from the vessel coordinate system.

• Pitch: The offset is positive when rotating the transducer towards 
the bow (bow up).

• Roll: The offset is positive when rotating the transducer away from 
starboard (starboard down).

• Yaw: Indicates the horizontal rotational offset and is positive for a 
clockwise rotation.

• Manufacturer: The maker of the transducer.
• Model: The particular make of transducer. The model information is 

necessary for the calculation of Total Propagated Uncertainty.
• Serial Number: The serial number of the transducer.
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Navigation
The navigation section of the HVF describes the location of the 
navigation source (for example, antenna or motion sensor). This 
section is used as a link between the fixed positioning coordinate 
system and the instantaneous vessel coordinate system.
1. Click Navigation in the Sensors list box so the selection is highlighted 

and the navigation data fields are visible.

2. Type data (as needed) in the following fields:
• Date: The year and Julian day of the current navigation time stamp.
• Time: The hour and minute of the current navigation time stamp.
• Time Correction: The time correction value.

The X-Y-Z fields set the location of the navigation source from 
the Reference Point (0).

• X: The athwart-ship distance of the source, positive to starboard.
• Y: The along-ship distance of the source, positive towards the bow.
• Z: The vertical distance of the source, positive into the water.
• Ellipsoid: From the drop-down list, select the ellipsoid on which the 

navigation is based. The ellipsoid should be the same as the one 
used in the survey. 

• Manufacturer: The maker of the navigation equipment.
• Model: The particular make of navigation equipment.
• Serial Number: The serial number of the navigation equipment.

Since the Simrad data read into HIPS is already corrected, 
the Transducer values in the HVF must be set as follows:

• The X/Y/Z offsets are zero because the Simrad data acquisition 
has already applied static draft and shifted the swath profile to 
the vessel reference point.

• The Roll / Pitch / Yaw transducer mounting rotations are typically 
zero because the Simrad data acquisition has already applied 
patch test calibration results.

If you will be applying GPS tide data it must use the same 
ellipsoid as selected here. 
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Gyro
The gyro sensor refers to any device providing a heading 
orientation of the vessel.
1. Click Gyro in the Sensors list box so the selection is highlighted and the 

gyro data fields are displayed.

2. Type data (as needed) in the following fields:
• Date: The year and Julian day of the current gyro sensor time 

stamp.
• Time: The hour and minute of the gyro sensor time stamp.
• Time Correction: The time correction value.

The Gyro Error is measured in degrees and is the difference 
between the recorded sensor value and the applied heading of 
the vessel: Applied Heading = Recorded value - Gyro 
Error.
3. Click an Edit button in the Error column to open the Gyro Error Table.

4. Type new values in the Gyro and Error fields and click OK to close the 
dialog box.

5. Type data (as needed) in the following fields.
• Manufacturer: The maker of the sensor equipment.
• Model: The particular make of sensor equipment.
• Serial Number: The serial number of the sensor equipment.

Heave
The heave sensor records the vertical motion of the vessel. 
Although the heave sensor has its own section in the Vessel 
Editor, it is usually part of the same sensor package as Pitch and 
Roll in most survey configurations.



44 CARIS HIPS and SIPS User Guide

Create Vessel File: Sensors

1. Click Heave in the Sensors list box so the selection is highlighted and 
the data fields are displayed.

2. Type data (as needed) in the following fields:
• Date: The year and Julian day of the current heave sensor time 

stamp.
• Time: The hour and minute of the current heave sensor time stamp.
• Time Correction: The time correction value.

The X-Y-Z fields set the location of the heave sensor from the 
Reference Position (0).
The X-Y-Z location of the heave sensor must be defined ONLY 
when you intend to apply heave data during Merge AND when 
remote heave compensation is necessary.

• X: The athwart-ship distance of the sensor, positive to starboard.
• Y: The along-ship distance of the sensor, positive to the bow.
• Z: The vertical distance of the sensor, positive into the water.
• Error: The applied instantaneous values for the heave sensor are 

computed by subtracting the appropriate errors from the recorded 
values:
Applied Heave = Recorded Heave - Heave Error.

• Apply: Select Yes to apply heave data in the merge process.
• Manufacturer: The maker of the sensor equipment.
• Model: The particular make of sensor equipment.
• Serial Number: The serial number of the sensor equipment.

The location of the heave sensor is shown in the Vessel Editor by 
a coloured dot. 

Pitch
Pitch refers to the rotational motion of the vessel around the X 
(port/starboard) axis. Although the pitch sensor has its own 
section in the Vessel Editor, it is usually part of the same sensor 
package as roll and heave in most survey configurations.
1. Click Pitch in the Sensors list box so the selection is highlighted and the 

data fields are displayed.

2. Type data (as needed) in the following fields:
• Date: The year and Julian day of the current pitch time stamp.

Note: Simrad systems apply dynamic Heave, Pitch, and Roll 
values to the swath data during survey. Therefore, the HVF 
must be set up with the Apply switches for Heave, Pitch, and 
Roll set to '”No” so these values are not applied twice. 
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• Time: The hour and minute of the current pitch time stamp.
• Time Correction: The time correction value.
• Error: The applied instantaneous values for the pitch sensor are 

computed by subtracting the appropriate errors from the recorded 
values:
Applied Pitch = Recorded Pitch - Pitch Error.

• Apply: Select Yes to apply the pitch data in the merge process.
• Manufacturer: The maker of the sensor equipment.
• Model: The particular make of sensor equipment.
• Serial Number: The serial number of the sensor equipment.

The location of the pitch sensor is indicated in the Vessel Editor 
by a coloured dot. 

Roll
Roll refers to the rotational motion of the vessel around the Y 
(fore/aft) axis. Although the roll sensor has its own section in the 
Vessel Editor, it is usually part of the same sensor package as 
pitch and heave in most survey configurations.
1. Click Roll in the Sensors list box so the selection is highlighted and the 

roll data fields are displayed.

2. Type data (as needed) in the following fields:
• Date: The year and Julian day of the current roll time stamp.
• Time: The hour and minute of the current roll time stamp.
• Time Correction: The time correction value.
• Error: The applied instantaneous values for the roll sensor are 

computed by subtracting the appropriate errors from the recorded 
values:
Applied Roll = Recorded Roll - Roll Error.

• Apply: Select Yes to apply the roll data in the merge process.
• Manufacturer: The maker of the sensor equipment.
• Model: The particular make of the sensor equipment.
• Serial Number: The serial number of the sensor equipment.

The location of the roll sensor is indicated in the Vessel Editor by 
a coloured dot. 

Note: Simrad systems apply dynamic Heave, Pitch, and Roll 
values to the swath data during survey. Therefore, the HVF 
must be set up with the Apply switches for Heave, Pitch, and 
Roll set to '”No” so these values are not applied twice. 
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Dynamic Draft
The squat and lift of a vessel changes as the speed changes. For 
some vessels, if the squat/lift is not accounted for, significant 
errors are introduced into the soundings. In this section, you can 
specify up to 10 speed-draft value pairs. During merge, the 
difference between the instantaneous draft and the static draft 
is computed and the final depth compensated.
Draft is measured in metres/feet, and speed is measured in 
knots. All draft values entered should be relative to the same 
reference, but what that reference is, is not important. The first 
Speed-Draft pair must correspond to a state where no draft 
correction is necessary. The delta draft values, relative to the 
initial draft, are computed and used to correct observed 
soundings. 
The following formula is used to correct soundings for dynamic 
draft:
Depth = observed depth – waterline + delta draft.

Delta draft is computed from the present vessel speed, as 
derived from the navigation system.
You can also create your own dynamic draft model and load 
Delta Draft information directly which will override the 
Dynamic Draft table in the HVF. (See “DELTA DRAFT” ON PAGE 172.)
1. Click Dynamic Draft in the sensors list box so the selection is highlighted 

and the dynamic draft data fields are displayed.

2. Type data (as needed) in the following fields:
• Date: The year and Julian day of the current time stamp for the draft 

table.
• Time: The hour and minute of the current time stamp for the draft 

table.
• Apply: Select Yes to apply the table during merge (or No to not 

apply the table).

3. Click Edit in the Error field. A dialog box containing a table with up to 10 
speed-draft pairs is displayed.

Note: Simrad systems apply dynamic Heave, Pitch, and Roll 
values to the swath data during survey. Therefore, the HVF 
must be set up with the Apply switches for Heave, Pitch, and 
Roll set to '”No” so these values are not applied twice. 
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4. Click inside the Speed cell and type a speed value (in knots).

5. Click inside the Draft cell and type a corresponding draft value.

6. Continue entering as many speed /draft pairs as needed.

7. Click OK.

The speed-draft table is saved in the HVF.

SVP
A sound velocity profile (SVP) records the speed of sound at 
various depths in the water column. HIPS enables you to apply 
SVP data in sound velocity corrections. However, this procedure 
is not available for all types of sonars because some sonar data 
logging systems compensate for sound velocity during data 
acquisition.
To ensure the SVP is accurately applied in HIPS, the transducer 
X-Y-Z offset values must be entered.
1. Click SVP 1 in the Sensors list box so the selection is highlighted and 

the SVP transducer data fields are visible. If there is a second 
transducer then click SVP 2 and complete the same procedures as 
listed below.

2. Type data (as needed) in the following fields:
• Date: The year and Julian day of the current SVP pole time stamp.
• Time: The hour and minute of the current SVP pole time stamp.

3. Select Yes if there are dual transducers (or No if there is only a single 
transducer).

The following three fields are for entering the pole’s X-Y-Z 
coordinates. All coordinates are measured from the Reference 
Point.
4. Type the transducer’s X-Y-Z offsets in the following fields:
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• X: The athwart-ship distance of the transducer, positive to 
starboard.

• Y: The along-ship distance of the transducer, positive to the bow.
• Z: The vertical distance of the transducer, positive into the water. 

 

The next three fields refer to the alignment of the transducer. 
The values you entered in the wizard when creating the HVF are 
displayed in these fields. The fields are only to be used for large 
transducer mounting offsets.

• Pitch: Pitch offsets of the transducer.
• Roll: Roll offsets of the transducer. 
• Yaw: Rotation of the transducer (either 0 or 180 degrees).

See also “SOUND VELOCITY CORRECTIONS” ON PAGE 33.
To apply SVP in processing see “SOUND VELOCITY CORRECTION” ON 
PAGE 133.

Sweep
Sweep systems typically contain multiple vertical beam 
transducers mounted on a boom and pointed straight down. The 
reference point for a sweep system can be anywhere on the X-Y 
plane, but must be on the water surface.
1. Click Sweep in the Sensors list box so the selection is highlighted and 

the data fields are visible.

2. Type data (as needed) in the following fields:
• Date: The year and Julian day of the current sweep time stamp.
• Time: The hour and minute of the current sweep time stamp.
• Time Correction: The time correction value.
• Transducers: Number of beams mounted on the boom.

3. Click the Edit button in the Transducer Status field to view a table for 
entering data for individual beams on the boom.

Note: The Reference Point for Simrad data is the 
centre of rotation. It should be possible to retrieve 
offset values from the Simrad Installation Datagram.
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4. Type values in the fields and click OK.

5. Click Edit in the TPU Status field to enter TPU values for each beam on 
the boom and to edit values entered in the new vessel wizard.

6. Type values as needed and click OK.

Towed Sensors
If a towed sensor—such as a side scan sonar— is used on a 
survey, then HIPS and SIPS can compute the sensor’s position 
as from the ship's position by calculating the horizontal layback 
and a direction to the sensor.
1. Click Towed in the Sensors list box so the selection is highlighted and 

the Towed data fields are displayed.

2. Type data (as needed) in the following fields:
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• Date: The year and Julian day of the current towed sensor time 
stamp.

• Time: The hour and minute of the current towed sensor time stamp.
• Time Correction: The time correction value.
• Layback Error: The error in the computed or recorded horizontal 

layback. This can be used, for example, to compensate the 
recorded layback data or tow cable length for the distance between 
the origin of the measurements and the defined tow point location in 
the tow cable length. This value is subtracted from the computed 
horizontal layback.

• X: Offset of the tow point from the vessel’s reference position.
• Y: Offset of the tow point from the vessel’s reference position.
• Z: Height of the tow point (negative upwards) in relation to the 

datum that is referenced to the sensor depth (in most cases, this is 
the waterline height).

• Manufacturer: The maker of the towed sensor.
• Model: The make of the towed sensor.
• Serial Number: The serial number of the towed sensor.

Waterline Height
The purpose of this section of the vessel file is to define long-
period changes in the vessel's draft due to fuel burn or other 
loading changes. 
Specifically, you can enter the height of the waterline below the 
Reference Point.
If the Waterline Height section of the vessel configuration is not 
defined here, then HIPS uses a default of zero as the height of 
the waterline below the RP. 
If you want waterline height to be applied during sound velocity 
correction, there must be a value in the Waterline Height section 
of the HVF. 

1. Click Waterline Height in the Sensors list box so the selection is 
highlighted and the waterline data fields are displayed.

2. Type data (as needed) in the following fields:
Date: The year and Julian day of the current waterline time stamp.
Time: The hour and minute of the current waterline time stamp.
Waterline: The distance from the RP, positive when below the RP.
Apply: Select Yes to apply the waterline data in the Merge process.
Comments: A text field for your use.

No interpolation of waterline height is done during Sound 
Velocity Correction.
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Total Propagated Uncertainty
This section defines the values used in the calculation of Total 
Propagated Uncertainty (TPU). TPU is derived from a 
combination of estimates of the accuracy of each individual 
sensor, estimates such as.
• nav/gyro/heave/pitch/roll/tide errors
• latency error estimate
• sensor offset error estimates
These uncertainty estimates are combined with individual sonar 
model characteristics in the DeviceModels.xml file to calculate 
horizontal and vertical uncertainty values for every sounding 
along a track line when TPU is applied
Sensor accuracy values for various sonar types can be viewed on 
the TPU Computation Resource page of the CARIS web site 
www.caris.com/tpu. 
Sensor accuracy values for TPU must be entered as 1-sigma.
1. Expand the TPU section of the HVF by clicking the + icon.

2. Type data (as needed) in the Offsets section:
• MRU to Transducer: The physical offset in three dimensions from the 

motion recording unit to transducer 1 on the vessel. 
• MRU to Transducer2: The physical offset in three dimensions from the 

motion recording unit to transducer 2 on the vessel.
• Navigation To Transducer: The physical offset in three dimensions 

from the navigation antenna to transducer 1 on the vessel.
• Navigation To Transducer2: The physical offset in three dimensions 

from the navigation antenna to transducer 2 on the vessel.
• Transducer Roll: The mounting roll offset for transducer 1. The offset 

is positive when rotating the transducer away from starboard 
(starboard down).

For Simrad data, the Waterline value must be set to the 
same value recorded as WLZ in the Simrad Installation 
Datagram. 

This Waterline value will only be used during Sound 
Velocity Correction.

Set the Apply switch to “No”. If it is set to “Yes”, it will be 
applied twice, once in SVC and again in Merge.

http://www.caris.com/tpu
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• Transducer Roll 2: The mounting roll offset for transducer 2. The 
offset is positive when rotating the transducer away from starboard 
(starboard down).

3. Uncertainty values used Type data (as needed) in the Standard 
Deviation section:
• Motion Gyro: The measurement standard deviation of the heading 

data in degrees.
• Heave % Amplitude: An additional heave standard deviation 

component that is the percentage of the instantaneous heave. 
• Heave (m): The measurement for standard deviation of the heave 

data. Most heave manufacturers quote heave error as being 
determined from StaticHeave or PercentageOfHeave depending on 
which value is larger.

• Roll: The measurement standard deviation of the roll data in 
degrees.

• Pitch: The measurement standard deviation of the pitch data in 
degrees.

• Position Nav: The standard deviation associated with the 
measurement of positions for the vessel. This is usually the error of 
the GPS sensor being used.

• Timing Trans: Standard deviation in transducer time stamp 
measurement.

• Nav Timing: Standard deviation in navigation time stamp 
measurement.

• Gyro Timing: Standard deviation in gyro time stamp measurement.
• Heave Timing: Standard deviation in heave time stamp 

measurement.
• Pitch Timing: Standard deviation in pitch time stamp measurement.
• Roll Timing: Standard deviation in roll time stamp measurement.
• Offset X: Standard deviation for the X measured offset on the vessel.
• Offset Y: Standard deviation for the Y measured offset on the vessel.
• Offset Z: Standard deviation for the Z measured offset on the vessel.
• Vessel Speed: The standard deviation for the vessel speed 

measurements.
• Loading: Vertical changes during the survey because of fuel 

consumption, etc.
• Draft: The standard deviation in the vessel draft measurements.
• Delta Draft: The standard deviation in the dynamic vessel draft 

measurements.
• MRU Align StdDev Gyro: This value is the uncertainty of the motion 

recording unit placement within the vessel fixed coordinate frame.
• MRU Align StdDev Roll/Pitch: This value is the uncertainty of the 

motion recording unit placement within the vessel fixed coordinate 
frame.

• Comments: Any additional information.
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Vessel Coordinate System
Vessel configuration is based on a three-dimensional coordinate 
system, which is used to record the location of sensors and other 
equipment, as illustrated below. 
 

Reference Point Sensor positions are described using X-Y-Z axis coordinates 
relative to a Reference Point (RP). The RP is a location from 
which all other positions are derived. (Imagine standing at the 
location of the Reference Position and describing how far and in 
what direction the sensor is away from you.)
The location of the RP depends upon the type of sonar system 
used in the survey. Its location is usually at the centre of the 
ship’s gravity. This position is used as the centre of the ship’s 
rotation when applying the pitch/heave/roll parameters, and 
must be applied as accurately as possible. 

Coordinate definitions The axes are defined as follows:
• The Y-axis is oriented along the vessel’s fore/aft axis, positive 

forward.
• The X-axis is oriented along the vessel’s port/starboard axis, 

perpendicular to the Y-axis, positive to the starboard.
• The Z-axis is perpendicular to the X-Y plane, and positive into 

the water. 
This is illustrated in the following image.
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The location of the vessel’s coordinate system within the local 
fixed coordinate system is determined by the navigation system 
and tide. The orientation of the coordinate system is defined by 
the vessel’s gyro and attitude sensors (pitch and roll). Gyro, 
pitch and roll observations are defined as follows:
• A positive gyro observation is defined as the clockwise 

rotation of the vessel (from 0 and 360 degrees) within the 
navigation coordinate system.

• A positive pitch is observed when the bow of the vessel is 
down (bow down).

• A positive roll is observed when the starboard side of the 
vessel is up (starboard up).
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Default Ellipsoid
The HVF must contain the ellipsoid and datum used by the 
navigation system in the survey vessel, regardless of whether 
projection coordinates or geographic coordinates are stored in 
the data. 
The list of available ellipsoids is maintained in the datum.dat 
file referenced by the uslXdatum environment variable. By 
default, this file is located in the System directory.
Set the ellipsoid for a new vessel file to be the same as the one 
used in the survey. 
1. Select the Options command.

The Options dialog is displayed.
2. Select the Options - General tab.

3. Select an ellipsoid from the pull-down menu.

4. Click OK to close the dialog box.

The name of the ellipsoid is displayed in the Navigation section 
of the editor.

M
en

u

Tools > Options
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3
 Create a New Project

All project information in HIPS and SIPS is maintained in a project data 
base. New projects are created with a wizard, which generates a HIPS 
Project File (.hpf).

In this chapter...
DEFINE NEW PROJECT ................................................. 58
OPEN PROJECTS ......................................................... 64
VIEW PROJECT PROPERTIES .......................................... 67
SET LINE PROPERTIES.................................................. 71
RENAME DAY AND LINE FOLDERS ................................... 73
ARCHIVE PROJECT ....................................................... 74
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Define New Project
In HIPS and SIPS, survey data is organized into projects. The 
default directory for project files is drive\Program 
Files\CARIS\HIPS\8.1\Data.
Before any survey data can be processed, a HIPS Vessel file 
(HVF) must exist. This file defines the offset configurations and 
associated error estimates for each of the sensors, which are 
necessary for creating final position and depth records for survey 
data.
If no HVF is available, it must be defined before the new project 
can be created. (See “CREATE A NEW HVF” ON PAGE 27.) 
To define a new project to organize your survey data in P/V/D/L/ 
hierarchy: 
1. Ensure that an appropriate vessel file has been created for this project.

2. Select the New Project command to open the New Project wizard

New Project (Step 1) 

Project folders in HIPS and SIPS are organized in a Project-
Vessel-Day hierarchy within a HIPS data repository. When 
creating a new project, you can add new Vessel and Day folders 
to an existing project, or create an entirely new project.

Add a new Project 1. Select an existing data folder, or, 

1. Right-click in the default listing and select Connect to to browse to 
another folder location. 

1. To create a new project folder, click Add Project.

M
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File > New > Project

To
ol



CARIS HIPS and SIPS User Guide 59

Create a New Project: Define New Project

The New Project Name dialog box is displayed.
2. Type a name for the new project.

3. Click OK.

A new Project folder is created and displayed in the dialog box in 
the Default folder. 

Change or add data 
repository

The Default directory for projects is …\Hips\ver\Data.
To create a new project in another project repository: 
1. Right-click in the data tree area of the New Project dialog box.

2. Select Connect To… from the pop-up menu.

3. Name the new project folder and use Browse to set the path to the 
new data directory. 

4. Click OK.

Add a new Vessel folder The Vessel folder contains the folders for each survey day of the 
project. To add a Vessel folder to your project:
5. Select a project folder so it is highlighted.

6. Click Add Vessel.

The Available Vessels dialog box is displayed.

7. Select a vessel file from the list.

8. Click OK.

The Vessel folder is created and added to the new Project folder.
Add a new Day folder The Day folder contains track line data. For most formats the 

date is typically recorded with the raw data. If not, give the Day 
folder the date that the survey lines were recorded. 
Day folders are shown in Julian Day format, for example, April 
24, 2009 is shown as 2009-114. 
To add a Day folder to a Vessel folder: 
9. Select the Vessel folder.
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10.Click Add Day.

The Calendar is displayed at the current year-month-day. 

11.Select a different year or month, if needed, by clicking the arrow 
buttons at the top of the dialog box.

12.Select a new day, if needed, by double-clicking on the date.

13.Click Add Day again to create the Day folder with the selected dates. 

14.Click Next to go to Step 2.

Add to an existing 
project

You can add new Vessel and Day folders to an existing project 
instead of creating a new project.
1. Select the existing project from the list in the dialog box.

2. Add vessel and day folders as needed. 

 

Delete empty folders You can also delete an empty Day or Vessel folder by clicking 
Delete. Delete is disabled if a Vessel or Day folder already has 
data converted into it.

New Project (Step 2)
Use the New Project (Step 2) dialog box to describe the project..

1. Type comments or identifying information about the project in the 
Description field.

2. Type the name of the person working with the project data in the Owner 
field. The default name that is displayed is taken from the current 
Windows NT logon name.

3. Click Next.

If you select an existing HIPS Project File (HPF), and add 
new vessel or day, the Finish button is displayed at this 
point. The original project parameters will be applied (set 
when the HPF was first created) .
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New Project (Step 3)
By default, HIPS and SIPS sets the Select UTM Zone Automatically 
check box to select the UTM zone automatically. (The country 
and zone options are dimmed).

To set a different projection for your project:
1. Clear the Select UTM Zone Automatically check box. 

2. Select a country or area from the Group Name list box.



62 CARIS HIPS and SIPS User Guide

Create a New Project: Define New Project

3. Select a zone from the Zone list box.

The Projection key name is automatically displayed once the 
country and zone have been selected.

4. Click Next.

New Project (Step 4)
Use this dialog box to set the geographic coordinates (degrees-
minutes-seconds) for the project area.

By default, the project extent is set to the entire area of the earth.
If you want to use the geographic coordinates of a currently open 
project, at the zoom level currently displayed in the Display 
window: 
1. Click Current View.

To manually enter the geographic coordinates for the project 
area:
1. Select a project extent box (e.g., W) and type the coordinates, or

select the degree, minutes or second field box, and use your arrow 
keys to change the values.

2. Click Finish to complete the creation of the new project.

NOTE: The world-wide map projection coordinate systems 
are defined in the file …\Hips\System\mapdef.dat.
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The new project has been created with Project-Vessel-Day 
folders according to the options selected in the wizard. 
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Open Projects 
1. Select the Open Project command.

The Open Project dialog box is displayed.

2. Select a Project folder so it is highlighted.

If the project contains both bathymetric and side scan data, you 
can open either the vessel or the towfish navigation, or open 
both. Your choice is saved in the registry and the session file for 
future use. 
3. Select either Open ship track lines or Open towfish track lines, or both 

options, to open the appropriate track lines in the Display window.

4. Click Open.

The track lines associated with the project are opened in the 
Display window. The Project/Vessel/Day/Line file tree is 
displayed in the Control window.

When you open a project created in a version of HIPS and SIPS 
prior to 8.0, the project will automatically be updated use the 
new *.hips database file. 

Multiple Data Paths 
The default repository for HIPS data is drive\Program 
Files\CARIS\HIPS\8.1\Data or drive\Program Data 
\CARIS\HIPS\8.1\Data. The projects stored here are shown in 
the Connect To dialog box under “Default”. 
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You are not limited to a single repository for project data. You 
can add other locations to the project tree in both the New 
Project and Open Project dialog boxes. 
To add a new project location:
1. Select Connect To from the right-click menu in the Projects listing. 

The Connect To dialog box is displayed.
 

2. Browse to the location of project folders that are on a different path 
from your Default repository. 

3. Type a name for the new location 

4. Click OK.

The new project location is listed in project tree in the Open 
Project dialog box.

New location
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Open specific data 
You can also open the data for a specific vessel (if the project 
contains more than one), or for a specific survey day, or for an 
individual track line. As you expand each folder, the contents 
are displayed in the Contents pane of the Open Projects dialog 
box. 
1. Choose the Open Project command.

2. In the Open Project dialog box, expand the folder tree by clicking the 
+ icon so that the Vessel and Day folders are visible.

3. Select a vessel folder name so it is highlighted, and click Open, or 
Expand the Vessel folder to see the Day folders. 

4. Select a Day folder and click Open, or

5. Expand the Day folder to see the Line folders. 

6. Select a Line folder and click Open.

Combining project data 
using Windows 
shortcuts

You can use a Windows shortcut to link to HDCS Project/Vessel/
Day/Line data on different drives or network locations. The 
project, plus the shortcut to the other data, is displayed in the 
Project dialog box. The data folders must contain a Vessel 
Configuration File.
1. Create a Windows shortcut in any P/V/D/L directory.

2. Copy the shortcut to the project where you want to place the shortcut. 
Remember that the shortcut must be copied to the appropriate folder. A 
Project folder shortcut must be copied to a HDCS data folder, a Vessel 
folder shortcut must be copied to a Project folder, etc.

3. Open the data using the Open Project command.
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View Project Properties
Essential information for open projects can be viewed in the 
Properties window.
1. Select the HIPS Data layer in the Layers tab of Control window.

2. Open the Properties window.

The Properties for all open projects are displayed, as in the 
examples below. 
 

The General section at the top shows the total number of open 
projects, vessels, lines and soundings. These fields are read-only. 
The properties of each open project are listed below these 
general statistics. 
With the exception of the field for the Name of the Coordinate 
Reference System and for the Vertical Reference System, project 
properties are read-only. 
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The properties of each open project are listed below the General 
statistics.

 

Properties Function

Project Name of first open project

General 

Vessels Number of vessels in project

Lines  Number of lines in project

Soundings Total number of soundings in the project.

Created By Name or initials of project creator

Project Name 

Project Name 



CARIS HIPS and SIPS User Guide 69

Create a New Project: View Project Properties

To change the projection for a project, use the Change Projection 
command on the View menu.

Creation Date Date the project was created

Comments

Coordinate Reference System

Name Identifies the coordinate reference system used in 
the project. Click in the field to open the Select 
Projection dialog box. 

Type Type of system , e.g., ground.

Projection Type of projection, e.g. UTM

Units The units of measurement of the coordinate 
reference system.

Central Meridian The line of longitude used as Central Meridian in 
the Projection.

False Northing The value applied as an offset to all northings.

Vertical Identifies the vertical datum, if known. Click in the 
field to select a reference from the drop-down list. 

Project Boundary

Minimum Latitude

Coordinates of the geographic extents of the 
project

Minimum Longitude

Maximum Latitude

Maximum Longitude

Data Extents

Minimum Latitude

Coordinates of the extents of the data in the 
project

Minimum Longitude

Maximum Latitude

Maximum Longitude

Project Name of next open project 

Properties Function
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View Vessel Properties
Vessel information for the currently open project can be viewed 
in the Vessel Properties dialog box. 
1. Select a Vessel folder from the Project tab in the Control window.

2. Select the Properties command.
 The Vessel Properties dialog box displays the location and 

creation date of the Vessel file. This information is read-only.
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Set Line Properties
Ship track and towfish track lines have default display colours: 
Ship track colours separate lines which have been Merged from 
those that have not. Towfish line colours identify lines that have 
been slant range corrected and those which are raw side scan 
data only.
These default colours are set in the Display tab of the Tools > 
Options dialog box. See “DISPLAY WINDOW” ON PAGE 100 of the 
Reference guide.
You can change the display colours and symbology for the lines 
in a session and save to a session file. 
To change the colour and symbology of ship and towfish track 
lines:
1. Select the Ship Track Lines or Towfish Track Lines layer in the Layers 

tab of the Control window.

2. Open the Properties window. (Shown below are the properties of the 
Ship Track Lines layer.)

General These General properties apply to both ship track and towfish 
track lines. 
1. Set the Symbolize Lines field to “True” to display the lines according to 

the symbolization specifications of a selected feature code.
Select a feature code from the Symbols drop-down list. (The default 
symbolization is TRACK_LINE.

2. Type a Line Weight value to set the size of a selected line in the 
Display. ( A line weight can only be set if Symbolize lines is set to 
“False”).

Line Colour Ship track lines and Towfish track lines have colour properties 
based on these different states: 
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• Ship Track Lines: “Merged” and “Not merged”
• Towfish track lines: “Slant range corrected” and “Raw side 

scan only” 
To change these identifying colours:
3. Highlight the field and select a new colour from the drop-down list.

Line colour can indicate State, but as well lines can also be 
coloured by SV Profile or by Tide applied. You can also have a 
different colour per line. 
To change the determinant of colour for either kind of line:
4. Select an option from the drop-down list in the Colour by field.

State is the default setting, e.g., Merged/Not merged.
SV Profile colours the lines based on the sound velocity profile 
applied. (Ship track line only)
Tide colours them based on the tide zone file applied. (Ship track 
line only)
Multiple colours uses a set of 10 distinct colours to colour the lines. 
This can be useful if data was logged as multiple files along the 
same runline.

If you select to colour by multiple colours, you can also select 
which colour file to apply from the drop-down list in the Colour files 
field.

These settings are saved when you save your session, and will be 
applied when the session is re-opened.
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Rename Day and Line Folders
You can rename existing Day and Line folders after raw data 
has been converted to HIPS/SIPS format. 
1. Select a Day folder or Line folder in the Control window, or select a 

track line in the Display window.

2. Select the Rename command.

The Rename dialog box is opened with the selected file or folder 
name displayed.
3. Enter a new name in the box.

4. Click OK.

The changed file name is displayed in the Control window.
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Archive Project 
A project and its related data can be saved to a compressed 
format (*.ZIP) using the New Archive command. 
To archive a project:
1. Select the New Archive command.

The archive Properties dialog box is displayed.
.

When you click in any of these property fields, a Browse button is 
activated. Use Browse to locate files. 
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2. Set paths and select files, as follows:

Field name 

General:

Archive Name 1. Click Browse to open the Save As dialog box.
2. Type a name and set a destination directory for the 

archive file and click OK. 

Project 1. Click Browse to open the Select Project dialog box.
2. Double-click on Default to open the project tree. 
3. Select the project and click OK.

Fieldsheets:

Fieldsheet Directory 1. Click Browse to select the field sheet directory from 
the Browse for Folder dialog box.

2. [Optional] Make a new folder.
3. Click OK to enter the path in the field.

Edit Selection 1. Click Browse to view the Open Field Sheets dialog 
box.

2. Click on the project name to expand the list of availa-
ble field sheets for the project.

3. Select the field sheets to be included in the archived 
file.
• Select a single fieldsheet by clicking on it. 
• Use <Ctrl> to select more than one field sheet 

from the list.
4. Click Open to list the selected field sheets.

Auxiliary Files: (Related files necessary for the successful processing 
of data, for example, tide, sound velocity, delta draft, 
delayed heave files, etc.)

Edit Selection 1. Click Browse to open the Select Files dialog box.
2. Click Add to open the standard Select Files dialog 

box and locate the auxiliary files to be included.
3. Repeat until list of files is complete.
4. Click OK. 

Use Remove and Clear to adjust your selection.

Additional Files: (Data that is associated with the project, but is not 
necessary for processing data, for example, 
background images and associated charts.)

Edit Selection 1. Click Browse to open the Select Files dialog box.
2. Click Add to open the standard Select Files dialog 

box and locate the additional files.
3. Repeat until list of files is complete.
4. Click OK. 

Use Remove and Clear to adjust your selection.
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3. Click OK to archive the file selected to the set destination. 

The ZIP file is created and contains these folders: 
• VesselConfig
• Project
• PreProcess
• Fieldsheets
• Background.



4
Convert Data

Use the Data Conversion wizard to convert various types of survey data 
into HDCS-specific format. 

In this chapter...
CONVERTING FILES TO HIPS/SIPS FORMAT................... 78
FORMATS THAT CAN BE CONVERTED TO HIPS AND SIPS: .. 79
OPTIONS FOR SPECIFIC FORMATS ................................... 96
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Converting Files to HIPS/SIPS Format
HIPS and SIPS files are created from survey data using the 
Conversion Wizard.(Survey data in ASCII format can also be 
converted using the Generic Data Parser. See “GENERIC DATA 
PARSER” ON PAGE 105 of the Tools guide.) 
Data that is converted to HIPS/SIPS format may be in varying 
stages of completion, depending on the data format options. 
Survey data may or may not have been corrected for factors such 
as heave/pitch/roll or sound velocity. Such correction can be 
applied during the Merge process and SVP Correction.   
All HIPS and SIPS data is organized in a Project/Vessel/Day/
Line directory structure. If you organize the raw data files 
according to this structure, then you can convert line data from 
entire Project or from multiple Vessel and Day folders contained 
in a common Project folder. Use the File Selection Type option in 
Step 2 of the wizard to do this (see “SELECT FILES FOR CONVERSION” ON 
PAGE 82).
When entire project data has been converted, a Project/Vessel/
Day/Line directory is created for the converted data. If there is 
already a Project folder that is identical to the preprocess folder, 
then the line data in the existing folder is over-written with the 
new data.

You must organize your raw data files in a HIPS/SIPS 
Project-Vessel-Day structure to convert complete Project, 
Vessel and/or Day data files.
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Formats that can be converted to HIPS and SIPS: 

File Format File extensions Data types processed in 
HIPS and SIPS

Geocoder 
Support 

Atlas *.sda, *.asd, *.acf, Surf multibeam, single beam No

Chirpscan3D *.brf multibeam No

CMAX *.cmx, *.cm2 multibeam, single beam No

Coda *.* side scan No

Edgetech *.* side scan No

EIVA *.sbd  (generic  EIVA binary 
format) or XTF

multibeam, single beam No

Elac *.* multibeam, single beam, side 
scan

No

Furuno *.* multibeam, single beam, side 
scan

No

GeoAcoustics *.rdf Dual frequency side scan  

GeoSwath /  GeoSwath 
Plus

 *.ssr, *.ssi, *.ssp simultaneous swath/multibeam, 
side scan

Yes

GSF ( Generic Sensor 
Format)

*.gsf, *.* multibeam Yes (all formats)

Hawkeye *.bin LIDAR No

Hypack *.hsx multibeam, single beam, side 
scan, sweep

Yes (HSX/81X, 
HSX/7k, HSX/
R2S, HSX)

Imagenex *.83p, *.83m multibeam, side scan No

LADS *.* LIDAR No

LAS (a public binary 
format for LIDAR data)

*.las LIDAR No

Marine Sonics MS Tiff files (*.*)  side scan No

Navitronics *.raw multibeam, single beam, sweep No

QMips *.* side scan No

Teledyne Reson PDS *.pds, *.s7k multibeam Yes (s7k only) 
BA/TS

SAS *.img swath No

Scripps *.* swath, side scan No

SDF *.sdf side scan No

Seaflacon *.* multibeam No

Seabeam *.* multibeam No

SEGY *.* side scan No

SHOALS *.out, *.hof, *.tof LIDAR No
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BA = Beam Average

TS = Time Series

Simrad *.all, *.out, *.raw, *.depth, 
*.mb57

multibeam, single beam, side 
scan

Yes BA/TS (for 
*.all data only)

Spawar *.dat  swath No

Swathplus Submetrix SXP files *.sxp, 
*.sxr, *.sxi

multibeam, side scan No

Teledyne *.tdy, *.* swath, side scan No

UNB swathed files (*.merged)

Reson *.*

swath No

Winfrog  *.* single beam No

XTF *.xtf multibeam, single beam, side 
scan, sweep

Yes (Reson, 
R2Sonic, various 
side scan)

File Format File extensions Data types processed in 
HIPS and SIPS

Geocoder 
Support 
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Select Data Format
To start the conversion process, activate the HIPS Conversion 
Wizard. 
1. Select the Conversion Wizard command in the HIPS and SIPS main 

interface.

The first Conversion dialog box is displayed. 

The Step 1 dialog box lists the data acquisition systems for 
which data can be converted to HIPS and SIPS files. (This list is 
created dynamically from all format libraries with the name 
convert_*.dll in the Hips\Bin directory.)

1. Select the survey data type to be converted by clicking the appropriate 
name.

2. Click Next. 
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Select Files for Conversion
In most converters this dialog box will appear so you can select 
the files to be converted. Some formats have other import 
options to set before selecting data files. (See “IMPORT OPTIONS” ON 
PAGE 83.)

1. Select the appropriate File selection type from the drop-down list. The 
default is RawData. 

2. Click Select to choose the files you want to convert. 

 

If you have selected Raw Data as the File selection type, clicking 
Select will open the Select Files dialog box. (The default 
directory for Raw Data is …\Hips\Preprocess.) 
If you select Project, Vessel or Day as the File selection type, Select 
will open the P/V/D tree structure so you can browse for the 
folder containing the files you want to convert. 
3. [Optional] To remove a file from the list, select it and click Remove.

4. Click Next.

If you are converting multibeam data with the Hypack 
converter, select HSX files, not RAW files for conversion. 



CARIS HIPS and SIPS User Guide 83

Convert Data: Select Files for Conversion

 

Import Options
Before selecting the data to be converted, some file formats have 
other options that must be set. 

Create or Update 
survey lines

The conversion process creates all new data files within the 
project structure. However, if line directories already exist 
within your project, they are deleted and replaced with the new 
survey data. 
Instead of overwriting all existing data, you can choose to update 
only certain data. For example, you can opt to update only the 
navigation information on your processed survey lines, or to add 
backscatter imagery data to a project, without overwriting any of 
the rest of your processed data.
At present this option is available for these formats:
• Hypack (HSX/81X)
• Teledyne Reson PDS
• Simrad
• XTF
These options are presented in the Step 2 dialog box of the 
Conversion Wizard, before the actual data files are selected. 

1. Select Create new survey lines to save new data to the project, 
overwriting any existing data. This is the default setting.

2. Select Update existing survey lines to choose which kinds of data to 
replace in your existing project. By default, all the types are set to 
overwrite your existing data. be overwritten. Clear the check box(es) for 
the data you do not want overwritten. (If the lines don't exist, no data is 
converted.)
• Overwrite Bathymetry: When checked on, this option will cause the 

SlantRange, ObservedDepths and ProcessedDepths data files to 
be replaced by the converter.

• Overwrite Navigation: When checked on, this option will cause the 
Navigation and SSSNavigation data files to be replaced by the 
converter.

Raw data being converted into HIPS and SIPS can also be 
located on a read-only media such as a CD-ROM, except 
for Atlas SURF data, which at this time, does not support 
conversion from read-only files.
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• Overwrite Motion: When checked on, this options will cause the 
Gyro, Heave, Pitch, Roll, DeltaDraft, CableOut, SensorHeight data 
files to be replaced by the converter.

• Overwrite Sidescan: When checked on, this option will cause the 
SideScan and SSSProcessedSideScan data files to be replaced by 
the converter.

• Overwrite Backscatter: When checked on, this option will cause all 
'imagery' related data files to be replaced by the converter (i.e. all 
data files needed for GeoCoder processing).

Carry Over Raw Data 
Files

The conversion process for some data formats can copy the 
original data files to the processed folders. This process is 
optional. By default, raw data files are not carried over. 
However, the location of the raw files is referenced in the 
Observed Depths file.
If you select the Carry Over Raw Data Files check box, your data 
will be converted and a copy of the raw files placed in the line 
folders. 
3. Select Carry Over Raw Data Files to copy raw data files to the line 

folders.

If a process uses raw data, and the raw data has been carried over, 
HIPS will use the files in the HDCS line folder. 

If the raw data file is not carried over then HIPS will search the 
referenced location of the raw files. If the data is not found, you will 
be prompted to have HIPS search for it, or to search for it yourself. 

Search for Files with 
Temporal Overlap

When converting Simrad or XTF data the converter scans the 
entire directory containing the files selected to be converted. This 
scan checks for navigation or motion data with time overlaps. This 
is done in order to synchronise the reference time stamps 
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properly, in cases where single survey lines are split up into 
multiple pieces by the acquisition software. 
This scanning can be time-consuming, particularly with large 
data sets. However, if this synchronizing is not done when a line 
has been split, the data in the converted line segments may not 
overlap correctly. 
To turn off this synchronizing function: 
4. Select the Search directories for files with temporal overlap check box.

5. Click Next to select the specific files to import.
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Select Project, Vessel and Day
Use the Step 3 dialog box to select the Project, Vessel and Day 
into which your converted data will be saved. 
 

1. Click the Expand (+) icon to expand the Project file tree so that a Day 
folder is visible.

2. Click the Day folder so it is highlighted.

3. Click Next.  

To select an existing project that is not listed in the current file 
tree:
1. Right-click in the data tree area of the dialog box.

2. Select Connect To… from the pop-up menu.

3. Name the new project folder and use Browse to set the path to the 
new data directory. 

4. Click OK.

To create a new project:
1. Click Add Project and follow the steps to “DEFINE NEW PROJECT” ON 

PAGE 58.

Add Vessel or Day You can also use this dialog box to add Vessel or Day folders to 
an existing project, or to delete empty folders.
1. To add a vessel to the selected project, make sure the project directory 

is highlighted and click Add Vessel.

The Available Vessels dialog box is displayed. 
2. Select a vessel folder and click OK.
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The new Vessel folder is displayed in the selected project 
directory.
To add a Day folder to the project:
1. Click the Vessel folder to expand it and click Add Day.

The Calendar dialog box is displayed.
2. Select a year/month/day from the calendar, and click OK.

A Day folder with the selected date is stored in the Vessel folder.
Remove folder 3. To remove an empty Day or Vessel folder from the wizard, highlight the 

folder and click Delete. 

To add a Project to the root directory:
1. Click Add Project to open the New Project wizard, and follow the steps 

in the wizard.

When you have finished creating a new project for your data, you 
will be returned to the Conversion wizard to continue the 
conversion process.
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Set Navigation Coordinate System
The next step is to define the type of coordinates that were used 
to record the navigation data in the raw data files.

To indicate the type of coordinate system that was used for 
navigation data during data logging,
1. Select one of the following options:

• Geographic: navigation data is recorded as latitude and longitude 
coordinates.

• Ground: navigation data is recorded as eastings and northings. 

If you select Ground, complete the following steps:
2. Select an area from the Group list.

3. Select a zone.

4. Click Next. 
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Setting Geographic as Navigation Coordinate Type for 
Hypack data: 

Hysweep format (HSX) does not store Geographic 
coordinates and GPS Height information. If recorded, this 
data is stored in RAW files.

When both the Geographic option and Multibeam options are 
set during conversion, the converter will search for *.raw files 
in the same directory with the same line name to get this 
information.
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Select Filters
During the conversion process, some soundings can be 
automatically rejected due to disabled beams. This is controlled 
by the beam status settings in the vessel configuration. 
Also, several multibeam formats pre-flag some soundings as 
being failed detects. These soundings are also automatically 
rejected during conversion. 
This dialog box defines basic navigation and depth filters to 
automatically reject extremely large errors in the recorded 
navigation and depth data.

1. Select the Navigation check box to enable the navigation filter.

The extents of the filter can be defined either by setting them 
manually in this dialog box, or by using the extents as defined in 
the project selected at Step 3 or 4. 
2. Select either Manual option or the Project File option.

3. If you selected the Manual option, enter the extent coordinates in the 
fields. You can use the <Tab> key to move between fields and use the 
arrow keys to move between values in a field.
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4. Select the Depth check box to enable the depth filter.

5. Enter the minimum acceptable depth.

6. Enter a maximum acceptable depth.

7. For advanced filtering for multibeam or multi-transducer data select the 
Advanced Filtering check box and click Parameters to set advanced 
filtering options. 

Advanced Filtering 
Currently, advanced filtering is only available for these 
multibeam and multi-transducer formats: GeoAcoustics, Klein 
SDF, EIVA and Hypack. 
If filtering is not available for the type of data you are 
converting, these options will be greyed-out.
 

Certain data can be filtered so that only the best quality data is 
imported to HIPS. The filter is applied to port and starboard 
beam angles.

The HIPS converter for reading Klein SDF data files has 
been enhanced to read the bathymetry data from the Klein 
data format 5000 V2. As a result of this enhancement, the 
filtering capabilities in step 5 of the Conversion Wizard are 
now enabled for this conversion. These settings are 
functional only for the format 5000 V2 data, as no other 
formats processed by the SDF converter currently contain 
bathymetry.
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1. Select Angle filter (Port/Stbd) and type a range of beam angles. 

The Range Filtering option converts soundings within a specified 
distance (in metres). Soundings outside of this range are not 
converted.
2. Select the Range Filtering check box to implement this option.

3. Click the up or down arrow buttons to select a minimum and maximum 
distance.

The Amplitude Filtering option filters soundings according to 
amplitude value. For each ping (port and starboard pings are 
handled separately), the min/max amplitude values are 
obtained, and samples that fall below the selected percentage (0-
50%) are rejected.
4. Select the Amplitude Filtering check box to implement this option.

5. Click the up or down arrow buttons to select a percentage value for 
rejecting soundings.

The Statistical Filtering option controls which soundings in each 
swath are considered for conversion. This option calculates the 
mean depth and standard deviation within a swath sector or 
horizontal bin. It then prevents any soundings that fall outside a 
multiple of the standard deviation from being converted.
If Statistical Filtering is used, then the mean within the sector is 
re-computed. Ultimately, soundings are sorted by their residual 
from the mean and those closest to the mean are converted. The 
actual number of soundings converted from within each sector is 
determined by the thinning factor (if used).
6. Select the Statistical Filtering check box to implement this option.

7. Determine a Threshold (multiples of the standard deviation) value by 
clicking the up and down arrow buttons.

The equivalent confidence value is displayed as a percentage.
The filtering and thinning methods are executed within a sector 
angle interval or a horizontal bin size. The sector angle option 
divides the swath into sectors according to degree angles while 
the horizontal bin size divides the swath into horizontal sectors 
based on a specified across track distance.
Vessel motion and transducer mounting angles are considered 
when sector angle and horizontal bin locations are determined.
1. Select the Sector Angle Interval option and choose a degree level (to a 

maximum of 10º) by clicking the up or down arrow buttons.

2. As an alternate method, Select the Horizontal Bin Size option choose 
an across track distance by clicking the up or down arrow buttons.

The thinning factor reduces the number of soundings converted 
on a per swath basis. The thinning factor uses a power of two 
reduction control (1/2, 1/4, 1/8, etc.) so that one of two, one of four 
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or one of eight soundings can optionally be converted per swath 
sector.
3. Select the Data Thinning check box to implement the thinning option.

4. Select a Thinning Factor value by clicking the up or down arrow 
buttons.

5. Select Output thinned data to convert only non-rejected data.

You have the option not to convert soundings which have been 
eliminated because of data thinning. Although by doing so, a 
mismatch is created between the converted HIPS data and the 
original data file. (Since multi-transducer data is tied to the 
settings in the vessel file, the full dataset is always converted).
6. Click Next. 

Enter Data Parameters
Depending on the data acquisition format you selected in the 
Step 1 of the wizard, one or more dialog boxes, appropriate to the 
format, are now displayed. See “OPTIONS FOR SPECIFIC FORMATS” ON 
PAGE 96 for description of options for different raw data formats. 
1. Choose the settings appropriate to the data format being converted.

2. Click Next.
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Convert Data
The final step is to launch the conversion process. 
The settings and parameters you have selected are displayed in 
the dialog box. This information can be copied to a text file, using 
the Copy command on the right-click menu. 
 

To convert the data using the settings: 
1. Click Convert.

Conversion progress A progress indicator bar along the bottom of the box is activated 
as the files are being processed. As each line is converted, the 
results of the conversion process are displayed in the dialog box. 

This information can also be copied to a text file.
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The converted files are saved in the directory you selected in 
Step 2 of the conversion process (see “SELECT FILES FOR CONVERSION” ON 
PAGE 82).
2. Click Close to close the wizard.

[Optional] to return to the initial step of the conversion process click 
Restart.
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Options for Specific Formats
In some cases, HIPS Conversion Wizard provides import options 
specific to the format being converted. The number of options 
depends on the data acquisition format that was selected in Step 
1 of the Conversion Wizard.
These are the current formats which can be converted:  

“ATLAS” ON PAGE 97 “CHIRPSCAN3D” ON PAGE 98

“CMAX” ON PAGE 98 “CODA” ON PAGE 98

“EDGETECH” ON PAGE 99 “EIVA” ON PAGE 101

“ELAC” ON PAGE 102 “FURUNO” ON PAGE 103

“GEOACOUSTICS” ON PAGE 104 “GSF” ON PAGE 107

“HAWKEYE” ON PAGE 108 “HYPACK” ON PAGE 109

“IMAGENEX” ON PAGE 112 “LADS” ON PAGE 113

“LAS” ON PAGE 114 “MARINESONICS” ON PAGE 114

“NAVITRONICS” ON PAGE 114 “QMIPS” ON PAGE 115

“TELEDYNE RESON PDS” ON PAGE 116 “SAS” ON PAGE 119

“SCRIPPS” ON PAGE 119 “SDF” ON PAGE 120

“SEABEAM” ON PAGE 121 “SEAFALCON” ON PAGE 121

“SEGY” ON PAGE 121 “SHOALS” ON PAGE 122

“SIMRAD” ON PAGE 122 “SPAWAR” ON PAGE 124

“SWATHPLUS” ON PAGE 124 “TELEDYNE” ON PAGE 124

“UNB” ON PAGE 124 “WINFROG” ON PAGE 124

“XTF” ON PAGE 126

Please be advised that some 64-bit versions of third-party libraries remain 
unavailable at this time. Therefore, the following capabilities will not be 
available in the 64-bit version of HIPS and SIPS:

• Navitronics format conversion 
• Hawkeye waveform viewer 

If any of the above capabilities are required, you will need to use the 32-bit 
version of HIPS and SIPS.
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Atlas
The ASCII versions of Hydrosweep DS files are now supported. 
1. Type the year of the survey into the Survey Year field. You cannot enter 

a year prior to 1970. (The default value shown is obtained from the 
HIPS Day directory into which data is converted.) 

2. From the pull-down menu, select one of the following SURF data types 
to convert:
• multibeam
• single beam (low frequency)
• single beam (medium frequency)
• single beam (high frequency)
• dual frequency (low-medium)
• dual frequency (low-high)
• dual frequency (medium-high)

3. Click the Convert Side Scan check box to include side scan data in the 
conversion process.

Critical line name information can be fitted into 12 characters 
provided by the CARIS Source ID attribute for soundings in a 
CARIS map.
4. Select the Shorten line names check box to modify the file name to a 

12-character name (YYDDD_HHMMDD). 

5. Select the higher frequency data as the primary soundings (if data 
format is dual-frequency). 



98 CARIS HIPS and SIPS User Guide

Convert Data: Options for Specific Formats

6. Select High Frequency or Low Frequency from the drop-down list to 
convert Atlas ASD side scan data (if available). 

Chirpscan3D
There are no options for the Chirpscan3D format.

CMAX
There are no options for the CMAX format.

Coda
1. Select a sonar channel.

2. Click the Decimate Imagery check box to apply a decimation routine to 
the side scan data. Decimation reduces side scan data to 1024 or 
fewer intensities per side for each swath.

3. Click the Correct Imagery check box to increase contrast in the side 
scan imagery.

4. Select the Cable Out is Horizontal Layback option to omit sensor depth 
during conversion. If there is no sensor depth and the towpoint has a Z-
offset of zero, the cable out value is treated as the horizontal layback 
value during processing.

The Atlas SURF library cannot be converted from read-only 
files. Atlas files must be located on a read-write media 
before they can be converted into HIPS.
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EdgeTech
Edgetech side scan data is imported in 16-bit format.

1. Select a side scan system:
• Midas
• 260
• JSF

2. If Midas is enabled, select a sonar frequency channel:
• 100 KHz
• 500 KHz

3. If JSF is enabled, select a sonar frequency channel:
• All data
• Low Frequency
• High Frequency

4. If altitude data is present in the JSF data, select the data source:
• Sensor
• Discover-2

5. Select either Layback or Cable Out from which to convert the JSF data. 
• If you select Cable Out, select the source for Depth, either Sensor 

or Discover-2. 

Bathymetry data collected with the Edgetech 4600 system has a 
quality value associated with every bathymetry sample in each 
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ping. This quality attribute is presented as a percentage value, 
with a higher value representing a better quality sample.
Use the Bathy Quality slider to set the quality value below 
which soundings will be automatically rejected during 
conversion. 
6. Set a value between 50% and 100% using the slider.
Since each ping can contain thousands of samples, you can 
reduce the volume of data that's converted by turning off the 
Convert rejected option. 
7. [Optional] Clear the Convert rejected check box.
If you leave this check box selected, all data will be converted. 
However, data which does not meet the quality value will be 
converted with “Rejected” status. 
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EIVA 
At Step 5, you have the option of using the generic multibeam 
filtering functions built into the HIPS Conversion Wizard.
See “ADVANCED FILTERING” ON PAGE 91. 
Step 6 offers further conversion options specific to EIVA data. 

1. Select the Convert ROV depth option to store the EIVA sub-packets as 
HIPS delta draft values.

2. Select the Pad with NULL beams option, to replace missing data with 
NULL (rejected) beams in the case of dual head data where the data 
from head #1 is missing. This results in the beam numbers for 
transducer 2 data remaining consistent with fully populated profiles.

3. Select Swap transducers 1/2 data to exchange data between heads (in 
dual head set-up). 

4. Select the Separate dual head data option to specify that soundings 
from the dual head transducer data are not combined into a single 
HIPS profile. (Soundings from transducer head #2 will be identified via 
status bits encoding so no changes to your vessel files are needed.)

Since EIVA allows data logging from multiple devices, the Data 
Source option enables you to select the source for heading, 
attitude, and navigation data. The data for each device is tagged 
with a number (from 0 to 4), that represents one of up to five 
devices collecting each type of data. (If you select a number for 
which no device exists, no data is converted.)
5. Select a device number from the list for Gyro, Navigation and/or Motion 

data to convert the data from that device.
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You can convert the XML portion of your Atlas ASD data, 
instead of the Binary (the traditional source of bathymetry data 
in the EIVA converter). The XML portion, if it exists, is 
contained within the EIVA sidescan datagrams. 
6. Select the source for bathymetry data from the Bathy drop-down list. 

The default selection is Binary.

7. Select High Frequency or Low Frequency to convert Atlas ASD data. 

Elac 

Beam numbering During conversion, XSE-format beams are numbered according 
to the sounding’s position along the swath (in relation to the 
vessel). 
1. To number the converted beams along the swath from starboard to 

port, select the Starboard-to-Port check box.

2. To number the converted beams along the swath from port to 
starboard, select the Port-to-Starboard check box.

Surface sound speed If a single Sound Velocity value was used during the survey:
3. Select the Manual option and type the sound velocity value.

If a Sound Velocity Profile was recorded and used by the logging 
system, then the Interpolate option must be selected.
4. Select Interpolate to read surface sound velocity values from a 

datagram.

Attitude data You can select the source for attitude data. The Navigation 
option will convert heave, pitch and roll data from the 
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navigation records in the file and multibeam will convert it from 
multibeam records. 
5. Select either Navigation or Multibeam as the source of Attitude Data.

Convert Side Scan 6. To convert side scan data, select the Convert Side Scan check box.

Survey mode ELAC XSE data can be recorded as 108 beams or 126 beams 
(depending on the survey mode). The Pad Transducer 1 with NULL 
beams writes 63 beams to Transducer 1 so that the same HIPS 
Vessel File (HVF) can be used for both survey modes.
7. Click the Pad Transducer 1 with NULL beams check box so that the 

soundings associated with transducer 1 are padded to have 63 beams. 

8. Click Next.

Furuno
1. Make sure the Convert Side Scan option is checked to include side 

scan data with the bathymetric data.
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GeoAcoustics
1. In the Nav Source field, select Any GPS String, or GGK, GGA, or 

GGL.

2. If you want to convert data from Aux1 as delta draft, select the Convert 
Aux1 data as delta draft option. 

Amplitude Filtering The Amplitude Filtering option filters soundings according to 
amplitude value. For each ping (port and starboard pings are 
handled separately), the min/max amplitude values are 
obtained, and samples that fall below the selected percentage (0-
50%) are rejected.
3. Select the Amplitude Filtering check box to implement this option.

4. Click the up or down arrow buttons to select a percentage for rejecting 
soundings.

Range Filtering The Range Filtering option converts soundings within a specified 
slant range, as determined by travel time times sound speed, 
regardless of the direction of travel. Soundings outside of this 
slant range are not converted.
5. Select the Range Filtering check box to implement this option.

6. Click the up or down arrow buttons to select a minimum and maximum 
distance.

Pre-Filtering The Pre-Filtering option controls which soundings in each swath 
are considered for conversion, by calculating the mean depth and 
standard deviation within a swath sector or horizontal bin. Any 
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soundings that fall outside the set multiple of the standard 
deviation are not converted.
This pre-filtering is done in two passes. The first removes the 
most obvious outliers. Then a second pass computes a new mean 
using a “better” set of soundings.
Ultimately, the soundings are sorted by their residual from the 
mean and those closest to the mean are converted. The actual 
number of soundings converted from within each sector is 
determined by the thinning factor (if used).
1. Select the Pre-Filtering check box to implement this option.

2. Determine a Threshold (multiples of the standard deviation) value by 
clicking the up and down arrow buttons.

The equivalent confidence value is displayed as a percentage.
Sector Angle The filtering and thinning methods are executed within a sector 

angle interval or a horizontal bin size. The sector angle option 
divides the swath into sectors according to degree angles while 
the horizontal bin size divides the swath into horizontal sectors 
based on a specified across track distance.
Vessel motion and transducer mounting angles are considered 
when sector angle and horizontal bin locations are determined.
3. Select the Sector Angle Interval option and choose a degree level (to a 

maximum of 10º) by clicking the up or down arrow buttons.

4. Alternatively, select the Horizontal Bin Size option choose an across 
track distance by clicking the up or down arrow buttons.

Data Thinning Soundings that survive Pre-Filtering are sorted according to depth, 
and those that are closest to the mean depth are selected, as 
specified by the Thinning Factor you set.
Data Thinning is done on a per swath basis, based on the set of 
soundings that are closest to the mean value computed. 
The Thinning Factor reduces the number of soundings on a per 
swath basis using a powers of two reduction control. Setting a 
factor of, for example, 4, will mean that the one-fourth of the 
soundings that are closest to the calculated mean will be 
converted per swath sector. 
1. Select the Data Thinning check box to implement the thinning option.

2. Select a Thinning Factor value by clicking the up or down arrow 
buttons. Values between 2 and 256 may be set (values between one-
half and 1/256th can be selected. 
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3. Click Next. 

This converter reduces data to fewer than 2000 soundings in 
a profile, as follows:

• If data contains more than 2000, and you select the Pre-filtering 
and Data Thinning options, these will be applied to the data.

• If data contains more than 2000, and you do not select Pre-
filtering and Data Thinning options, data is automatically reduced 
by the value in Thinning Factor field (using the last factor 
entered).
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GSF

Data recorded during line turns is marked as Offline data in 
GSF. This data can be included or excluded during conversion. 
When included it can also be automatically rejected. One 
purpose for including the Offline data would be to maintain the 
same swath profile numbers in HIPS format. 
1. Select the Include Offline Data box to convert data recorded during 

turns between track lines. 

2. Select the Reject Offline Data check box to automatically reject the 
Offline data.

3. Select a source for depth data, either True depth or Nominal depth. 

Horizontal and depth uncertainty values in the GSF file are also 
included during conversion.
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Hawkeye 

The Hawkeye data structure as exported from AHAB CSS 
Software needs to be maintained in order for processing to be 
successful in HIPS and SIPS. 
There are two kinds of Hawkeye files, with _HD.bin and _TD.bin 
extensions. The two kinds of files have identical data structures, 
but differ in contents: 
• The HD files store primarily hydrographic data but can 

contain topographic data as well. 
• The TD files store only topographic data. 
Each data point in the files contains two attributes: Depth and 
PointAltitude. 
• The Depth attribute is water depth relative to chart datum.
• The PointAltitude attribute is height relative to an ellipsoid.
Data in TD files is always be converted using the PointAltitude 
attribute, but where HD files are concerned, you can choose 
between the Depth and PointAltitude attributes.
1. Select the appropriate source for the hydrographic data from the drop-

down list, either Depth or PointAltitude.

Use the Invalid data set to option to apply a substitute depth of 
either +99m (below chart datum) or -99m (above chart datum) 
for data rejected by disabled beam. This data will be marked as 
“Rejected” and display this depth value. 
2. Select -99m or +99 m as substitute depth.

3. Select the depth classes to import to HIPS. (Default sets all classes to 
be imported.) 
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Hypack
The Hypack format records bathymetry from single beam, 
multibeam, and multiple transducer (sweep) systems. 
It also supports recording side scan data from Hysweep format 
(HSX).
For dual-frequency single beam data, you must indicate if the 
data records in Hypack are recorded as primary/secondary or 
secondary/primary. The primary frequency, by default, becomes 
the selected data for use in the field sheet.
When converting Side Scan data, if the conversion wizard 
detects records containing 12-bit data, they will be converted to 
16-bit format. Otherwise they are converted to 8-bit data. 

Use the Bathymetry and/or Side Scan drop-down lists to select the 
type of data to be converted. (You must make a selection or the 
conversion process will not go forward.) 
Select a Bathymetry setting to convert data in Hypack raw format 
(RAW and HSX) and processed format (HS2) from singlebeam, 
multibeam and multiple transducers systems.

1. Select a Bathymetry sounding data type from the drop-down list:
• Single Frequency

If you are converting Bathymetry, ensure that the vessel file 
for the data contains a Depths section, or conversion will fail.
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• Dual Frequency (Primary, Secondary)
• Dual Frequency (Secondary, Primary)
• Multibeam
• Multiple transducers (for sweep data)

Hysweep format (HSX) does not store Geographic Coordinates 
and GPS Height information. If recorded, this data is stored in 
RAW files. When both the Geographic option and Multibeam 
options are set during conversion, the converter will search for 
*.raw files in the same directory with the same line name to get 
this information. 

2. Select Side Scan data type from the drop-down list:
• Low Frequency, High Frequency or None. 
• If the data file contains only single frequency data then this setting is 

ignored, and all data is converted.

3. Select Apply static draft to apply the static draft during conversion. 

To ensure data collected in feet is converted correctly, convert 
data in feet rather than metres: 
4. Select HS2 in feet check box.

The HS2 format does not store day and year values with the 
timestamp (it does store a time value). When the data is 
converted to HIPS, by default the Day folder is used for reading 
the date. 
If you want to include another date value: 
5. Select the Use HS2 Survey Date check box to enable the Day and 

Year fields.

6. Type the year and day in the fields.

The value in the Sound Velocity field is used to compute the 
original travel time data from the recorded depths. Since this is 
used in performing sound velocity correction, it is important that 
the Sound Velocity value is correctly specified. 
7. Enter the Sound Velocity value for:

• single beam data (Single or Dual Frequency
• multiple-transducer (sweep) data.

Device Numbers The Device Numbers fields are used if sensor data was recorded 
from more than one device. To import data from a specific 
sensor, type the number for that device. If no number is entered 

If you are converting multibeam data, and you set 
"Geographic" at Step 5 as the Navigation Coordinate Type, 
the converter will search the directory where the HSX files 
are located for *.raw files with the same name as the *.hsx 
files. The RAW files contain the RAW record which contains 
the Geographic coordinates and GPS height information.
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then all sensor data is imported. In the case of the Port and 
Starboard Transducers, the first device found will be used.
The following sensors are affected by the device number setting:
• Navigation for positional records.
• Gyro for heading records.
• Motion Sensor for roll, pitch and/or heave settings.
• Port transducer for port multibeam records.
• Stbd transducer for starboard multibeam records. 
• SOW Sensor for speed over water records.
8. If data is recorded from more than one sensor device, click the sensor 

check box and enter a device number.

9. Click Next to continue.
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Imagenex

Navigation data can be imported from an external *.NAV file 
with the same name as the Imaginex *.83p file. If the HIPS 
converter detects that a *.NAV file exists, it will import 
navigation and GPS height data from the GPS strings in the 
*.NAV file. In this case the stored navigation data in the *.83p 
file is not converted.
You can choose read either the GGK or the GGA string, or have 
either read by selecting the Any option. These controls are only 
applied if there is an *.NAV file with the same name as the *.83p 
file. 
To read GPS height data from Imagenex files: 
1. Select the height string to be read: GGA, GGK or Any. 

HIPS can convert dual head data stored in the Imagenex 
*.83m format. However, in order to properly process the 
data, the HIPS Vessel file must be set up as a dual head 
vessel. 

As well, if the number of beams normally expected for 
head#1 is more than 200, set the number larger, for 
example, to 1000.

If you expect head #1 to generate no more than 200 beams, 
set the beam number in the HVF to 200. 
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LADS
LADS data is contained in two files that are copied into the 
HIPS survey line folder: An ASCII CAF file that contains the 
bathymetry data, and a binary CBF file that contains the 
waveform data. The CAF file can contain data from more than 
one survey line (or “run”). When this is the case, the converter 
splits the file into separate line folders for each run. The *.caf 
and *.cbf extensions are retained in the HIPS Line folder.
There are four sounding classifications in the LADS format:
• S (Secondary sounding): the best soundings
• P (Primary sounding): an unreliable result
• N (No bottom found at depth): potentially a useful depth 

result
• X (No bottom detected): no result 
When the data is converted, each sounding is given a status flag 
according to its classification. The following table lists the HIPS 
status flags applied to the LADS classifications. 
 

There are no dialog box options for the LADS format.

LADS
Classification

HIPS Sounding 
Flag Definition

S Accepted Good soundings until they are flagged as 
rejected during cleaning in HIPS.

P Rejected by 
disabled beam

A reject flag in HIPS that can be changed 
to Accepted, if necessary.

N Examined A special flag for an Accepted sounding. 
The sounding can be filtered out when 
creating a BASE Surface or exporting. It 
can also be flagged as Rejected during 
cleaning in HIPS

X Rejected by Depth 
Gate

A type of Reject flag that can be changed 
to Accepted, if desired.
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LAS
LAS files can contain either elevation or hydrographic data. 
Conversion step 6 for LAS data offers the option to invert the “Z 
values” from positive to negative, and vice versa, so that the Z axis 
is changed to match the HIPS “positive down” depth convention. By 
default this option is turned off.

MarineSonics
There are no specific options for the MarineSonics format.

Navitronics
1. Select one of the following data types to be converted:

• Multibeam
• Singlebeam
• Multiple Transducer

2. Select the Convert Side Scan check box to convert side scan data.

Navitronics side scan data can be imported in 16-bit format or 
converted to an 8-bit format.
3. Select either the Preserve 16-bit option or Convert to 8-bit option.

If the Convert to 8-bit option is selected, the Scale and Shift options 
are enabled. The Scale option averages the data and the Shift 
option selects a initial bit value (between 0 and 8) and includes 
the next seven bit values for export. For example, if you typed 8 
as your initial value, then bits 8 to 15 are exported.

NOTE: The LAS data format can store coordinates using the 
ground or geographic system. If geographic coordinates are 
stored, the data file should contain a “Coordinate System” 
record, stating this fact. If no Coordinate System record is 
found, the converter will assume ground coordinates have 
been used. 

If coordinates have been stored as geographic, but no 
Coordinate System record is present in the file, the data will 
be interpreted as with ground coordinates. 

To resolve this, select “Geographic (Lat/Lon)” from the 
Projection list in the Navigation Coordinate Type dialog box 
(Step 4), then select an appropriate zone, such as “World 
Geodetic System 1984” (WG84).
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4. Select the Scale option if you want to average the data into 8-bit format, 
or select Shift and type the value for the first bit.

5. Click Next.

Qmips
1. Choose a pair of sonar channels by clicking one of two options (1,2 or 

3,4).
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Teledyne Reson PDS 
The final step of the conversion process for Teledyne Reson data 
provides options for filtering soundings, and for identifying the 
devices containing the data you want to convert.
 

1. Select the Filter soundings by status option to filter using the status bits 
in the data file. 

2. To Reject soundings using quality flags, select the quality bits for the 
soundings you want to reject during conversion. (If you select all four 
check boxes, all soundings will be rejected. 

PDS data
By default, it is multibeam data which is read and converted. 
You can also convert single beam or dual frequency data, by 
identifying the devices containing the data.
3. In the PDS data drop-down lists, select the number for your Navigation, 

Heading and/or Motion device, so that data will be converted from that 
specific device. (Devices are numbered 1 to 5.) 

4. Select the type of data being converted (Multibeam, Singlebeam, Dual 
Frequency) from the Convert drop-down list.

If converting singlebeam or dual frequency data you will need to 
specify which echo sounding device was used. If you care 
converting singlebeam data, you can choose from the ECHO_ID 
(raw data) or CF_DEPTH (processed data) attributes from the 



CARIS HIPS and SIPS User Guide 117

Convert Data: Options for Specific Formats

Source drop-down list. If converting dual frequency data, the only 
source available is ECHO_ID.
5. From the Convert drop-down, select the kind of data to convert: 

Multibeam, Singlebeam or Dual Frequency.

Singlebeam If you select Singlebeam, you can convert records from either a 
ECHO_ID (raw data source) or CF_DEPTH (processed source) 
device.

If you select ECHO_ID as the source, you can select 1 of 2 
devices, with one of 4 depth attributes for either device.
If you select CF_DEPTH, you can select either device 1 or device 
2.
6. Select either ECHO_ID or CF_DEPTH from the Source drop-down list.

7. From the Primary (P:) drop-down list, select the device and channel 
where the data is stored. 

Dual Frequency If you select Dual Frequency, you can convert data from both a 
primary (P:) and a secondary (S:) device, with one of four 
channels for each device. 

8. From the Primary (P:) drop-down list, select the device and channel 
where the data is stored.

If you elect to convert primary data from a device that is not 
present, or in which the selected depth channel is not available, 
depths of 0.0 metres will be converted, but all data will be 
rejected.
If you convert secondary data from a device that is not present, 
or in which the selected depth channel is not available, no 
secondary depth data will be converted.

If you select a device that is not present, or in which the 
selected depth channel is not available, no depth data is 
converted.
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S7K data
It is possible to have 7004/7006 and 7027 records stored in the 
same file. In this case, you may want to set the options on the 
Swath drop-down to either “Bathymetry 7004/7006” or “Raw 
Detection” 7027. Leaving the setting as “All” may cause a 
mismatch between observed depths and SonarError records.
9. Indicate the source of S7K data by selecting an option from the drop-

down list. The default value is “All”. 
For example, the options for Heading are Altitude (1016), Heading 
(1013) or Navigation (1015).)

In the case of dual head data stored in the Reson 7K format, the 
data from transducer #1 is combined with that from #2 to form a 
single HIPS profile. 
To convert the two sets of data separately, 
10.Select the Separate profiles for dual head data option. 

By default, hidden or non-logged data exported from the 
PDS2000 is not converted. 
11.To include this data when converting Teledyne Reson PDS, select the 

Convert hidden (non-logged) data check box.

By default the depth field is not converted. To convert the depth 
field values: 
12.Select the Convert depth field option

This will populate Delta Draft file in the line directory.
13.For information applying Delta Draft, see “DELTA DRAFT” ON PAGE 172. 

14.Click Next.
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SAS 
The HIPS Converter for SAS (Synthetic Aperture Sonar) data 
filters out Quality 0 data, considered “bad” data, however, it can 
be included in the conversion.
1. Select the check box to convert Quality 0 data .

Scripps
There are no options specifically for the Scripps format.



120 CARIS HIPS and SIPS User Guide

Convert Data: Options for Specific Formats

SDF

1. Select a Klein 3000 High or Low frequency.

2. Select a Pressure Sensor reading from the drop-down list to set the 
depth of the towfish.

3. Select the Range of voltage for the pressure sensor, either 0-5V or 1-
5V.

4. Hidden data consists of repeated pings over the same area. Select the 
Convert Hidden check box to include hidden data in conversion.

5. Select the Convert SSGyro check box to include side scan sonar gyro 
data.

6. Select the Cable Out is Horizontal Layback option to omit sensor depth 
during conversion. When cable out is converted as horizontal layback, 
sonar depth is set to 0.0 metres.

7. Select Convert Aux Depth to use the data in the auxiliary depth field. 
This option will override the sonar depth converted into HIPS and SIPS 
from the depth field. (This option is disabled if the Cable Out is 
Horizontal Layback option is selected.) 

8. Select the Convert Aux Altitude check box, to convert sonar altitude 
from the auxiliary altitude field in the sonar record.

Bathymetry data associated with Klein 5000 V2 data contains 
quality values. You can filter for these values using the Bathy 
Quality slider control. 
9. Set the slider to a value between 50 and 100%.

You can retain the rejected data in the conversion to HIPS. The 
data will be marked as Rejected. 
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10.To include the rejected data in the converted dataset, select the 
Convert Rejected check box.

All sonar data is stored using 16 bits.

Seabeam
1. Make sure the Convert Side Scan option is checked to include side 

scan data with bathymetric data.

2. Select the Shorten Line Names check box to modify the file name to a 
12-character CARIS name (YYDDD_HHMMDD).

Seafalcon
Seafalcon allows the option of importing a full-sounding dataset 
or a thinned dataset. The thinning options are based on reducing 
the number of beams per profile that are imported. All profiles 
are imported.
1. Select the thinning option, if needed.

The following two options are enabled if the thinning option is 
selected.
2. Select the amount of data to be processed.

• half the number of beams are imported
• one fourth the number of beams from each profile are imported

3. Select the sounding type to be imported into HIPS format.
• shoal
• average
• deep

You can select the swaths per ping that you want to import. In 
deep water, the Seafalcon sonar produces five swaths with each 
firing of the transducer. These five swaths are in an along-track 
position to the ship, with swath 1 forward of the sonar and 
swath 5 aft of the vessel. In shallow water only one swath per 
ping is generated.
By default all five swaths are selected for import, but you can 
decide which swaths to import.
4. Select the swath number(s) for import.

SEGY
There are no options for the SEGY format.
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SHOALS
All soundings in the SHOALS* format are given a confidence 
value during acquisition. These confidence values are used to 
flag soundings during conversion so that soundings with certain 
confidence values are rejected. The following status flags are 
assigned to soundings. These can be changed in HIPS.
• Rejected by disabled beam: This flag rejects soundings with a 

negative confidence value.
• Rejected by depth gate: This flag is for soundings with 

confidence values that range from 0 to 70. The 0 to 50 range 
represents soundings where no bottom was found, and the 51 
to 70 represents soundings of questionable confidence.

• Accepted: This flag is for soundings with confidence values 
from 71 to 99.

When converting to HIPS, all soundings with a confidence value 
less than the Confidence Cutoff Value will be automatically 
rejected. The default cutoff value is 70.
1. Use the mouse to select a cutoff value.

If the dataset contains land data, you can select the topographic 
format (TOF) options to convert this data too.
2. Select either the First Pulse check box to convert the return from the 

top of the vegetation canopy or the Second Pulse check box to convert 
the return from the ground.

*(Scanning Hydrographic Operational Airborne LIDAR Survey)

Simrad

1. If you are using the EM3000 sonar, select the channel used for the 
primary position.

2. Select Manual Override to read from the navigation system data that is 
marked inactive by Simrad.

3. Click the Convert Side Scan/Backscatter box if you want to convert this 
data.

You can fit critical line information into the 12 characters 
provided by the CARIS Source ID attribute for soundings.
4. Select the Shorten line names check box to modify the file name to a 

12-character CARIS name (YYDDD_HHMMDD).

Large attitude data files can result if there is a straight one-to-
one import into HIPS. The Attitude Data Decimation option down-
samples the data so that a smaller attitude dataset is converted. 
The Decimation Factor determines the ratio of attitude data. For 
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example, if you select 10 as the Decimation Factor, then one out 
every tenth attitude record is converted. 
5. Select the Attitude Data Decimation check box to implement this 

option. 

6. Select a Decimation Factor to set the ratio for down-sampling attitude 
data.

Data Source Motion data (heading, heave, roll, and pitch) is automatically 
read from the active motion reference unit. However, you can 
select another motion reference unit to read the data. Gyro data 
can also be read from the headings datagram.
7. For Heading, select the Auto option to read gyro data from the active 

motion reference unit, or select an inactive unit by selecting MRU1/
MRU2 options. Select the H. Diagrams option to read gyro from the 
headings datagram.

8. For Heave, Roll, and Pitch, select the Auto option to read data from the 
active motion reference unit, or select an inactive unit by selecting 
AutoMRU1/MRU2 options.

9. For GPS Height, select a source from either the EM Height datagrams 
or the GPS String in the navigation datagrams.

Navigation time stamps can be selected from either the logging 
system or from a source specified by Simrad Installation 
datagram (the GPS string in the navigation datagram or the 
logging system).
10.Choose System to select the logging system or choose Automatic to 

select the timestamp specified by the Installation datagram.
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EA400/EA600 Options An EA400/600 dataset is composed of two parts, and side scan /
amplitude data is stored in the *.raw component. However since 
the file format does not explicitly state which channel contains 
the side scan data, you need to know beforehand where the port 
side and starboard side data are stored.
11. If you are converting single beam data from the dual frequency 

EA400\600 system, select Primary to use the primary sounding as the 
selected sounding in the HIPS file, or select Secondary to use the 
secondary sounding as the selected sounding.

12.Use the SIdescan drop-down list to select the number of the channel 
which contains the side scan data.

13.Use the [Port/Stbd] drop-by list to select the number of the port and of 
the starboard channels. If you select N/A for a channel, no side scan 
data will be converted for that channel. 

Time shifting The Time shifting option lets you add a constant number of 
seconds to each piece of data retrieved from the simrad.all file. 
This time shift value can be positive or negative and it’s set to 
zero by default. 
14.Enter the value to be added as a constant. 

Spawar
There are no options specifically for the Spawar format. 

SWATHPlus 
1. Type a value in the Speed of sound field to apply sound velocity to the 

imported data.

Teledyne
There are no other options specifically for the Teledyne format.

UNB
1. Select one or two transducers.

2. Select the Convert Sonar option, if you want to import side scan data.

Winfrog
1. Select Single or Dual Frequency.

2. Select attitude records to be converted.
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3. Specify the speed of sound, so that slant range data can be generated 
from the measured sounding depths.

4. Choose the navigation records to be converted.
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XTF
The XTF format converter contains options for converting both 
bathymetry and side scan.
 

Ship Navigation and 
Attitude

For both sonar types, you must indicate the field used as the 
source for navigation and gyro/heading data. 
1. Select from the drop-down list one of the following sources of 

navigation data:
• Raw Navigation Records 
• Position Data Records 
• Ping Header: Ship
• Ping Header: Sensor
• Header Navigation Records 

If you select Raw Navigation Records, the option to set Attitude data 
source is activated. 
2. Select either Attitude diagram or Raw Navigation datagram.

Convert Bathymetry To convert bathymetry data:
3. Click the Convert Bathymetry check box.

4. Select a bathymetric data format from the Convert drop-down list:
• Multibeam 
• Multi-transducer 
• Single beam from records {Prim=0} or {Prim=1}:

If there are two channels of data, you can identify which channel 
contains the primary data 
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• Single beam from AUX (1,2,3, or 4). 

 

Select gyro data field The Gyro data field options in the pull-down list are determined by 
the selection made in the Ship Navigation field. (See “SHIP 
NAVIGATION AND ATTITUDE” ON PAGE 126.)
• If the Ship Navigation source is Raw Navigation Records, and 

the Attitude source is Attitude Datagram, 
• Select either Attitude Packets or CMG from Navigation (Course 

Made Good from Navigation) from the drop-down list.

• If the Ship Navigation source is Raw Navigation Records, and 
the Attitude source is Raw navigation datagram, 
• Select either Raw Navigation Records or CMG from Navigation 

from the drop-down list.

When any of the other Ship Navigation source options are 
selected, these Gyro sources options are available:

• Ping Header: Ship 
• Ping Header: Sensor 
• Attitude Packets 
• CMG from Navigation 
• CMG from SSS Navigation 
• Header Gyro Records 

Set reject soundings 
flags

The XTF format attaches quality flags to soundings. For 
example, with Teledyne Reson sonars, 0 represents the lowest 
quality and 3 represents the highest quality. You can reject 
soundings with a specific flag. These soundings are flagged as 
Rejected by Disabled Beam in HIPS.
5. Select a quality flag so the soundings with that specific flag value are 

rejected when converted to HIPS format.

If you are converting C3D or QPS data, you can apply filtering 
before moving to the next step. See “MULTIBEAM FILTERING” ON PAGE 128.

If you do not want to apply filtering 
6. Click Next to continue to the next step.

Note: Benthos C3D data will be converted to two lines: 
multibeam and single beam. 

The singlebeam HIPS line (with the addition of _SingleBeam 
to the line name) will have the same set of navigation and 
attitude data as the multibeam line, but the sounding depths 
will be single beam data from the XTF sensor AuxAltitude 
field.
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Multibeam Filtering
To apply filters for Benthos C3D or QINSy QPS data
7. Select the Multibeam Filtering check box and click Parameters to 

select filtering options. 

The Filtering options dialog box is displayed.

Benthos C3D data can be filtered so that only the best quality 
data is imported into HIPS. You can apply the filter to port/
starboard beam angles.
1. Type a range of beam angles to select the cleanest data from the port 

and starboard beams.

All other options are applied to QPS data only.
The Range Filtering option converts soundings within a specified 
distance (in metres). Soundings outside of this range are not 
converted.
2. Select the Range Filtering check box to implement this option.

3. Click the up or down arrow buttons to select a minimum and maximum 
distance.

The Amplitude Filtering option filters soundings according to 
amplitude value. For each ping (port and starboard pings are 
handled separately), the min/max amplitude values are 
obtained, and samples that fall below the selected percentage (0-
50%) are rejected.
4. Select the Amplitude Filtering check box to implement this option.
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5. Click the up or down arrow buttons to select a percentage value for 
rejecting soundings.

The Statistical Filtering option controls which soundings in each 
swath are considered for conversion. This option calculates the 
mean depth and standard deviation within a swath sector or 
horizontal bin. It then prevents any soundings that fall outside a 
multiple of the standard deviation from being converted.
If Statistical Filtering is used, then the mean within the sector is 
re-computed. Ultimately, the soundings are sorted by their 
residual from the mean and those closest to the mean are 
converted. The actual number of soundings converted from 
within each sector is determined by the thinning factor (if used).
6. Select the Statistical Filtering check box to implement this option.

7. Determine a Threshold (multiples of the standard deviation) value by 
clicking the up and down arrow buttons.

The equivalent confidence value is displayed as a percentage.
The filtering and thinning methods are executed within a sector 
angle interval or a horizontal bin size. The sector angle option 
divides the swath into sectors according to degree angles while 
the horizontal bin size divides the swath into horizontal sectors 
based on a specified across track distance.
Vessel motion and transducer mounting angles are considered 
when sector angle and horizontal bin locations are determined.
1. Select the Sector Angle Interval option and choose a degree level (to a 

maximum of 10º) by clicking the up or down arrow buttons.

2. As an alternate method, Select the Horizontal Bin Size option choose 
an across track distance by clicking the up or down arrow buttons.

The thinning factor reduces the number of soundings converted 
on a per swath basis. The thinning factor uses a power of two 
reduction control (1/2, 1/4, 1/8, etc.) so that one of two, one of four 
or one of eight soundings can optionally be converted per swath 
sector.
3. Select the Data Thinning check box to implement the thinning option.

4. Select a Thinning Factor value by clicking the up or down arrow 
buttons.

5. Click Next to go to the Convert Side Scan Data dialog box.

Step 8: Convert Side Scan data 
If you do not want to convert side scan data, click Next and go to 
“CONVERT DATA” ON PAGE 94.
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To convert side scan data:
6. Click the Convert Side Scan check box.

7. Select one of four Sonar Channels pairs by clicking the radio button.

8. Select one of the following as the source for reading the Navigation 
data for the towfish:
• Raw Navigation Records
• Position Data Records
• Ping Header: Ship
• Ping Header: Sensor
• Header Navigation Records 

9. Select one of the following options from the drop-down list as the 
source for reading from the Gyro data fields:
• Ping Header: Ship 
• Ping Header: Sensor 
• Attitude Packets 
• Raw Navigation Records 
• CMG from Navigation 
• CMG from SSS Navigation 
• Header Gyro Records 

Note: Contact records created in Triton ISIS are also 
imported into HIPS when associated XTF data is imported.
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The XTF format flags repeated pings over an area as hidden 
data.
10. Select the Convert Hidden Data check box to include this data type in 

the SIPS project.

11.To enhance the image by scaling the intensity values, click the Apply 
Image Enhancement check box.

12.Click Next.

Step 9: Convert Layback
This dialog box contains options for converting horizontal tow 
fish layback or tow cable length distances in side scan data. 
There are also options for reading the dynamic depth 
information for a remote operated vehicle (ROV).

13.If you want to recompute side scan towfish positions in HIPS with the 
recorded horizontal layback or tow cable length data, make sure the 
Cable Out/Layback box is checked.

14.Select one of the following options:
• from Layback field: The distance from the vessel towpoint to the 

towfish.
• from Cable Out field: The length of the tow cable to the towfish. 

15.If you selected Cable Out, enter a number in the Multiplier box to 
correct for integer value recording, if necessary.
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If you have stored sensor depth data in an auxiliary field, you 
use it to calculate sensor depth. Sensor depth in this case is 
equal to the value in the field minus the sensor height. 
16.Select the Calculate Sensor Depth check box.

17.Type the number of the auxiliary containing the total measured depth. 

GPS Height The total measured depth and the digitized height of the towfish 
are used to compute the depth of the towfish below the 
waterline. The towfish depth can then be combined with the tow 
cable length data and the vessel's tow point configuration to 
compute the position of the towfish. 
The GPS Height field indicates the source of the GPS ellipsoid 
height data. The source options will vary depending on the Ship 
Navigation option selected in Step 7 of the Conversion Wizard. 
• If ship navigation is being read from the Raw Navigation 

Records then the GPS height is set to Raw Navigation 
Records, and cannot be changed.

• If Ship Navigation set to Position Data Records, the GPS 
height control shows only RTK Packets, and the user cannot 
change it

For all other Ship Navigation selections, the options available 
for the source of GPS ellipsoid height data are the RTK Packet 
and the Ocean Tide field.
18.If data is being collected from an ROV (Remote Operated Vehicle), 

click the check box to enable the source options for measurement of 
vehicle depth.

The auxiliary and sensor depth fields are enabled.
19.Click the appropriate check box to select a source for reading ROV 

depth data:
• Auxiliary
• Sensor Depth

20.Type the number of the Auxiliary field (from 1 to 6), if this option is 
selected.

Click Next to go to the step in the Conversion Wizard, to “CONVERT DATA” ON 
PAGE 94.



5
Sound Velocity Correction

Sound Velocity Correction contributes to a more accurate soundings file 
by applying travel time and angle information into across track and depth 
values. The process combines transducer orientation and positioning 
data from the HVF with Sound Velocity Profile data and applies a ray-
tracing algorithm. 

In this chapter...
SOUND VELOCITY PROCESSING .................................... 134
SOUND VELOCITY CORRECTION .................................... 136
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Sound Velocity Processing 
Raw data formats such as XTF contain two-way travel time and 
beam launch angle data. The Sound Velocity Correction 
algorithm uses this data to calculate the length and path of the 
sound wave through the water column for each beam. 
Sound velocity processing is not available for all types of 
multibeam and single beam sonar data. Only those sonar 
formats that provide raw travel time and angle from the 
transducer are currently supported in HIPS. This includes 
multibeam bathymetry from XTF, Hypack, XSE and Simrad EM 
formats. 
For all other multibeam sonar formats, it is assumed that sound 
velocity corrections were applied during data acquisition. 

HVF For effective sound velocity correction, the Sound Velocity 
section of the HIPS Vessel file must be set up to define the 
transducer offsets. These offsets are used in Sound Velocity 
Correction, together with the Sound Velocity profile data. (See 
“SVP” ON PAGE 47 for these sensor configurations.) 

SVP file A sound velocity profile contains data on the acoustic velocity of 
the water column, in a text file divided into sections defined by 
time stamps. This data can be viewed and modified in the SVP 
Editor .

Profile selection method
When there is more than one sound velocity profile, the program 
can use one of four options for selecting an SVP at the time of 
each swath:
• Previous in Time: Select the profile with a time stamp prior and 

nearest to the time of the swath.
• Nearest in Time: Select the profile with a time stamp nearest to 

the time of the swath. This can either be prior to or after the 
time.

• Nearest in Distance: Select the profile with a position nearest 
the position of the swath. This requires that positions be 
included in the SVP file.

The process of Sound Velocity Correction cannot be reversed. 
Once it is applied, data cannot be restored to its pre-SVC 
state. 
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• Nearest Distance Within Time: Select the profile with a position 
nearest to the swath and has a timestamp nearest the time of 
the swath within a selected range.

The following diagram demonstrates the relationship of the 
profile options to the time/location of the swath.

P1, P2 and P3 all are calculated within a time period. P4 is 
calculated independently of the time period.

P1=Previous in Time

P2=Nearest in Time

P3=Nearest Distance Within Time

P4=Nearest in Distance
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Sound Velocity Correction 
The sound velocity correction process uses a ray tracing 
algorithm to apply the sound velocity profiles. You can use either 
regular attitude data or smoothed data for applying vessel 
motion data to the ray-tracing algorithm (see “ATTITUDE FILTER” ON 
PAGE 286).
The SVC process will select the profile to apply based on the 
method you select. You can also choose to apply the last method 
used. 

To apply Sound Velocity Correction:
1. Select a track line or group of track lines.

2. Select the Sound Velocity Correction command.

The Sound Velocity Correction dialog box is displayed.
 

It is recommended that sound velocity correction be applied 
to bathymetry before cleaning the data. Whenever SVC is 
applied, the Merge command should also be applied to the 
data 

M
en

u Process > Sound 
Velocity Correction

To
ol
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SVC will use either the sound velocity profile from your 
converted data, or the last SVP applied to the data. You can 
choose to load another profile, and you can edit a profile to use.
To use a new profile:
3. Select the Load new SVP file check box, and click Select to choose an 

SVP file.

The “Browse for SVP file” dialog box is displayed.
4. Select the file you want, or type the file path in the File Name text box. 

The default directory is …\Hips\Svp.

5. Click Open.

The file name and path is displayed in the text box.
If you want to edit the data, click Edit to open the SVP Editor. 
(See “EDIT SVP DATA” ON PAGE 140.)

Profile selection method When there is more than one sound velocity profile for the data, 
HIPS can use one of four options for selecting an SVP.
6. Select a method from the drop-down list: 

• Previous in time - Apply the SV profile that was taken just prior to 
the recording of the survey data.

• Nearest in time - Apply the SV profile that was taken closest in time 
to the recording of the survey data.

• Nearest in distance - Apply the SV profile that was taken closest to 
the area where the survey data was recorded.

• Nearest distance within time - Apply the SV profile with a position 
that is nearest to the swath and has a timestamp that is nearest to 
the time of the swath, within a selected range.

You also have the option of applying the last correction method 
last used on each line, to the currently selected data. 
7. Select Last used method to apply the last selected profile method to 

the current SVC. 

Use Surface Sound 
Speed 

For systems which employ a flat transducer design, it is critical 
for the beam-forming electronics to know the exact sound speed 
at the location of the transducer. Therefore a sound speed probe 
is installed at the transducer. When this surface sound speed 
data is available, HIPS converts it and stores the time series 
data in the SSP file ( in the line directory). This data can be 
displayed in the Attitude Editor.
When HIPS performs sound velocity correction, the SSP data, if 
available, is retrieved and "inserted" into the Sound Velocity 
Profile (SVP) at the location of the transducer depth, replacing 

If a line has not had SVC applied previously, attempting to use Last 
used method for correction will cause the process to fail. In this 
case, choose another SVC method.
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the interpolated sound speed value at that depth. Ray-tracing 
then starts from that location.
To use available SSP data in sound velocity correction:
8. Select the Use Surface Sound Speed if available check box in the 

dialog box. 

There are times, however, when the SSP data is not correct, 
causing the beam-forming electronics to erroneously compute 
beam angle data. If you determine that this has happened, you 
can enable the option to recompute beam angles. The recorded 
SSP (known to be incorrect) along with the sound speed 
interpolated from SVP (assumed to be correct), will be used to 
compute new beam angle data. Ray-tracing will then proceed 
without insertion of the SSP into the SVP. 
To use the available SSP data only to compute new beam angle 
data: 
9. Select the Perform an additional recomputation check box to re-

compute the steered beam angles based on a new surface sound 
speed that is interpolated from the sound velocity profile.

Only certain systems support the recomputation of the steered 
beam angles. These include: Simrad EM 12/120/2040/3000-3008/
3020/300/710/122/302 (except when using SimradSVC Licenced 
dll), Atlas SURF, Geoacoustics RDF, Teledyne Reson 7K (when 
using the 7004/7006 depth records), Benthos C3D and 
SWATHplus.

Apply Delayed Heave In previous versions of HIPS, SVC used TrueHeave data in place 
of regular heave data when TrueHeave was available. Do not 
select this option if you want the original heave data to be 
applied. 
10.Select Apply Delayed Heave to apply delayed heave values instead of 

regular heave. 

If you choose this option, and no delayed heave data is available, 
there will be a warning message in the Output window, and 
regular heave data will be used instead. 

Smoothed Sensors 11.Select which smoothed sensor data is to be applied during sound 
velocity correction: Heave, Pitch, Roll, Delta Draft. (Sensor data can be 
smoothed in the Attitude Editor. See “FILTER AND SMOOTH” ON PAGE 16). 

 

Note: Waterline values are not interpolated during SVC.



CARIS HIPS and SIPS User Guide 139

Sound Velocity Correction: Sound Velocity Correction

12..Click Process to apply the SVP file to the selected lines.

Lines which have been SV Corrected will be displayed in the 
Display window in the Not Merged colour (as set in the 
Properties for the Ship Track Lines layer).
As well, the SVP Corrected field in the Selection tab will show 
“Yes” for any selected line to which SVC has been applied.
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Query Applied SVC Profiles
You can confirm whether SVC has been applied, and see which 
profile has been applied to which lines, by: 
• querying the SVC status of lines in the Selection tab
• examining the logfile.xml.
• display the SVP files as background data
• colour coding line display by SV profile

Query lines To query lines which have been sound velocity corrected:
1. Select lines in the Display.

Selected lines will be listed automatically in the Selection tab.
2. Scroll through the Selection tab to the SVP Corrected column.

A “Yes” value in the column indicates that the line has been SV 
corrected. 

Process Log Select SoundVelocityCorrect in the leftmost column of the Process 
Log. This will display profile information in the right column of the 
window. See also PROCESS LOG WINDOW in the Reference Guide.

Colour by SV Profile You can also determine which profiles have been applied to lines 
by turning on the Colour by SV Profile property. 
To view the profiles that have been applied in SVC:
1. Select the Ship Track LInes layer in the Layers tab.

2. Open the Properties window.

3. Set the Colour by SV Profile value to true by selecting the check box.

4. Refresh the Display.

All the lines will display a colour for each cast, as in the 
following example. 
 

Display profiles SVP files can be opened as background to a project, in order to 
see which profiles have been applied. To view the SVP files:
1. Select the Open Background Data command.
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2. In the Open dialog box, browse to the location of the SVP file that was 
applied to the lines.

3. Click Open.

The open file displays the various profile locations, as in the 
example below.

If the SVP values are not displayed, make sure that the colour 
set for Tide / SVP in Tools > Options > Display tab is not set to 
the same colour as your Display window background. 

1.

M
en

u File > Open 
Background Data

M
en

u Edit > Sound Velocity 
Profiles

To
ol
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6
 Correct for Tide

Tidal data must be loaded for every track line to generate final depths. 
Tide files can be edited or new files created using Tide Editor. 

In this chapter...
LOAD TIDE................................................................ 144
TIDE FILES................................................................ 146
TIDE ZONE FILES ....................................................... 146
GPS TIDE................................................................ 149
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Load Tide 
Tidal observation data must be loaded for every track line before 
the Merge process can be executed. Tide data is used to generate 
final depths relative to the tide datum by subtracting the tide 
from the sounding depth.
There are two options for tide loading:
• load a *.tid file to apply tide observations from a single 

station. (For information on these files, see “TIDE FILES” ON 
PAGE 146.)

• load a *.zdf file to apply tide observations from multiple tide 
stations to a tide zone. (For information on these files, see 
“TIDE ZONE FILES” ON PAGE 146.) 

To apply tide observation data to selected HIPS track lines,
1. Select the track line(s).

2. Select the Load Tide command.
 The Load Tide dialog box is displayed.

 

3. Click Browse… to choose a tide (.tid) file (single station data) or a tide 
zone (.zdf) file.

4. Click Open.

The tide file name is displayed in the field.
5. [Optional] To revise the contents either type of tide file, click Edit to 

open the Tide Editor.

If you are loading a tide zone (.zdf) file, you have the option of 
applying weighted averaging from multiple tide stations. 
Weighted Averaging gives priority to data from the closest tide 
station.
6. Select the Weighted Averaging check box to apply this option. (see “TIDE 

STATIONS AND WEIGHTED AVERAGE” ON PAGE 148). If the selected tide file 
doesn’t contain any averaging options, this option is not available 

M
en

u

Process > Load Tide

To
ol
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7. Select the Compute Errors check box to have the Load process save 
computed errors to a tide error file for each line. These tide error files 
will then be used in computing TPU. If the selected tide file does not 
contain any error parameters, this option is unavailable.

8. Click Load.

The tide data is loaded into the selected track lines from the tide 
zone definition file.

Load Tide status 
To determine if tide has been loaded for a line or lines:
1. Select the trackline(s). 

2. Select the Selection tab. 

The Selection tab will display line data for the selected line(s) in 
columns. 

The Tide Loaded column shows “Yes” when tide has been loaded 
for the selected line(s).
The GPS Tide column shows “Yes” when tide has been loaded 
for the selected line(s).
The Tide Applied column can display one of four values:
• None: No tide has been applied (Merge has never been run, 

and no ProcessedDepths exist.)
• Observed: The line has been Merged, and choose to apply 

Observed tides from loaded TID file(s). 
• GPS: The line has been Merged, and a GPS tide file has 

been applied.
• Zoned: The line has been Merged, and a previously loaded 

ZDF file has been applied.
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Tide Files
When tide observations from a single station are applied to a 
track line (or lines), the time extent of the line(s) is used. The 
illustration below shows tide values from a single station applied 
to three selected track lines, based on the time each line was 
recorded.

Tide data from a single station is loaded from files with the 
extension *.tid. These files can be created or edited in a text 
editor (such as Notepad), or with the Tide Editor. 
HIPS supports a standard Canadian Hydrographic Service tide 
format called COWLIS, as well as two NOS/NOAA formats and 
the NHS file format. HIPS also supports a basic format 
consisting of just the required date, time, and tide values.
Track lines in areas without water level changes, such as rivers 
or lakes, must also have a tide file. In this case, or if tidal data 
cannot be obtained, a “zero tide” file—where all tide/time values 
are zero—is used so merging can proceed.
All tide files, including zerotide.tid, are located by default 
in…\Hips\ver\Tide. 
For more detail, see ““TIDE FILE FORMATS” ON PAGE 147 in the 
Reference Guide.

Tide Zone Files
When tide observations from multiple tide stations are applied 
to a line or lines, tide zones are used. 
Where a survey line falls within two or more tide zones, the tide 
data to be loaded for each part of a line is determined by the zone 
in which that part of the line falls (as illustrated below). Note 
that the tide zones do not overlap each other.
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The tide data file must span the entire time frame of the track 
line. The time zone of the tidal observation data must match the 
time zone of the survey data to which it will be applied. 
The output from the Load Tide function (see “LOAD TIDE” ON 
PAGE 144) attaches a binary HIPS tide-time series to each track 
line.
The tide zone option assigns tide observations to track lines from 
multiple tide stations based on the time period in defined 
geographic zones. 
Each tide zone is defined by a closed polygon with tide, time and 
range corrections for a primary station, plus up to three backup 
secondary tide stations. Tide zone should not overlap each other.
HIPS uses a Zone Definition File (with the extension *.zdf) for 
defining tide zone data. This is an ASCII file and can be 
prepared with any text editor. 
For complete description of the ZDF format, see ““TIDE ZONE 
DEFINITION FILES” ON PAGE 153 in the Reference Guide .

Display tide zones
Tide zones and station locations can be displayed as background 
data. 
1. Select the Open Background Data command.

A standard Windows Open dialog box is displayed.
2. Navigate to the desired tide zone file (*.zdf).

3. Click Open.

The outlines of the tide zones, and their labels, are drawn in the 
Display window. The tide zones file is listed in the Layers tab of 
the Control window.

M
en

u File > Open 
Background Data
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Tide stations and 
weighted average

When an average tide is calculated from multiple tide stations, 
the weight given to a tide station’s data is inversely proportional 
to its distance from the vessel at that time. In other words, the 
further a station is from the survey line, the less weight is 
accorded to the data from that station. 

Tide Editor
Tide Editor presents tide file information in both graphical and 
tabular formats. You can use the editor to edit an existing file or 
to create a new tide file to apply to survey lines before the Merge 
process.
Tide Editor is a separate application that launched from the 
HIPS and SIPS interface. 
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GPS Tide 
The Compute GPS (Global Positioning System) Tide function 
provides an alternative to normal tidal observation for reducing 
soundings to the sounding datum. A single sounding datum 
height, or a datum model file with a grid of datum heights, can 
be applied with the GPS height during the computation. 
As of HIPS and SIPS 8.0.3, any open surface layer or TIN layer 
can be selected as the input “model” for computing GPS tide. 
For details on sounding datum models and a sample *.info file, 
see “GPS TIDE FORMAT” ON PAGE 156 and “INFO FILE” ON PAGE 160 of the 
Reference Guide.
To compute GPS tide:
1. Select a track line or group of track lines.

2. Select the Compute GPS Tide command.

The Compute GPS Tide dialog box is displayed.
.

M
en

u Process > Compute 
GPS Tide
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When a surface is used as the datum model, an elevation 
attribute must be set. This can be selected from a drop-down list 
in the Attribute field.
When parsable ASCII file is used as the datum model, but is not 
recognized as a known format, you must also open a *.info file 
that will control the parsing of the ASCII data. As well, a 
coordinate system must be selected. The Info File and Coordinate 
Reference System fields are enabled so that you can enter this 
information.
3. In the Type field, select either Single Value or Datum Model as the type 

of datum to be applied.

4. If Single Value is selected as Type, enter a single datum height value in 
the Value field to apply a single distance from the ellipsoid to the 
antenna. 

5. If Datum Model is selected as Type, use the drop-down list in the Model 
field to select a currently open surface, or to select <Browse> and open 
a model file. The field will display the surface name, or the filename of 
the model file.

If you have selected a surface as the datum, select an appropriate 
attribute from the list in the Attribute field.
If you have selected a datum model file of an unknown format, click 
Browse button in the Info File field to select the appropriate .info file. 
This field is disabled if the selected file is a known format with an 
available info file (which will be applied by default). 
In the Coordinate Reference System field, click the Browse button to 
open the Select Projection dialog box and set the relevant projection.

6. Select the check boxes or type in values to apply the following options 
during the process: 

7. Click OK to apply.

Smooth GPS Height Set to “True” to apply smoothing to GPS height.

Dynamic Heave Set to “True” to apply dynamic heave (either regular vessel 
heave, or delayed heave, if it exists).

MRU Remote Heave Set to “True” to apply remote heave resulting from 
vessel roll/pitch on an offset-mounted MRU.

Dynamic Draft Set to “True” to apply dynamic draft (as a result of 
interpolating the draft table in the HIPS Vessel File 
(HVF), or as stored in HIPS as time series data).

Water Line Set to “True” to apply the waterline offset in the HVF.

Water Line from 
Installation 
Parameters

Set to “True” to apply the waterline value from the 
InstallationParameters.xml file generated by the 
converter.

Height Correction Type an amount as a static offset to the GPS antenna.

Time Offset Type a value in seconds to apply as a time offset. 
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The GPS Tide is calculated for the selected line(s). The settings 
in the dialog box are saved in a GPS Tide file in the line 
directory. 
You can open and view the GPS tide data in the Attitude Editor 
(“ATTITUDE EDITOR” ON PAGE 9).
Sounding datum model files in gridded binary (.bin) or ASCII 
(.xyz) format can be opened in HIPS and SIPS as background 
data. See “OPEN BACKGROUND DATA” ON PAGE 46 in the Reference Guide.
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7
Compute TPU

Total Propagated Uncertainty (TPU) is used to assign a horizontal error 
estimate (HzTPU) and a depth error estimate (DpTPU) to each sounding.

In this chapter...
TOTAL PROPAGATED UNCERTAINTY ............................... 154
COMPUTE TPU......................................................... 156
TPU FILTERING ........................................................ 159
APPLY FILTER ........................................................... 161
LOAD ERROR DATA.................................................... 163
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Total Propagated Uncertainty
Total Propagated Uncertainty (TPU) is derived from a 
combination of all individual error sources. The following errors 
(among others) contribute to TPU:
• nav/gyro/heave/pitch/roll/tide errors
• latency error estimate
• sensor offset error estimates
• individual sonar model characteristics
TPU is essential for the following functions:
• creating S-44 or S-57 compliant datasets (see “TPU FILTERING” ON 

PAGE 159)
• calculating Bathymetry Associated with Statistical Error 

(BASE) Surfaces weighted by uncertainty (see “UNCERTAINTY 
WEIGHT” ON PAGE 189)

Error values are located in the vessel file for the survey and the 
DeviceModels.xml file in …\HIPS\System. Other errors are 
directly entered in the Compute TPU dialog box.
The following sonar error-models in the DeviceModels.xml have 
been tested by the University of New Hampshire (UNH).
• Atlas Hydrosweep DS
• Elac Nautik 1180
• Seabeam 2112
• Teledyne Reson SeaBat 8101
• Teledyne Reson SeaBat 9001
• Teledyne Reson SeaBat 9003
• Teledyne Reson SeaBat 8125
• Simrad EM300
• Simrad EM1000
• Simrad EM1002
• Simrad EM3000
• Simrad EM3000D
Other sonars listed in the file may make assumptions that could 
produce less rigorous results than these error models supplied 
by UNH.
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The Compute TPU function must be performed after Sound 
Velocity correction. Whether it is applied before or after 
Merge will depend on the workflow you are following. When 
you compute TPU it will always be done on the Observed 
depths, therefore tide and draft offsets will not affect the 
values.
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Compute TPU
The Compute TPU (Total Propagated Uncertainty) command 
applies Horizontal TPU (HzTPU) and Depth TPU (DpTPU) 
values to each sounding in the observed depths.

DpTPU is the uncertainty associated with the depth value of a 
sounding. It is a random error and is scaled to 95% 
(1.96 sigma).
HzTPU - The uncertainty associated with the position of a 
sounding. It is a random error and is scaled to 95% 
(1.96 sigma).

The HzTPU and DpTPU values are stored line-by-line with 
indexing to profiles and beams. You can view the specific error 
values for individual soundings by querying the soundings in 
Swath, Single Beam, or Subset Editor. The HzTPU and DpTPU 
values are displayed in the Selection tab. 
Static errors (such as those related to sensor position) that are 
used to compute the TPU are read directly from the project’s 
vessel file and from the DeviceModels.xml file. These errors are 
directly entered in the TPU computation. 
Dynamic errors due to tide and sound velocity values, which can 
change from time to time, are entered via the Compute TPU 
dialog box.
1. Select a track line in the Display window so it is highlighted.

2. Select the Compute TPU command.

The Compute TPU dialog box is displayed. 

3. In the Tide Values fields, enter the vertical uncertainty values due to tide. 
These will be applied to all lines being processed. 

M
en

u Process > Compute 
TPU

To
ol
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• The Measured offset is the error value for the tide station. It is 
equivalent to the standard deviation of the TideGauge 
measurements.

• The Zoning offset is the vertical uncertainty value in range 
calculation for a tide zone file. (HIPS does not model the TPU for 
the tide zone. Instead a single user-defined single value may be 
used here.) 
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4. Enter error offsets for Sound Speed Values. 
• The Measured offset value is used in computing range error to 

compensate for inaccuracies in SVP measurements. 
• The Surface offset value is used to account for errors in surface 

sound speed measurements that alter the beam angle. (This 
parameter is only applicable to systems that require accurate 
surface sound speed measurements.)

Transducer motion offsets for sweep surveys are entered in the 
Sweep specific parameters fields.
5. Type the estimated observed heave offset in the Peak-to-Peak Heave 

field.

6. Type the roll values for the transducers in the Max Roll field.

7. Type the pitch values for the transducers in the Max Pitch field.

You can use previously loaded RMS data in the TPU 
computation instead of data from the vessel file. 
8. Select Vessel Settings to use vessel data. (If you select Vessel Settings 

and RMS data has been loaded it will not be used.) 

9. Select Error Data to use RMS data.
If you select Error Data and no RMS data is available, vessel settings 
will be used.
If you select Error Data and one or more of the RMS data attributes 
are not available, then a zero value will be used for the missing 
attribute. 

10.Click Compute.

The results are displayed in the Output tab of the Worksheet 
window. A log file is also created showing the results. 

Note: If you choose to use RMS data in computing TPU, and 
true heave RMS has been loaded (via the Load True Heave 
process), Compute TPU will override the Down/Heave RMS 
values loaded from the Load Error Data process, and use the 
true heave RMS data loaded with Load True Heave. 



CARIS HIPS and SIPS User Guide 159

Compute TPU: TPU Filtering

TPU Filtering
TPU filtering can be applied with one of the HIPS and SIPS 
automatic filters. Flittering parameters are set in the Set Filters 
dialog box and applied using the Apply Filters command. 
The filter compares the HzTPU and DpTPU values for each 
sounding against the depth and horizontal error limits for a 
specific S-44 survey order, or S-57 zone of confidence (CATZOC) 
attribute. All soundings with HzTPU and DpTPU values outside 
those limits (set by International Hydrographic Organization 
(IHO) standards) are rejected (or accepted).
To set TPU filters:
1. Open a project.

2. Select the Set Filters command.

The Set Filters dialog box is displayed.

3. Select the TPU tab.

The TPU filter fields will display any values previously entered. 
Parameters set in these fields are retained until you change 
them or load a saved filter file.
4. [Optional] Select an existing HIPS Filter File from the list or click 

Browse to select a file.

M
en

u

Tools > Set Filters

To
ol
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If you load a filter file, all the values used in that file are shown 
in the fields. You can change any of the values.
5. Select either a Reject or Accept logic command to apply to the filtered 

data.

6. Select the IHO check box. 

This will enable the TPU filter so the values will be applied to 
data when the Apply Filters command is used.
7. Select the standard to apply, either IHO S-44 or IHO S-57 CATZOC, and 

complete data in the appropriate fields.

Depending on which you select, the dialog box is refreshed to 
display the options associated with that standard.

Each survey order or zone of confidence contains the following 
fields:
• a: constant depth error (i.e. the sum of all constant errors)

S-44

S-57
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• b: factor of the depth dependent error
• m: position limit for horizontal errors
• %: percentage of depth used to calculate horizontal error (S-44 

only).
Depth error limit To calculate the error limits for depth accuracy, the constant 

depth error (a) and the factor of the depth dependent error (b) 
are combined with depth (d) and the depth dependent error 
(b * d) in the following formula:
 

When the filter is run, soundings with a vertical uncertainty 
outside the error limit for the survey order or zone of confidence 
are rejected (or accepted).

Horizontal error limit To calculate horizontal accuracy, the limit for horizontal 
error (m) and (if applicable) the depth percentage (%) for the 
selected survey order or zone of confidence are compared against 
a sounding’s HzTPU. Soundings with a horizontal uncertainty 
outside the limits are rejected (or accepted).
Values entered in the TPU filter will be retained when the dialog 
box is closed. However, you can also save the settings in a HIPS 
Filter File (.hff) for use on other data.
8. Click Save As to save the settings to a filter file.

9. Click Close. 

Your filter can now be applied to your data using the Apply 
Filters command.

Apply Filter
To apply the filtering values set in the Set Filters dialog box:
Enable the TPU filter by selecting the IHO check box in the 
1. Select either the ISO 2-44 or S-57 CATZOC options.

The IHO frame of the TPU tab is refreshed to display the S-44 
survey order options (Special Order, Orders 1a, 1b, 2) or the S-57 
zones of confidence (see above).
You can apply filtering to a selected depth range by entering the 
maximum and minimum soundings for that range. Leave these 
fields empty to apply filtering to every sounding along the track 
line.
2. Select the Depth Limit check box to apply the filters to a depth range.

a2 b d )×(+ 2±Error limit for depth accuracy =
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3. Type depth levels in the Minimum and Maximum fields to set a range for 
the filters.

4. Select a survey order or zone of confidence option.

All fields in the User defined option are activated when this option 
is selected.
5. Type Depth and Horizontal values.

6. Run one of the Filtering commands.

For other automated filters, see “ATTITUDE FILTER” ON PAGE 286, 
“AUTOMATIC FILTERING” ON PAGE 325, “SINGLE BEAM FILTERING” ON PAGE 105, 
and “PROTECT CRITICAL SOUNDINGS” ON PAGE 304.)

M
en

u Tools > Apply Filters > 
Selected Lines/All 
Lines

To
ol
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Load Error Data
Use this process to override error values in the HIPS Vessel File 
with real-time error values. The Load Error Data process 
generates a HIPS RMS (root-mean-square) file which can be 
used in TPU computations.
Applanix POS MV files and Applanix POSProc files contain real-
time attitude, navigation and RMS error values recorded during 
survey. This means that different error values are recorded for 
different conditions, resulting in more precise error estimates 
than the static error values recorded in the HIPS Vessel File.
The files must be timestamped with valid GPS entries to fix the 
time of the data, and must contain the Julian date of the day the 
data was acquired in the form: YYYY-JJJ-filename or filename 
YYYY-JJJ
1. Select a track line in the Display window.

2. Select the Load Error Data command.

The Load Error Data dialog box is displayed. M
en

u Process > Load Error 
Data
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3. Click Add to select files. You can load either POS MV files OR load 
POSProc files, but not both at the same time.

4. To remove a file from the File List field, select the file and click Remove.

Reference Week Reference weeks start on Sunday at midnight and are time-
stamped in GPS seconds, starting at 0. If the survey week runs 
from, for example, Wednesday to Tuesday, the start day for the 
survey week can be set, so Sunday is “rolled over” and data for 
the full survey week is applied. 
5. [Optional] To accommodate a GPS week rollover event, click Select 

Day and select the start date from the calendar. This will enter the 
Julian date. 

Import Data Choose which error records in the Applanix files you want to 
import into the line by clicking on the appropriate check boxes. 
Then enter an output interval (in seconds). This value 
determines how frequently the data is written to the HIPS RMS 
file.
6. Select Vertical RMS to load vertical RMS data, then select one of the 

following alternatives:
• Down to load Down RMS data stored with Group 2 records, or 
• Heave to load Heave RMS data stored with Group 111 records. 

7. Select Roll RMS, Pitch RMS, Gyro RMS to load roll error, pitch error and 
gyro error values from the Applanix files to the track line.

8. Type an output interval.

Options 9. The Apply to all partially covered line option will load the error data even if 
the data does not cover the entire line.

10.Select the Allow gap between records check box to limit the interval 
allowed between consecutive data records in the file. If an interval 
exceeds the amount specified in the Maximum field, the data will not be 
loaded and the process will stop.

11. If the time stamp does not match the time stamps in the project, you 
can select the Apply Time offset option and enter a time value (in 
seconds).

12.Click Load.

The Output tab displays a summary of the records loaded. 
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SBET files loaded Use the Detailed Line Query function to confirm which files have 
been loaded:
1. Select a line or lines in the Display window.

2. Select the Detailed Line Query command.

This opens the Detailed Line Query window, displaying the 
records for the selected line(s) in columns. 
3. Scroll through the table to the SBET RMS File column.

The Load Error Data process generates a HIPS RMS file. If this 
RMS file exists, the name of the SBET file used to generate it, 
will be displayed in this column. If no RMS file exists, the text 
"*** Not Loaded ***" is displayed.

See also “DETAILED LINE QUERY” ON PAGE 274.

M
en

u Process > Detailed 
Line Query

Only newly loaded SBET RMS data stores the file name. Data 
loaded previously will only show a blank field.
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Merge

The Merge process converts along track/across track depths into latitude, 
longitude, and depth by combining the ship navigation with the horizontal 
and vertical offsets from the HIPS vessel file. This geographically 
references the sounding position and depth.

In this chapter...
MERGE PROCESS ...................................................... 168
APPLY MERGE........................................................... 170
DELTA DRAFT............................................................ 172
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Merge Process
Once Sound Velocity Correction has been applied, (see “SOUND 
VELOCITY CORRECTION” ON PAGE 136) the final sounding depth and 
geographical position needs to be calculated. This is done in the 
Merge process. 
Trackline data must be Merged before BASE surfaces can be 
created and before surface cleaning can be performed. 
Merge takes into consideration pertinent vessel configuration 
offsets and the following values, many of which are set in the 
HIPS Vessel file:
• Navigation
• Gyro - based on the settings in the HIPS Vessel file.
• Dynamic draft - based on the settings in the HIPS Vessel file.
• Smoothed sensor data
• Waterline (if not applied in the SVC process)
• Motion data: Heave, Pitch, and Roll (if not applied in the SVC 

process)
• Tide or GPS tide
• Delta draft 
• Refraction coefficients 
• Observed depths
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The following operations take place when merging:
• Recorded sensor information is compensated for constant 

time errors as noted in the vessel file.
• For each time-tagged depth record, the position for the centre 

of the swath profile is calculated based on the interpolated 
position fix at that time.

• For each depth record, the position of the sounding is 
calculated, based on the profile centre position and any gyro/
heave/pitch/roll corrections that are appropriate (this is echo 
sounder system dependent).

• Tide is interpolated and applied to each depth record. 
• Draft is applied.
A processed depths file is created for each line. This file contains 
the final computed geographic position for each depth record.
If any of these offsets or parameters is changed the data must be 
Merged again.
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Apply Merge
Lines must have tide loaded before they can be merged. 
To apply Merge: 
1. Select a line or group of lines.

2. Select the Merge command from the Process menu or toolbar.

The Merge dialog box is displayed.

3. Select the Apply refraction coefficients check box to apply any data 
created in Refraction Editor. (See “CORRECTION FOR REFRACTION 
ARTIFACTS” ON PAGE 334)

4. Select the Apply GPS tide check box to use GPS tide data instead of 
tidal observation data.

5. Select the Apply Delayed Heave check box to apply delayed heave 
values instead of regular heave. 

If you choose this option, and no delayed heave data is available, 
there will be a warning message in the Output window, and 
regular heave data will be used instead.
If you have a SmoothedCoefficients file (see “FILTER AND SMOOTH” ON 
PAGE 16) for a sensor, you can apply this file during merge to 
smooth selected sensor data.
6. Click the check box beside a sensor to select the appropriate data that 

is to be smoothed during Merge. 

7. Click Merge.

M
en

u

Process > Merge

To
ol
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You can view the progress of the Merge process in the Output 
tab of the Worksheet window.
The Merge is now complete. Other functions requiring geo-
referenced soundings can now be used such as the Subset Editor, 
Surface Cleaning, BASE Surface and others. The settings in the 
dialog box are remembered by the application. 

If a line is merged and then changes are made to the sensor 
data used by merge, the track line is marked in the Project 
tab with the Outdated icon. As well, the Outdated field for 
that line is set to “Yes” in the Selection tab. An Outdated 
track line must have Merge applied again.
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Delta Draft
The Load Delta Draft function lets you import your model for 
dynamic changes in draft and have these changes applied to the 
soundings during the Merge process. Delta Draft represents a 
change in draft that is positive as draft increases and negative 
as draft decreases. The data, which is loaded from a ASCII text 
file, overrides the Dynamic Draft information in the vessel file. 
The Delta Draft value is interpolated between timestamps in 
Merge and added to the Observed Depth to obtain the Final 
Depth.
The input format for the Delta Draft text file is similar to the 
COWLIS tide format. Each record is in the following format: 
YYYY/MM/DD HH:MM:SS.SSS 1.234

The Delta Draft function can also be used to load recorded depth 
versus time data for an underwater platform on which the 
multibeam sonar is mounted, such as a ROV (Remote Operated 
Vehicle) or AUV (Autonomous Underwater Vehicle), or a towed 
vehicle.
1. Select the track line(s).

2. Select the Load Delta Draft command.

The Load Delta Draft dialog box is displayed.

3. Type the path of the file or click Select to locate the file.

4. To make changes to the file, click Edit.

The file is opened in the default text editor (such as Notepad). 
Make any changes and save the file.
5. Click Load.

The delta draft is loaded into the line folder.

M
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Create Field Sheets

Field sheets in HIPS and SIPS are used to organize data products 
created from cleaned and processed bathymetry and side scan data. 

In this chapter...
CREATE A FIELD SHEET .............................................. 174
OPEN AND CLOSE FIELD SHEETS ................................. 179
SET FIELD SHEET PROPERTIES .................................... 181
FIELD SHEET PROJECTION GRID .................................. 182
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Create a Field Sheet
Field sheets have a role in almost every process in HIPS and 
SIPS. They are essential for the creation of BASE surfaces. The 
image below illustrates a newly created field sheet over an area 
of track lines.

A field sheet consists of a data directory with a field sheet 
definition file and a CARIS file for storing vector products. The 
definition file contains information about the geographic 
boundary of the field sheet and the coordinate system to be used 
for the data products.
Field sheets are used to:
• create BASE surfaces. (“CREATE A BASE SURFACE” ON PAGE 193)
• create a layer of contours from a BASE surface or a layer of 

tiles. (“CONTOURS” ON PAGE 361)
• create a layer of tiled soundings.
• generate a profile from a BASE surface.
• create a mosaic from side scan data.
• select soundings from a layer of tiles. (“SOUNDING SELECTION” ON 

PAGE 383)
To define an area for a new field sheet: 
6. Select the new New Field Sheet command.

The New Field Sheet Step 1 dialog box is displayed.M
en

u Process > New Field 
Sheet
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7. Type a name for the field sheet in the Name text box. Names should be 
alphanumeric characters only and cannot contain any spaces.

8. Define the scale of the field sheet.

The Horizontal Resolution field sets the minimum distance between 
two adjacent coordinate values in the field sheet. The first time 
you create a field sheet this field will contain the default value of 
0.020 (the minimum allowable resolution for S-57). You can 
reset this field to default to a different value. 
9. Type a new value in the Horizontal Resolution field, if needed.

The Depth Resolution sets the minimum distance between two 
adjacent depth values. The Depth Resolution field contains a default 
value of 0.0010 (default resolution used in CARIS maps for 
heights/depths).Type a new value in the Depth Resolution field, if 
needed.
10.Click Next.

The New Field Sheet Step 2 dialog box is displayed.
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This dialog box lists projections available to display your field 
sheet data. These are based on the coordinate systems and 
ellipsoid parameters as defined in the editable text file 
..\Hips\System\mapdef.dat. 
11.Select a projection from the Group column. 

The pre-defined projections specific to that projection system are 
listed in the Zone column. 
12.Select a projection from the Zone column. 

13.Click Next.

The New Field Sheet Step 3 dialog box is displayed.
14.Select either the Geographic or Ground coordinates option.

15.Define the extent of the field sheet by one of three methods:
• use the current extent of the Display window, or 
• use the mouse to create a box defining the extent, or
• enter the geographic or ground coordinates.
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Use current display 1. Zoom in on the area you want to include field sheet so that it fills 
the Display window.
2. Click the Current Display Extent button.   

OR
Draw a bounding box 1. Click the Bounding Box button. 

The cursor in the Display window is shown as a cross-hair.
Press and hold the mouse button, and drag the cursor across the 
area where you want to create the field sheet.

A rectangular box is drawn across the area where the cursor was 
dragged.

• If you want to move the bounding box, position the 
cursor inside the box so it becomes a four-headed arrow. 
Press and hold the mouse button, and then drag the box 
to a new location.

• If you want to resize the bounding box, position the 
cursor on any of the box handles so the cursor becomes a 
two-headed arrow. Press and hold the mouse button and 
drag the handle to resize the box.

OR
Enter coordinates 1. Enter the northeast and southwest extents by clicking in one of 

the appropriate fields and typing the information, or by using the 
arrow keys to toggle the values into the entry fields.

After the area for the field sheet has been defined, 
16.Click Finish to create the field sheet.

The new field sheet is outlined in the Display window.
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The new field sheet data and files are located, by default, in 
..\Hips\Fieldsheets\ProjectName\FieldSheetName. 
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Open and Close Field Sheets
Open a field sheet in a project or session.  

1. Select the Open Field Sheets command.

The Open Field Sheets dialog box is displayed.
2. Select a field sheet from the list of available field sheets.

3. Click Open.

The field sheet outline is displayed in the Display window. Any 
layers that have been created within the field sheet are listed in 
the file tree in the Layers tab of the Control window, and are 
visible in the Display window. 

You can toggle the display of the layers on and off using the 
check box next to a layer. (You may have to Refresh the display 
to view the data). 

Set as active field sheet
You can have field sheets with different coordinate systems open 
in the same session. But only one field sheet can control the 
coordinate system used in the Display window. 
The Set as Active Field Sheet command identifies the field sheet 
that controls the coordinate system in the Display window. By 
default, the first field sheet you open in a session is the active 
field sheet.

NOTE: Opening a session file automatically opens all field 
sheets that were open when the session file was last saved.
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To change the active field sheet:
1. Select a field sheet in the Layers tab of the Control window.

2. Select the Set as Active Field Sheet command.

The icon for the active field sheet is highlighted green in the 
Layers tab. As well, the Active Field Sheet value in the 
Properties window will be set to “True” for the active field sheet.

Turn off field sheet
Individual layers in a field sheet can be activated or turned off 
by clicking the check box next to the layer. To make it easier to 
view data when there are many layers, or when more than one 
field sheet is open, you can turn off an entire field sheet with one 
command.
To remove a field sheet from the display without closing it:
1. Highlight the field sheet in the Layers tab.

2. Select Turn Off Field Sheet from the right-click menu.

All the previously selected layers of the field sheet are un-
selected. To display the field sheet or any of its layers again, 
select the check box beside the layer. 

Hide a surface To hide a surface (e.g., a BASE surface) and its attribute layers, 
while continuing to display the field sheet:
1. Highlight the surface in the Layers tab. 

2. Select Turn Off Layers from the right-click menu.

The selected surface and all its attribute layers are no longer 
visible in the Display window.

Delete field sheet 1. Select the field sheet by name in the Layers tab of the Control window.

2. Select Delete from the right-click menu.

The field sheet is permanently removed. 

Close all field sheets 1. Select the field sheet by name in the Layers tab.

2. Select the Close Field Sheets command.
 The field sheet outline is removed from the Display window and 

the file name is no longer displayed in the Layers tab.

Close single field sheet 1. Select the field sheet by name in the Layers tab.

2. Right-click on the field sheet layer and select the Close command from 
the pop-up menu.

The field sheet is no longer open in the interface.
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Set Field Sheet Properties
To set the display properties of a field sheet:
1. Select a field sheet layer in the Layers tab of the Control window. 

2. If the Properties window is not open, select a Properties window 
command.

The Properties window for field sheets is displayed.

The Extents, Coordinate System, Projection and Scale fields are read-
only and cannot be modified. You can modify the following 
properties: 
3. Set the Show outline check box to “True” to display a border around the 

field sheet area.

4. Set the Show label check box to “True” to display the name of the field 
sheet in the Display window.

5. Set Active Field Sheet to “True” to make one field sheet the active sheet, 
when more than one field sheet is open. 

6. Select a border Colour from the colour picker, or, create a custom colour 
from the standard Windows Colour Palette.
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Field Sheet Projection Grid 
The Projection Grid feature lets you display a grid of ground 
projection coordinates within a field sheet. 
(The grid will cover the area of the field sheet only. To display a 
grid over the full extent of the display, use the Projected Grid 
option in the Tools > Options > Display dialog box. See “PROJECTED 
GRID” ON PAGE 108 in the Reference Guide.) 
The projection grid has grid line properties such as thickness, 
shape and colour. You can also annotate the grid with the 
coordinates of your field sheet data, and set the look and 
positioning of these annotations. These settings for the grid are 
saved with the field sheet. 
1. Select a field sheet in the Layers tab. 

2. Select the Projection Grid command.

The Grid Properties dialog box is displayed.

3. Set the options for positioning and style of grid lines as described in the 
table below. 

M
en

u Process > Products > 
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 Grid Lines Prop

4. Set Annotations options. See “ANNOTATIONS” ON PAGE 184. 

GRID LINES 

Property Description

Corners The lower left and upper right corners of the rectangular field 
sheet determine the corners of the grid.

Lower Left The latitude (North) and longitude (East) coordinates of the 
lower left corner of the field sheet. 

Upper Right The latitude (North) and longitude (East) coordinates of the 
upper right corner of the field sheet.

Spacing The spacing of the grid lines is calculated by adding the 
spacing values to the 0,0 position until the grid fills the area 
defined by the corners.

Synchronize To space the grid lines the same interval apart, enable 
Synchronize.

North Set the latitude interval between grid lines (North)

East Set a longitude interval (only available if Synchronize is not 
enabled.) 

Line Attributes Set a colour and line weight for the grid lines.

Colour Click on the Colour button and select a colour for the grid 
lines from the drop-down list. 

Weight Set the thickness of the lines . Units are millimetres at display 
scale.

Type Select the type of grid: solid lines or ticksand.or crosses.

Full The grid will be formed of solid lines.

Ticks and 
Crosses

If you enable Ticks, you can set the following options:
• Length (length of the markings in mm at display scale)
• Offset
• Alignment

If you enable Crosses, you can set the following option:
• Length (the dimensions of the crosses)

You can use both ticks and crosses in the same grid.
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Annotations 
This dialog box provides controls for annotating the projection 
grid with the coordinates of your field sheet data. 
5. Click the Annotations tab to set position and format of annotations for 

the grid.

ANNOTATIONS

Property Description

Position 
Attributes

 Select any combination of Top, Bottom, Right, Left 
positions for the annotations relative to the grid lines.
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6. Click OK to create the grid.

A grid of coordinates is generated and displayed in the Display 
window. A Projection Grid layer is added to the Layers tab.

To change the settings of the projection grid:
1. Select the Projection Grid layer in the Layers tab.

2. Open the Properties window and select the Settings field.

Digits Set the format of the digits used in the annotations. The field 
at the top of the dialog box shows how digits are displayed. 

By default, the annotation is displayed in full.
• Thousand Separator: uses a comma to separate the digits 

to the right of the decimal point into groups of three, (e.g., 
1,004,532). 

• Left: The number of digits to the left of the decimal point 
(e.g., 4 digits displays 4,532).

• Right: The number of digits to the right of the decimal 
point ( e.g., 3 digits displays 4532.123)

Format Select a font for the digits, and choose to have it positioned 
above or below the normal line of digits.

Position • Position to neatline: placement of annotation relative to 
neatline, either Inside or Outside the field sheet

• Offset from neatline: distance of the annotation from the 
neatline in millimetres

• Position to Grid: Choose Above /Left, Centre, or Below/ 
Right 

• Offset from grid line: the distance between the annotation 
and the grid line in millimetres

• Orientation to grid: Parallel to the grid or at right angles to 
it.

ANNOTATIONS

Property Description
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This will open the grid Properties dialog box where attributes 
other than the extents of the grid can be changed.
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Create BASE Surfaces

The Bathymetry Associated with Statistical Error (BASE) Surface can be 
generated to view data for safety of navigation or for a detailed 
examination of the seafloor.

Three kinds of BASE surfaces can be created: 
• Uncertainty 
• Swath angle
• Combined Uncertainty and Bathymetry Estimator (CUBE)

In this chapter...
OVERVIEW ................................................................ 188
FOUR TYPES OF BASE SURFACES................................ 189
CREATE A BASE SURFACE ........................................ 193
PROPERTIES OF BASE SURFACES ............................... 204
VERTICAL REFERENCE SYSTEM .................................... 215
BASE SURFACE COMMANDS ...................................... 218
BASE SURFACE QC REPORT .................................... 238
SURFACE FILTERING ................................................... 244
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Overview
A Bathymetry Associated with Statistical Error (BASE) Surface 
is a georeferenced image of a multi-attributed, weighted-mean 
surface. A BASE Surface can also contain a visual 
representation of horizontal and vertical uncertainty. 
An example of a BASE Surface image is shown below.

The BASE Surface is used for the following purposes:
• as a background visual aid when cleaning data interactively 

or automatically.
• to create a georeferenced TIFF that can be exported to other 

software such as real-time navigation systems.
• to export data as an XYZ text file so it can be imported as 

soundings in a CARIS map or used to build digital terrain 
models in other software.

• as a Product Surface that can be used to build contours, 
sounding selections, profiles, and other data layers. This data 
can later be used to create an ENC or raster chart.

• as a quality control feature for data. By viewing the 
uncertainty values for nodes, you can identify bad data and 
determine if an area needs to be re-surveyed.

A BASE Surface file is saved within the CARIS Spatial ARchive 
(CSAR) framework. This file contains the metadata for the 
surface.
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Four types of BASE surfaces 
Four different surface types can be created:
• Uncertainty  uses a weighting scheme based on depth 

uncertainty as specified by a selected S-44 survey order.
• Swath angle uses a weighting scheme based on a beam's 

intersection angle with the seafloor.
• Shoalest Depth True Position  stores the shoalest depth 

within a given node in the depth layer. The true position of 
this depth is also stored on the BASE Surface.

• Combined Uncertainty and Bathymetry Estimator (CUBE) 
surface uses multiple hypotheses to represent potential depth 
variances along the seafloor (see ““CUBE PROCESSING” ON 
PAGE 247).

Uncertainty Weight
The weight that a sounding contributes to a node is inversely 
proportional to the predicted depth uncertainty of the sounding. 
The sounding’s depth uncertainty is scaled as a function of the 
sounding’s distance from the node. The propagation of the depth 
uncertainty to the node takes into account the sounding’s 
distance from the node AND the sounding’s horizontal 
uncertainty. Thus, both depth uncertainty and horizontal 
uncertainty play a role in determining the weight a sounding 
contributes to a node.
The sounding’s area of influence is a radius that determines the 
number of nodes to which the sounding can be applied. This 
radius is determined by the depth uncertainty of the selected 
IHO S-44 survey order (see formula below).   

Once the depth uncertainty is propagated beyond the S-44 
survey order requirement that has been selected for depth 
accuracy, then it has reached its area of influence limit.
All distance computations are based on the ground coordinate 
system defined for the BASE Surface—they are not simplified to 
cell distances. All of the nodes within a sounding’s area of 
influence are located rigorously. No simplified weight matrix 
scheme is used.

Depth Uncertainty = 
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Swath Angle Weight
The weight a sounding contributes to the Surface also varies 
with the sounding's grazing angle with the seabed. 
This weighting value is important in areas with adjacent or 
overlapping track lines. The swath angle weight ensures that 
higher weight is given to beams from the inner part of a swath 
than to outer beams from adjacent track lines.
In the following graph, beams with a grazing angle between 90 
and 75 degrees are given a weight of 1.0. The weight decreases 
linearly to 0.01 as the angle with the sea floor decreases to 
15 degrees.

This is the default swath angle weight scheme as defined by the 
file...\Hips\System\GrazingAngleWeights.txt. The default file 
can be customized to another weighting scheme. 

Range weighting
All BASE Surfaces use range weighting to determine how a 
sounding is applied to a node. Range weighting is based on 
distance—soundings close to a node are given greater weight 
than soundings further away. The calculated node positions are 
determined by the corner coordinates of the field sheet.
The range weight is inversely proportional to distance from the 
node: soundings closer to a node are given a greater weight than 
soundings further away.
The number of nodes each sounding is applied to is determined 
by the size of the beam footprint. The beam footprint is 
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calculated using depth, sonar beam width, and the grazing 
angle. 
The sonar that is used, with the appropriate beam width, is 
defined in the BASE Surface wizard. 
A list of multibeam systems and corresponding beam widths is 
listed in ..\Hips\System\DeviceModels.xml. 
The following graph demonstrates range weighting using 
distance from a node in units of pixels (multiples of the BASE 
Surface resolution).
 

Shoalest Depth True Position
This BASE surface stores the shoalest depth within a given node 
in the depth layer. It can also create a true position surface layer 
for which Horizontal and Vertical Uncertainty can be specified 
as optional output layers.
If true position data does not exist for the lines selected, the 
surface creation will continue without these attributes. If, at a 
later time, uncertainty data becomes available, a surface 
recomputation can be invoked and the surface will be updated 
accordingly.

CUBE 
The Combined Uncertainty and Bathymetry Estimator (CUBE) 
generates a surface that contains multiple hypotheses 
representing potential depth variances on the seafloor. 
Examining these hypotheses in Subset Editor, you can 
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determine if they are valid or not. The hypotheses can be 
replaced by alternative hypotheses (if necessary). 
Using a CUBE filtering tool soundings that fall outside specified 
parameters can be rejected and another CUBE Surface 
generated. Thus, CUBE is used in an iterative process to filter 
data to produce the best-possible representation of the surveyed 
area. 
For generation of CUBE surface and hypothesis editing see 
“GENERATING CUBE SURFACES” ON PAGE 251.
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Create a BASE Surface
BASE Surfaces are created using a wizard. You can select 
specific track lines to include in the BASE Surface or let the 
wizard select them for you automatically. You can generate as 
many BASE Surfaces as necessary within a field sheet. 

To create a BASE Surface:
1. Open a field sheet of the area for the BASE Surface:

• To create a BASE Surface for the entire field sheet area, select the 
field sheet in the Layers tab in the Control window.

• To create a BASE Surface for a single track line, select a track line 
within the field sheet and then select the field sheet layer in the data 
tree. 

2. Select the New Base Surface command.

The number of steps in the wizard is determined by the type of 
surface you are creating. 

BASE Surface (Step 1)
The BASE Surface Wizard (Step 1) dialog box opens.

All track lines must be merged before a BASE Surface can 
be created.
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1. Type a Name for the BASE Surface.

2. Type any necessary Comments in the text box, and click Next to 
display the BASE Surface Wizard (Step 2) dialog box.
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BASE Surface (Step 2)

The Resolution value(s) sets the distance(s) between BASE 
Surface nodes. You can use the same single resolution value for 
the entire surface, or use different resolutions for each range of 
depths. 
1. Select Single and enter a resolution value, or select the Multiple option 

and enter a range of values.

If you select the Single option, you can determine the range of 
depths to include in the BASE surface by using the Depth Filter 
option.
2. Select Depth Filter and enter a range of depths. 

If you select the Multiple option, the depth ranges and related 
resolution values can be saved as a template to apply when 
creating other new BASE surfaces. 
3. Click Load to use a saved file.

OR
4. Click  to activate the fields for depth ranges and the desired 

resolution in metres, and type the depth and resolution values.
• Click  to delete contents of the field.

5. Click Save to save the settings as a template. 

Values are entered in the following format: 
minimum depth - maximum depth, resolution (all in 

Click to 
activate
depth range 
and resolution
fields.
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metres). For example, 0.0-10.0,5.0 which associates depths 
between zero and 10 metres with a resolution of 5 metres.
6. Select a Surface Type: Swath angle, Shoalest Depth True Position, 

Uncertainty or CUBE from the drop-down list.

7. Select the Vertical Datum, if known, from the list.

The Vertical Datum set for the BASE surface will be maintained 
in products created from it, such as finalized or interpolated 
surfaces. The Vertical Datum setting for a selected BASE 
surface can be seen and changed in the Properties window.
8. Click Next. 

The content of the next dialog box is determined by the choice of 
surface type made in step 5: 
“BASE SURFACE (STEP 3) - CUBE” ON PAGE 253

“BASE SURFACE (STEP 3) - SWATH ANGLE WEIGHTING” ON PAGE 197

“BASE SURFACE (STEP 3) - UNCERTAINTY WEIGHTING” ON PAGE 199

“BASE SURFACE (STEP 3) - SHOALEST DEPTH TRUE POSITION” ON PAGE 201
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BASE Surface (Step 3) - Swath Angle Weighting 
If you selected the Swath Angle Weighting option at Step 2, the 
(Step 3) dialog box is displayed. 

Add Survey Lines: The Max Footprint Size defines the maximum area in the Surface 
to which a sounding is applied. Use this value to prevent over-
expansion of the footprint due to large depth spikes or very 
shallow grazing angles.
1. Click the up and down arrow buttons in the Max Footprint Size.

If one or more track lines were selected before the BASE Surface 
process was started, the Use Selected Lines check box is enabled. 
2. Check Use Selected Lines if you want to create the BASE Surface only 

on the selected line or lines.

Use the Ignore Lines with errors option so that the surface creation 
is not interrupted if it encounters bad data. The process will skip 
the part of the line containing bad data and continue creating 
the surface with the next line. Once the surface is complete you 
can decide whether to remove the partial line. 
3. Check Ignore Lines with errors to have bad line data omitted from the 

surface. 

4. Check Include Additional Bathymetry to include water column 
bathymetery added to project.

5. Select either Accepted, Examined or Outstanding check boxes to 
include soundings with these status flags in the BASE Surface process. 
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Additional Attributes 6. Select one or all Additional Attributes to create an attribute layer of the 
BASE Surface that displays that attribute. 
• Density: create an attribute layer that displays the density of 

soundings contributing to a node.
• Mean: create an attribute layer that displays the mean of all 

soundings contributing to a node.
• Standard Deviation: create an attribute layer that displays the 

standard deviation from the mean.
• Shoal: create an attribute layer that displays the shoalest soundings 

contributing to a node.
• Deep: create an attribute layer that displays the deepest soundings.

7. Click Finish.

The Swath Angle BASE Surface is created.
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BASE surface (Step 3) - Uncertainty Weighting 
If you selected the Uncertainty option, the (Step 3) dialog box is 
displayed.

Add Survey Lines 1. Select an IHO S-44 Order from the drop-down list.

The a (constant depth error) and b (factor of depth dependent 
errors) fields are automatically filled when a survey order is 
selected. The values are read from 
..\HIPS\System\IHO_Standards.xml.
2. If one or more track lines were selected before the BASE Surface 

process was started, the Use Selected Lines check box is enabled. 
Select this check box if you want to create the BASE Surface for the 
selected line or lines. 

Use the Ignore Lines with errors option so that the surface creation 
is not interrupted if it encounters bad data. The process will skip 
the part of the line containing bad data and continue creating 
the surface with the next line. Once the surface is complete you 
can decide whether to remove the partial line. 
3. Check Ignore Lines with errors to have bad line data omitted from the 

surface. 

4. Check Include Additional Bathymetry to include water column 
bathymetery added to project.

Additional Attributes 5. Select either the Examined or Outstanding check boxes to include data 
with these status flags in the BASE Surface process. The Accepted 
check box is selected by default.
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6. Select one or all Additional Attributes to create an attribute layer of the 
BASE Surface that displays that attribute. 
• Density: create an attribute layer that displays the density of 

soundings contributing to a node.
• Mean: create an attribute layer that displays the mean of all 

soundings contributing to a node.
• Standard Deviation: create an attribute layer that displays the 

standard deviation from the mean.
• Shoal: create an attribute layer that displays the shoalest soundings 

contributing to a node.
• Deep: create an attribute layer that displays the deepest soundings.

7. Click Finish.

The Uncertainty BASE Surface is created.
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BASE surface (Step 3) - Shoalest Depth True Position 
If you selected Shoalest Depth True Position in Step 2, the Step 
3 dialog box displays the following options. The options specific 
to this surface type are Median, Horizontal Uncertainty and 
Vertical Uncertainty, which enable you to create surface 
attribute layers from those kinds of data .
If such data does not exist for the lines selected, the surface 
creation will continue without these attributes. If, at a later 
time, uncertainty data becomes available, a surface 
recomputation can be invoked and the surface will be updated 
accordingly.
 

Add Survey Lines 1. Check Use Selected Lines if you want to create the BASE Surface only 
on the selected line or lines.

Use the Ignore Lines with errors option so that the surface creation 
is not interrupted if it encounters bad data. The process will skip 
the part of the line containing bad data and continue creating 
the surface with the next line. Once the surface is complete you 
can decide whether to remove the partial line. 
2. Check Ignore Lines with errors to have bad line data omitted from the 

surface. 

3. Check Include Additional Bathymetry to include water column 
bathymetery added to project.

4. Select either Accepted, Examined or Outstanding check boxes to 
include soundings with these status flags in the BASE Surface process. 
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Additional Attributes 5. Select one or many of the Additional Attributes to create a layer of the 
BASE Surface that displays that attribute. 

6. Click Finish.

Density creates an attribute layer that displays 
the density of soundings contributing to a 
node.

Mean creates an attribute layer that displays 
the mean of all soundings contributing to 
a node.

Standard Deviation: creates an attribute layer that displays 
the standard deviation from the mean.

Deep creates an attribute layer that displays 
the deepest soundings.

Median creates an attribute layer that displays 
the median values of soundings 
contributing to the node

Horizontal TPU creates an attribute layer that displays 
the Horizontal TPU value for the 
shoalest sounding used for the Depth 
Attribute layer. 

Vertical TPU creates an attribute layer that displays 
Depth TPU value for the Shoalest 
sounding used for the Depth attribute 
layer
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View BASE Surfaces
In the HIPS interface, when a BASE Surface layer is created it 
is displayed in the Layers tab of the Control window. Attributes 
such as Depth are displayed as child layers of the BASE Surface.

1. Click Expand ( + ) icon beside the Field Sheet file name to expand the 
directory tree in the Layers tab.

2. Display the BASE Surface by selecting the check box beside the layer.

The following attributes can be displayed in the BASE Surface 
(depending on the weighting method you selected in Step 6 and 
the selected attributes in Step 7):
• Depth: Depth at the node.
• Density: The number of soundings contributing to a node.
• Standard Deviation: The number of standard deviations that 

the node is from the mean.
• Uncertainty: The depth uncertainty assigned to each node.
• Mean: The mean depth calculated from all soundings 

contributing to a node.
• Shoal: The shoalest sounding contributing to a node.
• Deep: The deepest sounding contributing to a node.
3. To view or hide layers, select or clear the check boxes beside the layer.
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Properties of BASE Surfaces
Use the Properties window to view information about a BASE 
Surface or to set the display options for its attribute layers.

View Surface Properties
1. Select a BASE Surface layer in the Layers tab of the Control window.

2. Select the Properties window command, or right-click the layer and 
select Properties from the pop-up window.

The Properties window displays the BASE Surface information. 
The image below shows the properties of a CUBE surface parent 
layer.
 

M
en

u

Window > Properties

To
ol

s
Po

p-
up Properties



CARIS HIPS and SIPS User Guide 205

Create BASE Surfaces: Properties of BASE Surfaces

Most of this information is read-only, however, the following 
fields can be edited:
Editable fields:

Properties Function

General 

Vertical Coordinate System Select the appropriate vertical datum for the 
surface data from a drop-down list.

(Coverage) (This field cannot be edited, but the coverage 
value can be updated using the Update Coverage 
command on the pop-up menu.)

Creation: 

Data Start Date Date can be modified using the drop-down 
calendar

Data End Date Date can be modified using the drop-down 
calendar

Comments This field is populated with the contents of the  
Comments field from Step 1 of the BASE Surface 
creation. This may be the mandatory <abstract> 
element for 19115 metadata, or other information 
about the surface entered during creation. 

This content can be edited.

Platform Name Displays the vessel name. 

CUBE Configuration Displays the configuration selected in the last step 
of creating a CUBE surface. 

If a configuration other than Default was selected, 
or created in the Advanced Options dialog box, 
click on the Browse button [...] to see the values 
applied in that configuration. 

(See also “ADVANCED OPTIONS FOR CUBE 
SURFACE” ON PAGE 255.)

S-44 Values: (Present only if selected surface is a CUBE 
surface.)

Disambiguation Select the process used the create the CUBE 
surface, form a drop-down list.

Operation: 

Keep Up To Date Set to True to automatically update the currently 
selected surface. (Automatic BASE Surface 
update must also be set in Tools > Options > 
General.)
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Attribute Layer Properties
All of the properties for an attribute layer can be edited, however 
some fields are only activated when others are set. For example, 
Sun Position and Vertical Exaggeration fields are greyed out unless 
Shading Enabled is set to “True”.
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BASE Surface Properties are organized into four groups: 
“GENERAL OPTIONS” ON PAGE 207

“LEGEND OPTIONS” ON PAGE 208

“FILTER OPTIONS” ON PAGE 209

“DISPLAY OPTIONS” ON PAGE 210

General options General properties control the colour display for the attribute 
layer. Use either a colour map file or a colour range file to 
display data values as colours in the display. Colours can be 
reversed when using a colour map file. 
See “COLOUR MAP EDITOR” ON PAGE 39 for more information. 
: 

The Min Range and Max range values determine the upper and 
lower extents to which the colour file is applied. The Minimum 
or the range is mapped to the first value in the colour file, and 
the maximum to the last value. 

The properties of the Bounding Polygon layer are different 
from those of the other attribute layers. See “BOUNDING 
POLYGON PROPERTIES” ON PAGE 213.

Property Function

General 

Colour Type Select Colour Map or Colour Range (Colour Map 
activates other fields).

Colour File Displays the active colour file based on the 
Colour Type selected above. The default colour 
map is Rainbow.

If you chose Colour Range, but no colour range 
files exist in the directory, the surface will 
automatically be coloured grey. By default, the first 
colour range file in the drop-down list will be 
selected. 

Reverse colours Select to apply colour mapping from maximum to 
minimum values instead of from minimum to 
maximum.

Min range The minimum value for the attribute layer to which 
the colour file is applied, e.g., the shoalest data on 
the Depth layer or the minimum number on 
Density layer.

Max range The maximum value for the attribute layer to which 
a colour is applied e.g., the deepest sounding on 
the Depth layer or highest number on the Density 
layer.
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The Min and Max range is taken from the data for the selected 
layer, and can be adjusted. For example, if the minimum of the 
range is increased, all data falling below that value will be 
mapped to the first colour defined in the colour file. Similarly, if 
the maximum in lowered, all data falling above that maximum 
will be coloured with the last colour in the colour file.

Legend options You can add a raster legend to the display, to identify which 
attribute values (e.g., depths) are represented by which colours.

See also “RASTER LEGEND” ON PAGE 38.

 

Property Function

Legend: 

Show Legend Set to True to display a legend to identify the range 
of values to which each colour is mapped. 

Location Select the position of the legend, e.g., Left of the 
display, bottom of the display etc.

Labels: These are options for descriptive text on the 
legend. 

Display Title Set to True to display the name of the attribute 
layer and units, e.g., Depth (m).

Include Name Set to True to display the full path and name of the 
attribute layer e.g., 
C:\CARIS\HIPS\71\Fieldsheets\Project\Fieldsheet 
name\BASEsurfacename.csar. - Depth (m).

Label Colour Set the colour of the labels on the legend. The 
default colour is black.

Interval Set an interval between the values displayed on 
the legend scale 
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Filter options Use filter controls to limit the display of data to that which falls 
between the minimum and maximum values. The image below 
illustrates filtering to display a range of shoalest depths.

 

Property Function

Filter:

Filter Set to True to display only the surface data with 
values between the Filter minimum and maximum 
values (as set in the fields below). 

Min val Set a minimum value below which data will not be 
displayed.

Max Val Set a maximum value above which data will not be 
displayed.
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Display options Display properties include controls for display of images and 
digits. The Draw Cells property will display a grid representing 
the nodes of the surface layer. With large data sets, you may 
need to zoom in to see this grid, as in the illustration below. 

Image properties control whether or not the selected attribute 
layer is displayed, and options such as transparency and 
shading. Shading effects reflect the sun elevation and azimuth 
values. 
Properties for display of digits include the option to display data 
in engineering format instead of hydrographic format. For 
example, hydrographic format would show a depth as 127. 
Engineering format would display the same value as 12.7 (to as 
many decimal places as set). 
When using engineering digits for depth values, sounding 
rounding rules are applied. However, only the last digit in the 
sounding will be rounded to ensure that the desired precision is 
not lost.
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Property Function

Display: 

Draw Cells Set to True to display a grid representing the 
nodes of the surface. 

Image:

Draw Image Set to True to display the selected layer or grid. 
Default setting is True.

Transparency Type a Transparency percentage for the 
selected layer: the higher the percentage value, 
the more transparent the layer will appear.

Shading:

Shading Enabled Set to True to turn on shading to heighten the ridge 
detail for fine-scaled features. 

Colour Enabled Set to display the attribute layer using the full 
colour map or file. If set to False, the layer will be 
displayed as grey only. 

Sun Position 5. Click in the field to display the sun compass.
6. Move the symbol to shift the light direction.
7. Click in the display to see the change in shad-

ing.

When the sun symbol is in the centre of the 
compass, the light is represented as directly 
above the image. The height and direction from 
which the light is displayed is shown by the Sun 
Elevation and Sun Azimuth values.

Sun Azimuth An adjustment here is reflected in the Sun 
Position field.

Sun Elevation An adjustment here is reflected in the Sun 
Position field.

Vertical Exaggeration Increase the exaggeration value to heighten the 
vertical detail.

Digits:

Draw Digits Set to True to display data values.

Engineering Digits Set to True to display the digits of the data nodes 
with decimal places instead of superscripts, and in 
regular (un-slanted) text. 

Engineering Precision Set the number of decimal places to include when 
values are displayed in engineering digits. Default 
is 1 decimal place.

Digit Font Click the Browse button to select the font from the 
Fonts dialog box. 

Minimum Display Scale Set the value of the smallest scale at which digits 
will be displayed.
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Suppression: Filter out specific data based on the number of 
soundings in a selected area. Fields are activated 
when Draw Digits is set to “True”. 

Suppression Type Apply Overplot Removal (to remove overlapping 
soundings), Radius (filter out soundings within a 
set radius), or None. 

Radius: Size of the area to which the suppression is 
applied.

Radius Value The radius defined as metres on the ground, or as 
the number of millimetres between soundings at 
map scale. 

Radius Map Scale Value to apply to scale.

Property Function
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Bounding Polygon Properties
A bounding polygon displays properties similar to those of a 
parent BASE surface (Extents, General, Creation, and Sources). 
(See “PROPERTIES OF BASE SURFACES” ON PAGE 204.)
One property specific to bounding polygons is the ability to 
adjust the boundary so that it more closely delineates the extent 
of the surface.

How closely the bounding polygon fits the extents is determined 
by the level of detail used to create the polygon. Settings in the 
Level field in the Properties window can be used to rebuild the 
polygon with a different resolution. (By default, polygons are 
created at a Medium level.) The polygon can be recreated using a 
Coarse level (less detail), or a Fine level (more detail). 
To change the Level property:
1. Select the Bounding Property layer in the Layers tab. 
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2. Select the Level field in the Properties window.

3. Choose a different setting from the drop-down list.

4. Right-click on the Bounding Polygon layer, and select Rebuild from the 
pop-up menu.

The bounding polygon will be rebuilt. The image below shows 
the difference between the polygon drawn at the default level 
and rebuilt at a Fine level.
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Vertical Reference System
A vertical reference system is a 3D coordinate reference system 
in which position is defined by latitude, longitude, height or 
depth and a linear unit of measure, for example, feet or metres. 
When the Z values in a vertical reference system represent 
depths, the Z axis direction is “positive-down”. (This is consistent 
with the HIPS and SIPS depth convention.)
In HIPS and SIPS the identification of the vertical reference 
system information used for a project can be added to a BASE 
surface during its creation. Alternatively, it can be added to the 
Vertical Coordinate System field in the Properties of an existing 
BASE surface. 
A database of defined vertical reference systems in available in 
HIPS and SIPS through the Vertical System Editor. This 
information is drawn from the European Petroleum Survey 
Group (EPSG) database of reference systems, which can be 
found at: http://www.epsg-registry.org.1

Vertical Reference System Editor
The existing datum, ellipsoid and reference system entries in the 
database are read-only. Each entry has a unique name and 
numerical identifier. 
Used-defined entries can also be added to the database using the 
Editor.
To open the Vertical Reference System Editor:
1. Select the Reference System Editor command.

The Vertical Reference System Editor is displayed.

1. Use of material from OGP Surveying and Positioning Committee’s EPSG Geodetic 
Parameter Registry does not imply endorsement by OGP Surveying and Positioning 
Committee of CARIS products or services.
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The leftmost column lists the types of coordinate system 
elements for which you can view properties.
2. Select the category of data you want to view, for example, Datums. 

This will activate the listing of all the entries for that category. 
to view the properties of a specific entry, 
3. Select an item from the list. (The example above shows the Fair Isle 

datum selected.)

The properties for the selected datum (or ellipsoid or vertical 
reference system) are displayed in the pane on the right. As you 
select each property field, a brief description of the field is 
displayed below the properties. In the example illustrated above, 
the content of the Scope field show “Topographic mapping and 
geodetic surveying” as the areas of applicability for the selected 
datum.

The first property field contains the EPSG code number that 
identifies the selected datum, ellipsoid or reference system.
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Editing the Vertical Reference database
You can add your own entries to the database, provided the 
names of the entries do not duplicate existing names. User-
defined entries can be deleted, but original entries cannot. 
To add an item:
1. Select the icon for the category of data that you want to add. For 

example, to add an ellipsoid, click the Ellipsoids icon.

2. Right-click anywhere in the ellipsoids listing, and select New from the 
pop-up menu.

A New entry is added to the list.
3. Click on the new entry and type the name for your entry, over-writing 

“New”.

In order for your new entry to be saved to the database, it must 
have values defined for the properties. If you do not define the 
properties, the new item will be removed from the list when the 
editor is closed.
4. Type appropriate information in the properties fields in the list on the 

right.

5. Click OK to save your changes to the database and close the dialog 
box.

Deleting entries
While the original items in the Vertical Reference System 
database are read-only, any user-created entries can be deleted. 
To delete a user-defined entry:
1. Select the entry.

2. Right-click in the pane and select “Delete” from the pop-up menu. 

3. Click OK in the dialog box to confirm the deletion.
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BASE Surface Commands

Open
To open a BASE surface you first need to open the field sheet in 
which it was created. 
1. Select the Open Field Sheets command.

The Open Field Sheets dialog box is displayed.
2. Select one (or more) field sheet files from the list.

3. Click Open.

The field sheet filename is displayed in the Layers tab of the 
Control Window and the field sheet outline(s) is shown in the 
Display window.
4. Click the ( + ) icon to expand the field sheet file tree.

5. Select the BASE Surface check box.

The BASE Surface is now visible in the Display window. 

Delete
Permanently delete a BASE surface from a field sheet.
1. Right-click on a BASE surface layer in the Control Window, and select 

the Delete command from the pop-up menu.

The BASE Surface layer is permanently deleted from the field 
sheet.

Add to BASE Surface
The Add to BASE Surface command applies new track lines to 
an existing surface without the need to regenerate the surface. 
You can add specific lines to the Surface or you can let the 
program select the lines to be added automatically. 
1. Select the track line layer in the Layers tab of the Control window.

2. Select the track line(s) you want to add to the BASE Surface so it is 
highlighted.

3. Select the Add to BASE Surface command.
 The Select Surface dialog box is displayed.

4. Select the surface to which the line is to be added.

5. Click OK.
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The BASE Surface is updated to include new track lines.

Remove From BASE Surface
Remove a survey line from a Swath Angle or Uncertainty BASE 
Surface.
1. Select the survey line in the Project tab of the Control window.

2. Select a BASE Surface layer in the Layers tab of the Control window.

3. Select the Remove from BASE Surface command.
 The BASE Surface is regenerated without the data from the 

selected survey line.

Add Layer 
Use the Add Layer command to create a new sub-layer for an 
existing BASE Surface. The new attribute layer can be created 
from one or more existing attribute layers, numerical operators 
and numeric values in an equation. You cannot create a layer for 
an attribute that is not present in the surface.
1. Select a BASE Surface (parent) layer in the Layers tab of the Control 

window.

2. Select the Add Layer command from the right-click menu.
 The Compute Layer dialog box is displayed.
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3. Type a name for the new surface layer in the Layer Name field.

The Layer Z-axis convention field defines the Z-axis convention for 
the data in the new layer. The options are:
• Depth with Z-axis positive down: to be used if the data in the 

new layer will contain depth values that are positive down.
• Height with Z-axis positive up: to be used if the data in the new 

layer will contain elevation values that are positive up.
• Not applicable: to be used if the data in the new layer will 

represent generic, non-Z values (e.g., Std_Dev). 
4. Select a Layer Z-axis convention from the drop-down list.

The Available Attributes list displays the attribute layers 
currently present in the selected surface. 
5. Double-click an attribute in the Available Attributes list to insert it into 

the conditions field below.  

Use your keyboard and the condition buttons to create the 
equation for the new layer. The example above shows the 

If there are spaces in the name of the selected attribute, 
place quotation marks around the attribute in the 
conditions field, (e.g., "attribute name").
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equation to create a new depth layer with values increased by 3 
metres. 
6. Click any of the operators to add it to the field.  

To add values:
7. Click at the point in the equation where you want to enter a numerical 

value, and type the number. 

Use Backspace to remove parts of an equation, or click Clear to 
remove everything from the conditions field. 
8. Click OK to compute the new layer.

The new layer is drawn in the Display window and is listed as a 
BASE Surface child layer in the Layers tab. 
The properties of the new layer can be viewed in the Creation 
fields of the Properties window: the Method field shows it is a 
computed layer, and the Equation field shows the variables in the 
equation.

Recompute surface
The Recompute function rebuilds a BASE Surface and 
regenerates the surface image.
If you have updated the BASE Surface since it was interpolated, 
you can apply the Recompute command to rebuild the 
interpolated surface.

Operator Function Displays

( ) parentheses ( Depth )

+ addition Depth + 4

x multiplication Depth * 4

– subtraction Depth - 4

\ division: Depth / 4

^ exponentiation (DepthX ) Depth ^ 4
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1. Select a Surface name in the field sheet file tree so it is highlighted.

2. Select the Recompute BASE Surface command.

Only the track lines used previously in the Surface are processed 
during rebuilding. 
The Recompute operation checks to see if the surface makes use 
of HIPS data that is no longer present. 
If data is missing, a dialog box lists what is missing. You then 
have the option of terminating the Recompute process, or 
continuing without the missing data. If you choose to continue, 
the replacement surface will have the missing data lines 
removed from its list of contributing lines.

Interpolate BASE Surface
The Interpolate command eliminates small holes that appear in 
areas of sparse data. This sometimes happens in the outermost 
beams along the outside edges of surveyed areas where there is 
little or no overlapping coverage.
This command examines each Surface node to determine if it 
contains a pixel value. If the node does not contain a value, the 
neighbouring pixels are examined to determine if enough of 
them contain pixel values to justify interpolating a value for the 
hole. This limits the interpolation to holes in the BASE Surface 
and prevents it from expanding the surface outward from the 
survey area. A copy of the BASE Surface, with these gaps filled, 
is then created.
In the following example of a 3 x 3 Surface node area, five nodes 
have pixel values (shown in red). 

This means if you select five or less as the value for the Number of 
Neighbours, a pixel value is created for the node without a value 
from the neighbouring nodes. 
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When recomputing a CUBE BASE Surface all CUBE Surface 
editing, including nominations, hypothesis and node 
rejections are considered no longer valid and will thus not be 
retained after recomputation of the BASE Surface.

This node does not 
contain a pixel value.

This node contains a pixel 
value and can be used to 
interpolate a value for nodes 
without a pixel value.
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To interpolate a surface:
1. Select a BASE Surface layer in the Control window so it is highlighted.

2. Select the Interpolate command.

The Interpolate Surface dialog box is displayed.

The Destination Surface field displays the file name of the copy 
that is created from the original BASE Surface. The default 
name is the original Surface name with _Interp appended to it. 
You can change the name, if necessary.
3. [Optional] Type a new name in the Destination Surface field.

The Matrix Size determines the number of nodes closest to the 
node that can be used to interpolate a pixel value.
4. Select either the 3 x 3 or the 5 x 5 option.

The Number of Neighbours field is a threshold level used to 
determine the minimum pixels in the matrix area that must be 
present to interpolate a new pixel value. The matrix size 
determines the maximum and minimum values for the 
neighbours field. For example, if you select 3 x 3 for the matrix 
size, then the possible maximum number of neighbouring nodes 
with pixels is 9 and the minimum number is 3.
5. Type the number of neighbouring nodes used to interpolate pixels.

6. Click OK.

The interpolated Surface is created and displayed with an 
_Interp extension, in the field sheet data tree in the Layers tab. 
As you continue to re-interpolate the Surface, the effects 
accumulate to remove any remaining gaps. To interpolate again:
1. Select the interpolated Surface in the Layers tab.

2. Select the Interpolate Surface command. 

The second interpolation is applied to the selected Surface layer. 
It does not create a new surface layer. 
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Every time an interpolated Surface is re-interpolated, the 
parameters are stored. Thus, when the Recompute command 
(see “RECOMPUTE SURFACE” ON PAGE 221) is used on an interpolated 
BASE Surface, all interpolations are performed on the Surface 
layer.
An interpolated BASE Surface cannot be updated with the 
Automatic BASE Surface Update setting in the Options dialog 
box.

Finalize BASE Surface 
A finalized BASE Surface is a finished version of the surface 
that is ready for export or for further processing (for example, to 
create a Product Surface). Most importantly, finalizing a surface 
ensures that designated soundings are included in the final 
surface, to be carried through to bathymetric products.
These three operations can be applied when finalizing a BASE 
Surface:
• Minimum uncertainty: Vertical uncertainty can fall to almost 

zero if a node contains too many soundings. This function 
applies a user-defined vertical uncertainty to each node to 
compensate for this situation.

• Designated soundings: If the data set contains designated 
soundings, the Surface is regenerated and the designated 
soundings’ depth values are applied to the nearest nodes. (See 
“CRITICAL SOUNDINGS” ON PAGE 297).

• Depth thresholds: A Finalized BASE Surface can be modified 
to represent a range of depths levels in the field sheet. When 
the Finalized Surface is generated, only these depths are 
displayed. 

To create a finalized BASE Surface:
1. Select a BASE Surface layer in the Layers tab of the Control window.

2. Select the Finalize BASE Surface command.

The Finalize BASE Surface dialog box is displayed. M
en

u Process > BASE 
Surface > Finalize
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The Surface name field shows the name that will be applied to the 
finalized surface. This defaults to the name of the source BASE 
Surface with _Final appended to the end. 
To change the name: 
1. Type a different name for the finalized surface.

The Final uncertainty from drop-down list gives three options as the 
source of values for calculating the uncertainty of the finalized 
surface: 
• Uncertainty: The vertical uncertainty values from the 

Uncertainty layer of the source surface.
• Std Dev.(scaled to 95% CI): The standard deviation values 

from the source surface (scaled to 95% confidence interval).
• Greater of the two: The larger of the two above values.
2. Select a final uncertainty option from the drop-down list. (This option is 

greyed out if the source surface does not contain uncertainty values, 
for example, if it is a swath angle surface.)

3. Select the Minimum Uncertainty check box and type a depth value to 
represent the minimum vertical uncertainty value.

4. Select the Apply Designated Soundings check box to use this option.

When this option is selected, designated soundings take prece-
dence over other soundings during the soundings selection proc-
ess. 

If this option remains un-selected, designated soundings are proc-
essed no differently from other soundings. 

Using Depth Threshold values allows the finalized surface to 
contain only a specified range of depth nodes. The finalized 
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surface will be “clipped” so that the surface will only contain 
depths where the surface resolution is optimal.
5. Select the Depth Threshold check box to create a finalized Surface that 

displays only node depths between the minimum and maximum depth 
values.

6. Type the minimum and maximum depth values in their respective 
fields.

7. Click OK.

A finalized BASE Surface is generated and visible in the Display 
window. The finalized BASE Surface is listed in the Layers tab 
of the Control window.

Combine
The Combine options stitches two or more BASE Surfaces 
together to form one surface. This option is used when you have 
created finalized BASE Surfaces with different depth thresholds 
(see “FINALIZE BASE SURFACE” ON PAGE 224), or when you have two 
adjacent Surfaces with different resolutions. The geographical 
extent of the combined BASE Surface is determined by the 
geographical extent of the field sheet.

Surface A displays 
depths between 0 and 
16 m. Surface B 
displays depths greater 
than 16 m. 
The Combine function 
joins these two 
Surfaces into one 
Surface.

Surface B

Surface A
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1. Select the field sheet that contains the BASE Surfaces you want to 
combine.

2. Select the Combine command to display the Combine BASE 
Surfaces dialog box.

 

3. Select the BASE Surfaces from the file tree by two methods (you may 
have to click the expand icon to view all the available Surfaces):
• Press <Ctrl> and select individual surfaces with the mouse.
• Press <Shift> and select a range of surfaces by clicking the first and 

last surface in the range. All surfaces between the first and last 
surface are selected.

4. The Output Folder field is read-only and displays the directory path of 
the selected field sheet. The combined BASE Surface is saved to this 
folder.

5. Type a name for the combined Surface.

6. Type a resolution for the combined Surface

7. Click OK.

A new BASE Surface that combines the selected Surfaces is 
generated. The new combined surface is listed in the Layers tab. 

M
en

u Process > BASE 
Surface > Combine
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up

New > Combine 
Surfaces (Control 
window only)
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The combined BASE Surface reproduces all the attribute layers 
contained in the source Surfaces.
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Difference Surfaces
Create a surface showing the differences in attribute values 
between two BASE Surfaces. 
The Difference Surface function is useful for comparing changes 
to an area. A surveyed area can change considerably over time 
due to the redistribution of sediment with the currents. This 
redistribution can cause changes in depths. A difference surface 
can be used to find these changes by comparing two surfaces for 
the same area that were created at different times.  

To use this function, the surfaces to be compared must cover 
part or all of the same area, and the data in the attribute layers 
being compared must be of the same type. 
The data types include: 

For example, Depth layers can be compared, but you can’t 
compare a Density layer to a Depth layer, since the former 
contains Integer data and the latter is Float.
When you select a layer in the Difference Surface dialog box, its 
data type is displayed in the Data Type field.
To compare two open surfaces: 
1. Select a surface or attribute layer in the Layers tab.

2. Select the Difference Surfaces command. 

The Difference Surface dialog box is displayed.

Note: the difference surface is not part of a field sheet and is 
not saved with the project. However, it can be opened using 
the Open Background Data command.

Type Size/Format Range

Short 16-bit (2-byte), integer -32,768 to 32,767 (no decimal points)

Integer 32-bit (4-byte), integer -2,147,483,648 to 2,147,483,647 (no 
decimal point)

Float single-precision, IEEE 754 
32-bit (4-byte), floating-point

1E-44 to 3.4E+38 (positive or negative)

Double double-precision, IEEE 
64-bit (8-byte), floating-point

negative values: 
-1.79769313486231570E+308 to 
-4.94065645841246544E-324

positive values: 
4.94065645841246544E-324 to 
1.79769313486231570E+308 

M
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u Process > BASE 
Surface > Difference 
Surfaces
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Any open surfaces are listed in the Surface fields. 
3. Click the expand ( + ) icon beside a layer in the Surface 1 list to view 

the available attribute layers.

4. Select an attribute layer to use as the data source for the difference 
calculation.

The Data Type field displays the data type of the selected layer.
5. Expand the Surface 2 list and select an attribute layer with the same 

data type as the layer selected for Surface 1.

The Data Type field displays the data type of the second selected 
surface attribute.
6. Click the Browse button (...) to define the name and location for the 

new surface file, which is saved in CSAR format.

7. Click OK.

A new surface is generated, with an attribute layer named Diff 
and a Bounding Polygon layer. The resolution of the new surface 
will be the same as the resolution of the surface selected as 
Surface 1.
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An example of a Difference Surface is shown below.

The colours represent the range of discrepancies between the 
two compared surfaces. The dark areas of this surface represent 
greater depth differences than the light areas. If the contrast is 
not clear, you can reverse the colours, or change the colour map 
settings or set a colour range, in the Properties window. (See 
“COLOUR MAP EDITOR” ON PAGE 39 and “COLOUR RANGE EDITOR” ON PAGE 43 of 
the Tools guide.

Difference Surface
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Compute Surface Statistics 
The Compute Statistics command generates statistics on the 
nodes in an attribute layer of a surface, such as a BASE surface, 
mosaic or GeoBaR. 
The statistics calculated are:
• Minimum value in the attribute layer of the surface
• Maximum value in the attribute layer
• Mean of the values in the layer
• Area 
• Standard Deviation (Std_dev)
• Total count
These statistics are reported together with a histogram 
depicting the distribution of the points/nodes within the min/
max range of values.
To compute the statistics of an attribute layer:
1. Select the parent layer of the attribute layer. 

2. Select the Compute Statistics command.

The Compute Statistics dialog box is displayed.

3. Select the Attribute layer for which you want to compute statistics, for 
example, the Depth or Std_Dev layer. 

Bin Size The Bin size field defines the range of each grouping of data that 
will be displayed as a column in the histogram. Each bin or 
column will contain all the data within the range set by the bin 
size. 
The unit of measure for the Bin size field is controlled by the 
type of data in the selected attribute layer. For example, Depth, 
Standard Deviation and Mean layers are reported in the units 

M
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u Process > BASE 
Surface > Compute 
Statistics 
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up Compute Statistics 
(Layers window only)
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set for the data in Tools > Options > Display > Units. Density 
and Hypothesis Count are unitless. 
4. Enter a Bin size for the histogram.

For example, if the range of values for the Std_Dev layer is 0 to 
16, a bin size of .02 m will yield a more useful histogram than 
would 2m bin size.
5. Select a colour for the content of the columns from the Histogram 

colour drop-down list. The default colour is white (outlined in black). 

6. Click OK.

Statistics output The Compute Statistics dialog box displays the input data and 
the computed statistics as values and as a histogram.
• The Input section displays the settings that were used to 

calculate the statistics: data set, attribute layer and bin size.
• The Statistics section provides the results of the analysis of the 

data in the selected attribute layer.
• The histogram displays the distribution of the data. The X 

axis is labelled with the source layer name and unit of 
measure. The Y axis contains the count of the data points in 
each bin or column.

The histogram below displays the statistics generated for the 
standard deviation layer of a BASE surface.

The Min and Max Range values in the Properties for the 
selected attribute layer can help you set a useful bin size for 
the histogram.



234 CARIS HIPS and SIPS User Guide

Create BASE Surfaces: BASE Surface Commands

To save these statistics, export them to image or ASCII formats. 
When exporting to an image format, only the histogram is 
exported.When exporting to ASCII, the Input, Statistics and 
histogram data will all be exported. 
See “EXPORT HISTOGRAM TO IMAGE” ON PAGE 234 and “EXPORT STATISTICS TO 
ASCII” ON PAGE 237 for more information.
7. Click OK to close the dialog box when finished.

Export Histogram to Image 
Use the Image Export option in the statistics results dialog box 
to export an image of the current histogram as:
• PDF (Portable Document Format)
• PS (PostScript)
• SVG (Scalable Vector Graphics)
• TIFF (Tagged Image File Format)
To export an image of the histogram:
1. Click Image Export.

The Export dialog box is displayed. 
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Use the Export dialog box to define the settings for exporting the 
image. Click on each row to activate the options for that field. 
The example above displays the options for export to TIFF 
format.
By default, the File Name field is populated with a name 
combining the names of the surface and the attribute layer that 
was computed (<surfacename>_<layername>). You can 
change this file name. 
2. [Optional] Type a File Name for the image file. 

3. Click within the Output Directory field to enable the Browse (...) button. 

4. Click Browse and select a location for the exported file.

5. Select the Output File Format from the drop-down list.

Once you select a format, specific options for that format are 
displayed in the lower section of the dialog box. 
6. [Optional] Enter or select a value for the options as needed.

Export options:

PDF and PostScript options

Paper size Set the page size of the exported file.

Width/Height Set the width and height of the histogram in the resulting file.

Data Orientation Set the orientation of the histogram in the resulting file. 
Portrait is a vertical position; Landscape is a horizontal 
position. Landscape is selected by default.

Margins Set the width of the area between the histogram and the 
edge of the file. The default is 5mm. 
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7. Click OK.

The image file is saved to the specified location.

Image Export DPI 
(Quality)

Set the resolution used to export the histogram. The higher 
the resolution, the better the quality of the image when 
zoomed in. 

If the file will be used in the electronic form with the image 
being zoomed in tightly, a higher resolution is recommended. 
If the file will simply be printed, a smaller resolution is 
adequate.

SVG format options

Width/Height The width and height of the histogram in the resulting file.

Image Export DPI 
(Quality)

Set the resolution used to export the histogram. The higher 
the resolution, the better the quality of the image when 
zoomed in. 

If the file will be used in the electronic form with the image 
being zoomed in tightly, a higher resolution is recommended. 
If the file will simply be printed, a smaller resolution is 
adequate

TIFF format options

Image Resolution  The resolution (quality) at which to export the image. The 
higher the resolution, the closer the image can be zoomed, 
but the larger the file. 

Width/Height 
(Pixels)

Set the width and height of the resulting image in pixels. 
These fields are controlled by the resolution of the image. As 
the DPI is increased or decreased, so is the number of 
pixels. 

Image Depth Set the number of values applied to each pixel in the image 
(one value for each colour, plus one for transparency if using 
32 Bit). 

If you would like a transparency setting applied to the 
background colour, the 32 Bit (RGBA) option must be 
selected.

Background Colour The colour displayed in the background of the histogram. 
The default is black.

Background Alpha (This option is only available when the Image Depth is set to 
32 Bit RGBA).

Set the degree of transparency applied to the background 
colour. The default setting is zero transparency. 

Compression Compress the resulting image file during export to decrease 
the file size. This option is only available when using the TIFF 
format. There are various compression methods available, 
each of which performs differently. By default, LZW is used.
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Export Statistics to ASCII
Use the ASCII Export option in the Compute Statistics results 
dialog box to export all of the statistical information to an ASCII 
text file. This file will include:
• Information about the computed surface
• The resulting statistics
• The centre value of each bin and the count of data points 

within the bin.
To export to an ASCII file:
1. Click ASCII Export.

A standard Save As dialog box is displayed. By default, the File 
Name field is populated with a name combining the names of the 
surface and the attribute layer that was computed 
(<surfacename>_<layername>). 
2. [Optional] Enter a new File name. 

3. Select a location for the file and click Save.

An ASCII text file is created in the specified location.
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BASE Surface QC Report 
The BASE Surface Quality Control report lists significant data 
gaps within the surface. It also analyzes how much of your data 
conforms to the confidence levels set by the S-44 standard for the 
four orders of survey.
1. Select the BASE Surface parent layer in the Control window.

2. Select the Surface QC Report command.

The BASE Surface QC Report dialog box is displayed. 

Holiday Criteria The top section of the dialog box sets the criteria for finding 
significant data gaps (known as “holidays”). A holiday is formed 
when enough gaps are clustered together within a specified 
radius. You can create a layer that displays these holidays. This 
layer does not display every gap in the surface, but only those 
gaps that meet the criteria.
1. Type the number of nodes to use as a radius for searching for gaps in 

the Holiday Search Radius field.

2. Type the Minimum number of nodes that must contain data so that a 
data gap holiday is not formed. 
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For example, if the value is 6, then a node without data must be 
surrounded by five or less nodes with data to be included (with other 
empty nodes) in a holiday.

3. Select the Create holiday layer check box to create a layer in the 
Layers tab displaying the data gaps selected by the search criteria.

IHO S-44 Settings The lower section compares uncertainty values contained in the 
surface to the S-44 standard. These values are drawn from the 
Standard Deviation and Uncertainty layers. This comparison 
will show how many nodes in the surface fall within the S-44 
categories. 
4. Select the source of error values from the drop-down list: 

• Uncertainty layer (which contains the uncertainty “model” values 
entered when the surface was created),

• Standard Deviation (the values showing how the data varies from 
the “model”), 

• Greater of the two (uncertainty or standard deviation, whichever is 
larger value)

• Lesser of the two. 

The depth levels shown in the dialog box are the minimum and 
maximum depth levels for each survey order. You can change 
these to conform with the minimum and maximum depths in 
your surface.
5. [Optional] Type new depth levels for any of the survey orders. (You can 

have overlapping depth levels.)

6. Click Browse to select a directory path and name for the QC report. 
The path and name is shown in the Output File field.

7. Click OK.

The report is shown in the Output window, and in the Output 
file you designated. The Holiday layer is displayed in the Layers 
tab under the other layers for the surface.

For a swath angle surface, the error values come from the 
Standard Deviation layer only. (The option will be greyed out, but it 
is applied.)
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QC Report File example

Sections of a QC report 
file

The first section contains information about the report file and 
the data holiday options set in the dialog box:
• The data and time that the QC report file was created.
• The BASE Surface on which the QC report is based
• The holiday search radius.
• The minimum number of nodes required to omit a node 

(without data) from being included in a holiday.
• If a holiday layer was created or not.
• The source of error values (the layer).
The second section contains information on the number of nodes 
containing data:

BASE Surface QC Report 
Date and Time: 2/4/2010 3:39:49 PM
Surface: 
d:\CARIS\HIPS\70\Fieldsheets\FundyData\PASG1\pagstest1.csar
Holiday Search Radius: 2
Holiday Minimum Number of Nodes: 12
Holiday layer created: No
Error values from: Greater of the two

Number of nodes processed: 8859
Number of nodes populated: 8858 (99.99%)
Number of holidays detected: 0
IHO S-44 Special Order:
     Range:  0.000 to 100.000
     Number of nodes considered: 8858
     Number of nodes within: 2523 (28.48%)
     Residual mean: 0.743
S-44 Order 1a:
     Range:  0.000 to 100.000
     Number of nodes considered: 8858
     Number of nodes within: 3995 (45.10%)
     Residual mean: 0.473
S-44 Order 1b:
     Range:  0.000 to 100.000
     Number of nodes considered: 8858
     Number of nodes within: 3995 (45.10%)
     Residual mean: 0.473
S-44 Order 2:
     Range: 100.000 to 5000.000
     No depths within the specified range
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• The total number of nodes processed in the surface.
• The total number of nodes that contains data.
• Percentage of the surface that contains data.
• Number of data holidays located.
The third section contains information about each S-44 survey 
order:
• The depth range for the survey order (set in the dialog box).
• The number of nodes within that depth range with 

uncertainty values that were considered for the survey order.
• The number of nodes that fall within the depth error limits 

for that survey order.
• The residual mean is derived from the computed and reported 

uncertainty. 
If the value is negative, the uncertainty values meet the 
requirements for the selected survey order. If the value is 
positive, the uncertainty values do not meet the requirements 
for the selected survey order. Therefore, if no nodes were 
considered for the survey order, the residual mean would 
have to be above zero.
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Group multiple surfaces
Multiple BASE surfaces created in different field sheets can be 
grouped together, so that the same display properties can be 
applied consistently to all the grouped surfaces. (See “PROPERTIES 
OF BASE SURFACES” ON PAGE 204.
Grouped surfaces are listed together under a new Sources layer, 
followed by their combined attribute layers, as in the illustration 
below. 

When a surface is added to an existing group, the properties of 
the first of each type of attribute layer included in the group are 
applied to all other attribute layers of the same type. 
For example, if the Depth layer for the grouped surfaces has 
Filter values set, the Depth layer for a surface added to the 
group will display data within the filter range, regardless of its 
settings before it was added to the group. 

Sources
GROUP

BASE 
surface 
layers

Attribute 
layers



CARIS HIPS and SIPS User Guide 243

Create BASE Surfaces: Group multiple surfaces

Create a group To group multiple surfaces:
1. Right-click on a surface parent layer in the Layers tab. 

2. Select the Create New command from the Group item on the pop-up 
menu. 

The New Group dialog box is displayed. 
3. Type a name for the group layer in the Group Name field. 

4. Click OK.

The group is created in the Layers tree, and the selected surface 
is added to the group.

Add surface to group To add another surface to the group:
1. Right-click on the surface to be added.

2. Select Group from the pop-up menu.

The pop-up sub-menu will list any created and available groups.
(If a selected surface already belongs to a group, that group is 
greyed out in the pop-up menu, to prevent a surface from being 
added to a group twice.)
3. Select the group you want to add the surface to.

The surface is added to the group, under the Sources layer.

Remove a surface from 
a group

You can remove a surface from a group. It will be returned to its 
place in the field sheet (if the field sheet is open)—otherwise the 
surface is listed with other layers in the Layers tab.
To remove a surface from a group:
1. Right -click on the surface you want to remove from the group.

2. Select Group from the pop-up menu.

3. Select None from the sub-menu.

The surface is removed from the group and restored to a position 
in the Layers tab.

Ungroup To disband the group and restore the component surfaces, use 
the Ungroup command:
1. Right-click on the group layer.

2. Select Ungroup from the pop-up menu.

The group is removed from the layers tree.
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Surface Filtering
Surface filtering uses a scaled standard deviation or uncertainty 
threshold to reject soundings that fall outside that threshold. 
You can also filter sounding depth by a direct threshold amount, 
for example, 2 metres from the surface.
Soundings that fall outside the threshold are assigned a 
Rejected by Surface Filter flag and are no longer available for 
processing (unless they are given an Accepted flag again).
This can greatly reduce the number of manual edits required to 
produce a clean sounding set.
1. Select the Surface Filter command.

The Surface Filter dialog box is displayed. 

2. Select the BASE surface to be filtered from the Select Layer tree.

3. Select the Threshold Type from the drop-down list: 
• Standard Deviation 
• Uncertainty
• Greater of the two
• Lesser of the two.

M
en

u Tools > Apply Filters > 
Surface Filter
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• Static Value

4. Set the desired Threshold value. 

• For standard deviation or uncertainty thresholds, the value entered 
will show the confidence interval next to the field.

• Static values are entered in units set in Tools > Options > Display > 
Units > Vertical units, e.g., metres. 

5. Select the Include data previously rejected... check box to include 
rejected data when running the filter.

6. Select the Reject soundings check box to reject soundings that are 
offset from the surface.

7. Click OK.

Surface filtering can also be used in Subset Editor, where you 
can apply filters to a subset of a BASE surface. See “SUBSETS AND 
BASE SURFACES” ON PAGE 350. 
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CUBE Processing

A Combined Uncertainty and Bathymetry Estimator (CUBE) surface uses 
multiple hypotheses to represent potential depth variances along the sea 
floor.

In this chapter...
OVERVIEW ................................................................ 248
GENERATING CUBE SURFACES................................... 251
HYPOTHESIS EDITING.................................................. 259
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Overview
The CUBE process uses sounding propagation along with 
disambiguation to create and select hypotheses.
When soundings are propagated to a grid of estimation nodes:
• Soundings with a low vertical uncertainty are given more 

influence than soundings with high vertical uncertainty
• Soundings with a low horizontal uncertainty are given more 

influence than soundings with a high horizontal uncertainty.
• Soundings close to the node are given a greater weight than 

soundings further away from the node.
Generally, as soundings are propagated to a node, a hypothesis 
(depth value) is developed at that node. If a sounding’s value is 
not significantly different from the previous sounding then the 
same or modified hypothesis is used. If the value does change 
significantly, a new hypothesis is created. A node can contain 
more than one hypothesis.

In the above graphic, two soundings—S1 and S2—have similar 
values and therefore are part of the same hypothesis at the 
estimation node. However, sounding three (S3) has a 
significantly different value so it forms a new hypothesis.

Disambiguation The final process in CUBE is disambiguation. Disambiguation 
selects one hypothesis over others. There are four 
disambiguation options:
• Density: Select the hypothesis with the greatest number of 

sounding samples.
• Locale: Select the hypothesis that is most consistent with the 

surrounding nodes that have only one hypothesis.
• Locale and Density: Select the hypothesis the contains the 

greatest number of soundings and is also consistent with 
neighbouring nodes.

• Initialization: Select the hypothesis that is nearest to a node 
value of a previously created BASE Surface. Initialization 
differs from the other methods because it filters potential 
outlier soundings just prior to disambiguation.
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When a surface using the density and locale options is 
generated, two layers specific to the CUBE Surface are 
displayed.
• The Hypothesis Count layer is a visual representation of 

hypothesis density at a node. A Surface with a Hypotheses 
Count layer is displayed below.

• The Hypothesis Strength layer is a visual representation of 
the mathematical confidence of a chosen hypothesis. Each 
node is given a value ranging from 0.0 (high confidence) to 5.0 
(low confidence). Nodes with one hypothesis have a confidence 
value of 0.0 while nodes with multiple hypotheses will have 
confidence values greater than 0.0. A Hypothesis Strength 
layer is displayed below.

More than one hypothesis or a low confidence value does not 
necessarily mean an error. Uneven areas (slopes, for example) 
show more than one hypothesis because of the changing terrain. 
Nodes with multiple hypothesis should be examined in the 
Subset Editor. See “HYPOTHESES CLEANING” ON PAGE 266.

Areas with multiple 
hypotheses are shown 
in a brighter colour 
than areas with only 
one hypothesis.

The brightly coloured 
areas represent nodes 
with more than one 
hypothesis.
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When you select the Initialization method of disambiguation, 
two additional layers are created:
• Guide_Depth: Depths from the initialization surface.
• Guide_Uncertainty: Vertical uncertainty values from the 

initialization surface.
The User Nominated layer displays the nominated hypotheses 
that were chosen over the hypotheses selected by CUBE 
disambiguation (see “NOMINATE ALTERNATIVE HYPOTHESES” ON PAGE 263).
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Generating CUBE Surfaces
CUBE Surfaces are created using the BASE Surface wizard. All 
track lines must be merged and TPU must be computed before a 
CUBE Surface can be created.
To create a CUBE Surface:
1. Open a field sheet of the area for the Surface:

• To create a Surface for the entire field sheet area, select the field 
sheet in the Layers tab in the Control window.

• To create a Surface for a single track line, select a track line within 
the field sheet and then select the field sheet layer in the data tree.

2. Select the New Base Surface command.

The number of steps in the wizard is determined by the type of 
surface you are creating. 

BASE Surface (Step 1)
The BASE Surface Wizard (Step 1) dialog box opens.

1. Type a Name for the BASE Surface.

2. Type any necessary Comments in the text box, and click Next.

BASE Surface (Step 2)
The BASE Surface Wizard (Step 2) dialog box is displayed.
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The Resolution value(s) sets the distance(s) between BASE 
Surface nodes. You can use the same single resolution value for 
the entire surface, or use different resolutions for each range of 
depths. 
1. Select Single and enter a resolution value, or select the Multiple option 

and enter a range of values.

If you select the Single option, you can determine the range of 
depths to include in the BASE surface by using the Depth Filter 
option.
2. Select Depth Filter and enter a range of depths. 

If you select the Multiple option, the depth ranges and related 
resolution values can be saved as a template to apply when 
creating other new BASE surfaces. 
3. Enter the series of depth ranges and the desired resolution in metres, 

and click Save to save the settings as a template.

OR
4. Click Load to use a saved file. 

Values are entered in the following format: 
minimum depth - maximum depth, resolution (all in metres. For 
example, 0.0-10.0,5.0 which associates depths between zero and 
10 metres with a resolution of 5 metres
5. Select CUBE from the Surface Type list. 

6. Select the Vertical Datum, if known, from the list.
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7. Click Next. 

The content of the next dialog box is determined by the choice of 
surface type made in step 5: 
“BASE SURFACE (STEP 3) - CUBE” ON PAGE 253

BASE Surface (Step 3) - CUBE
The S-44 survey order is used to determine the area of influence 
that a sounding can apply to the nodes.
A sounding’s area of influence (the number of nodes to which a 
sounding is applied) is determined by the vertical uncertainty 
limit in the selected S-44 survey order. When a sounding’s 
vertical uncertainty increases beyond the requirement for the 
survey order then it cannot contribute to the node.
 

1. Select an IHO S-44 Order from the drop-down list.

The a (constant depth error) and b (factor of depth dependent 
errors) fields are automatically filled when a survey order is 
selected. These values are read from 
..\HIPS\System\IHO_Standards.xml.
If one or more track lines were selected before the BASE Surface 
process was started, the Use selected lines check box is enabled.
2. Clear this check box if you want to apply the BASE Surface to the 

entire field sheet area.
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Use the Ignore Lines with errors option so that the surface creation 
is not interrupted if it encounters bad data. The process will skip 
the part of the line containing bad data and continue creating 
the surface with the next line. Once the surface is complete you 
can decide whether to remove the partial line. 
3. Check Ignore Lines with errors to have bad line data omitted from the 

surface. 

4. Check Include Additional Bathymetry to include water column 
bathymetery added to project.

5. Check either Accepted, Examined or Outstanding to include data with 
these status flags in the CUBE surface. 

6. Select Shoal or Deep (or both check boxes) to include shallowest or 
deepest soundings data in the CUBE Surface

7. Click Next.

BASE Surface (Step 4) - CUBE 

1. Select a disambiguation method from the drop-down list: 
• Density
• Locale
• Density and Locale
• Initialization Surface

(These methods are described in “DISAMBIGUATION” ON PAGE 248.) 
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Default Configuration values will be applied unless you select 
otherwise. To apply other configuration options, click the […] 
Browse button to open the Advanced configuration settings. (See 
“ADVANCED OPTIONS FOR CUBE SURFACE” ON PAGE 255.) 
If you selected Initialization as the method for disambiguation, the 
Initialization Surface check box is automatically selected, so you can 
set values for the filtering tests. 
2. Type the path and name of an existing BASE Surface, or click Select 

and browse to the BASE Surface.

If you have selected a disambiguation method based on density 
or locale, the Initialization Surface tests can be used as an optional 
filtering method. 
Initialization Surface filtering uses the depth and vertical 
uncertainty values in an existing BASE Surface (the 
Initialization Surface) to exclude potential outliers from the new 
surface. There are three filtering tests:
• Minimum Difference is a set distance from an existing BASE 

Surface node. For example, if the Minimum Distance is set at 10 
metres, all soundings that are not within 10 metres of the 
node are excluded when a new Surface is generated.

• Filter Percentage is a percentage of depth at a node. For 
example, if the depth at a node is 20 metres and the 
percentage value is 0.25, all soundings that are more than 5 
metres from the node (20x0.25) are excluded from the new 
Surface.

• Variance Scaler is a multiplier of vertical uncertainty at a node. 
For example, if the scaler is set to three and depth 
uncertainty for a node is one metre then soundings more than 
three metres (1x3) from the node are excluded from the 
processing of the new BASE Surface.

The shoalest values from the three tests are then used as the 
threshold to filter outlier soundings.
3. [Optional] Changes the default values set for the filtering tests.

4. Click Finish.

A CUBE Surface is shown in the Display window and the layers 
associated with the Surface are listed in the Control window. See 
“VIEW BASE SURFACES” ON PAGE 203 for more information on display 
options.

Advanced Options for CUBE surface 
The Advanced Options dialog box displays the detailed 
configuration settings applied to the CUBE surface. These 
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settings are contained in the CUBEparams.xml file, found in the 
installed Template folder. 
You can use the settings in this file or select a custom 
configuration file. If you use a custom file, make sure that you 
use the same syntax and structure as the CUBEparams.xml file.
 

1. [Optional] Click Browse to select another configuration file. The file 
path is displayed in the Template File field.

2. Select a configuration file from the Configuration drop-down list: 
Default, Deep or Shallow. 

You can adjust the configuration settings can in these files, but 
you must save changes before they can be applied. If you do not 
want to overwrite the CUBEparams.xml file, select New and 
create a new template file. 

• Deep: This configuration is intended to be used in areas where 
small features are not likely (shifting sand shoals), not important 
(steep grades and deep water), or separately located with sidescan.   
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This parameter set corresponds with NOAA's 2006 Complete 
gridding standard.

• Shallow: This file defines the parameters for the CUBE algorithm 
and are intended to be used in areas of critical underkeel clearance, 
in areas with numerous small features, and multibeam that can 
stand on its own without feature-by-feature sidescan correlation. 
This parameter set corresponds to NOAA's 2006 Object Detection 
gridding requirements. 

• New: select “New” to save any changes to the default settings, or to 
create a new configuration. Otherwise the changes will be saved to 
the CUBEparams.xml file. 

3. If you select “New”, the New CUBE Configuration dialog box is 
displayed.

 

4. [Optional] Type the name for the new configuration setting and click 
OK.

5. [Optional] Type any additional information in the Comments field.

6. The default values in the following fields can be adjusted, as needed. 
You will be prompted to save your changes before the configuration 
can be applied. Estimate Offset: The threshold for significant offset 
from current estimate to warrant an the creation of a new hypothesis. 
The value must be between 0.1 and 10.0.
• Capture Distance Scale: Scale on predicted or estimated depth for 

how far out to accept data. Value is a percentage of depth used to 
limit the radius of influence a sounding may have on the grid. Value 
must be between 1.00 and 100.00.

• Capture Distance Minimum: The minimum value (in metres) on 
predicted or estimated depth for how far out to accept data. This 
value is used in conjunction with Capture Distance Scale to limit the 
radius or influence of a sounding. Value must be between 0.0 and 
100.00.

• Horizontal Error Scalar: The value used to scale the horizontal error 
of each sounding when used in the radius of influence computation. 
Value must be between 0.0 and 10.00.

• Density Strength Limit: The strength value used to switch from the 
'density' disambiguation method to the 'locale' version when using 
the density & locale algorithm. Value must be between 0.00 and 
5.00.

• Locale Strength Maximum: The maximum strength value allowed as 
part of the mean in the locale algorithm. Value must be between 
0.00 and 5.00.
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• Locale Search Radius: The radius of the search when computing 
the trimmed mean. The values are in pixels and must be greater 
than zero. The original system default value is 1.

• Null Hypothesis Test: Flag used to control the application of the 
NULL hypothesis test. Value must be either True or False. Default 
value is False. 

• Minimum Number of Neighbours: During the Null Hypothesis test, 
this controls the minimum number of neighbours that a node must 
have in order to be considered for the Standard Deviating Ratio test. 
If the node has less the specified number, it is automatically marked 
as 'Null'. Values must be between 2 and 8.

• Standard Deviation Ratio: During the Null Hypothesis test, this 
represents the cut-off limit for the standard devotion ratio including 
the node in question to the standard deviation of the qualified 
neighbouring nodes. If the computed ratio exceeds the specified 
value, the node is marked as 'Null'. Values must be between 0.0 and 
10.0.

• Neighbour Strength Maximum: The maximum strength value that is 
allowed to be considered as part of the standard deviation 
computations in the NULL hypothesis test. Value must be between 
0.00 and 5.00.

7. Click OK to save and apply settings.
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Hypothesis Editing
CUBE surfaces can be displayed in the Subset Editor for 
examination and editing, using an iterative process to choose 
which of multiple hypotheses of depth values are the best ones to 
represent the sea floor.
When a CUBE surface is created, soundings are weighted and 
contribute to surface grid nodes based on TPU values and 
distance from the nodes. The CUBE surface allows for multiple 
depth estimates or hypotheses to exist at a single grid node, 
depending on the variation of the sounding data. CUBE then 
uses “Disambiguation” to determine which hypothesis at each 
node is the most “correct”.
You can verify and, if necessary, override, a CUBE decision in 
Subset Editor, by nominating an alternative hypothesis as the 
depth. Once these kinds of changes have been made to the 
CUBE surface, the surface is updated. 
A surface filter can then be applied to the data. Any sounding 
data that is not in agreement with the selected hypotheses will 
be flagged as rejected. By applying this surface filtering, the 
number of manual edits required by the hydrographer to 
produce a clean sounding data set is greatly reduced. 

To examine an open CUBE Surface in Subset Editor:
1. Select the Subset Editor command.

2. Define the subset with a bounding box.

3. Load the subset.

Data contained within the bounding box is loaded into the 3D 
Subset view.
4. In the Subset Editor tab, select the CUBE Hypothesis layer.

When following a CUBE workflow, this hypothesis editing 
process is performed instead of other filtering such as Swath 
or Subset Editor filters.

M
en

u

Tools > Subset Editor

To
ol
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up Tools > Subset Editor
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5. Expand the Select Surface data tree and select a BASE Surface 
containing CUBE data.

6. Click Load to view the CUBE surface.

7. To return to the normal display in the 3D and 2D Views, click Unload.

The display options for the hypotheses are listed at the bottom of 
the Subset Editor tab. 
“WIRE FRAME HYPOTHESES” ON PAGE 261

“FIXED SIZE HYPOTHESES” ON PAGE 262

“NOMINATE ALTERNATIVE HYPOTHESES” ON PAGE 263

“SHOW ONLY SELECTED ALTERNATIVES” ON PAGE 264

“SHOW ONLY HYPOTHESES WITH ALTERNATIVES” ON PAGE 264

8. View and edit the hypotheses. See “HYPOTHESES CLEANING” ON PAGE 266

9. Update the surface. See “UPDATING A CUBE SURFACE” ON PAGE 267
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Hypotheses views
Below is an example of an enlarged section of a CUBE surface 
loaded in the 3D View.

Hypotheses are represented as squares. The squares have 
different dimensions to reflect the confidence level given to each 
hypothesis. These confidence levels range from 0.0 (the highest 
value) to 5.0 (the lowest value). The size of a square is related to 
the numerical confidence level: large squares represent nodes 
with the high confidence values while smaller squares represent 
nodes with low confidence values.
The thickness of the square represents the vertical uncertainty 
assigned a node (to a 95% confidence interval). The thicker the 
square, the greater the vertical uncertainty.
More than one hypothesis or a low confidence value does not 
necessarily mean an error. Uneven areas (slopes, for example) 
show more than one hypothesis because of the changing terrain. 

Wire frame Hypotheses
Hypothesis squares can also be displayed without a fill so that 
they are transparent except for the outlines of the squares.
1. Select the Wireframe Hypotheses check box.

The 3-D View is refreshed to display the squares without fill, as 
illustrated below.
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Fixed Size Hypotheses
The Fixed Size Hypotheses option flattens the hypotheses squares 
and redraws them to a standard size. This option is useful if you 
want to examine the dataset for holes or to see the exact position 
of a square in the subset.
1. Select the Fixed Size Hypotheses check box.

The 3-D View is refreshed to display the squares as flattened 
and in a standard size.
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Nominate Alternative Hypotheses
Some nodes have alternative hypotheses that were not selected 
during disambiguation You can view alternative hypotheses and 
compare them against the selected ones. If needed, the 
alternative hypotheses can be nominated to replace the 
established hypotheses.
“SHOW ALTERNATIVE HYPOTHESES” ON PAGE 263

“SHOW ONLY SELECTED ALTERNATIVES” ON PAGE 264

“SHOW ONLY HYPOTHESES WITH ALTERNATIVES” ON PAGE 264

Show alternative 
hypotheses

1. Select the Show Alternative Hypotheses check box and click Apply.

The 3-D and 2-D Views are refreshed to highlight the alternative 
hypotheses. The following image shows a 3-D View with the 
alternative hypotheses displayed in red.

The red squares represent hypotheses that were not selected 
during disambiguation. The vertical lines that run between the 
nodes are viewing aids to match these alternative hypotheses to 
the ones selected by CUBE. 
1. To replace an hypothesis, select an alternative hypothesis in the 2D or 

3D window.

The Nominate and Clear commands are now active.
2. Select the Nominate command.

The alternative hypothesis is now highlighted in blue. This 
means that the nominated hypothesis has replaced the 
established one. 

M
en

u Tools > Subset Editor 
> Nominate

To
ol
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All nominated hypotheses are given the highest confidence value 
of 0.0.)

Show only Selected 
Alternatives

To compare nominated nodes against the existing nodes, 
3. Clear the Show Alternative Hypotheses check box 

4. Select the Show Only Selected Alternatives check box.

The 2D and 3D Views are refreshed to show only the nominated 
and established hypotheses. The following image shows the 3-D 
View with only nominated and established hypotheses 
displayed. 
 

Show Only Hypotheses 
with Alternatives

Some hypotheses will not have alternatives. To view only those 
hypotheses selected by CUBE that do have alternative 
hypotheses:
5. Select the Show Only Hypotheses with Alternatives check box.

The Views are refreshed to show only the hypotheses for which 
there are alternative hypotheses, as illustrated below.
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When you have finished nominating alternative hypotheses to 
replace the hypotheses selected by CUBE disambiguation, the 
User Nominated layer will display these nominated hypotheses.
6. Select the Save command to save your data.

7. To remove the nomination flag, select the Clear command.M
en

u Tools > Subset Editor 
> Clear

To
ol
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Hypotheses Cleaning
Like soundings in Swath and Subset Editor, hypotheses can be 
given a rejected flag. When a hypothesis is rejected, it is retained 
in the Surface but is excluded from processing when 
disambiguation is run again or when filtering is applied.

Reject 1. Select a hypothesis.

2. Select the Reject command.

The hypothesis is now flagged as rejected.
To change rejected back to the accepted status (and therefore 
available for further processing).

Accept 1. Select a hypothesis.

2. Select the Accept command.

The hypothesis is now flagged as accepted and is available for 
further processing.

Reject Node To reject all hypotheses at a node:
1. Select a hypothesis.

2. Select the Reject Node command.

All hypotheses associated with the node are rejected.

Accept Node To return hypotheses associated with a node to their normal 
status.
1. Select a hypothesis.

2. Select the Accept command.

All hypotheses associated with the node are flagged as accepted.

M
en

u Tools > Subset Editor 
> Reject

To
ol

M
en

u Tools > Subset Editor 
> Accept

To
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u Tools > Subset Editor 
> Reject Node
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> Accept
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Updating a CUBE Surface
If changes are made to the data contributing to the surface, the 
CUBE Surface can be rebuilt to show these changes using the 
following methods:
• Select the Recompute BASE Surface command . (See 

“RECOMPUTE SURFACE” ON PAGE 221). 

• Select the Automatic BASE Surface Update check box in Tools> 
Options > General. After edits are made, this will 
automatically update the area of the CUBE surface contained 
within the subset bounding box. (See GENERAL for more 
information).

M
en

u Process > BASE 
Surface > Recompute

To
ol When recomputing a CUBE BASE Surface, all CUBE BASE 

Surface editing, including nominations, hypothesis and node 
rejections are considered no longer valid and will not be 
retained after recomputation of the BASE Surface.

When using the Automatic BASE Surface Update option, all 
CUBE BASE Surface editing, including nominations, 
hypothesis and node rejections could be retained if no 
soundings were rejected in the proximity of the nodes. 

If soundings have been rejected after CUBE BASE Surface 
editing, these editing adjustments will be lost.
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Data QC

Use the BASE surface to highlight problems with sensor data that may 
exist, and if necessary, edit problem areas. 

In this chapter...
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QUERY DATA ............................................................ 273
REJECTING AND ACCEPTING DATA ................................ 277
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Workflow
Problems with sensor offsets, auxiliary sensor data, and so forth, 
become readily apparent in the BASE Surface. Relying on a 
surface to highlight problems in the auxiliary sensors can 
improve processing efficiency, because you are no longer 
required to investigate the motion and navigation for each 
survey line.
In the HIPS multibeam workflow described here, the auxiliary 
sensor data was not investigated prior to creating the surface. So 
at this point, you can use the BASE or CUBE surface to 
highlight problem areas that may exist.
Certain edits will require that data be Merged again. For 
example, if you reload tide, edit navigation, or edit gyro, you will 
need to Merge the modified lines again. 
If you edit heave, pitch or roll, you will need to re-apply Sound 
Velocity Correction. If you re-apply SVC, recompute TPU before 
Merging again.
If any project lines are re-Merged, the BASE surface will need to 
be re-generated. See “RECOMPUTE SURFACE” ON PAGE 221.

After data QC, the following processes can be applied to further 
clean data:
• statistical surface cleaning (see “CREATING TILES AND CLEANING DATA” 

ON PAGE 314)
• “SUBSET CLEANING” ON PAGE 339
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• “SWATH CLEANING” ON PAGE 324

• filters 
• “PROTECT CRITICAL SOUNDINGS” ON PAGE 304, 
• “ATTITUDE FILTER” ON PAGE 286, 
• “TPU FILTERING” ON PAGE 159, 
• “SINGLE BEAM FILTERING” ON PAGE 105.
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Tools for examining and editing data
There are a number of tools available to assist examining 
soundings, and in tracking the progress of data cleaning. For 
example, you can: 
• examine information about one or more selected track lines 

(“QUERY DATA” ON PAGE 273). 
• set a flag to indicate the type of survey line (“CLASSIFY LINES” ON 

PAGE 293).
• reject an entire track line to remove it from processing (“REJECT 

LINE” ON PAGE 294)
• show selected types of rejected soundings (“VIEW REJECTED 

SOUNDINGS” ON PAGE 295)
• preserve and highlight shallowest soundings (“CRITICAL 

SOUNDINGS” ON PAGE 297)
• easily view Designated, Examined and Outstanding 

soundings when working with a large data set (“CRITICAL 
SOUNDINGS” ON PAGE 297)

• reverse previous depth cleaning by re-setting status flags 
from “Rejected” to “Accepted” (“RESTART CLEANING” ON PAGE 305)
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Query Data
Line information, such as project and date of survey, and status 
of corrections such as SVC and Merge, can be viewed in the 
Selection tab and the Detailed Line Query window. 
This line profile information is displayed in columns. The 
columns which are displayed, and the order in which they are 
displayed, is controlled by a pop-up menu. (See “COLUMN SETTINGS” 
ON PAGE 20 of the Reference guide for details on adjusting the 
columns displayed.) 
Similar information for data in HIPS editors can be viewed when 
selected and queried using the Query or Query Line command.
Queried data can be saved to a text file from the display, or a 
line report can be generated using the Process > Line Report 
command.
“VIEW LINE DATA” ON PAGE 273

“QUERY LINE DATA” ON PAGE 275

“QUERY DATA IN EDITORS” ON PAGE 274

“LINE REPORT” ON PAGE 275

View Line Data
To view data profiles for one or more track lines selected in the 
Display window:
1. Select a track line in the Display window or in the Project tab of the 

Control window. 

2. Open the Selection tab in the Worksheet window.

The Selection tab automatically displays the data profile for 
each selected line. As well as Project, Vessel, Day and Line 
identification, the profile data displayed can include this 
information: 

•

The information is read-only and cannot be modified.
3. [Optional] Select Save As from the right-click menu to save the line 

data to a text file.

• Min Time • Max Time • Total Time • Merged • Outdated

• Speed • Line 
Reject

• Line Class • Heading • Length

• SR 
Corrected

• GPS Tide • Tide Loaded • Raw Range • SVP 
Corrected

• TPU 
Computed

• Nav 
Examined

• Del Dft 
Loaded

• Tide Applied • Locked
•
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(See “COLUMN SETTINGS” ON PAGE 20 of the Reference guide for details 
on selecting and adjusting the columns displayed.)

Detailed Line Query
In addition to the line data displayed in the Selection tab, a 
Detailed Line Query can display an additional 30 columns of line 
data in the Detailed Line Query window. 
To view this detailed line information:
1. Select a line or lines in the Display window.

2. Select the Detailed Line Query command.

The Detailed Line Query window opens. If you are processing a 
large number of lines, a progress bar will display in the left side 
of the Status bar. 
You can cancel loading of the selected lines into the Line Query 
window:
3. Select Cancel on the Processing dialog box. 

To query another line or lines: 
4. Select the lines.

5. Select the Detailed Line Query command again.

The display in the Query window will be refreshed to show your 
new selection.
As with the Selection tab, the Detailed Line Query window will 
display the line information in a table. These read-only records 
can be sorted by column by clicking on a column header.
Which data is visible and in what order it is displayed is 
controlled using the Column Settings dialog box, opened from 
the right-click menu. (See "COLUMN SETTINGS".) Changes made to the 
column selection and order are retained until you change them. 
This detailed information can be saved to a text file. 
6. [Optional] Select Save As from the right-click menu to save the line 

data to a text file.

You can also save a customized selection of the data using the 
“LINE REPORT” ON PAGE 275.

Query Data in Editors
Use the Query function to examine data selected in any HIPS 
and SIPS interactive editor. For example, position data selected 
in Navigation Editor, or pings selected in Side Scan Editor. 
1. Select the data so it is highlighted in one of the editor windows.

M
en

u Process > Detailed 
Line Query
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2. Select a Query command.

The selected records are displayed in the Selection tab. For 
example, in Navigation Editor, this data is displayed for each 
numbered record:

This data is read-only. However, individual records can be 
rejected or accepted using the pop-up menu in the Selection tab. 
(See “COLUMN SETTINGS” ON PAGE 20 of the Reference guide for details 
on selecting and adjusting the columns displayed.

Query Line Data To view records for entire lines in a HIPS and SIPS Editor, use 
the Query Line command.
1. Select data in any editor window.

2. Select a Query Line Command.

The records for the entire line are displayed in the Selection tab, 
in the same tabular format as the Query function provides. This 
data can be rejected or accepted from the pop-up menu in the 
Selection tab.

Line Report
Use the Line Report command to save line profiles directly to a 
text file. 
The saved report will contain a table of values under the same 
column headings that can be viewed in the Detailed Line Query 
window.
As well as the detailed line data, the report also shows the totals 
of the values for these specific columns:  

The text file can be opened in a text editor, but column data can be 
best viewed in a spreadsheet. 

To create a line report:
1. Select a line in the Display window.

2. Select the Line Report command.

The Choose Details dialog box is displayed.
 

M
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Edit > Query
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• Time • d-Time • Lat (DMS) • Lon (DMS)

• Distance (m) • d-Distance (m) • Speed (m/s) • d-Speed (m/s)

• CMG • d-CMG • Status

M
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u

Edit > Query Line
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up Query Line

• Total Time • Length • Total Nav

• Accept Nav • Reject Nav • Total Depth

• Accept Depth •  Reject Depth

M
en

u Process > Line 
Report
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3. Select a Delimiter to use to indicate the separate columns. The default is 
Tab.

4. Select Include column totals to have this information included in the text 
file.

5. From the Details list select the column headings to include in the text 
file.

6. Click Move Up and Move Down to change the order of the columns. 

7. Click OK.

8. In the Save As dialog box, set a name and destination folder for the text 
file.

9. Click Save. 

Your selection of Details and the order of the columns, are 
retained for the next time you use Line Report.
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Rejecting and Accepting Data
Data can be rejected or accepted in HIPS and SIPS Editors. All 
data is marked as “Accepted” until flagged otherwise.

Reject Data 1. Select and highlight the data in the View window of the editor.

2. Select a Reject command (Reject with Interpolation or Reject_ Break 
Interpolation). 

The selected data is now flagged as rejected.

Accept Data Use this command to revert the status of rejected data back to 
“Accepted”.
1. Select the data so it is highlighted.

2. Select the Accept command.

The previously rejected data is now flagged as Accepted. 

M
en

u

Edit > Status Flag > 
Reject-With 
Interpolation/Reject-
Break Interpolation

To
ol
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Reject > Reject-With 
Interpolation/Reject-
Break Interpolation
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u Edit > Status Flag > 
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Examine Navigation Data
Navigation outliers can affect the final positions of soundings 
during the Merge process. Therefore, the navigation data should 
(but is not required to be) be examined and cleaned for outliers. 
In Navigation Editor you can examine track lines to accept or 
reject, and query data, as necessary. 
There are two methods for locating navigation outliers:
• Examine the track lines and time graphs that show the 

computed speed, distance, and course made good between 
navigation points.

• Find speed and time jumps using the search functions in the 
Navigation Editor tab in the Control window. (See “NAVIGATION 
EDITOR TAB” ON PAGE 46.)

To edit lines in Navigation Editor:
1. Select a track line in the Display window. 

2. Select the Navigation Editor command.

Navigation Editor time graphs open in the HIPS and SIPS 
interface and display relevant speed, distance, and course-made-
good data for the selected line.

M
en

u Tools > Navigation 
Editor

To
ol
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3. Select data in either the Display window or the time graphs by pressing 
and holding the mouse button while dragging the cursor across the 
data.

The selected data is highlighted.
4. Release the mouse button when finished.

5. You can now select a Reject option (see “REJECT DATA” ON PAGE 277) or 
Accept (see “ACCEPT DATA” ON PAGE 277) or Query the selected data 
(see“QUERY DATA IN EDITORS” ON PAGE 274).

You can also use the Spike Detection options in the Navigation 
editor tab:
“SPEED JUMP” ON PAGE 279

“TIME JUMP” ON PAGE 279

Speed Jump
The Speed Jump option searches the track line for changes in 
vessel speed that are same as, or greater than, the Speed Jump 
value.
1. Select the Automatic Query check box if you want to display the selected 

position fixes in the Selection tab of the Worksheet window.

2. Enter a value in the Speed Jump check box.

3. Click the List Buffer up or down arrow keys to select the number of 
adjacent position fixes that are highlighted when a jump is found. For 
example if you choose 5, the two position fixes to the right and left of 
the selected fix are also selected.

4. Click Find.

5. Select Accept (“ACCEPT DATA” ON PAGE 277), one of the Reject options 
“REJECT DATA” ON PAGE 277) or Query (see“QUERY DATA IN EDITORS” ON 
PAGE 274).

6. Click Find again to move along the track line.

Time Jump
The Time Jump option searches the track line for changes in 
time (in seconds) that are the same as, or greater than, the Time 
Jump value.
1. Ensure that the Control window is open and the Navigation Editor tab is 

displayed. 

2. Select the Automatic Query check box if you want to display selected 
position fixes in the Selection tab of the Worksheet window.

3. Enter a value in the Time Jump box.
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4. Click the List Buffer up or down arrow keys to select the number of 
adjacent position fixes that are highlighted when a jump is found. For 
example if you choose 5, the two position fixes to the right and left of 
the selected fix are also selected.

5. Click Find.

6. Select one of the Reject options (“REJECT DATA” ON PAGE 277) or Accept 
(“ACCEPT DATA” ON PAGE 277) or Query (see“QUERY DATA IN EDITORS” ON 
PAGE 274).

7. Click Find again to move along the track line.
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Rejecting Navigation Data
All data is marked as Accepted until flagged otherwise. Data can 
be queried for position fixes, and rejected.
Data can be rejected using either 
• Reject - With Interpolation: Soundings associated with this 

navigation data are processed further since they have 
positions interpolated for them.

• Reject - Break Interpolation: Soundings associated with this 
navigation data are flagged as rejected and cannot be 
processed.

These alternatives are illustrated below.

Line Interpolation
Position observations do not usually occur at exactly the same 
instant as a depth observation (ping). Thus it is unlikely that 
there is position data for every ping.
For example, positions observations may be taken every second, 
(1 Hz frequency), while pings may be observed 10 times a second 
(10 Hz frequency). So, in most cases it will be necessary to 
interpolate positions to match the time for each ping. 
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You use either linear or Bezier method of interpolation.
• Linear: Calculate new positions by connecting consecutive 

positions using straight lines. This is the default method.
• Bezier: Calculate new positions by connecting points using a 

Bezier curve that does not necessarily connect all navigation 
positions. Bezier curves are available in three types: tight, 
medium and loose.

Linear interpolation is suitable if the original navigation 
positions are clean and do not significantly deviate from 
neighbouring positions. Bezier interpolation is suitable if the 
original data is noisy.
 

In the Navigation Editor the interpolation method is set in the 
Interpolation method section of the Navigation Editor tab.
1. Select the Navigation Editor tab in the Control window.

2. Select either Linear or Bezier Curve by selecting the appropriate check 
box.

3. If the Bezier Curve option is enabled, select either a Loose, Medium or 
Tight format from the drop-down menu.

Linear Interpolation.

Bezier Interpolation: 
Loose

Bezier Interpolation: 
Tight

Bezier Interpolation: 
Medium
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To set an interpolation option for one or more survey lines 
without opening the Navigation Editor: 
1. Select a line.

2. Select the Set Interpolation command from the Tools menu.

The Set Interpolation dialog box is displayed.

3. Select an interpolation option: Linear or Bezier Curve

4. Click OK.

M
en

u Tools > Set 
Interpolation
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Shift Navigation Data
Use this to apply a shift in latitude and longitude to an entire 
survey. Latitude and longitude can be shifted independently to a 
maximum of 1 minute (0.016667 in decimal degrees and 1800 
metres).
After data is shifted this way, Merge must be applied.
To shift survey data to a new position:
1. Select one or more lines.

2. Select the Shift Navigation command.

The Shift Navigation dialog box is displayed.

3. Select either Ground or Geographic units.

4. Type the amount of shift in one or both of the Offset fields. (Offset value 
can be positive or negative.) 

5. Click Process.

6. [Optional] Click Cancel to cancel the process, and click Yes to confirm 
the cancel.

M
en

u Tools > Shift 
Navigation 
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Attitude data 
You can examine and clean the motion data of the vessel or 
towed transducer using the Attitude Editor, within the HIPS 
and SIPS interface. (See also “ATTITUDE EDITOR INTERFACE” ON PAGE 10.)
To open the Attitude Editor:
1. Select a track line so it is highlighted.

2. Select the Attitude Editor command.

The Attitude Editor is displayed, showing graphs for Gyro, Pitch 
and Roll (in degrees) and Heave (in metres) for the selected line.
• Gyro data is displayed as a positive value when a clockwise 

rotation is experienced.
• Pitch data is displayed as positive when the vessels bow is 

down.
• Roll data in is displayed as positive when the vessels 

starboard side is up.
• Heave data is displayed as a positive value when the vessel is 

heaved upwards.
Other sensors can be added by selecting them from the Available 
Sensors list on the Sensor Layout dialog box. 
1. Select the Sensor Layout command. 

Query data
Use the Query command to display information about selected 
data. 
1. Select the data to be queried.

2. Select the Query command.

The following data is displayed in the Selection tab:
• time stamp
• d-time difference in seconds from last time stamp
• sensor value in either degrees or metres/feet
• d-value difference from last value
• status
You can change the data status flag to rejected or accepted.

M
en

u

Tools > Attitude Editor

To
ol

M
en

u Tools > Sensor 
Layout

Use the space bar to move forward along a track line 
and <CTRL> + <SPACEBAR> to move back.
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Edit > Query
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1. Select the data in the Selection tab so it is highlighted.

2. Select a Reject or Accept command.

The data is marked as accepted or rejected, depending to the 
option you selected.

Filter Attitude Data
Attitude Editor is displayed within the HIPS and SIPS interface. 
To open the Editor:
1. Select a track line so it is highlighted.

2. Select the Attitude Editor command.

The Attitude Editor is displayed. (See “ATTITUDE EDITOR INTERFACE” ON 
PAGE 10.) 

Attitude Filter
You can reject data with residual values that fall outside user-
defined threshold limits, and apply these changes to attitude 
data across entire track line(s). 
The Attitude filter can be used to:
• Smooth data: The Smooth function is used to even out 

localized variability. The parameters for creating the 
smoothed data are saved to the SmoothedCoefficients file in 
the HCDS_Data\Project\Vessel\Day\Line folder. 
This file can be applied to the track line during any process 
that supports smoothing. 

• Filter data: The Filter function is used to reject attitude that 
falls outside of defined boundaries. Soundings with the same 
time stamp as the rejected data are also flagged as rejected. 
You can choose to use interpolation when rejecting data.

(These filter and smooth functions are also available in the 
Attitude Editor.)
To set filtering options for attitude:
1. Select a track line. 

2. Select the Set Filters command.

The Set Filters dialog box is displayed.

M
en

u

Tools > Attitude Editor

To
ol
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u

Tools > Set Filters

To
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3. Select a sensor from the list.

4. Select the Filter check box.

By default, the filter is set to “Reject with interpolation” so that 
soundings with the same time stamp as the rejected data are not 
also flagged as rejected. 
5. Clear the Reject with Interpolation check box if you want soundings 

associated with the rejected sensor data to also be rejected.

There are two filtering options: Moving Average and Fast 
Fourier. 
• The Moving Average calculates a mean for each data point, by 

calculating an average sensor value over a window of data 
using the Box Size parameter. The window is defined as a 
number of data points or seconds centred on a point. The 
average value for all of the values in the window is calculated 
and will be given to the central point. 

• Fast Fourier applies a common wave-smoothing algorithm to a 
data point. The Fast Fourier transformation performs a low-
pass filter on the selected sensor. You select a Box Size in 
either points or seconds.This value is converted into seconds 
and then inverted to become the cut-off frequency.

6. Select either the Moving Average or Fast Fourier filtering option.
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7. Select the Box Size parameter by clicking the up or down arrow 
buttons. When using the Moving Average, the Box Size determines the 
size of the window for averaging the data point. When using the Fast 
Fourier, the Box Size determines the cut-off frequency that is applied to 
all data.

8. Determine if the Box Size is in (data) points or time, by selecting the 
Points or Seconds option.

9. Click the Box Size up or down arrow buttons to select the number of 
adjacent data points.

10.Click the Threshold up or down arrow keys until you reach a desired 
value. Threshold is a multiple of the standard deviation (sigma).

11.Click Save As to save the filter settings to a HIPS filter file.

To use the filter: 
12.Select an Apply Filter command from the Tools menu.

The corresponding attitude data is rejected.
For other automated filters, see “AUTOMATIC FILTERING” ON PAGE 325, 
“TPU FILTERING” ON PAGE 159, “SINGLE BEAM FILTERING” ON PAGE 105, and 
“PROTECT CRITICAL SOUNDINGS” ON PAGE 304.) 
See also “FILTER AND SMOOTH” ON PAGE 16. 

M
en

u Tools > Apply Filters > 
1 Screen/To End of 
Line/Selected Lines

To
ol   
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Delayed Heave 
Real-time heave values are stored in HIPS during the conversion 
process. Some systems also provide post-processed heave data, 
which must be separately loaded to the track line using the Load 
Delayed Heave function. If the data is not stored in a supported 
format, the Generic Data Parser may be used to import post-
processed heave data stored in an ASCII format.
HIPS currently supports these delayed heave formats: 
TrueHeave® and PFreeHeave®.
To load delayed heave data:
1. Select a track line.

2. Select the Load Delayed Heave command.

The Load Delayed Heave dialog box is displayed.

3. Click Add and select the Delayed Heave file. (The location of delayed 
Heave files can be set from the Directories tab of the Tools > Options 
dialog box.)

The file name is displayed in the dialog box.
4. To remove a file, select it and click Remove.

Options 5. Select the Apply Time Offset if the time stamps in the delayed heave files 
do not match the time stamps for the rest of the project.

M
en

u Process > Load 
Delayed Heave

To
ol



290 CARIS HIPS and SIPS User Guide

Data QC: Delayed Heave

6. Type the offset value (in seconds) that will synchronize the time stamps 
in the delayed heave files with the project time stamps.

7. Clear the Default check box and click Select Day to override the year/
Julian date with a calendar date. If Default is checked, the function will 
proceed as if the delayed heave file originates in the same GPS 
reference week as each of the HIPS data lines. 

8. To apply the delayed heave data to the track line, click Load. 

See also “LOAD ERROR DATA” ON PAGE 163.
See also “COMPUTE TPU” ON PAGE 156.

NOTE: if True Heave RMS data has been loaded for a line, it will 
override Down/Heave RMS data loaded by the Load Error Data 
process when Compute TPU is run. 
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Load Attitude/Navigation Data
Load attitude and navigation data from Applanix POS MV or 
POSProc files to selected track lines. (Applanix POS MV files 
and Applanix POSProc files contain real-time attitude, 
navigation and RMS error values recorded during survey.)
1. Select one or more track lines.

2. Select the Load Attitude/Navigation command.

The Load Navigation/Attitude Data dialog box is displayed.

3. Click Add to select the files by browsing to their location.
• You can load either POS MV files OR load POSProc files, but not 

both at the same time.

4. To remove a file from the File List, select the file and click Remove. 

Reference Week You can specify a specific calendar date to override the year and 
Julian date that forms part of the SBET file name. This can also 
be used to accommodate a GPS week roll-over event. (The 
rollover cannot span more than 7 days.)

M
en

u

Process > Load 
Attitude/Navigation 
Data
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5. Clear the Default check box and click Select Day to override the year/
Julian date with a calendar date. 

Import Data 6. Click the appropriate check boxes to choose which records you want to 
import into the track line(s) from the attitude/navigation files.

7. To reduce the volume of large attitude records to a manageable level, 
enter an output interval (in seconds).

Options 8. The Load data for lines that are partially covered option will load the 
navigation data even if the data does not cover the entire line.

9. Select the Allow gap between data records check box to limit the interval 
allowed between consecutive data records in the file. If an interval 
exceeds the amount specified in the Maximum field, the data will not be 
loaded and the process will stop.

10.If the time stamp in the file does not match the time stamps in the 
project, you can select the Apply Time Offset option and type a time 
value (in seconds).

11.To set a time buffer to extend the loading of navigation /attitude beyond 
the time extent of the line’s observed depths data, select the Apply Time 
Buffer check box and type the value of the buffer in seconds.

12.Click Load.

Use the Detailed Line Query function to confirm that the files 
have been loaded:
1. Open the Detailed Line Query window.

2. Select a line or lines in the Display window.

The records for the selected line(s) are displayed in a table in the 
Detailed Line Query window. 
3. Scroll through the table to the SBET Nav/Att File column.

If the navigation data has been modified by the Load Nav/
Attitude command, the name of the loaded SBET is listed in the 
SBET Nav/Att File column. If navigation data has not been altered, 
the field will display *** Not Loaded ***.
(The SBET RMS File column will list the SBET file used when 
user performs the Process->Load Error Data function. See “SBET 
FILES LOADED” ON PAGE 165.) 

M
en

u Window > Detailed 
Line Query
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Classify Lines
Use this command to set or change a classification flag for a 
track line, to help distinguish between line types.
1. Make sure the Ship Track Lines layer is selected in the Layers tab of 

the Control window.

2. Select a track line in the Display window or Control window.

3. Select the Classify Lines command.

The Classify Lines dialog box is displayed.

4. Select from four options for setting the line classification flag:
• Check Line: A line that is run perpendicular to the survey and is 

used to check the validity of survey data.
• Patch Test Line: A line that is run over a surveyed area to calibrate 

sensor and sonar offsets.
• Shoal Examination Line: A line that is run over a surveyed area to 

re-check possible shoals on the sea floor.
• Track Line: A line that is part of the main survey grid.

5. Click OK.

The line is now flagged according to one of four categories.
8.

M
en

u

Edit > Classify Lines 
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Reject Line
Use the Reject Line command to remove an entire track line 
from data processing. 
When a rejected line is merged, the profiles are marked as 
rejected, which prevents the soundings from being used in BASE 
surfacing, surface cleaning, and mosaicking. However, status 
flags on the individual soundings are maintained. A rejected line 
is not processed in the tiling operations or exported to a CARIS 
map or ASCII file.
1. Select a track line.

2. Select the Reject Line command.

The rejected line is displayed in the Project tab in the Control 
window with a red X beside the file name.
To change status of a rejected line back to accepted: 
3. Select the Accept Line command.

The line is displayed in the Project tab of the Control window 
with a red exclamation point ( ! ) beside the file name. This icon 
indicates the line has been flagged as outdated. You must merge 
the soundings again before they are available for further 
processing (see “MERGE” ON PAGE 167).

M
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u

Edit > Reject Line
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Edit > Accept Line
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View Rejected Soundings
You can show or hide rejected data in Attitude, Navigation, 
Single Beam, Swath, and Subset Editor. Soundings that were 
rejected in the Subset Editor can also be viewed in Swath Editor.
Use the two-part Display Filter button on the View tool bar to 
display rejected data in an Editor. (This control will also display 
data in Accepted, Designated and other critical sounding states.)
Use the right half of the button to set which data to display. 
When the left half of the button is depressed, the selected data 
type is displayed. When the button is not active, all data is 
displayed.
.

For example, to toggle between displaying all the data open in a 
HIPS editor, and displaying only rejected data:
1. Open data in an Editor.

2. Click the arrow part of the Display Filter button and select the Rejected 
check box from the drop-down list. 

3. Depress the Display Filter button to make the Rejected data visible. 

4. Click the button again to see all data. 

Reason for Rejection You can also control which type of rejected soundings are 
displayed in the Single Beam, Swath, and Subset Editors.
To display specific types of rejected data:
1. Select the View Rejected Flag Types command.

The Rejected Flag Types dialog box opens.

Click to 
choose a filter

Click to toggle visibility

Display Filter button

M
en

u View > Rejected Flag 
Types
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2. Place a check mark beside the box with the type of rejected data you 
want to view.
• Rejected by Swath/Single Beam Editor: View soundings rejected in 

Swath or Single Beam Editors or by the Swath or Single Beam 
filters.

• Rejected by Hydrographer: View data rejected interactively in the 
Subset Editor by the hydrographer.

• Rejected by TPU: View soundings rejected through the Total 
Propagated Uncertainty filtering process.

• Rejected by Surface Cleaning: View soundings rejected through the 
Surface Cleaning process.

• Rejected by Surface Filter: View soundings rejected through surface 
filtering.

• Rejected by Depth Filter: View soundings rejected by the depth filter 
in the Conversion Wizard or the Generic Data Parser when it was 
converted to HIPS format. 

• Rejected by Disabled Beam: View soundings rejected due to a 
disabled beam status during conversion. This occurs when the 
beam is disabled in the (legacy) vessel configuration or if the sonar 
system flagged the beam as a bad detection in the raw data file.

3. Click OK.

The rejected data types you selected are displayed in the editors.
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Critical Soundings
Three types of critical soundings can be flagged in HIPS: 
• Designated: soundings that have been flagged in the Swath or 

Subset Editors as being the shoalest sounding in an area.
• Outstanding: soundings that have been flagged in the Subset 

Editor as needing further examination.
• Examined: soundings that have been flagged in the Subset 

Editor as having been examined and verified
The Designated flag identifies the shallowest (also called 
“shoalest”) sounding on important features. For example, 
upright masts on a significant wreck would be flagged as 
Designated.
The purpose of the Designated flag is to ensure that the 
shallowest depths over significant seabed features are 
maintained for standard hydrographic products.
When these soundings are applied to a BASE Surface, the 
Surface is regenerated so that the Designated sounding’s depth 
value is applied to the nearest node (see “FINALIZE BASE SURFACE” ON 
PAGE 224).

Identify Designated 
Soundings

Designated Soundings can be identified in two ways: 
• automatically with the Critical Sounding Detection command 

(see “DESIGNATE CRITICAL SOUNDINGS FROM A SURFACE” ON PAGE 298)
• manually as part of processing in Single Beam, Swath and 

Subset Editors (see “FIND AND DESIGNATE SOUNDINGS IN HIPS EDITORS” 
ON PAGE 300) 

Designated soundings can exported to ASCII, CARIS, GSF, and 
HOB formats. 
The location of designated soundings can be viewed in the 
Display window. They can also be viewed in the HIPS editor in 
which they are designated. (See “VIEW CRITICAL SOUNDINGS IN HIPS 
EDITORS” ON PAGE 301 and “VIEW CRITICAL SOUNDINGS IN THE DISPLAY WINDOW” 
ON PAGE 302.)
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Designate Critical Soundings from a Surface
The Critical Soundings Detection function automatically finds 
and designates shoal or deep soundings in a surface or surface 
attribute layer. 
The process contours the selected surface, between minimum 
and maximum depth at a step interval equal to half the 
resolution of the surface. For instance, if a surface has a min/
max depth of 5/40 metres, with a resolution of 1 metre, the 
process will contour from 5-40 meters at every 0.5m, resulting in 
contours at 5.0, 5.5, 6.0, ... , 39.5, 40.0.
Any isolations (closed contours which have no contours inside 
them) are identified. The direction within these isolations is 
known (i.e. either shoaling or deepening). Based on the direction 
within the isolation, a shoal or deep is flagged on the HIPS data. 
You can define these flags, and possible attribute values as well, 
in the Critical Soundings Detection dialog box. 
To automatically designate shoal or deep soundings:
1. Open a BASE Surface. 

2. Select the Critical Sounding Detection command.

The Critical Sounding dialog box is displayed.

First, define the Input to the process:

M
en

u Process > BASE 
Surface > Critical 
Sounding Detection
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Right-click on layer 
and select Critical 
Sounding Detection
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3. Click in the Source field to select a surface by name from the list of 
surfaces currently open in HIPS. (If you select a surface in the Layers 
tab before opening the Critical Soundings Detection dialog box, that 
surface will be displayed by default.)

4. Click in the Attributes field to select a surface attribute layer, such as 
Depth, from the drop-down list.

Next, define the Output:
5. Click in the Shoal field to select Designated, Outstanding or Examined 

from the drop-down list. This will determine which soundings are 
flagged.

6. [Optional] Click in the Deep field and do the same.

At least one Output Type needs to be set to run the process. 
Advanced Options are available to set additional user-defined 
attributes for the detected critical soundings. Any attributes set 
here are applied to the detected soundings when the process is 
run.
7. Click in the Shoal Attributes field to open the Shoal Attribute 

Configuration dialog box.

Attributes in this list and their values are defined in the 
Catalogue Editor and contained in the catalogue for the current 
project. 
In the image below, an attribute called “Type” has been selected. 
If this “Type” were to represent, as an example, the type of 
process which designated the sounding, then the Value that 
would be set would be either, say, 0 if detected automatically, or 
1 from manual processing. 
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The attributes defined will be listed in the Shoal Attributes field 
in the previous dialog box, when you click OK. When the 
Detection process is run, the attributes and their set values will 
be saved with the detected soundings. 
8. Click in the Name field and select an attribute from the drop-down list. 

9. Click in the Value field to set a value.

To clear an added attribute row, click Remove. Remove All will 
clear all the entries from this dialog box and from the Advanced 
Options fields.
Reset will reset this list to the entries listed when the Shoal 
Attributes Configuration dialog box was opened. 
10.Click OK to return to the previous dialog box.

11. [Optional] Repeat the process to set additional attributes for Deep. 

12.Click OK to run the detection process.

Find and Designate Soundings in HIPS 
Editors
To flag a shallow sounding as the shoalest:
1. Open either Single Beam, Swath or Subset Editor, and load data.

2. Select the shallowest sounding from a cluster of soundings around a 
shoal feature. 

3. Select the Designate command.

The sounding will be flagged as Designated in the Selection tab, 
and highlighted in the editors by a special symbol (as shown in 
the zoomed-in view below).

Find Designated 
Soundings

The Find Designated command automatically selects the 
shallowest sounding in cluster of highlighted soundings. This 
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To
ol

Ke
y <D>



CARIS HIPS and SIPS User Guide 301

Data QC: Designate Critical Soundings from a Surface

feature reduces the time needed to designate shallowest 
soundings.
To automatically find and designate the shallowest sounding: 
1. Use the cursor to highlight soundings in Swath, Single Beam or Subset 

Editor. 

2. [Optional] Use the Query command to view the soundings in the 
Selection tab.

3. Select the Find Designated command.

View Critical Soundings in HIPS Editors
To view critical soundings in an editor such as Swath Editor, use 
the two-part Display Filter button on the View tool bar. This 
control will display data in Accepted, Designated, and other 
critical sounding states.)
Use the right half of the button to set which data to display. 
When the left half of the button is depressed, the selected data 
type is displayed. When the button is not active, all data is 
displayed.
.

For example, to toggle between displaying all the data open in a 
HIPS editor, and displaying only Designated soundings:
1. Open data in an Editor.

2. Click the arrow part of the Display Filter button and select the 
Designated check box from the drop-down list. 

3. Depress the Display Filter button to make the Designated data visible. 

4. Click the button again to see all data. 

M
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u Edit > Status Flag > 
Find Designated
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View Critical Soundings in the Display window
Critical soundings that have status flags set during subset and 
swath cleaning are contained in a HIPS Data layer in the Layers 
tab.
To view these critical soundings in the Display window:
1. Select the Critical Soundings layer in the Layers tab of the Control 

window.

2. Refresh the display.

The Designated, Outstanding and Examined soundings will be 
displayed.
Each type has a default display colour, based on status. These 
colours by status are set in the Display tab of the Tools > 
Options dialog box. See “STATUS” ON PAGE 115 in the Reference 
guide. 

Properties You can over-ride these default colours using the Properties for 
the Critical Soundings layer. Settings changed in the Properties 
window are retained in the session file.
1. Highlight the Critical Soundings layer in the Layers tab. 

2. Open the Properties window.

3. Highlight a status field (in the example below, Designated is selected).

4. Set a new colour from the drop-down list.

5. Refresh the Display.

These settings are saved when you save your session, and will be 
applied when the session is re-opened.

To limit the type of critical soundings visible in the Display 
window, for example, to display only the Designated soundings:
1. Highlight the Critical Soundings layer in the Layers tab. 

2. Open the Properties window.

3. Remove the check mark from the check box for the status types you 
don’t want to view, leaving the desired status type active (as in the 
illustration above). 

To change the type face and font size of the soundings: 
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4. Highlight the Font field in the Properties window, and click the browse 
button to select from the standard Font dialog box.

These settings are saved when you save your session. 
Outdated layer If changes are made to the Critical Soundings layer, the icon for 

that layer will indicate that the layer is outdated. 
To update the Critical Soundings layer:
1. Right-click on the layer, and select Regenerate from the pop-up menu.

Query Soundings To view information on specific soundings, select the soundings 
in the Display window and use the Query command. (See “QUERY 
DATA” ON PAGE 273.) Information about the soundings will be 
displayed in the Selection tab of the Worksheet window.

(See also “SUBSET CLEANING” ON PAGE 339 and “SWATH CLEANING” ON 
PAGE 324.) For more information on sounding status flags, see 
“STATUS FLAGS AND VALUES” ON PAGE 138 in the Reference Guide.
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Protect Critical Soundings
You can set a protective sphere around critical soundings to 
protect any other soundings within the sphere from being 
rejected when you apply automated filters. 
The size of this protective area is determined by setting a radius. 
You can also select which type of critical soundings the 
protection is applied to.  

To prevent the neighbours of critical soundings from being 
rejected during automated filtering:

 1. Select the Set Filters command from the Tools menu.

The Set Filters dialog box is displayed.

2. Select the Critical tab.

3. Select the Enable Protective Radius check box.

4. Select which type(s) of soundings to apply the radius to.

5. Type the dimensions of the protective area in the Radius field. This 
value is in the default units set in Tools > Options > Display > Units.

6. Click Save or Save As to save your filter file so it can be applied with 
the Apply Filters command.

Data must be merged before critical sounding filtering is 
applied.

M
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Tools > Set Filters
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Restart Cleaning
Edits made to sounding, attitude, and navigation data using the 
various data cleaning tools can be undone by using the Restart 
Cleaning function. The Restart Cleaning function resets status 
flags for each selected track line from “Rejected” to “Accepted”. 
You can set which editing process will be reversed by selecting 
the appropriate check boxes in the dialog box.

1. Select the track line(s).

2. Select the Restart Cleaning command.

The Restart Cleaning dialog box is displayed.

3. Select any of the following check boxes to select a rejected data 
criteria.
• Rejected by Swath Editor/Single Beam Editor: Reset to “Accepted”, 

any sounding data that was rejected in Swath or Single Beam 
Editor, or by the Swath or Single Beam filters.

Warning: All previous depth cleaning is lost once this 
command is implemented.

M
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u Edit > Restart 
Cleaning

To
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• Rejected by Hydrographer: Reset to “Accepted”, any sounding data 
that was interactively rejected in Subset Editor.

• Rejected by TPU: Reset to “Accepted”, the data that was rejected 
during Total Propagation Uncertainty (TPU) filtering.

• Rejected by Surface Cleaning: Reset to “Accepted”, the data that 
was rejected during Surface Cleaning.

• Rejected by Surface Filter: Reset to “Accepted”, data that was rejected 
during CUBE filtering.

• Rejected by depth filter: Reset to “Accepted”, data that was rejected 
by the depth filter during conversion.

• Rejected by disabled beam: Reset to “Accepted”, data that was 
rejected due to the disabled beam flag during conversion.

• Rejected with interpolation (Navigation): Reset to “Accepted”, any 
navigation data rejected with interpolation in Navigation Editor. 

• Rejected break Interpolation (Navigation): Reset to “Accepted”, any 
navigation data rejected without interpolation in Navigation Editor.

• Rejected with Interpolation (Attitude): Reset to “Accepted”, any 
attitude data that was rejected with interpolation in Attitude Editor.

• Rejected break Interpolation (Attitude): Reset to “Accepted”, any 
attitude data that was rejected without interpolation in Attitude 
Editor.

4. Click OK.

The selected data is now flagged as accepted.
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Quality Control Reports
The Quality Control (QC) process in HIPS is typically used to 
statistically compare soundings recorded from check lines 
against selected attribute values from a BASE Surface in the 
same survey area.
Statistical variance between the check-line soundings and the 
attribute values are shown in a table in QC Reports tab of the 
Worksheet window once the QC tool is run.
1. Open data.

2. Open a field sheet.

3. Select a survey line in the Display (or you can select a Project, Vessel, 
or Day folder in the Project tab). 

4. Select the Quality Control command. 

QC Report - Step 1
The QC Report - Wizard Step 1 dialog box is displayed.

1. Select a BASE Surface attribute from the Select Reference Surface list.

A template file is an XML file that contains output from the 
Quality Report. You can save the output as a template file or 
open an existing template file. If you open an existing template 
file, the settings saved in that file are applied to the options in 
the other dialog boxes.
2. Select the Use template file check box to create or open a template file.

3. Click Browse to select a location and name for the file or select an 
existing file.

4. Click Next.

M
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u

Process > QC Report
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QC Report - Step 2
The QC Report - Wizard Step 2 dialog box is displayed. 

This dialog box selects the IHO standard for determining what 
percentage of soundings fall within a selected error limit for 
depth accuracy. You can use the S-44 Ed. 4 survey orders or 
S-57 CATZOC zones of confidence. (For more information on how 
error limit for depth accuracy is calculated, see “TPU FILTERING” ON 
PAGE 159).
S44 is selected by default. If you select S57, the dialog box is 
refreshed to show the s-57categories relevant to S-57CATZOC 
zones of confidence. 

1. Select S44 or S57.

2. To display a category in the QC report, select it in the Available list and 
click Add to move to the Active list.
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If you are using the user defined (User Def) category, the a 
(constant depth error) and b (factor of the depth dependent error) 
fields become active once it is moved to the Active list.
3. [Optional] Type the values for the user defined category in the a and b 

fields.

4. To remove a category, select it in the Active list and click Remove to 
move it back to the Available list.

5. Select a category and click the up or down arrow buttons at the top of 
the Active list to determine its order in the Active list. This will determine 
the order that data is displayed in the Worksheet window when the QC 
Report is generated.

6. Click Next.

QC Report - Step 3
The QC Report - Wizard Step 3 dialog box is displayed.

This dialog box defines how soundings are grouped in the QC 
Report. There are three options available:
• Beam number: Soundings are grouped according to across track 

beam number.
• Angle: Soundings are grouped according to beam angle from 

nadir.
• Distance: Soundings are grouped according to across track 

distance from nadir.
1. Select a method for grouping soundings from the drop-down list.
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Soundings can be further organized by range. The range values 
must correspond to grouping method selected above.
2. Type the range in the Minimum and Maximum fields.

Ranges are incremented according to the value entered in the 
In steps of: field. For example, for beam numbers 1 to 100 with an 
increment of 10, the beams are then displayed in the QC Report 
tab in 10 rows.
3. Type a value to increment the ranges.

4. Click Add to display the range in the Defined Ranges list.

5. To remove a range, select it in the Defined Ranges list and click 
Remove.

6. To include rejected soundings, select the Include Rejected check box.

7. Click Finish to complete the wizard and close the dialog box, or click 
Cancel to close the wizard without implementing changes.

Quality Control Statistics
The quality control report is displayed in the QC Reports tab of 
the Worksheet window.

These fields are: 

Field Definition

Beam Number Range grouping as defined in the third dialog box in 
the wizard.

Count Total soundings in range.

Max Maximum distance of soundings above surface.

Min Maximum distance of soundings below surface.

Mean Mean difference of soundings to surface.

Std Dev Standard deviation of mean differences is presented 
at one sigma or 68% Confidence Interval.

(Selected S-44 or S-57 
categories)

Percentage of soundings that fall within the selected 
S-44 survey orders or S-57 CATZOC zones of 
confidence categories.
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Statistical Surface Cleaning

The surface cleaning function is used to perform area-based statistical 
data cleaning on multibeam data in HIPS. 

The process uses advanced tiling technology for subdividing the entire 
area into variable size and density cells. It then applies polynomial 
regression statistics to compute the surface.

In this chapter...
PROCESS ................................................................. 312
POLYNOMIAL SURFACE TYPES ...................................... 313
CREATING TILES AND CLEANING DATA........................... 314
QUERY DATA IN TILES.................................................. 320
TILE HISTOGRAM........................................................ 319
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Process
In surface cleaning, tiling is used to subdivide the area into 
manageable cells where each tile is considered separately during 
the polynomial regression and statistical threshold testing. The 
tile split criteria is based either on the density of soundings 
within the tile, or the tile size, or both.
The Surface Cleaning function automatically creates a Starting 
Level Tile set (even if you do not select the tiling option). The 
Starting Level Tile Set is created by taking the largest 
dimension of the field sheet and dividing the area by 3.
For each tile, a polynomial solution is computed using iterative 
least-squares re-weighted regression. The objective of the 
regression is to generate a surface defined by a set of polynomial 
terms, which closely matches most of the real depths. However, 
since the number of terms defining the polynomial surface are 
less than the number of points considered, then the points do not 
fit the surface exactly. Using the residual values of each point as 
a goodness measure, outliers can be detected by testing for high 
residual values.
The process is iterative within each tile, and for each new 
iteration the soundings are re-weighted inversely proportional to 
their previous residual. You can fix the re-weighting scheme to 
apply full weight to all soundings within a defined limit from the 
surface. This re-weighting limit can be based on a fixed distance 
or a multiple of the standard deviation of the residuals within 
the tile.
You can also define the maximum number of iterations. The 
buffer around each tile determines how much extra data is used 
to compute the tile polynomial surface. This helps eliminate 
edge effects during statistical testing.
The second stage of surface cleaning is the testing of the 
residuals once the surface has been computed. The relevant 
parameters are the rejection threshold scaling values in both the 
positive and negative directions (above and below the surface), 
and the minimum absolute residual of an outlier. The latter 
parameter specifies that no point within this distance (either 
above the surface or below) are rejected. This is an important 
parameter if the local standard deviation of a tile is small, 
because the scaling values are multiplied by a small standard 
deviation and may reject points which are only slightly removed 
from the surface. This parameter is location dependent and 
maybe used, for example, to prevent the rejection of rocks of a 
specific height. The rejection threshold values are also location 
dependent and surface dependent.
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Polynomial Surface Types
The following table lists each of the polynomial surface types 
with the corresponding equation and a graphical example of 
each surface type.
 

Polynomial Surface Types

Surface Equation Example

Mean

Tilted Plane

Curved Tilted 
Plane

Quadratic

Cubic 

f xy( )– b0=

f xy( )– b0 b1x b2y+ +=

f xy( )– b0 b1x b2x b3xy+ + +=

f xy( ) b0 b1x b2x b3xy b4x2 b5y2+ + + + +=

f xy( ) b0 b1x b2x b3xy b4x2 b5y2
b6x2y b7xy2 b8x3 b9y3

+ + + + + +
+ + +

=
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Creating Tiles and Cleaning Data
 

1. Select a field sheet.

2. Select a Surface Cleaning command.

The Surface Cleaning dialog box is displayed. 

By default, the dialog box fields are listed by category. To view 
these fields in alphabetical order:
3. Click on the Alphabetical button in the toolbar.

Data must be merged before surface cleaning can be 
performed.

M
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u Tools > Surface 
Cleaning
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Cleaning 4. Set the Cleaning check box to True to enable the surface cleaning 
functions.

5. Enter cleaning Options, as needed, in the following fields. (The sigma 
value is a multiple of the standard deviations of residuals in the tile. 
The equivalent confidence values are displayed as a percentage.)
• Shallow threshold: The threshold above the polynomial surface. 

The value is selected by clicking the up and down arrow buttons 
beside shallow threshold field. 

• Deep threshold: The threshold below the polynomial surface. The 
value is selected by clicking the up and down arrow buttons 
beside deep threshold field. 

• Minimum residual: A sounding that fails the threshold test will not be 
rejected if the absolute value of the residual is less than the 
minimum.

• Include preciously rejected: Include any data previously rejected by 
Surface Cleaning in this computation. 

Field sheet The Field sheet field displays the name of the selected field 
sheet. 

Tiling Choose the method to create tiles: either By Density of tiles or By 
Size of tiles. 
6. Set By Density to True. Each tile is continuously sub-divided until one of 

the sub-tiles has less than the minimum number of soundings.

Type a Minimum soundings per tile value for the minimum number of 
soundings that will be covered by a tile.

7. Set By Size True. This will continuously sub-divide each tile until the 
sub-tiles reach the minimum size. (This size cannot be larger than the 
Starting Level Tile Set. The Starting Level Tile Set is created by taking 
the largest dimension of the field sheet and dividing the area by 3.)

Set the Minimum size of tile, in default measurement units.

8. Type a name for the tile file. Surface Cleaning cannot be applied unless 
a tile file is set. (All tile files are assigned an .mts extension. Also 
created is a .mmi file that records the list of track lines used to create 
the tiles.)

Print 
Preview

Categorized Alphabetical Quick 
Print
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Filtering You can set a protective sphere around critical soundings to 
protect any other soundings within the sphere from being 
rejected when you apply automated filters. (See “CRITICAL 
SOUNDINGS” ON PAGE 297.)
The size of this protective area is determined by setting a radius. 
You can also select which type of critical soundings the 
protection is applied to. 
9. Set Use Protective Radius to True.

10.Set to True the type(s) of soundings to apply the radius to.

11.Type the dimensions of the protective area in the Radius field. This 
value is in units set as default Horizontal Length in Tools > Options > 
Display > Units. 

Surface Parameters Set advanced parameters, as needed:
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12.Degree of polynomial: From the drop-down list, select one of the 
available polynomials to match the expected complexity of the sea 
floor. 
• The equation for the selected degree will be displayed in the field 

below. (See “POLYNOMIAL SURFACE TYPES” ON PAGE 313 for polynomial 
descriptions.) 

13.Set the Least Squares Parameters:
• Maximum iterations: Set the number of times the least squares 

computation of the polynomial will process the soundings. This re-
weighting continues until there are no additional rejected soundings 
or the maximum number of iterations is reached.

• Full re-weighted threshold. Select either by:

Standard deviation: The full re-weighting of soundings for each 
iteration can be a multiple of the standard deviation of the residu-
als. The Value field will show a multiple of the standard deviations 
of residuals in the tile. The equivalent confidence values are dis-
played as a percentage.)

Residual surface value: The full re-weighting of soundings for 
each iteration can be fixed as a distance from the surface. The 
Value field will show in units as set by the default Horizontal 
Length units in Tools > Options > Display > Units. 

14.Set other options
• Use perpendicular: When this option is set to True, the residual is 

calculated as the perpendicular distance between the sounding and 
the nearest point on the polynomial surface. The default calculation 
for the residual uses the depth difference between the sounding and 
the polynomial surface at the location of the sounding.

• Use tile buffer: When this is set to True, an extra area around the tile 
is included in the surface computation. 

• Tile buffer size: a percentage of the tile size that describes the width 
of the buffer around the tile.

15.Click OK.

The tiles are displayed in the Display window and the tile 
surface is listed (by the file name that was assigned in Step 4) in 
the Layers tab under its parent field sheet layer. 
The properties of the tiles can be viewed in the Properties 
window.
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Properties of the displayed tiles
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Tile Histogram
The Tile Histogram dialog box displays the distribution of 
residuals within a tile.
If the histogram resembles a bell curve then the selected 
polynomial is well suited for the area. However, if the histogram 
has many peaks or a wide centre, then the polynomial surface is 
not suited to the area. If there are severe shifts in data 
distribution, then the area may have to re-tiled using a higher 
degree of polynomial.
You can also use the histogram to change the threshold values 
and reject soundings.
1. Select the tiles you want to examine using the tile selection command.

2. Select the Tile Histogram command.

The Histogram dialog box is displayed.
Information about the tile is displayed on the right-hand side of 
the dialog box.

3. To view data for another tile, click Next Tile or Previous Tile. 

4. Use the Shallow Threshold or Positive Threshold sliders to adjust these 
values.

The corresponding confidence intervals and Maximum Residual 
Distance values change as the bars are moved.
5. Click Apply.

The rejected residuals are displayed in red.

M
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Query data in tiles
There are three ways to examine data in tiles:
• “SELECT AND VIEW TILE DATA” ON PAGE 320 
• “QUERY SOUNDINGS IN TILES” ON PAGE 320

• “QUERY TILE DISPLAY” ON PAGE 321

Select and View Tile Data
To see data about the tiles created for surface cleaning:
1. Open surface cleaning tiles in the Display window.

2. Select the tile layer in the Layers tab of the Control window.

3. In the Display window, select tiles to be queried.

The data for the selected tiles is automatically displayed in the 
Selection tab, including among other attributes:
• X and Y coordinates for the centre of the tile 
• Z mean, Z minimum and maximum
• Res mean and Res Sigma 
• Count of the number of soundings within the tile area, and 

the number of Rejected soundings within the tile area
• Tile level and tile size

Query Soundings in Tiles
To view data on the soundings in selected tiles:
1. Open surface cleaning tiles in the Display window.

2. Select the tile layer in the Layers tab of the Control window.

3. In the Display window, select tiles over the soundings to be queried.

4. Select the Query Tile Soundings command.

The data for each sounding in the selected tiles is displayed in 
the Selection tab. As well as the Project/Vessel/Day/Line data for 
each sounding, other attributes are also displayed, such as:
• X: andY coordinates for the soundings
• Profile, Beam and Status data 
• Depth: depth of sounding.
• Surface Depth: depth of polynomial surface at the location of 

the sounding.

M
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• Residual: percentage difference between the sounding and the 
polynomial surface.

• Shallow Threshold: depth of rejection threshold above the 
polynomial surface.

• Deep Threshold: depth of rejection threshold below the 
surface.

Query Tile Display 
You can also use the Tile Display Query function to create an 
SQL-type query that will display only those tiles with selected 
attributes. For more information, see “TILE DISPLAY QUERY” ON 
PAGE 407.
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Cleaning Swath Data

Data cleaning in Swath Editor consists of interactively selecting and 
rejecting soundings and using proven and efficient filtering functions to 
automatically detect and reject outliers. 

You can also flag Designated Soundings.

(For descriptions of the Swath Editor interface and controls, see “SWATH 
EDITOR” ON PAGE 143 in the Editors guide.)

In this chapter...
SWATH CLEANING ...................................................... 324
AUTOMATIC FILTERING ................................................ 325
MANUAL CLEANING .................................................... 328
UPDATE BACKSCATTER ............................................... 332
FLAG DESIGNATED SOUNDINGS .................................... 333
CORRECTION FOR REFRACTION ARTIFACTS..................... 334
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Swath Cleaning
During data conversion, the original data file is separated into a 
number of distinct files, each storing a different type of 
information. All are related by time. One of these files is the 
Observed Depths file. This file contains measured single beam, 
sweep, or swath soundings as reported by the data acquisition 
system.
The Swath Editor displays the contents of the file for sweep and 
swath systems in the Display window in graphic form so you can 
perform cleaning and filtering operations on the data.
Each soundings begins with Accepted status. If rejected (for any 
reason) during processing it can be restored to Accepted status 
without loss of data. 
Sounding outliers can be rejected by applying automatic swath 
filters (see “AUTOMATIC FILTERING” ON PAGE 325) or interactively using 
manual cleaning tools (see “MANUAL CLEANING” ON PAGE 328).
For information on the Swath Editor interface, see SWATH EDITOR 
in the HIPS and SIPS Editors Guide.
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Automatic Filtering 

When dealing with high-volume bathymetric datasets, it is 
advantageous to be able to reject outliers automatically. Using 
Swath filters can be an effective way to reduce the time it takes 
to clean large volumes of data.
There are three basic types of swath filters:
• Spike detection: The minimum and maximum depth filters 

and the beam-to-beam slope filters.
• Swath reduction: across track distance filters and nadir angle 

filters.
• Sonar quality: Quality values set by the sonar and missing 

neighbours 
The parameters for filtering are set through the Set Filters 
dialog box. These parameters can be saved in a HIPS Filter File 
(.hff) that can be reopened in the Set Filters dialog box for use in 
another track line.
1. Select the Set Filters command.

The Swath/Sweep tab of the Set Filters dialog box is displayed.
 

1. [Optional] Select an existing HIPS Filter File from the list or click 
Browse to select a file.

M
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If you chose to load a filter file, all the values used in that file are 
shown in the fields. You can filter data or change any of the 
values in the fields.
2. Set the logic to Accept or Reject.

3. Select the Include Filter check box to activate the filtering options.

4. Select the filter parameters used to flag data (see below).

You can define and apply more than one filter test. The filters 
are applied in sequence. Any data rejected by one filter is not 
considered in the next filter test.
5. Click Close, or click Clear to remove data from the fields.

6. Click Save As to save the settings to a filter file.

The following filters are available.
• Minimum Depth. Reject any soundings that are shallower than 

the depth specified (e.g., 10 m). 
• Maximum Depth. Reject any soundings that are deeper than the 

depth specified (e.g., 50 m). 
• Across track angle Beam-to-beam slopes, across track. For each 

beam on the same swath, calculate the slopes in degrees to 
the prior and post beams, and if both slopes exceed the 
defined value and are of opposite sign then reject the beam. 
The Include Rejected option includes previously rejected 
soundings when recalculating the slopes during multiple runs 
of the filter.

• Across track distance: X Nadir Depth. Any soundings with an across 
track distance, from the centre beam, greater than the nadir 
depth times this number (e.g,. 3.0) are rejected. For example, 
in 30 metres of water, with a setting of 3.0, all soundings with 
an across track distance greater than 90.0 metres are 
rejected. 

• Across track distance: Port. Filter a sounding if the across track 
distance on the port side is greater than the value entered in 
this field.

• Across track distance: Starboard. Filter a sounding if the across 
track distance on the starboard side is greater than the value 
entered in this field.

• Beam Numbers. Specify beams to be rejected. Separate 
individual beams with a space and specify a range of beams 
with a hyphen. For example, entering 12 32 56-60 72 rejects 
beams 12, 32, 56, 57, 58, 59, 60, and 72.

• Angles from Nadir: Port and Starboard. Filter beams that are outside 
of the designated angles (e.g., 60 degrees). Angles are 
computed from the nadir using depths and across track 
distances (roll corrected).
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Quality Flags. If your system attaches quality codes to soundings, 
and those codes are transferred to HIPS during conversion, a 
sounding can be rejected according to its value. 

Missing neighbours are beams rejected during the conversion 
process into HIPS. This occurs if the beam is disabled in the 
vessel configuration or if the sonar system flags the beam as a 
bad detect in the raw data file.
• Port-Starboard. Beams are rejected if beams on each side of the 

swath are rejected.
• Forward-Aft. Beams are rejected if the adjacent beams in the 

previous and next swath are rejected.
• Any 2 of 4. Beams are rejected if two of the four neighbouring 

beams are rejected.
During filtering, only accepted soundings are examined. 
Soundings rejected after one filter pass are not considered in the 
next.

Apply Filters
The last step is applying the automatic depth filter to the swath 
data.
1. Select an Apply Filter command to apply the criteria set by the Set 

Filters dialog box.

You have four options for applying the filters:
• Filter 1 Screen: Apply the filters only to the swaths that are 

currently visible in the Plan View of Swath Editor.
• To End of Line. Apply the filters to the track line currently 

open in Swath Editor, from the first swath currently visible in 
the Plan view to the end of the line.

• Selected Lines. Apply the filters to all of the currently 
selected track lines. This function does not require that 
Swath Editor be open. 

• All Lines. Apply the filters to all track lines currently open in 
the Display window. This function does not require that 
Swath Editor be open.

Quality flags are currently supplied by Teledyne Reson, 
Elac, Hypack, and GSF multibeam systems/formats. 
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Manual Cleaning 
1. Select the Ship Track Lines layer in the Layers tab.

2. Select a track line.

3. Select an Open Swath Editor command.

The Swath Editor opens with all views displayed. 
(For a complete description of the Swath Editor interface, and 
ways of viewing data display options and controls, see SWATH 
EDITOR in the HIPS and SIPS Editors Guide.) 
4. Select soundings to be cleaned. (When soundings are selected they 

are highlighted in yellow.)

5. Apply the Reject or Reject Swaths command o the sounding as 
appropriate. 

Tools
To assist with manual cleaning, use:
“AUTO CURSOR MODE” ON PAGE 328

“FIND SOUNDING” ON PAGE 328

“QUERY DATA” ON PAGE 331

Auto Cursor Mode
Auto Cursor Mode can be used to speed up the interactive 
process. This mode combines the selection and Accept/Reject/
Query functions into a single procedure. 
1. Select the Auto Cursor command.

2. Select a Reject/Accept/Query command.

3. Press the mouse button and draw a bounding box over the data.

4. Release the mouse button.

Find Sounding 
Use the Find function to search a survey line for a specific 
sounding(s) by beam and/or profile number.
1. Select a track line.

2. Select the Find command. 

The Find dialog box is displayed.
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3. To search by the swath or beam number, select the Profile and/or 
Beam option.

4. Type the swath or beam number in the Profile Number or Beam 
Number field.

5. To search for a swath that was recorded at a specific time, select the 
Time option.

6. Click inside the Profile Time box and type the time in the relevant fields 
(hour:minutes:seconds:decimal fractions of a second), using the 24-
hour clock.

7. Click Find.

The selected beam or swath is highlighted in the Plan, Rear and 
Side Views.
8. Click Query to display the data in the Selection tab. 
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Rejecting Data 
A sounding rejected within Swath Editor has the Reject by 
Swath Editor flag turned on. This flag is displayed in the Status 
field of the Selection tab when the sounding is queried.
To reject a sounding: 
1. Select the data you want to reject.

2. Select a Reject command.

The Reject by Swath Editor status flag is now on and the 
sounding may or may not be displayed depending whether the 
Show Rejected function is turned on. (See “VIEW REJECTED SOUNDINGS” 
ON PAGE 295 for description.)

A rejected sounding can always be returned to the “Accept” 
status without loss of data. To revert rejected soundings back to 
“Accept”: 
1. Select the rejected data so it is highlighted.

2. Select the Accept command.

The soundings are now flagged as accepted.

Reject Swaths
In some instances it may be necessary to reject all soundings in 
one or more swaths. This can be done with the Reject Swaths 
command without having to select all of the data in the swaths.
1. Select some sounding in the swath you want to reject.

2. Select the Reject Swaths command.

All soundings in the swath (whether individually selected or not) 
now have the Rejected by Swath Editor status flag turned on. 
The sounding will not be displayed unless the Show Rejected 
function is turned on (see “VIEW REJECTED SOUNDINGS” ON PAGE 295).

M
en

u Edit > Status Flag > 
Reject

To
ol

Po
p-

up Reject

K
ey <R>

M
en

u Edit > Status Flag > 
Accept

To
ol

Po
p-

up Accept

K
ey <A>

M
en

u Edit > Status Flag > 
Reject Swaths

To
ol

K
ey <S>



CARIS HIPS and SIPS User Guide 331

Cleaning Swath Data: Query Data

Query Data
Select soundings to view status and other information. 
1. Select the data in one of the Swath Editor windows.

2. Select a Query command. 

The following data fields for the selected soundings are 
displayed in the Selection tab: 
• time of the swath profile
• d-time from the previous profile
• profile number
• beam number
• across track distance 
• along-track distance
• depth
• d-depth from the previous profile
• d-depth from the previous beam
• amplitude / phase detect
• quality value
• status flag
• horizontal error value
• vertical error value

You can reject queried soundings selected in the Selection tab. 
1. Query a selection of soundings. 

2. Highlight certain soundings in the Selection tab. 

3. Select an Accept or Reject command.

You can also use the keyboard to set the flag: “A” key for Accept, 
“Q” for Query, “R” for Reject, and “S” for Reject Swath.
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Update Backscatter
This command updates the backscatter imagery for a line after 
swath cleaning is complete. 
Backscatter data is referenced directly to the individual beams 
of bathymetry data. After soundings have been rejected in 
Swath Editor, Update Backscatter is applied to remove the 
intensity values for the rejected soundings from the backscatter 
image. 
1. Select a track line. 

2. Select the Update Backscatter command.
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Flag Designated Soundings
The Designated Sounding flag identifies the shallowest, or 
“shoalest” sounding in a feature. For example, in a cluster of 
soundings surrounding an outcrop of rocks, the shoalest 
sounding among that cluster is identified as Designated.
The purpose of the Designated Sounding flag is to ensure that 
the shoalest depths over significant seabed features are 
maintained in charts and other standard hydrographic products. 
Soundings can be designated in both Swath Editor and Subset 
Editor.
For more information, see “CRITICAL SOUNDINGS” ON PAGE 297. 
1. Select the shoalest sounding from a cluster of soundings around a 

feature in Swath Editor.

2. Select the Designate Soundings command. 

The sounding is flagged as Designated.M
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Correction for Refraction Artifacts
Since it is not possible to completely control the sound speed 
variations in water we apply sound velocity profiles to correct for 
this. However, refraction artifacts may still remain, especially if 
incorrect or insufficient sound velocity profiles are applied either 
during acquisition or during post processing.
To correct for this, you could choose to limit the usable swath 
angle (and therefore survey more lines), or you can use the 
Refraction Editor, which simulates the effects of altering the 
SVP to derive a better refraction solution.
Since refraction errors are most pronounced in the outer parts of 
the survey line coverage, they tend to create characteristically 
curved (upward or downward) refraction artifacts.
Apply the velocity correction at a user-defined depth. As you 
adjust the values, you can observe the changes in the shape of 
the swath profiles. When you arrive at the values which give you 
the desired correction, you can save these coefficients. Later, 
during the Merge process, you can apply these Refraction Editor 
coefficients. 
To open the Refraction Editor:
1. Select a track line.

2. Open Swath Editor, then select the Refraction Editor command. 

The Refraction Editor tab is displayed next to the Swath Editor 
tab in the Control window.
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3. Set the values for depth and velocity correction until the desired effect 
is observed.

4. Click Add to add the new entry to the list of coefficients.

5. Click Reset before clicking Add to set the values to their original 
setting. 

6. To change an existing coefficient, select it, adjust the settings and click 
Replace to update it.

7. To remove an entry from the list select it and click Delete.

8. Click Save to save your entries.

As you change the values in the Refraction Editor tab you will be 
able to see the effects of these changes in the Swath Editor 
display. 
9. Select the Preview check box to view the effects of your changes.

If the Preview option is selected, you can also enable the Apply Roll 
option. When you first open the Refraction Editor, this control is 
set to be the same as the setting in the Roll section of the Vessel 
file (HVF). This control allows you to quickly observe the effects 
of applying (or not applying) dynamic roll to the sounding data. 

10.Select the Apply Roll check box to see the effects of roll on the data

If there is no roll data, or if the appropriate Roll section 
cannot be found in the HVF, or if the survey line has already 
been sound velocity corrected, toggling the Apply Roll switch 
will have no effect.
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The velocity correction and depth are recorded with the current 
swath profile number. While paging through the track line 
during cleaning, new swath/correction/depth values can be 
recorded.

Interpolation When you add the first Refraction Coefficient, the correction 
starts at that profile and goes to the end of the line with that 
same correction. If you add a second Refraction Coefficient after 
the first, the correction applied between the two profiles is 
interpolated. This is done so that there is no “jump” in the profile 
when the correction at the second Refraction Coefficient is 
applied to the data.
This interpolation is linear. That is, if the selected profile is 
between two refraction entries, the depth and delta velocity are 
both interpolated from these entries.

Querying Querying the data in Swath Editor will always give the results 
from the display, so if you change the display with the Preview 
option of the Refraction Editor turned on, the query will return 
the results of the change. The Observed Depth data (across 
track, along track and depth) does not change.
The effects of the Refraction Editor can be turned on or off 
during Calibration. As well, the effects on the final merged 
depths can be modified any time by editing the coefficients and 
re-merging, or the effects can be removed by re-merging and 
choosing not to apply the coefficients.
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Process Data in Subsets

Create subsets to efficiently visualize and clean data from multiple track 
lines at the same time, and use subset tiles to track the progress of 
processing. 

In this chapter...
DATA CLEANING WORKFLOW ....................................... 338
SUBSET CLEANING ..................................................... 339
DESIGNATE SOUNDINGS .............................................. 342
TRACK PROGRESS WITH SUBSET TILES.......................... 343
SUBSETS AND BASE SURFACES.................................. 350
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Data Cleaning Workflow
A subset is a user-defined rectangular area that contains some of 
the soundings of a survey project. Dividing the area of the survey 
into subsets makes the cleaning of a large data set more 
manageable.
The following workflow is a suggested method for cleaning data 
with Subset Editor.
1. Open a field sheet with a BASE surface.

(See “CREATE A FIELD SHEET” ON PAGE 174)

2. Create Subset Tiles in the field sheet area.
(See “TRACK PROGRESS WITH SUBSET TILES” ON PAGE 343)

3. Open Subset Editor and create a subset area within the tiled area. (See 
SUBSET EDITOR INTERFACE in the HIPS and SIPS Editors Guide.)

4. Use the 3D View Controls to adjust the view of the data. (See SUBSET 
3D VIEW in the HIPS and SIPS Editors Guide.)

5. Clean subset data. 

(See “SUBSET CLEANING” ON PAGE 339)
6. Classify data in subset area.

(See “TRACKING CLEANING STATUS” ON PAGE 349)
7. Define another subset and repeat the process.

If you are processing a small amount of data, using subset tiles 
to track progress can be omitted (Steps 1 and 2), and Subset 
Editor can be directly opened into the track lines.
However, if you are processing large areas of data, the subset 
tiling method is a useful way to track changes. 

(For hypothesis editing a CUBE surface in Subset Editor, see 
“HYPOTHESIS EDITING” ON PAGE 259.)



CARIS HIPS and SIPS User Guide 339

Process Data in Subsets: Subset Cleaning

Subset Cleaning
Soundings in the 2D and 3D Views can be interactively 
examined and their status flags can be modified.
To open Subset Editor:
1. Select the Subset Editor command. 

2. Define the area in the Display window to be included in the subset. 

See “OPEN SUBSET EDITOR AND LOAD DATA” ON PAGE 111 in the Editors 
Guide.

3. Select the Load Subset command to the load the data into the Subset 
Editor windows.

The subset of your data is generated and displayed in the 2D and 
3D windows in Subset Editor

Reject
Each sounding in the HIPS format carries several status flags 
that are turned on and off as needed. Each sounding begins as 
an Accepted status. If rejected during processing, it can always 
be returned to the accepted status without loss of data. 

1. In either the 2D or 3D View, select the data you want to reject so it is 
highlighted.

2. Select the Reject command.

If you query the rejected soundings, you will see that they now 
display the status flag “Rejected (Subset-Hydrographer)”. As 
well, the soundings may or may not be displayed depending on 
whether the Show Rejected button is toggled to visible.
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If data for any line has not been merged, the depth information may 
not be accurate. In this case, the subset will be loaded, but the 
Output window will warn you that the processed depths for a 
specified line are outdated and require Merge. (See “MERGE” ON 
PAGE 167.

Note: When you select data in the 3D View, all data in the 
highlighted area is selected, not just the visible data.
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Accept
Change rejected soundings back to the accepted status.
1. Select the rejected data that you want to return to accepted status.

2. Select the Accept command.

The soundings are now marked as accepted.
 

Outstanding
Flag a sounding as requiring further examination.
1. Select the data that you want flag as Outstanding.

2. Select the Outstanding command.

Examined
Flag questionable soundings as having been examined and 
verified.
1. Select the data that you want to flag as Examined. 

2. Select the Examined command.

Query
View information on selected data.
1. Select the data that you want to query.

2. Select the Query command.
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The data is displayed in the Selection tab.
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Note: When you select data in the 3D View, all data in the 
highlighted area is selected, not just the visible data.
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Designate Soundings
Shoal soundings over significant seabed features can be flagged 
as “Designated” to ensure that these depths are maintained in 
charts and other standard hydrographic products.
Use the Designate commands to flag, for example, the top of a 
mast in a wreck, or the shoalest sounding in a cluster of 
soundings identifying an outcrop of rocks. 
For more information, see “CRITICAL SOUNDINGS” ON PAGE 297.
1. Select the shoalest sounding from a cluster of soundings around a 

feature in Subset Editor.

2. Select the Designated Soundings command.

The sounding is flagged as Designated.
Shoalest soundings can also be designated in Swath Editor.

Find and Designate The Find and Designate command automatically selects the 
shallowest sounding in cluster of highlighted soundings. This 
feature reduces the time needed to designate shallowest 
soundings.
1. Use the cursor to highlight soundings in Swath or Subset Editor. 

2. [Optional] Use the Query command to view the soundings in the 
Selection tab.

3. Select the Find and Designate command.

The shoalest sounding among the cluster of highlighted 
soundings is now flagged as Designated in the Selection tab, and 
displays the Designated symbol when viewed in Swath or Subset 
Editor.
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Track Progress with Subset Tiles

Subset Tiles are used to track the process of examining and 
cleaning areas within the survey project. Each tile within a 
Subset Tile layer has one of three tracking settings: Incomplete, 
Partially Complete, or Completed (see “TRACKING CLEANING STATUS” ON 
PAGE 349).
The extent of the subset tile area can be determined in two ways: 

• the tiles cover the entire field sheet area, or
• the tiles cover the area of the field sheet that contains a 

height source, such as a BASE Surface.

The option to cover the entire field sheet area is useful if you are 
cleaning newly acquired data with Subset Editor while the area 
is being surveyed. You would not have to create a new subset tile 
layer because of additional data in your project.
Subset tiles are produced in field sheets. To create subset tiles 
for tracking: 
1. Select a field sheet in the Layers tab of the Control window.

2. Select the New Subset Tiles command.

The New Subset Tiles dialog box is displayed.

Field sheet with 
BASE Surface

Tiles cover 
BASE Surface

Tiles cover entire
field sheet
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The Control Coverage by Surface option constrains the new subset tile 
area to the selected BASE Surface. When this check box is 
cleared, the subset tiles will cover the entire field sheet area.
To tile the entire field sheet, 
3. Clear the Control Coverage by Surface check box.

4. Type the tile size.

5. Click OK.

A Subset Tile layer is created and displayed within the extent of 
the field sheet area. 
To tile the area of a specific BASE surface, 
1. Select the Control Coverage by Surface check box to apply the subset 

tiles to a BASE Surface.

2. From the list, select the BASE surface to be used as the template for 
subset tiles.

3. Type the tile size.

4. Click OK.

The Subset Tile layer name is added to the Layers tab. The 
names are automatically generated beginning with 
SubsetTiles1. You can show or hide the layer with the check box 
beside the Subset Tile file name in the Layers tab.



CARIS HIPS and SIPS User Guide 345

Process Data in Subsets: Track Progress with Subset Tiles

Subset tile properties
You can set display properties for tiles in the Properties window. 
For example, you can set colours to display the progress of 
subset cleaning, or make the tile layer transparent so the 
features below it are more visible. 
The Active Attribute field lists all attributes included in the tiles. 
When you select an attribute, such as cleaning status, tiles are 
displayed according to the values of those attributes. 
For example, if Cleaning_Status is selected as the active 
attribute, and the Colour fill tiles is set to “True”, the tiles will 
be displayed in
• red, if the tiles have not been examined. (status = Incomplete)
• yellow, if the tiles are partially complete. (The tiles were only 

partially covered by a subset that has been marked as 
complete.)

• green, if the cleaning of the tiles is complete. 
As well, the numeric value for the attribute status can be 
displayed, using the Display tile value field. 
When this field is set to “True”, the tiles will display the value 0 
for Incomplete, 1 for Partially complete or 2 for Completed. The 
example below shows tiles with “Cleaning status” set as the 
active attribute, and both Colour fill tiles and Display tile value set to 
“True”.
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These cleaning status values can also be viewed in the Selection 
tab of the Worksheet window when tiles are selected. 
To set properties for the tiles layer, 
1. Select a tile layer in the Layers tab of the Control window.

2. Select the Properties window command. 

The Properties window shows the display options for tiles.
 

3. Select an attribute from the drop-down Active Attribute list.

4. Select a colour map from the Colour Map drop-down list. 

5. Change how tiles are rendered to the Display Window by selecting the 
Display Level, either:
• Maximum: Draw all tiles
• Automatic: Draw tiles to fit the current extent of the Display window.

The Colour Fill Tiles check box determine how attribute values are 
drawn in the Display window.
• If the Colour Fill check box is set to “True”, the tiles are drawn 

according to the selected colour map.
• If the check box is unchecked and set to “False”, the tiles are 

drawn in outline only. 
6. Select a Transparency percentage to make features visible through the 

tiles. 

The Show Tile Borders check box determines how the border lines 
dividing the tile areas are displayed.
• If the Show Tile Borders check box is checked, the value is set to 

“True” and the lines are colour coded according to the colour 
selected in the Border colour field. 

• If the Show Tile Borders check box is clear, the value is set to 
“False”, and the borders of the tiles are not displayed.

7. [Optional] Select an alternative colour for the border lines from the 
colour picker in the Border colour field.
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8. Select the Display tile value check box to set the value to “True” so the 
appropriate cleaning status value (0=Incomplete, 1=Partially Complete 
and 2=Complete) is displayed in each tile.

Edit tiled subset data Once the tracking tiles are created, you can examine and edit 
the data by opening Subset Editor and defining a subset. (See 
“OPEN SUBSET EDITOR AND LOAD DATA” ON PAGE 111). You can clean data 
from the open subset (see “SUBSET CLEANING” ON PAGE 339). You can 
track the progress of cleaning by the colours of the tiles, or by 
selecting the tiles and viewing status in the Selection tab of the 
Worksheet window.

Tracking Layer Options
The layer containing the tracking tiles has options which can be 
set in the Subset Editor tab of the Control window (see “SUBSET 
EDITOR TAB” ON PAGE 115).
1. Select the Tracking layer in the Subset Editor tab.

The tab is refreshed to display the tracking options.
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Use the Subset Snapping check box so that the subset bounding 
box encloses entire tiles. 
2. Select the Subset Snapping check box.

3. Select the tile tracking layer.

4. Click Apply.

You can also set an amount by which the subset snapping will 
overlap tiles as you move from completed to unprocessed tiles.
This helps ensure coverage of all of the data that lies within tiles 
along the edges of the subset. 
5. Select a percentage in the Tile Overlap field. 

6. Click Apply.

7. In the Subset Tracking options, select the Automatically mark as complete 
check box to flag the data as examined and cleaned. This can be 
changed later (see “TRACKING CLEANING STATUS” ON PAGE 349).

When the Automatically mark as complete check box is selected, two 
other options are made active.
8. Select the Mark all Subset Tile layers option to flag the tiles in ALL tile 

layers as completed, or select Mark only snap target to select tiles only in 
the selected tile layer as completed.
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Tracking Cleaning Status 
Once you have examined and cleaned a subset, the subset area 
can be assigned one of three classifications:

• Complete: All data in the selected area is clean and ready for 
further processing or export.

• Partially Complete: Not all the data within the area has been 
viewed and verified as clean in Subset Editor.

• Reset: Data has not been verified or cleaned.

The area is colour-coded in the Subset Tile according to the 
selected cleaning status classification (and the settings in the 
Properties tab):
• Complete = green (2)
• Partially Complete = yellow (1)
• Incomplete or not processed = red (0). 
To assign a cleaning status to a subset area,
1. Select the appropriate status from the Subset Editor toolbar or from the 

Tools >Subset Editor submenu. 

The flagged tiles will be displayed with the colour appropriate to 
their status. Only tiles totally encompassed by the subset 
bounding box are flagged with the selected status. Tiles only 
partially covered by the bounding box are flagged as Partially 
Complete, as in the example below.

Subset bounding box

Tiles with 
Partially 
Complete
status

Incomplete or
not processed
tiles

Tiles with 
Complete 
status
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Subsets and BASE Surfaces
BASE surfaces can be opened in Subset Editor and displayed in 
the 2D and 3D Views. This enables you to determine the position 
of Designated soundings against an existing BASE Surface, and 
whether Designated soundings have been correctly applied to a 
Finalized BASE Surface. (See “CRITICAL SOUNDINGS” ON PAGE 297.)
As well you can apply surface filtering to a subset of any BASE 
surface in Subset Editor. 

.Open BASE surface in Subset Editor
1. Open the BASE surface for your project.

2. Open Subset Editor and define a subset over the BASE surface.

3. Load the subset.

4. Select the Reference Surface layer in the Subset Editor tab.

The Subset Editor tab is refreshed to show the property options 
for the Reference Surface layer.

5. Select a BASE Surface layer from the Select Surface file tree.
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Although the Depth attribute is used to display the surface, you 
can colour the surface by another attribute by selecting that 
attribute from the Colour by Attribute drop-down list.
6. Display the BASE surface as points, wire frame or a complete surface 

by selecting an option from the Display drop-down list.

7. Select a transparency level for the Surface, using the up and down 
arrow buttons.

8. Click Load.

The BASE Surface is displayed in the Views according to the 
above options.
9. [Optional] Click Unload to remove the BASE Surface from the Views.
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Surface filter 
You can load any type of BASE surface to Subset Editor and 
apply filtering to the part of the surface within the subset slice, 
or to the part of the surface defined within the full subset. 

1. Open a BASE surface.

2. Open Subset Editor and define a subset over the BASE surface. (See 
“OPEN SUBSET EDITOR AND LOAD DATA” ON PAGE 111.)

3. Load the subset.

4. Select the Reference Surface layer in the Subset Editor tab. 

5. Select the BASE Surface Depth layer from the Select Surface file tree in 
the Properties.

6. Click Load.

When the surface is loaded, the Surface Filter button on the 
Subset Editor toolbar is activated.
7. Select the Surface Filter command.

The Surface Filter dialog box is displayed. 

Subset
2D slice

BASE surface

Surface Filter 
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Once you select the surface in Reference Surface, it is selected in 
the Filter dialog box and cannot be changed.
8. Select the Threshold Type from the drop-down list: 

• Standard Deviation 
• Uncertainty
• Greater of the two
• Lesser of the two.
• Static Value

9. Set the desired Threshold value. 

• For standard deviation or uncertainty thresholds, the value entered 
will show the confidence interval next to the field.

• Static values are entered in units set in Tools > Options > Display > 
Units > Vertical units, e.g., metres. 

10.Select the Include data previously rejected ... check box to include 
rejected data when running the filter.

11.Select the Reject soundings that do not fall on the surface check box to 
reject soundings that are offset from the surface.

12.Select Filter Slice to filter only the soundings within the subset slice, or

13.Select Filter Full Subset to filter all the soundings within the subset 
bounding box. 
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14.Click OK to apply the filter.

For description of applying surface filtering to an entire BASE 
surface, see “SURFACE FILTERING” ON PAGE 244.
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Create Product Surfaces

Create product surfaces from finalized BASE surfaces. Product surfaces 
maintain the designated soundings from the finalized BASE Surface and 
can be used to create more cartographically correct contours. Product 
surfaces can also be created from tile layers.

Use product surfaces for building contours, sounding selections, profiles, 
and other data layers. 

In this chapter...
PRODUCT SURFACES.................................................. 356 
CONTOURS ............................................................... 361
PROFILES ................................................................. 367
SOUNDING SELECTION ................................................ 383
COLOUR OPTIONS FOR SOUNDINGS AND CONTOURS ........ 394
TILING A FIELD SHEET.................................................. 396
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Product Surfaces
A Product Surface is a shoal-biased surface that can be used for 
creating more cartographically correct contours for navigation 
aids (for example, Electronic Navigational Charts). 
The Product Surface is created from a finalized BASE surface, t 
is down-sampled so that some of the finer surface details are no 
longer visible, while the shoals are preserved. This surface can 
be used to directly generate contours and selected soundings 
(instead of generating contours or selected soundings from tiles).

Process
A Product Surface is created through the process of 3D Double 
Buffering. This process smooths the surface to reduce clutter 
and highlight significant shoals. 
Double buffering is like rolling a ball over the surface at an 
interval determined by the surface’s node resolution. The radius 
of the ball is determined from the chart scale (radius = 1/100 of 
chart scale). As the ball is rolled over the surface, the surface is 
smoothed, but the shoals are retained.

Defocusing 
This optional process can also be applied to the generalization 
process. Defocusing spreads each shoal depth over an area 
defined by the horizontal error. The process uses an ellipsoid of 
rotation around each node with the horizontal error as the semi-
major axis. Nodes within the ellipse are adjusted up to the 
surface of the ellipse. 
In the following image, the webbed surface overlaying the BASE 
Surface represents the Product Surface area after defocusing 
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has taken place. The shoals are preserved, but without the 
sharply defined detail of the original BASE surface.
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Create a Product Surface
1. To create a Product Surface from a finalized BASE surface: 

Open the BASE surface.

2. Select the BASE Surface layer in the Layers tab.

3. Select the New Product Surface command.

The Generalize Surface dialog box is displayed. 

The path and filename of the selected BASE surface is displayed 
at the top of the dialog box. 
4. [Optional] Select one or more attribute layers to add to the Depth layer 

in your product surface. 

5. Type a name for the new product surface in the Output field. (The file is 
saved to the same field sheet directory as the BASE surface.) 

6. Type the scale ratio that best suits the type of chart.

The scale of the Surface should match the scale of the product 
being created. For example, if you are creating a Product Surface 

M
en

u Process > BASE 
Surface > Product 
Surface
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up Product Surface
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that is going to be used for an ENC approach to a harbour, then 
use the appropriate scale for an approach.
The scale determines the radius used for generalizing the 
contours of the Surface. The Radius value changes as the Scale 
value is changed.
The Resolution value sets the node spacing of the generated 
Product Surface.
7. Type a Resolution value, if needed.

8. [Optional] Select Surface Defocusing to implement this option.

The defocusing operation requires you to apply a horizontal 
error value. This value must be derived from the errors values 
associated with the data. 
9. Type a Horizontal Error value.

10.Select the Reapply Designated Soundings check box to make sure that 
designated soundings are applied to the surface.

11.Click OK.

When the Product Surface is created, it is listed in the Layers 
tab and shown in the Display window. 

Also created is a Generalized layer which displays the nodes 
that were affected during the product surface-creation process.
• Nodes that have been modified are given a status flag of 1.
• Nodes that retain their original values are given a status flag 

of 0. 
The status of the nodes is displayed in the tool tip, as illustrated 
below, which shows Generalized = 1.
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In this example, the filter in the Properties for the 
Generalization layer has been set to show only the nodes which 
have been modified by the Product Surface. These are displayed 
as red dots in the example above.
When you create selected soundings from the Generalization 
layer, you can use SQL-type filters to omit nodes that have been 
modified. See “ENABLE FILTER” ON PAGE 390.
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Contours
Contours can be generated from a Product Surface, a finalized 
BASE surface or a tile layer. 
Contour smoothness is related to the amount of detail in your 
depth source. A finely detailed depth source will result in 
rougher contour lines. For smoother contour lines, use a 
smoothed Product Surface as a source for contouring. 
You can label contours with depth values, adjust the size and 
colour of contours, and mask the lines behind the contour label.

Create Contours 
1. Open a project and a field sheet containing a BASE surface.

2. Select the field sheet layer in the Layers tab. 

3. Select the New Contour Layer command.

The Contour Wizard - Step 1 dialog box is displayed. 

4. Expand the layer tree and select a tile, Product Surface or BASE 
Surface attribute layer to be the height source for the contours. 

5. Click Next.

The Contour Wizard - Step 2 dialog box is displayed.

M
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u Process> Products > 
Contours > New 
Contour Layer
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At this step you enter the intervals for standard and index 
contours. You can create contours at regular intervals, or you 
can load a file listing specific depths at which to create the 
contours. 
The dialog box displays the Range of depth values derived from 
the contour source (BASE Surface, bin or tile). You can contour 
over this entire range, or limit contouring to a specific range of 
values.
The depth intervals you set are saved in the project field sheet 
directory as ContourLayerName_DepthList.txt.
1. [Optional] Type the Minimum depth level for the contour interval.

2. [Optional] Type the Maximum depth level for the contour interval. 

3. Type an Interval value to set the distance between contour lines.

4. Click Add.

The contour depths are listed. As you change the Interval value, 
the number of contour depths will vary accordingly.
5. If you are satisfied with the values, click Next.

Contour levels file Contour levels files, or depth list files, are text files that set a 
range of depths for tiling and contouring data, where values are: 
• negative when representing heights above the datum, and 
• positive when representing depths below the datum. 
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These files are automatically generated during the contouring 
process. You can use a contour levels file to set the values for 
contours. 
6. Click the browse button and select a contour levels file.

7. Click Load.

The contour depths are listed. You can edit these values using 
the commands on the pop-up menu.
8. Right-click in the depth values list, and select a command.

• Insert: manually add a specific depth value. It will be added to the 
list in order. 

• Delete: deletes the selected value. You can select multiple values.
• Save: saves the values as a contour levels text file.
• Clear: removes all the values from the list. (Clicking Clear will do 

this also.) 

Index Contours Index contours visually emphasize certain contour levels, for 
example, every 5th contour. These index contours are optional. 
To create index contours:
1. Select the Index Contours tab.

2. Select the Enable check box.

This activates depth list fields identical to those in the Standard 
Contours tab. Follow the same process as for standard contours, 
however, enter a larger interval value.
• For example, to index every 5th contour where contours are 

every 5m, set the interval for indexing to 25m.
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3. Click Next. 

The Contour Wizard - Step 3 dialog box is displayed.
You can save the contours as a field sheet layer or save the 
contours to a new or existing HOB file.
1. Select either the Contour to Field Sheet option or the Contour to HOB 

File option. (See “CONTOUR TO HOB FILE” ON PAGE 364.) 

Contour to field sheet The next step is to describe the various CARIS attributes for the 
new contours.
2. Enter the following information for standard and index contours:

• Name
• Theme Number
• Feature Code

3. Click Finish.

Contours are created for the selected field sheet and shown in 
the Display window. The standard and index contours are listed 
in the Control window.

Contour to HOB file If you selected the Contour to HOB option, the dialog box is 
refreshed to display the Contour Wizard - Step 3 (HOB) dialog 
box.

1. Click Browse […] and select an existing HOB file, or type the path and 
name for the file. You can also enter the name of a new file.

2. Click Finish.

The contours layer has now been added to the existing HOB file, 
or a new file with contours has been created. The contours can be 
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viewed in the Display window by choosing the File Open 
command and selecting the HOB file.

Contour Labelling
You can label contour lines with their associated depth values. 
You set the path for the labels by drawing a line across the 
contours where you want the depth values to appear. Labels are 
added at the point where the line intersects the contours.
1. Select the Contours layer in the Layers tab of the Control window.

2. Select the Add Labels command.

Your cursor changes to a digitizing tool so that you can set the 
path for the labels.
3. In the Display window, click on the part of the field sheet where you 

want to start the line and drag the cursor to the part of field sheet where 
you want the line to end. 

Labels are now added to the contours.
You can change the size and colour of contour labels. To set the 
size of the labels in mm, 
1. Select the contour layer.

2. Select Set Label Size from the pop-up menu. 
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Drag the cursor along the 
line where you want the 
labels to appear.

l
 Release the mouse button and 
the labels are added along the 
path of the line.
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3. Type the new value in mm.

4. Click OK.

The colour of the labels can be changed from the default (black) 
by checking the Override Colour option in the Properties window 
and selecting a colour from the drop-down menu.
Labels can also be removed from the display. 
1. Select the Remove Labels command.

Masking Lines Behind Contour Labels
Concealing the part of the contour line behind a label can make 
a map area easier to read.

To mask the area behind contour labels: 
1. Make sure all previous work is saved.

2. Select the Contour Masking command.

The parts of the contour lines that intersect the labels are now 
hidden.
This masking process can be reversed with the Unmask contours 
command.
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Profiles
Use the Profile command to draw a cross-sectional view of a 
height source, such as a BASE Surface attribute layer. 
Profile graphs are created from a line digitized on a surface, 
either manually drawn or along a superselected trackline.
A profile is graphed in a dockable window, and can be viewed in 
real time as the profile is digitized or edited. Profile lines can be 
edited, and exported as an image or to an ASCII file. 
Profiles are saved as field sheet layers.

Digitize a Profile
Creating a profile by digitizing a line involves these basic steps:
• select the field sheet containing the surface
• select layers to profile
• [Optional] set options for the graph display
• digitize the line across the surface
To create a profile:
1. Select the field sheet layer containing the BASE surface to be profiled.

2. Select the Profile by Digitizing command. 

The Profile Settings dialog box is displayed.M
en

u Process > Products 
>Profile > By 
Digitizing
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up New >Profile



368 CARIS HIPS and SIPS User Guide

Create Product Surfaces: Profiles

.

In this dialog box you can set all the options for the profile, or, 
you can select one or more height sources, generate the profile, 
then re-open this dialog box to adjust settings while viewing the 
effect in the Profile window.
3. Select the height source check box for the layer(s) you want to profile. 

You can select more than one layer as height sources for the 
profile. Each source that you select will generate its own profile 
line in the graph. Lines with the same values will overlap.
4. [Optional] Set a Sample step size. Default value is 5m.

5. Set other options as desired. (See “SETTING PROFILE OPTIONS” ON 
PAGE 370.) 

6. Click OK.

The Profile window opens and displays the message “Empty 
profile line”. 

Digitize the profile line: The cursor changes to digitizing mode.  
7. Click once on the surface to fix the anchor point for your profile line.

8. Click to add a series of points to define the line.

The profile line is automatically drawn between the points. The 
Profile window dynamically displays the profile as you add more 
points to the digitized line.
9. To remove points before the line is completed, right-click and select 

Remove Last from the pop-up menu. Repeat as needed. (Points can 
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also be removed from a completed line in Edit mode. (See “LINE EDITING 
OPTIONS” ON PAGE 376.)

10.Click the Enter key to complete the line, or right-click on the line and 
select End line from the pop-up menu.

The Profile is displayed in the Profile window. The example 
below shows the profiles on different height sources, generated 
by the same digitized line. The dots in the graph represent the 
digitized points of the line. 

Create Profile by Superselection
You can create a profile that follows a superselected line, such as 
a track line. The line must fall within the bounds of a field sheet. 
To create a profile for superselected track line: 
1. Open the field sheet layer containing the BASE surface to be profiled.

2. Select the ShipTrack Lines layer in the Layers tab.

3. Select a track line. 

4. Select the Profile by Superselection command. 

5. In the Profile Settings dialog box, select the height source check box 
for the layer(s) you want to profile. 

You can select more than one height source for the profile. Each 
layer that you select will have its own profile line in the graph. 
Lines with the same values will overlap.
6. [Optional] Set a Sample step size. Default value is 5m.

A profile drawn on three layers 

Depth 

Deep

Shoal

M
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>Profile > 
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7. Set other options as desired. (You can also generate the profile and 
then re-open this dialog box to adjust settings.)

8. Click OK.

The Profile is displayed in the Profile window. 

Setting Profile Options 
Profile options are set in the Profile Settings dialog box. You can 
set options here before you create your line, or use this dialog 
box to adjust or edit the settings for an existing profile.
To open the Profile Settings dialog box:
1. Select the Profile layer in the Layers tab.

2. Select the profile line in the Display window. 

3. Right-click in the Profile window, and select Settings from the pop-up 
menu.

The Profile settings box is displayed. 
• If you are setting options for a new profile, set the options and 

click OK, and draw the line. 
• If you are changing or setting options to an already digitized 

profile, click Apply to dynamically see the effect of the option 
in the Profile window.

Profile colour Use the Colour field to assign a different colour to each line 
graphed in the Profile window. 
1. Highlight a layer in the Height sources list. 

The Name field is automatically populated with the name of the 
surface and the layer you selected (e.g., SurfaceName - 
LayerName). You can edit this name.
2. [Optional] Replace the automatically generated name. 

3. Select a colour from the colour picker. (Default colour is black.)

4. Repeat to assign a different colour for each profile. 

Graph labels 5. Enter a Title for the profile graph.

The vertical axis in the graph shows the attribute values from 
the surfaces. The horizontal axis is always distance along the 
profile. 
6. Enter a Vertical axis label for the profile graph.

Sample step size The Sample step size field controls the frequency with which the 
surface is sampled. HIPS samples the data at the specified 
interval and uses it to draw the profile line between the digitized 
points. The smaller the step size, the more detail in the profile. 
7. Enter a value for Sample step size.
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Fill The Fill type option allows you to colour the profile according to 
the elevations in the data. You have the option of applying the 
colours horizontally or vertically. 
This is an example of a profile with vertical fill. 

8. Select an option from the Fill type drop-down list. 

Smooth The Smooth option allows you to smooth the profile line in the 
profile graph. Smoothing is applied reduce the number of peaks 
in the graph if it has a high number of sample points. The 
number of sample points is based on the Sample step size setting. 
There are three types of smoothing to choose from:
• Average: This method will create the graph using the average 

elevation values within each sample distance.
• Shoal: This method will create the graph using the shoalest 

values within each sample distance. 
• High/Low: This method will create two lines in the graph; one 

for the minimum values in each sample distance and one for 
the maximum values in each sample distance. 

Below is an example of a profile with and without shoal 
smoothing applied.

Depth 

Deep

Shoal
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9. Click the check box to enable the Smooth option.

10.Select a smoothing type from the drop-down list. 

Optionally, you could apply smoothing to the digitized line. See 
“EDIT THE PROFILE LINE” ON PAGE 375.

Lock aspect ratio Use Lock aspect ratio option to maintain the ratio of the width of 
the profile graph to its height, if the Profile window is re-sized. 
11.Click the check box to enable the Lock aspect ratio option.

The current ratio of the graph will be displayed in the aspect 
ratio field. 
12.[Optional] Enter a new ratio value for the graph.

With Shoal Smoothing

Without Smoothing

The settings for Vertical axis label, Fill type, Smooth and Lock 
aspect ratio will be remembered the next time the dialog box is 
opened.
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Resize Profile window The size of the Profile window can be changed to provide a better 
view of the profile. As the window is re-sized, the view is 
automatically scaled and the axes values updated dynamically. 
• The vertical axis represents the height source of the profile 

and can be assigned a name in the Profile Settings dialog box.  
• The horizontal axis represents the length of the line feature 

being used to generate the profile. The unit of measure for the 
values on this axis are controlled by the Horizontal Length 
setting in Tools > Options > Display > Units. 

For information on re-sizing, see “DISPLAY, REPOSITION AND RESIZE 
WINDOWS” ON PAGE 25 of the HIPS and SIPS Reference.

Import Profile
Profiles saved in a field sheet in earlier versions of HIPS and 
SIPS may be listed in the Layers tree when the field sheet 
containing the surface is opened.
These profiles will be listed by name and can be viewed in the 
Profile window.
1. Right-click on the named layer, and select Display from the pop-up 

menu. 

2. In the Profile Settings dialog box, select a height source (and other 
options as desired).

3. Click OK.

The profile will be seen in the Profile window.
To import a profile in ASCII format:
1. Select the field sheet layer containing the surface to which you want to 

import the profile. 

2. Select the Import Profile command.

The Import Profile Layer dialog box is displayed.M
en

u Process > Products 
>Profile > Import 
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3. Click Browse to select the ASCII file containing the profile to import.

4. Type a Profile Layer Name. The default name is Profile1.

5. Type a Theme Number. The default is 1.

6. Select the View Type: X,Y or Latitude, Longitude. This value should be 
the same as the type set when the profile was exported to the ASCII 
file.

The File View field shows the contents of the ASCII file, which 
you can scroll through. To skip extraneous content in the file, 
you can set where the data begins.
7. Set a value for the number of lines from the top that should be 

disregarded when the file is imported.

8. Click OK. 

The imported profile will be listed as named under the field 
sheet in the Layers tab. It can now be viewed, edited and 
exported as any other profile.
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Edit the Profile line
Profile lines are saved with the field sheet in the Profile layers. 
Edits which can be done on a profile line include: 
• add, remove or move points to change the path of the line 
• move the entire line to see the profile on a different part of the 

surface
• rotate the entire line around a selected point 
To edit a profile:
1. Select the child Profiles layer in the Layers tab.

2. Select the profile line you want to edit in the Display window.

3. Select the Edit profile command.

The profile line is placed in edit mode. Square vertex markers 
show the points which digitized the line. 
If you hover your cursor over the line, the cursor will change 
shape to indicate the edit function that you can perform. 
When the cursor is over a point it looks like this: 
In the image below the cursor shape indicates it is ready to edit 
the line, for example, to drag the entire profile line to another 
position in the Display. 
 

(The black lines are the previous positions of the profile line. 
When the Display is refreshed, these lines will disappear.) 
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Line Editing Options

Edit Function Procedure 
Cursor 
changes 
to: 

Add a point to 
the profile line

1. Select the profile line. 
2. Press and hold the <Ctrl> key. 
3. Move the cursor to the place on the where you 
want to add a point. 
4. Click once. 

Reposition a a 
point on the line

1. Select the profile line. 
2. Click on the point you want to move. (The 
cursor changes shape and the selected point 
square turns red.)
3. Drag the point to its new location. 

Move an entire 
profile line 

1. Select the profile line. 
2. Move the cursor over the line until the cursor 
changes shape. 
3. Drag the line to a new location. 

 

Rotate a profile 
line around a 
selected point

1. Select the line 
2. Select a point on one of the lines. (The point 
turns red.)
3. Hold down the <Shift> key.
4. Move the cursor over the line until the cursor 
changes shape. 
5. Click then drag to rotate the line around the 
selected point. 

  

Delete a point 1. Select the profile line. 
2. Select a point. (Selected point square will turn 
red.) 
3. [Optional] Press <Ctrl> and click on other 
points to select them. 
4. Press <Delete>, or right-click and select Delete 
from the pop-up menu. 

Redigitize parts 
of the profile line 

 1. Select the line. 
2. Select a point at either end of the line or on a 
specific point within the line.
3. Right-click on the line and select Redigitize 
from the Edit Line pop-up menu. 
(The cursor changes to the line digitizing shape.)
4. Click to a point, then continue to digitize. 

Shorten or 
extend a line 

1. Select the line. 
2. Right-click on the line and select Trim/Extend 
from the pop-up menu. 

To trim a line, do one of the following: 
•Click on the line at the point you want to shorten 
it to, OR 
• Click on the end point and drag it back along the 
line to the desired length.

To extend a line, drag an end point out to a new 
location. 
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Remove Profiles
Profile lines in the Profiles layer can be removed from the layer 
if necessary.
To remove a profile line:
1. Select the Profiles layer in the Layers window.

2. Select the profile line you want to remove in the Display window. 

3. Select the Remove Profile command.

The profile line is removed from the display and the profile 
graph is removed from the Profile window.

Export Profiles
To save profile information to use in another project, you can 
export the profile to an ASCII file or as an image to various 
formats. 
See “EXPORT PROFILE TO ASCII” ON PAGE 377 and “EXPORT PROFILE TO IMAGE” 
ON PAGE 380 for more information.

Export Profile to ASCII 
Use the ASCII Export option in the Profile window pop-up menu 
to export profile lines to ASCII files.
To export to ASCII:
1. Right-click the Profile graph in the Profile window. 

2. Select the ASCII Export command.

The Export Profile to ASCII dialog box is displayed.

M
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u Process > Products > 
Profile > Remove
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Destination If you have created a profile line on multiple layers, you have the 
option of exporting the profile as one file or to one file for each 
layer.
To export to a single file:
3. Select Single File and click Browse to select the destination folder. 

4. Type a name for the file.

When you export to multiple files, the ASCII files will be named 
with a combination of the surface name and layer name. You can 
add a prefix to the file name. The format of the filename with 
this option enabled is:

Prefix-SurfaceName - LayerName.txt
5. Select the Multiple Files output option.

6. Click Browse (...) to select the output folder. 

7. [Optional] Enter a Filename prefix to add to each file name.

Coordinates By default, the Geographic (Lat/Lon) - WGS84 coordinate 
system is set as the coordinate system for the output. 

8. [Optional] Click Browse (...) to select another output coordinate 
system. 

9. Select an option from the Units drop-down list.

If you change the coordinate system here, the new system will be 
set the next time the Export to ASCII command is used.
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10.Select a Precision value to define the number of decimal places to 
apply to the exported coordinate values. 

11.Use the Order drop-down list to specify the order of the coordinate 
columns in the output file, e.g., Long/Lat or Lat/Long. 

Output type The ASCII file will contain the depth values at specific points 
along the profile and the locations of those points. Depending on 
the Output type selected, the locations may be reported as 
distances from the start of the profile (in metres, feet, etc.), or as 
geographic coordinates.
12.Select an Output type option.

If exporting locations as Distances, you can also define the 
number of decimal places to apply to the distance values. 
13.Select a Precision value for the Distances field.

You have the option of exporting depths at all control points in 
the profile, or at a sampling of points. 
• The Control points option exports depth values at the points 

that were digitized to create the profile line. 
• The Sampled points option selects points at a specified 

interval and exports the values at those locations. 
14.Select a Point sampling option.

15.[Optional] If exporting sampled points, enter a value for the Interval 
between points. 

The Interval setting defaults to the Sample step size setting of 
the profile graph, but you can export sampled points at a 
different interval if desired. 
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The profile was created using attribute values from the selected 
source layer, e.g., Depth. You can define the precision for these 
values as well as the Z-axis convention to use in the output. 
16.Select a Precision value to define the number of decimal places to 

include in attribute values. 

17.Select the Z-axis convention to use in the exported values. 

18.Click OK to perform the export.

The data in the Profile window is exported to an ASCII file. 
Header information includes:
• The name of the profile line.
• The coordinate projection of the data.
• The unit of measure for the attribute values.
• The Z-axis convention of the data.
• The unit of measure for distance values.
• The start and end coordinates of the profile line.
• The headings for the column order.

Export Profile to Image
Use the Image Export command in the pop-up menu of the 
Profile window to export an image of the current profile graph. 
The profile image can be exported to:
• PDF (Portable Document Format)
• PS (PostScript)
• SVG (Scalable Vector Graphics)
• TIFF (Tagged Image File Format)
To export an image of the profile graph:
1. With the profile displayed, right-click the Profile window and select 

choose Image Export from the pop-up menu.

The Export dialog box is displayed. 
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Use the Export dialog box to define the settings for exporting the 
image. The example above displays the options for export to 
TIFF format.
2. Type a File Name for the image file. 

3. Click within the Output Directory field to enable the Browse (...) button. 

4. Click Browse and select a location for the exported file.

5. Select the Output File Format from the drop-down list.

Once you select a format, specific options for that format are 
displayed in the lower section of the dialog box. 
6. [Optional] Enter or select a value for the options as needed.

Export options  

PDF and PostScript options

Paper size Set the page size of the exported file.

Width/Height Set the width and height of the histogram in the resulting file.

Data Orientation Set the orientation of the histogram in the resulting file. 
Portrait is a vertical position; Landscape is a horizontal 
position. Landscape is selected by default.

Margins Set the width of the area between the histogram and the 
edge of the file. The default is 5mm. 

Image Export DPI 
(Quality)

Set the resolution used to export the histogram. The higher 
the resolution, the better the quality of the image when 
zoomed in. 

If the file will be used in the electronic form with the image 
being zoomed in tightly, a higher resolution is recommended. 
If the file will simply be printed, a smaller resolution is 
adequate.
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7. Click OK.

The image file is saved to the specified location.

SVG format options

Width/Height The width and height of the histogram in the resulting file.

Image Export DPI 
(Quality)

Set the resolution used to export the histogram. The higher 
the resolution, the better the quality of the image when 
zoomed in. 

If the file will be used in the electronic form with the image 
being zoomed in tightly, a higher resolution is recommended. 
If the file will simply be printed, a smaller resolution is 
adequate

TIFF format options

Image Resolution  The resolution (quality) at which to export the image. The 
higher the resolution, the closer the image can be zoomed, 
but the larger the file. 

Width/Height 
(Pixels)

Set the width and height of the resulting image in pixels. 
These fields are controlled by the resolution of the image. As 
the DPI is increased or decreased, so is the number of 
pixels. 

Image Depth Set the number of values applied to each pixel in the image 
(one value for each colour, plus one for transparency if using 
32 Bit). 

If you would like a transparency setting applied to the 
background colour, the 32 Bit (RGBA) option must be 
selected.

Background Colour The colour displayed in the background of the histogram. 
The default is black.

Background Alpha (This option is only available when the Image Depth is set to 
32 Bit RGBA).

Set the degree of transparency applied to the background 
colour. The default setting is zero transparency. 

Compression Compress the resulting image file during export to decrease 
the file size. This option is only available when using the TIFF 
format. There are various compression methods available, 
each of which performs differently. By default, LZW is used.
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Sounding Selection
 Survey data contains so many soundings that they cannot all be 
displayed legibly on a chart or map. HIPS enables users to make 
a meaningful selection of soundings to be displayed. 
A selection of soundings is created as a sub-layer of a field sheet. 
The sounding selection is generated from a tile or BASE Surface 
attribute layer. The selection mechanism is shoal- or deep-
biased and allows control over the final density of the selected 
sounding layer. The sounding layer can be written to a CARIS 
file or to a Hydrographic Object Binary (HOB) file.
This process does not physically remove the soundings from the 
HIPS file. It merely determines which soundings are displayed. 
You can colour code the selected soundings according to depth, if 
necessary. See “COLOUR OPTIONS FOR SOUNDINGS AND CONTOURS” ON 
PAGE 394.
To create a layer of selected soundings:
1. Open the field sheet containing the tile layer or BASE surface. 

2. Select the Selected Soundings command.

The Sounding Selection Wizard is displayed.

Select Height Source

M
en

u Process > Products 
>Selected Soundings 

Po
p-

up New > Selected 
Soundings…
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The Selected Soundings function uses tile layers (including bin 
layers) and BASE Surface attribute layers as data sources.
From the chosen layer, one value from each tile/bin or attribute 
layer node is used to represent all of the soundings from that 
cell. In the case of a bin layer, there is only one value present, so 
it is used. In the case of a tile layer, each tile contains a number 
of attributes and a primary sounding. The primary sounding is 
the value that is used in the Selected Soundings operation.
3. Select a BASE Surface attribute layer or tile layer. You can view all 

layers by clicking the + icon to expand the file tree.

4. Click Next.

Selection Criteria
The settings in this dialog box determine the density of the 
selected soundings in the layer.
 

Selection is based on two main options:
• a sounding criteria method (e.g., radius or overplot removal) 
• a conflict resolution method (shoal bias or deep bias)

Selection criteria You can apply one of three methods for sounding selection: 
• All: selects soundings from: 

• node values from the BASE Surface attribute layer 
• the primary sounding from every tile
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• the sounding stored in every bin
• Radius: selects only the (shoal or deep) soundings within a set 

distance 
• Overplot Removal: selects only certain soundings in a dense 

data set so that they can be plotted within the field sheet 
without overlapping.

Conflict resolution You can set whether the shoalest soundings or the deepest 
soundings will be included when conflicts are encountered 
during selection. For example, if you select Shoal bias, and two 
soundings overlap, the shoalest of the two will be selected.
1. Set either Shoal Bias or Deep Bias as the method of resolving any 

conflicts during the selection process. 

2. Select one of the three criteria from the Selection Criteria drop-down 
list.

If you select Radius or Overplot Removal, the dialog box will display 
the options associated with those criteria.

Template Settings in the wizard can be saved to a Sounding Selection 
Template (CSST) file. This file can be opened and reused.
3. Select the Use template option to open or create a template file that 

contains sounding selection options.

4. Select Load to open an existing template file, or 
select Save to create a new template file from the options you are 
setting in the wizard.

5. Click the Browse button to open a file, or create a new file.

6. Click Next.

Radius
If you choose Radius as your selection criteria, the following 
option fields are displayed:
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The radius value you set (either as a specific value or from a 
radius table file) will either be applied as metres on the ground, 
or as the number of millimetres between soundings at map scale. 
Once you have set how the radius value will be applied, you can 
either set the same interval value to be applied to each radius, or 
have varying values applied from a radius table file. 
For example, if you selected Shoal bias, and set a single-defined 
radius of 5, then only the shoalest sounding within each 5m 
radius on the ground, or within 5mm at map scale, will be 
displayed.

Sounding Radius Table A radius table sets the minimum radius between soundings for 
various depth ranges. Each depth range will have its own radius 
value. 
The sounding radius table is a text file containing three 
columns: 
• minimum depth of the range
• maximum depth of the range
• radius value for the depth range.
For example, using the example radius table below, 8m 
soundings would be a minimum of 1mm apart at map scale, 
while 80m soundings be 10mm apart.. 

1. Set the Radius Value. 
• Select distance on the ground (m), or 
• Select mm at map scale, and type a scale value in the Map Scale 1: 

field (default is 1:10000). 

2. To set a standard minimum distance between soundings, select the 
Use single defined radius and enter the interval. 

3. To use a radius table to set the minimum distance between soundings, 
select the Use radius table file option and click Browse to select the 
file. 

4. Click Next.

Min depth Max depth Radius value for 
range

0.0 10.0 1.0

10.0 20.0 2.0

20.0 50.0 5.0 

50.0 500.0 10.0
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Overplot Removal
If you choose the Overplot Removal option from the Selection Criteria 
list, the dialog box is refreshed to show the following options.

Overplotting occurs when soundings overlap or are so close 
together that they are plotted on top of each other. Two 
soundings with depths of 11 and 22 might look like 1212 if they 
were overplotted. 
Overplot Removal places a buffer zone around each sounding, then 
suppresses either the deepest or shoalest soundings which 
overlap these buffer zones. 
5. Type the map scale for the selected soundings (default is 1:10000).

6. Type the size of the soundings (that you want them to appear in the 
Display window) in the Sounding Size field.

7. Select a Sounding Rounding Rule from the drop-down list. Click Next.
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Output Selection
Use this dialog box to set the output format options for the 
selected soundings. 
 

The soundings can be exported to two formats: CARIS map or 
HOB file. The CARIS map file is opened as a layer in your 
currently open project. The HOB file is stored in the same 
directory as the field sheet. The default directory is 
..\Hips\Fieldsheets\ProjectName. 
“OUTPUT TO CARIS MAP” ON PAGE 388

“OUTPUT TO HOB FILE” ON PAGE 389

Output to CARIS map 
To display selected soundings in HIPS:
1. Select the Output to CARIS Map command.

2. Type a name for the layer in the Layer Name field.

The Theme Number is used to organize information in the CARIS 
file. It is important to maintain each layer on a separate theme, 
therefore be sure to change it from the default number each time 
you create a new sounding selection.
3. Type a number in the Theme Number field.

Soundings can be displayed in two formats.
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• Slanted: This format displays the digits of the sounding in a 
slanted font with any value less than 1 in subscript.

• Engineer Soundings: This format 
displays the digits of the sounding in 
regular text with values to the right 
of a decimal point where appropriate.  

4. Select either Engineer or Slanted sounding 
styles from the drop-down menu.

The Add Extended Attributes option adds useful additional 
information to each sounding. The Add Keys option gives each 
sounding a unique identifier or key. This key provides a link 
back to the original sounding in the HIPS file and is required to 
open a specific sounding in the HIPS Swath/Single Beam or 
Subset Editors.
5. Select the Add Extended Attributes option if you want to include time 

stamp, launch ID, accuracy value, and tidal reduction value with the 
soundings.

6. Select the Add Keys option to give each sounding a unique identifier. 
The key format is XXXPPPPPBBB where XXX is a random value, 
PPPPP is the profile number and BBB is the beam number.

7. Click Next. 

Output to HOB file
A HOB file contains S-57 feature objects. Attributes to help 
identify the soundings are also included in the HOB file. The 
wizard enables you map these attributes to corresponding  S-57 
attributes. 
1. Select the Output to Hob File option.

2. Click Browse to select a directory and a name for the HOB 
file.

3. Click Next. 

Slanted Engineer
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Enable Filter  

The Enable Filter option allows you to extract and display only the 
soundings that meet the conditions you set for the filter. 
1. Select the Enable Filter check box.

2. Use a combination of attributes, operators and values to construct your 
filter. 

3. Use the Backspace key to delete a character or Clear to remove the 
entire filter string

For example, to display only the soundings with a Depth less 
than 10 metres, and a hypothesis count of 2: 
• Double-click on Depth in the list of available Attributes to place 

it in the filter field. 
• Click the “<” button, and type 10. 
• Click the and button and double-click on the 

Hypothesis_Count attribute.
• Click the “=“ button, and type 2.
HIPS and SIPS will automatically adds the necessary spaces 
between the parameters in the filter string. However, if you 
choose to type the filter parameters into the filter field, you must 
manually add those spaces. 
4. Click Next if a HOB file is your output, or click Finish if you selected 

CARIS Map in Step 3.
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HOB S-57 Options 
When sounding selection output goes to a HOB file, the process 
generates S-57 SOUNDG objects. These can have certain 
attributes populated.
Use the options on this dialog box to automatically enter 
information into SORIND and RECDAT attribute fields, and to 
map BASE surface attributes to specific S-57 attributes.
 

Auto Populate SORIND 
and RECDAT 

These attributes can be automatically populated:
• SORIND (information about the source of the sounding) and
• RECDAT (date the object was captured, edited or deleted).
1. [Optional] Select the Auto Populate SORIND and RECDAT check box 

to have information on these attributes automatically added to the 
soundings in the HOB file. 

S-57 options The other S-57 option is to map the BASE surface attributes to 
S-57 attributes, via a translation file. The translation file has a 
BSST file extension and is in XML format. The No Attribute 
Translation option is set by default. 
To continue without mapping any attributes:
1. Click Finish. 

Note: auto populating the SORIND and RECDAT attributes 
can increase save and export times as well as file size, 
particularly with large, high-density data sets.
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Translation file To use a translation file to map attributes:
1. Select Translation File.

2. Click Browse to select an existing BSST translation file (or to specify a 
name for a new translation file).

3. Click Edit to set the mapping for BASE surface attributes to S-57 
attributes.

The Edit Translation File dialog box is displayed.

1. Select a BASE surface attribute from the Available Attributes list. 

2. Select an appropriate S-57 attribute from the drop-down list. 

If no mapping is possible between the selected attribute and the 
chosen S-57 attribute acronym, “No conversion available” is 
displayed.
If conversion can be applied, the dialog box will display the 
available values that can be mapped. 
HIPS attributes of Integer data type, may be appropriate to map 
to S-57 attributes, using a conversion formula. A conversion 
formula is created by inserting values and appropriate 
mathematical operators into the Conversion area, as in the 
example below. 
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To create a conversion formula, for example, to map Std_Dev to 
SOUACC, (sounding accuracy attribute):
1. Click Value to use the value of the selected BASE surface attribute in 

the conversion formula. 
• This places the <value> variable in the formula window.

2. Insert mathematical operators using the +, -, x, / buttons.

3. Type the numeric value by which to adjust the original value, if needed.
• In this example, adjust the original value by adding 3.5.

4. Click Test to see the formula.

5. If you want to erase the formula, click Clear.
6. Click Reset to remove the mapping of BASE surface attribute to S-57 

attribute.

7. Click OK to save the mapping settings and return to the HOB S-57 
Options dialog box.

8. Click Finish. 

Selected soundings are saved to the HOB file, as SOUNDG 
features. The original BASE surface attributes, e.g., Std_Dev, 
are converted to the S-57 attributes to which they were mapped. 
In the example above, the Std_Dev value was 10. In the HOB 
file, this is translated to a Sounding accuracy of 13.5. 
View the HOB file using the Open Background data command. 
The values mapped to the SOUACC attribute are displayed in 
the Sounding accuracy column in the Selection tab, when the 
soundings are selected and queried. See also “VIEW SOUNDINGS IN 
HOB FILE” ON PAGE 51 in the Reference Guide. 
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Colour Options for Soundings and Contours
The Colour Table Editor lets you colour code soundings and 
contours for easier display and interpretation.
1. Select a sounding or contour layer in the Layers tab.

2. Select the Edit Colours command from the right-click menu.

The Colour Table Editor dialog box is displayed.
.

Single colour Use this option to display a soundings or contours in a single 
colour.
3. Select the Single Colour option.

4. Select a colour from the colour picker, or create a custom colour from 
the standard Windows colour palette.

5. Click OK to save and apply settings.

Colour table To apply different colours to different depth ranges:
1. Select the Colour Table option.

2. Select a colour from the colour palette, or create a custom colour from 
the standard Windows colour picker.

3. Type a minimum range depth in the field beside the palette.

4. Type a maximum range depth in the next field

5. Click Insert Range.



CARIS HIPS and SIPS User Guide 395

Create Product Surfaces: Colour Options for Soundings and Contours

The colour and range values are displayed in the Colour Table 
dialog box.
6. Repeat Steps 2 to 5 to continue adding a colours for each range.

7. To remove a single colour range, select a range so it is highlighted and 
click Remove Range.

8. To remove all selected ranges, click Clear.
9. Click OK to save and apply settings.

The soundings or contours are colour-coded according to the 
range values you selected earlier.

Standard colour map Use this option to select a standard colour map.
1. Select the Colour Map option.

2. Select a colour map from the drop-down menu.

3. Type the minimum and maximum range values for the colour map.

4. Click OK to save and apply settings.

The layer objects are displayed according to the colour map 
settings.

Reverse colours Select this option to reverse the order in which the colour map is 
applied (see illustration below). 
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Tiling a field sheet
The tiling of a dataset allows for data points, in this case 
geographically referenced soundings, to be gathered into tiles 
depending on user-defined statistical criteria. Once the tiles 
have been created, products such as contours and selected 
soundings can be created using the tiles as a height source.
Generally, the tiling process splits a selected area into sections 
(tiles) and continues sub-dividing until a network of squares 
cover the data.
Below is an example of a tiled field sheet in the Display window. 
These tiles are all the same size.
 

A special type of tiling is used to track the progress of 
subset data cleaning, (see “TRACK PROGRESS WITH SUBSET TILES” 
ON PAGE 343) and for performing statistical surface cleaning 
on sounding data (see “STATISTICAL SURFACE CLEANING” ON 
PAGE 311).
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Tiling methods
There are three methods of tiling a field sheet: tiling, binning 
and QTC tiles. If you need to examine the data for more detailed 
statistical information then the tiling option should be selected.

Tiling The process divides the field sheet into four sections (tiles) and 
continues sub-dividing each section by four until the criteria for 
creating the tiles is reached. The result is a network of tiles 
covering the data. Tiles can be the same size or vary in size.

Binning Binning splits the surface of a field sheet into squares or “bins” 
based on a user-defined size. Within each bin, the shallowest or 
deepest sounding can be selected. This option is less 
computationally intensive than tiling as there are no additional 
statistical criteria applied.

QTC Tiles Sea floor classification is a procedure in which the amplitude 
and shape of the reflected acoustic signal is used to interpret the 
physical nature of the bottom. Quester Tangent Corporation has 
developed a program called QTC View to perform this analysis. 
The analysis in QTC View groups the return signals into classes 
which correspond broadly with physical properties of the sea 
floor. The results are summarized in a text file (.seabed). HIPS 
and SIPS generalizes these results by creating tiles based on the 
class values in the *.seabed files.

Create Tiles 
1. Open a field sheet.

2. Select the field sheet layer in the Layers tab.

3. Select the Tiling command.

The Tiling Wizard - Step 1 dialog box is displayed.M
en

u Process > Products > 
Tiles 

Po
p-

up New > Tiles
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4. Select the method of tiling. (In this example, Tiling is selected.)

5. Click Next.

The Tiling Wizard - Step 2 dialog box is displayed.
 

Tiling options This step is to define which of the tiling methods will be used to 
create tiles: tiling by size, by depth tolerance or by depth range. 
First, a minimum tile size must be set, since it is an important 
criteria in each of these methods.
6. Set the minimum tile size by clicking the arrow buttons. 

Next, select a tiling option from the following:
• Same Size For All Tiles: Set all tiles to the minimum tile size.
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This method will subdivide the data until all tiles are equal to 
the selected size. No other statistical criteria will be applied. 
The result will be equal sized tiles similar to the result from 
Binning, as illustrated below. 

• Tile by Depth Tolerance: This method makes use of two criteria: 
a tolerance value as well as the minimum tile size. 
The tolerance value entered here will determine the variation 
of depths allowed in a single tile. For example, if a value of 2 
is entered as the tolerance value, the tiles will be subdivided 
until all the depths contained in a single tile are within 2m of 
each other. 
The second criterion to be met is the Minimum Tile Size. If 
the first criterion is not met for certain tiles, the tiles will only 
be subdivided until they meet the Minimum Tile Size.
Illustrated below is a tile set created with a depth tolerance of 
2m and a minimum tile size of 1.28m.

• Tile By Depth Range: Uses range criteria as well as the 
minimum tile size. Based on the user-defined interval, the 
tiles will be subdivided until no tile crosses the specified 
depth interval. The subdivision will only take place between 
the specified starting and ending depths. However, if the 
depth range criterion cannot be met before the tiles met the 
minimum tile size, the subdivision of the tiles will stop. 
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This method allows for greater sampling at an interval 
change. Tiling by Depth Range can be applied by selecting a 
Depth Range file, or by entering a Range Interval, Starting 
Depth and Ending Depth. In the example below, a depth 
interval is set to 5m. 

7. Select a tiling option.
If you select Tile by Depth Tolerance, type the value to be applied.
:If you choose Depth Range File, click Browse to select the file. The 
tiles are created using the depths listed in the file. (See “DEPTH 
RANGE FILES” ON PAGE 409.)
If you select Tile By Depth Range Interval, type a value for the depth 
interval and for the starting and ending depths. 

8. Click Next.

The Tiling Wizard - Step 3 dialog box is displayed.

9. Type a name for the tile file.
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Primary sounding 10.Select a primary sounding as the starting point for the tiling process. 
Choose from five options:
• Minimum - True Position: Use the shoalest sounding at its actual 

position.
• Maximum - True Position: Use the deepest sounding at its actual 

position.
• Average - Tile Centre: Use the mean value of the soundings as the 

centre of the tile.
• Minimum - Tile Centre: Use the shoalest sounding as the centre of 

the tile.
• Maximum - Tile Centre: Use the deepest sounding as the centre of 

the tile.

You can also add other attributes to the tile set. These attributes 
(such as maximum depth, average depth, etc.) add to the value of 
the tile set as they can later be selected as the height source for 
the tile display or used to produce contours and selected 
soundings.
11.Choose other tile attributes by selecting an attribute in the Available list 

and clicking Add to move it to the Active list.You can move the attribute 
from Active list by clicking Remove.

12.Click Finish to complete the tiling process.

A progress indicator on the status bar shows how much of the 
tiling process has been completed. Once the tiling is completed, 
it is shown in the Display window and the tile layer is listed in 
the Control window.

Create Bins
1. Select the field sheet.

2. Select the field sheet layer in the Layers tab.

3. Select the Tiles command.

The Tiling Wizard - Step 1 dialog box is displayed.
4. Select the Binning option.

5. Click Next.

The Tiling Wizard - Step 2 dialog box is displayed.

M
en

u Process > Products > 
Tiles 

Po
p-

up New > Tiles
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6. Type a size for the bin tiles.

7. Click Next.

The Tiling Wizard - Step 3 dialog box is displayed. The Available 
Attributes section is dimmed.
8. Type a name for the file

9. Select a minimum or maximum sounding position as the starting point 
for the binning process.

10.Click Finish. 

A progress indicator on the status bar shows how much of the 
process has been completed. Once the binning is completed, a 
bin file is created and displayed in the Display window. A bin 
layer is also added to the Layers tab.

Create QTC Tiles
1. Select the field sheet.

2. Select the field sheet layer in the Layers tab.

3. Select the Tiles command.

The Tiling Wizard - Step 1 dialog box is displayed.
4. Select the QTC Seabed Classification option.

5. Click Next.

The Tiling Wizard - Step 2 (QTC) dialog box is displayed.

M
en

u Process > Products > 
Tiles 

Po
p-

up New > Tiles
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6. Type a name for the QTC tile layer.

7. Set the minimum tile size by clicking the up or down arrow buttons. As 
you increment upwards, the tile size is doubled.

The Percent Value Used to Split option continuously splits the tiles 
until the total amount of a specific class value in a tile meets or 
exceeds the entered percentage. For example, if the percentage 
is set at 50, then a tile is continuously sub-divided into smaller 
tiles until one of the tiles contains at least 50 per cent of a class 
value.
8. Type the percent value.

9. Click Next.

The Tiling Wizard - Step 3 (QTC) dialog box is displayed.
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10.Click Select files to browse to the *.seabed file used to create the tiles.

The selected file is displayed in the QTC Files text area.
11.Click Finish.

A progress bar displays the percentage of tiles created. When the 
process is completed, the tiles are drawn to the Display window, 
and listed in the Layers tab. 

Open and Close Tiles
Tiles are opened when the field sheet with which they are 
associated is opened. 
1. Open a field sheet. 

The field sheet file name is displayed in the Layers tab of the 
Control window. 
2. Expand the field sheet file tree by clicking the Expand ( + ) icon beside 

the field sheet so the tile file layer is visible. 

3. Select the check box beside the tile layer name, to make the tile visible 
in the Display window.

Tile layers are closed when the field sheet they are associated 
with is closed. 

Set Tile Display Properties
Set the display properties for tiles.

M
en

u File > Open Field 
Sheets
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1. Select a tile layer in the Layers tab of the Control window.

2. Select the Properties window command, or right-click the layer and 
select Properties from the pop-up menu.

The Properties window displays the tile layer properties. 

The Active Attribute list contains all attributes included in the tile 
(such as the Profile number). When you select an attribute, the 
tile is displayed according to the attribute values
1. Select an attribute from the drop-down Active Attribute list: MinDepth, 

MinXCoord or MinYCoord. By default MinDepth is selected.

2. Select a colour map from the drop-down list. A preview of the colour 
map is displayed below the list. 

3. Change how tiles are rendered to the Display Window by selecting a 
Display Level option:
• Maximum: Draw all tiles
• Automatic: Draw tiles to fit the current extent of the Display window.

The Colour fill tiles check box determines how attribute values are 
drawn in the Display window.
• If the Colour fill tiles check box is cleared, these values are 

drawn according to the selected colour map, but the tiles are 
left blank. 

• If the Colour fill tiles check box is selected and set to True, the 
individual tiles are filled according the colour map, but the 
attribute values are shown in black.

4. Select a Transparency percentage to make features visible through the 
tiles: the greater the percentage, the more transparent the tiles appear.

The Show tile borders check box determines how the border lines 
dividing the tile areas are displayed.
• If the Show tile borders check box is cleared, the lines are colour 

coded according to the colour map and attribute values.
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• If the Show tile borders check box is set to True, you can choose 
a single colour (using the Border colour map) for the tile 
border lines. 

5. Set the Show tile borders check box to True to display a border line 
colour.

6. Select a colour for the tiles borders from the Border colour map.
7. Set the Display Tile Value check box to True to display the values for 

the active attribute, for example, MinDepth will display sounding.

View Tile Attributes
You can view information on currently selected tiles in the 
Selection tab of the Worksheet window.
1. Open tiles are open in the Display window.

2. Select the tile layer in the Layers tab of the Control window.

3. Select the tiles to be viewed.

The selected tiles are highlighted in the Display.
4. Select the Selection tab.

The tile data for the selected tiles is displayed in the Selection 
tab. 
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Tile Display Query 
Using the Tile Display Query dialog box you can create an SQL-
type query based on selected tile attributes and defined values. 
Only those tiles that meet the search criteria are displayed in 
the Display window. The query results can be saved in the Tiles 
Properties when the session is saved.
The Tile Query dialog box is opened from the Properties window, 
when the tile layers are selected. 
1. Select the tile layer in the Layers tab.

2. Open the Properties window for the Tiles layer, as seen below.

3. Click the Browse (...) button in the Tile Display Query field. 

The Tile Display Query dialog box is opened
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4. Select an attribute from the list.

5. Click one of the following operator buttons:
• (<) less than (e.g., to select attributes that have a value less than 

the entered amount)
• (>) greater than 
• (<=) less than or equal to 
• (=) equals 
• (>=) greater than or equal to 
• (!=) not equal to

6. Type a value for the attribute in the Value field, and click Enter.

The search criteria you selected in the dialog box are displayed 
in the Query section.
7. To add other search criteria, click either of these logic operators:

• AND: This operator combines two queries together so the results of 
both are shown in the Display window.

• OR: This operator searches and displays either one of two search 
criteria in the Display window.

For example, to select only the tiles with a count more than 2500 
soundings that also have a resolution of 500, the query string 
would be:
Count < 2500 AND MinRes = 500

8. Repeat Steps 3 through 6 to add as many search criteria as needed. 

9. Click OK.

The Display window is refreshed to show only the tiles that meet 
the criteria you entered. The Query string is displayed in the 
Tile Display Query field in the Properties window.

If you save your session, the query will be saved and restored 
when that session is loaded again.
To clear the Tile Display Query field:
10.Select the tile layer.

11.Click the Browse button in the Tile Display Query field. 

12.In the Tile Display Query dialog box, click Clear.

This will remove the criteria and display all the tiles for the 
selected tile layer. 
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Depth Range Files
Depth range files are text files that set a range of depths for 
tiling and contouring data. These files are automatically 
generated during the contouring process (see “CREATE CONTOURS” ON 
PAGE 361).
The convention for setting depth values is similar to that of 
other CARIS files: 
• Drying heights above the datum are represented as negative 

values
• Depths below the datum are represented with positive values.
Below is an example of a range depth file.. 

In the above file the negative values (-30 to -5) are above the 
datum, and the positive values (5 to 50) are below the datum.

-50
-30
-20
-10
-5
0
5
10
15
20
30
50
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Process Imagery Data

Side scan and multibeam backscatter imagery data can be processed 
directly into mosaics, which can then be examined for anomalies and 
corrected. 

In this chapter...
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Overview
Multibeam backscatter and side scan sonar data can be 
processed for the purpose of creating mosaics. But as well as 
being end products, mosaics can be used as tools to more 
efficiently process imagery data.
Imagery data processed in Mosaic Editor is stored as 
Georeferenced, Backscatter Rasters, or GeoBaRs. GeoBaRs are 
the basis for all mosaics created in HIPS and SIPS
A GeoBaR is essentially a mosaic of imagery data for a survey 
line, which can be edited in georeferenced space. Once imagery 
has been corrected a full mosaic can be compiled from the data. 
Sediment analysis can be performed on data processed with the 
Geocoder engine.
Most users will be able to perform all their imagery processing 
directly in Mosaic Editor. 
However, if you:
• need to edit altitude data for side scan data, or 
• will be digitizing and editing contacts, or
• prefer to use a waterfall display for editing, or 
• intend to apply advanced TVG controls 
then these functions must be performed in Side Scan Editor. 
(This is described in the SIDE SCAN EDITOR section of the Editors 
Guide.)
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Workflow for Processing Imagery Data 
There are differences in the workflow depending on the kind of 
data being processed in Mosaic Editor. However, the basic 
workflow is the same:

For multibeam and backscatter processing, see “GEOCODER 
WORKFLOW FOR MULTIBEAM DATA” ON PAGE 415. 

For side scan processing in Side Scan Editor, see “SIDE SCAN EDITOR 
WORKFLOW” ON PAGE 50 of the Editors Guide.

Multibeam data must be fully processed and merged before 
creating mosaics. Side scan data must have digitized altitude 
before creating mosaics.
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Processing Engines 
Mosaic Editor has two processing engines: Geocoder Engine and 
SIPS Engine. 

Geocoder Engine
Geocoder processes multibeam backscatter, both beam-averaged 
and the higher resolution time-series returns, as well as side 
scan sonar data. 
The Geocoder engine has multibeam-optimized routines and 
data handling, such as automated gain corrections, suitable for 
normalizing data from specific sonar types with varying 
acquisitions settings, as well as automatic slope correction using 
inherent multibeam bathymetry.
 

SIPS Engine
The new Side Scan Editor workflow configures correction values 
that are retained and can be used to create mosaics from lines 
selected in the Display window, without the need to create 
GeoBaRs. However the option to create GeoBaRs and mosaics 
from them is still avaiable.
Corrections which originally were options when mosaics were 
created with the SIPS engine, are now automatically applied, 
based on settings in the Side Scan Editor Properties window. 

Multibeam data must be converted to HIPS format, 
processed with the bathymetric editors (Sound Velocity 
Correction, Apply Tide etc.— see Multibeam “WORKFLOW 
DIAGRAM” ON PAGE 16), and Merged (see “MERGE” ON PAGE 167) 
before the imagery can be corrected in Mosaic Editor. 
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Geocoder workflow for multibeam data
Main steps to process backscatter imagery
• convert data to HIPS 
• edit navigation, gyro, heave, load tide, compute TPU etc.
• Merge
• open Mosaic Editor
• create at least one GeoBaR using only default corrections 
• create a Beam Pattern correction file (using patch test data if 

available)
• set options for processing: 

• source data type
• auto corrections
• beam pattern corrections
• despeckle strength

• create GeoBaRs applying desired corrections
• edit GeoBaRs to adjust the imagery “on-the-fly”
• generate Mosaics from selected edited GeoBaRs
• edit Mosaics - adjust the display of the imagery and the 

contributing GeoBaRs
• Sediment Analysis - analyze sea bottom sediment from files 

generated by the Geocoder 
• digitize contacts in Side Scan Editor
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Open Mosaic Editor
To open Mosaic Editor:
1. Select the Open Mosaic Editor command.

The Mosaic Editor and Beam Pattern toolbars are displayed. 
The Control Window now displays the three control tabs of 
Mosaic Editor. 
The Mosaic Editor and Beam Pattern toolbars are also 
displayed.
For a description of the Mosaic Editor interface, see MOSAIC EDITOR 
in the Editors guide.

Side Scan Editor To see a waterfall display at the same time as your 
georeferenced imagery, you can open Side Scan Editor as well as 
Mosaic Editor. 
1. Open Mosaic Editor. 

2. Select a single trackline and open Side Scan Editor.

The Side Scan Editor window will open, displaying the waterfall 
view. 

M
en

u Tools > Mosaic Editor 
> Open

To
ol

 

M
en

u Tools > Side Scan 
Editor > Open

To
ol
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Create GeoBars
GeoBaRs are created using the options selected in the Process 
tab of the Mosaic Editor. Different options are available, 
depending on the processing engine selected. 
You can create multiple GeoBaRs on a survey line to:
• Correct multiple sources of data (i.e., time series, beam 

averaged, and/or side scan) from the same file, if applicable.
• Have different resolutions per GeoBaR.
• Visually compare data.
The simplest way to create a GeoBaR is to use the default values 
displayed on the Process tab, and then view and correct the 
GeoBaR imagery by adjusting these values. Then you can apply 
these settings from the created GeoBaR to other track lines.
GeoBaRs are displayed in the Display window and are listed by 
name in the Layers tab. A GeoBaR has three child layers: 
• Intensity: displays the current intensity (including edits).
• Original Intensity: displays the intensity when the GeoBaR 

was created (before edits to GeoBaR).
• Weights: displays the computed weights based on sonar 

geometry. These values are used when compiling a mosaic 
based on the Auto-Seam or Full Blend methods.

GeoBaRs remain open when Mosaic Editor is closed. Mosaic 
Editor will recognize GeoBaRs that are already open and will 
not try to load an open GeoBaR. 
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Naming GeoBaRs
Each GeoBaR should be given a unique filename, particularly 
when there will be many created in a project. A convenient way 
to standardize naming, and at the same time ensure unique file 
names for all GeoBaRs, is to use formatting tags combined with 
text. 

Formatting tags available for GeoBaR naming are:  

Tags will automatically add strings of identifying information 
such as the date and time the GeoBaR is created. 
For example, this string: 
%Y-%M-%D(%h’%m”%s)_%e(%i@%r) 

will name the GeoBar as: 
2009-10-21(11’13”29)_Geocoder(TS@1.0m).

This example can be used repeatedly to provide a standardized 
series of names differentiated by timestamp.

If you try to create a GeoBaR with the same name as an 
existing one, you will be warned that the new GeoBaR will 
overwrite the older one, and be given the option to proceed. 

Formatting Tag Adds to GeoBaR name:

%Y Current year (YYYY)

%M Current month (MM)

%D Current date (DD)

%h Current hour (hh) based on 24-hour clock

%m Current minute (mm)

%s Current second (ss)

%j Current Julian date (jjj)

%p Project name

%v Vessel name

%d Data date, e.g., 2007-244

%l Line identifier, e.g., 244-2327

%i Imagery type selected in the Source Data Type field (SS 
=side scan, TS= time series, BA=beam average)

%e Processing engine selected (SIPS/Geocoder)

%r Value and units from the Resolution field (Note: a decimal 
point is represented by underscore, for example, 4_5m is 4.5. 

GeoBaR names must not contain any spaces.
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Create GeoBaR with the Geocoder Engine
To create a GeoBaR: 
1. Open Mosaic Editor.

2. Select a survey line (or lines) in the Display window.
 

3. In the Process tab, select Geocoder from the Processing Engine drop-
down list.

4. Select the type of data being processed: Side Scan, Beam Average or 
Time Series. 

5. By default, the General Options of Auto Gain, Auto TVG and Anti-
Aliasing are selected. It is recommended that these automatic 
correction options be left on. 

6. [Optional] Select the Beam Pattern Correction check box, and select a 
Geocoder Beam Pattern Correction file (*.bpt). (If no file is available it 
will need to be created.) See “BEAM PATTERN CORRECTION” ON PAGE 426.
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7. [Optional] Set the AVG Correction check box and select a method from 
the drop-down list. 

8. Set the AVG window size using the arrow buttons.)

9. [Optional] Select the Despeckle check box and select a strength of 
adjustment to filter out pixels with intensity values inconsistent with 
their neighbours. 

10.Select the Create GeoBar command.

The Create GeoBaR dialog box is displayed.

11.Type a name for the GeoBar. The name must not include any spaces. 
(See “NAMING GEOBARS” ON PAGE 418.)

12.Type a resolution value. With the Geocoder engine you have the option 
of selecting Auto to have an optimal resolution set automatically based 
on the beam footprint. 

13.[Optional] Select a colour map for the new GeoBaR. The colour map 
will be displayed in the Preview field. The default map is GreyScale.

14.[Optional] Click Advanced for other options.

In the Geocoder Advanced Options dialog box:

M
en

u Tools > Mosaic Editor 
> Create GeoBar

To
ol
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15.Select Port, Starboard or Both sides on which to create a GeoBaR.

16.Set minimum and maximum values for the range of the Angle from 
Nadir. Default range is from minimum of 0 to maximum of 87 degrees.

17.Set minimum and maximum values in dB for the Intensity Range, for 
example, a minimum of -100 and maximum of 0. (Intensity values are 
expressed as negative numbers.) 

18.Select Smooth Gyro to apply gyro that has been smoothed in Attitude 
Editor. 

 

19.Click OK to return to the Create GeoBaR dialog box.

20.Click Cancel to return to the Create GeoBaR dialog box, discarding 
any changes that were made.

21.Click Create. The new GeoBar is displayed and listed in the Layers 
tab. 

For description of GeoBaR layer properties, see “PROPERTIES OF 
MOSAICS AND GEOBARS” ON PAGE 23 of the Editors reference.

In some cases it may be more useful to maintain the full 
intensity range when creating the GeoBaR, and limiting this 
range only in the final Mosaic.
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Create GeoBaRs with the SIPS Engine
Corrections which originally were options when mosaics were 
created with the SIPS engine, are now automatically applied, 
based on settings in the Side Scan Editor Properties window. 
1. Select a line or lines in the Display window.

2. On the Mosaic Editor Process tab, select SIPS from the Processing 
Engine drop-down list.

3. Select the type of data being processed: Side Scan, or Beam Average.

4. Select the Create GeoBar command.

5. .In the Create GeoBar dialog box, type a name for the GeoBar. 

GeoBaRs must have unique names. If you try to create a 
GeoBaR with the same name as an existing GeoBaR you will be 
warned that the new GeoBaR will overwrite the older one. See 
“NAMING GEOBARS” ON PAGE 418 for more information.
6. Type a resolution value, or accept the default value. (The Auto function 

is only available when using the Geocoder engine.) 

M
en

u Tools > Mosaic Editor 
> Create GeoBar

To
ol
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7. [Optional] Select a colour map for the new GeoBaR. The colour map 
will be displayed in the Preview field. The default map is GreyScale.

The imagery corrections that are applied in the creation of 
GeoBaRs with the SIPS engine, are those which are set in the 
Properties tab in Side Scan Editor. 
To modify these settings: 
8. Click Advanced to set or change correction options. 
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SIPS Engine Advanced Options settings:

General Options 

Extrapolate Select Extrapolate to extend the heading and/
or navigation data at each end of the line to a 
maximum specified by the selected value. 

Use Bathymetry to Register 
Imagery

Select TOuse the bathymetry location data 
from the same swath to register the side scan 
imagery. 

If not selected, a flat seafloor assumption 
will be used. (This function is only 
applicable to systems which provide 
bathymetry and imagery information at 
the same time in the same swath.)

Gyro From: Select source from the drop-down list Select 
the orientation source from the Gyro 
drop-down list: Automatic, Course Made 
Good, Ship Gyro or Towfish Gyro.

Smooth Gyro Select Smooth Gyro to apply gyro that 
has been smoothed in Attitude Editor. 

Include Channel Select Port or Starboard, or both.

TVG & Gain

TVG Select the boxes to apply to Port or Starboard 
or both.
• Type values in dB/100 m in the fields

Gain Select the boxes to apply to Port or Starboard 
or both .
• Type values in dB/100 m in the fields

Beam Pattern

Click Browse to select the Beam Pattern file 
to apply.
• Check the boxes to apply to Port or 

Starboard or both.

Gain Normalization Enable and set the window size for the moving 
average filter.

Despeckle Set the Despeckle threshold value.

Override per-line corrections Select this option to apply these correction 
settings to all lines in the mosaic.

Acrosstrack/Altitude Ratio

The Acrosstrack/Altitude Ratio excludes data 
starting from nadir extending across track to a 
distance determined by the towfish altitude 
and the given ratio.

Min/ Max Select the check boxes to activate the value 
fields so you can type in desired values

Limit Select the check boxes to activate the value 
fields so you can type in desired values
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9. Click OK to return to the Create GeoBaR dialog box

10.Click Cancel to return to the Create GeoBaR dialog box, discarding 
any changes that were made.

11.Click Create. 

The new GeoBaR will be displayed in the Display window, and 
listed by name in the Layers tab.
For description of GeoBaR layer properties, see “PROPERTIES OF 
MOSAICS AND GEOBARS” ON PAGE 23 of the Editors reference.

Acrosstrack Distance

The Acrosstrack Distance option can also 
be set to exclude a fixed distance across 
track, regardless of altitude.

Min Max Select the check boxes to activate the 
value fields so you can type in desired 
values
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Beam Pattern Correction 
Beam Pattern Correction is applied to remove acoustic artifacts 
from the imagery caused by imperfections in the sonar. Beam 
pattern correction relies on a user-generated beam pattern file to 
identify and remove this effect. Once the beam pattern file is 
created it can be applied to the survey data to uniformly correct 
the selected data. This also results in a more consistent 
appearance in imagery.
Applying Beam Pattern Correction with the Geocoder engine 
selected removes sediment artefacts and multibeam sonar 
system artefacts from data. Angular artefacts are removed from 
side scan data if the SIPS engine is selected. 
For consistent results, you should create your beam pattern file 
over as flat, homogenous, and featureless an area as possible, 
preferably sand. For best results, it is recommended that a 
“patch test” be done during a survey over an area known to have 
such properties. 
The process to apply Beam Pattern Correction in Mosaic Editor 
consists of:
• selecting the processing engine: Geocoder or SIPS
• creating a GeoBaR from the patch line, preferably with only 

the default corrections applied.
• creating the Beam Pattern file
• setting the Beam Pattern options for the type of data you are 

correcting
• creating GeoBaRs and applying Beam Pattern Correction
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Create Beam Pattern file 
1. Make sure the Ship Track Lines layer is active in the Layers tab.

2. Load one or more GeoBaRs.

3. In the Display window, select a trackline and then superselect an area 
of the line by pressing the down arrow key on the keyboard while 
range-selecting over a suitable area of the GeoBaR.  

The superselected area will be highlighted in blue at nadir of the 
GeoBaR, as in the example below.
 

4. [Optional] Query the superselected area to determine the number of 
pings in the superselection. 

5. [Optional] From the data in the Selection tab, subtract the value of the 
End ping from the Start ping. 

6. Select the Geocoder or SIPS processing engine in the Process tab of 
Mosaic Editor.

7. Select the Create Beam Pattern command. 

(The Create Beam Pattern command is only active in 
Mosaic Editor while part of a line is superselected.)

The Save Beam Pattern Correction file dialog box is displayed.
8. Name the file and click Save to save and load the file.

The created file will have the extension *.bp.

In order to create a robust beam pattern file, a minimum 
number of pings should be selected (usually 250), so that 
sufficient data is included for statistical analysis.

M
en

u Process > Beam 
Pattern Correction > 
Create

To
ol
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Despeckle
Imagery may have isolated pixels with intensity levels that are 
inconsistent with neighbouring pixels. It is possible to filter the 
isolated light and/or dark pixels through the Despeckle process. 
This will produce smoother, more consistent imagery.
Despeckling imagery is a visual process, consisting of adjusting 
the despeckle values and viewing the display until the desired 
results are obtained. 
Despeckling uses a calculated value based on neighbouring 
intensity levels to replace the current pixel’s intensity if it is 
outside the specified range. 
To apply the Despeckle tool:
1. Select the Despeckle check box.

When using the Geocoder engine, the value calculated from the 
strength of neighbouring intensities.
2. Select a value from Weak to Very Strong from the Strength drop-down 

list. 

When using the SIPS engine, the despeckle value is derived from 
applying a mean filter or a median filter with a specific 
threshold, calculated from a matrix of neighbouring pixels. The 
default values are to apply a Mean Filter with a 3x3 matrix cross 
and a threshold of 100%.
To change the default options:
1. Click Change.

2. Select the Median Filter from the Method drop-down list.

3. Use the up and down arrows to select a Threshold for defining an 
acceptable range in which the pixel value will not be replaced. 

For example, if the mean value is 50 and the threshold is +/- 20% 
then the acceptable range is 40 to 60. Thus a pixel value of 38 
would be replaced by the mean value of 50 as it is outside the 
range, but a pixel value of 42 would not be replaced. 
4. Select a pattern of neighbouring pixels from the Matrix Size drop down 

list be used in calculating the mean/median.

5. Click Set to return to the Process tab.
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Edit GeoBaRs
Editing GeoBaRs includes adjusting brightness, contrast, 
visibility options and the draw order of GeoBaRs. These 
corrections are done with the tools on the Edit tab.

Editing is done one GeoBaR at a time. 
To open a GeoBaR for editing:
1. Select the survey line for the GeoBaR you want to edit. 

2. Use a Load GeoBaR command to load a GeoBaR for the line. 

3. If there is more than one GeoBaR for the selected line, use the Resolve 
Conflict dialog box to chose the GeoBaR to be edited. See “CONFLICT 
RESOLUTION” ON PAGE 444.

This will activate the functions on the Edit tab.
You can also edit GeoBaRs that are already loaded and visible in 
the Display window. 
1. Select the survey line for the GeoBaR you want to edit. (View the 

Properties for the GeoBaR to determine the source line.) 

This will activate the functions on the Edit tab.
If there is more than one GeoBaR loaded for the selected line, 
the Resolve Conflict dialog box will open so you can select the 
one to edit.

The Edit tab is activated when you load a GeoBaR for a 
selected line. If there is more than one GeoBaR on a line, the 
Edit tab is activated when you select a specific GeoBaR on 
that line, using the Resolve Conflict dialog box. 

M
en

u Tools > Mosaic Editor 
> Load Single 
GeoBaR

To
ol

  

M
en

u Tools > Mosaic Editor 
> Load all GeoBaRs

To
ol
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Editing The Intensity Range fields show the minimum and maximum 
intensity values for the selected GeoBaR.
1. To adjust brightness, move the sliders to the right or left to change the 

intensity of the image. 

2. To adjust contrast, slide the Contrast slider to the right for more 
contrast and to the left for less contrast.

As you move the sliders, new values are displayed in the 
Intensity Range fields. 
Use Reset to restore the GeoBaR to the original intensities it had 
when it was created. 
3. Use the Visibility Options to turn on or off the various child layers of the 

GeoBaR.

4. Manipulate the Draw Order of the GeoBaR using the Top, Bottom, Up 
and Down buttons. This will change the layer at which the GeoBaR is 
drawn in the Display window. (This function can be important if you 
intend to make your final mosaic using the Overwrite method.)
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Image Classification 
Image classification groups return-signal intensities 
(represented in the mosaic as pixel values) into classes. These 
classes are displayed in the mosaic using specific colours.
To determine the range of intensities:
1. Select the Intensity layer of the mosaic in the Layers tab.

2. In General field of the Properties window, view the Min/Max Ranges for 
the layer.
• You can also move the cursor across the mosaic in the Display 

window. As you move the cursor, screen tips show the inensity 
values in dB.

To apply Image Classification: 
3. Select the Mosaic layer. 

4. Select the Classify command to open the Image Classification dialog 
box.

The Image Classification dialog box is displayed.
 

5. Use the Number of classes drop-down list to set the total classes in the 
mosaic.

Po
pu

p

Classify
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6. Set a range of values for a class by typing values for Minimum intensity 
and Maximum Intensity in their respective fields.

7. [Optional] Select a colour for a class by selecting a class from the 
Classification colour drop-down list, and the colour picker.

8. This colour will be displayed beside the class name.

9. [Optional] Select another colour from the colour picker, or create a 
custom colour from the standard Windows colour palette.

10.Repeat Steps 4 to 7, as needed.

11.Click Classify.

A colour table is generated according to the number of classes you 
selected in Step 3. Pixels are grouped according to class starting 
from the minimum to the maximum pixel value.

The histogram is refreshed to show the pixels coloured according 
to the class designation. When the dialog box is closed, the 
intensity values in the mosaic will be displayed with these colour 
classifications.
To save the colours and their classes to a .CRF (colour range file) 
for future use:
12.Click Apply.

13.In the Save As dialog box, type a name for the file and click Save.
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Delete GeoBaR
To delete a GeoBaR:
1. Right-click on the GeoBaR layer in the Layers tab. 

2. Select Delete GeoBaR from the pop-up menu.

This deletes the GeoBaR permanently from your disk.
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Create Mosaic from GeoBaRs
A mosaic can be created from two or more GeoBaRs. As with 
other HIPS and SIPS surfaces, a mosaic is created in a field 
sheet. 
(Mosaics of side scan data can also be created directly from a 
selection of track lines. See “CREATE MOSAICS” ON PAGE 78.)
To create a mosaic from GeoBars in Mosaic Editor:
1. Open or create a field sheet that encompasses the area you want to 

mosaic.

2. Select the Ship Track Lines layer in the Layers tab.

3. Select two or more track lines for which GeoBaRs have been created.

The Create Mosaic command and toolbar button are activated.
4. Select a Create Mosaic command.

Mosaics are created using one GeoBaR per line. When there is 
more than one GeoBaR loaded on a selected line, the Resolve 
Conflict dialog box will appear so you can choose which GeoBaR 
you want to include in the mosaic. 

There are three methods to resolve a conflict: Newest GeoBaR, 
Finest Resolution, and Manual. (For more information on 
conflict resolution, see “CONFLICT RESOLUTION” ON PAGE 444.)
5. Select a method to resolve the conflict. 

M
en

u Tools > Mosaic Editor 
> Create Mosaic

To
ol
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When any conflicts in selecting GeoBaRs are resolved, the 
Create Mosaic dialog box is displayed.  

Name the mosaic. Every mosaic should be given a unique filename. A new mosaic 
created with the same name as an existing one will overwrite the 
older mosaic. 
 

A convenient way to standardize naming, at the same time as 
ensuring unique file names, is to use formatting tags combined 
with text. 
 

Using tags will automatically add strings of identifying 
information such as the date and time the mosaic was created. 
For example, this string: 
Fundy_%Y-%M-%D(%h’%m”)_%r

will name the mosaic: 

Names must not contain any spaces.

Formatting Tag Adds this to the mosaic name

%Y Current year (YYYY)

%M Current month (MM)

%D Current date (DD)

%h Current hour (hh) based on 24-hour clock

%m Current minute (mm)

%s Current second (ss)

%j Current Julian date (jjj)

%r Value and units from the Resolution field (Note: a 
decimal point is represented by underscore, for 
example, 4_5m is 4.5 metres.
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Fundy_2010-04-24(14’13”)_@1.0m.

The above example tag string could be used repeatedly to 
provide a standardized series of names that would be 
differentiated by timestamp.
6. Type a name for the mosaic

Image Resolution If one or more of the GeoBaRs to be included in the mosaic have 
a lower resolution than what you set for the mosaic, the mosaic 
you create may have empty cells. To avoid this, choose one of 
these options from the Mosaic Creation warning dialog box:
• keep the resolution you have set for the mosaic, and re-

sample the GeoBaRs with the lower resolution, or
• keep the resolution you have set for the mosaic, and use all 

GeoBaRs regardless of resolution, or
• keep the resolution you have set for the mosaic, but don’t 

include the GeoBaRs with lower resolution, or
• set the resolution for the mosaic to that of the lowest 

resolution GeoBaR.
7. Enter a resolution value in metres. 

Smaller values will result in finer resolution than larger values, 
but involve a longer creation time and larger file size.

Overlapping data GeoBaRs often overlap. You can set how you want any 
overlapping data to be handled in the mosaic. There are five 
methods to choose from:
• Auto-Seam: This method determines which pixels have 

higher significance when there is overlap. A weighting 
function assigns lower significance to pixels at the edge of the 
swath than to pixels near the centre. The first few pixels near 
the nadir are assigned low significance due to the low 
resolution in that region.

• Full Blend: This method uses Geocoder’s blend operation to 
smooth pixel values. It also relies on a weighting scheme. 

• Overwrite: Uses the draw order to decide which pixel will be 
used in an overlapped area. 

• Shine Through: The highest intensity pixel will be used.
• Underlay: The opposite of Overwrite. The pixel is added only 

if no other point exists.

Auto-Seam and Full Blend use the Weights layer generated 
for each GeoBaR. Auto-Seam picks one pixel or the other 
when there is overlap; Full Blend takes a weighted average 
of the two.
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8. Select a method to process overlapping data from the drop-down list.

You can set the display colours for the mosaic.
9. Select a colour map from the drop down list. The range of colours will 

be displayed in the Preview field below. 

When a GeoBaR is created, limits can be set on the intensity 
range. In some cases it may be more useful to maintain the full 
intensity range in creating the GeoBaR, then limiting this range 
in the final Mosaic. 
10.[Optional] Click Advanced to set intensity options.
 

11.Set minimum or maximum values in dB for the Intensity Range. This 
will exclude nodes that fall outside of the range defined by the min/max 
values. 

12.Click OK to return to the Create Mosaic dialog box.

13.Click Create.

The mosaic that is created will appear in the Layers tab, with its 
colour-coded child layers: Intensity, Original Intensity and 
Weights (as for GeoBaRs) plus a layer called Contributor. 

Delete Mosaic
To delete a Mosaic:
1. Right-click on the Mosaic layer in the Layers tab. 

2. Select Delete Mosaic from the pop-up menu.

This will permanently delete the mosaic from your disk. (It 
does not delete the component GeoBaRs. 
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Edit Mosaics
Mosaics can be edited for brightness, contrast, and visibility. As 
well, component GeoBaRs can be added, modified or removed.
While you may have more than one mosaic open in the display, 
only one mosaic can be edited at a time. 

To edit a mosaic:
1. Open Mosaic Editor.

2. Right-click on a mosaic layer in the Layers tab of the Control window.

3. Select Edit Mosaic from the pop-up menu.

The functions on the Edit tab are displayed. The top line of the 
Edit tab displays the name of the mosaic being edited
 

1. To adjust brightness, move the sliders to the right or left to change the 
intensity of the image. 

2. To adjust contrast, move the Contrast slider to the right for more 
contrast and to the left for less contrast.

As you move the sliders, the new values are displayed in the 
Intensity Range fields.

Mosaics created as field sheet layers in HIPS and SIPS prior 
to version 7.0, can be opened in Mosaic Editor, for 
comparison purposes, but they cannot be edited.
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3. Use Reset to restore the values of the Original Intensity layer. 
(Removes the effects of the adjustments made with the sliders.)

4. Use the Visibility Options to turn on or off the various child layers of the 
mosaic.
• Select the layer (Intensity, Original Intensity or Weights) from the 

drop-down list and click On/Off.
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Edit Mosaic Components 
GeoBaRs can be added to and removed from an existing mosaic, 
and the way in which the component GeoBaRs contribute to a 
mosaic can modified. 
To edit a GeoBaR that is a component of a mosaic:
1. Open the field sheet containing the mosaic.

2. Right-click on the mosaic layer in the Layers tab, and select Edit 
Mosaic from the pop-up menu. 

This will activate the Edit tab of Mosaic Editor. The top line of 
the tab will display the name of the active (selected) mosaic.
3. With the Edit tab activated, select the Ship Track Lines layer in the 

Layers tab.

4. In the Display window, select a line that is part of the mosaic. 

Since mosaics are created from one GeoBaR per line, selecting a 
line automatically selects the component GeoBar, whether or not 
that GeoBaR has been opened. 
The Edit tab is updated to display Composition options for the 
selected component.
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The methods available to edit the components of a mosaic are 
the same as used to create the mosaic: Auto-Seam, Full Blend, 
Overwrite, Shine Through, and Underlay.
Also available is the blending method used to create the original 
mosaic. This is listed as Default.

Add a new component To add another GeoBaR to the mosaic:
1. Select an open GeoBaR that is not a ready part of the mosaic.

2. In the Edit tab, select the Add option.

3. Select a method for processing overlap from the drop-down list.

4. Click Commit.

Modify Components To modify the method by which a component GeoBaR 
contributes to the mosaic: 
1. Select a line that is part of the mosaic. 

1. Select Modify. 

2. Select the preferred method from the drop-down list.

3. Click Commit.

Remove GeoBaR from 
mosaic

To remove a component from a mosaic, 
1. Select Remove.

2. Select an option from the drop-down list: 

• Remove Complete will re-mosaic the portion of the mosaic 
covered by selected GeoBaR, without any contributions from 
the selected GeoBaR. 

• Remove Explicit will keep any blended pixels, but remove any 
pixels that are explicitly from the selected line.

3. Click Commit to save the changes.

Manual Blend You can select a GeoBaR and perform a manual blending 
operation with it.
1. Click Blend to open a slider dialog that you can use to blend a GeoBar 

into the existing mosaic.

2. Move the slider to see the effects of blending. When you have a 
desired blend, click Commit. 

3. To back out of the Blend function without saving, click Cancel.

Other functions • When a component GeoBaR is opened in Edit tab, the 
Intensity Range fields display the minimum and maxiumum 
intensity values for the GeoBaR. You can adjust these values 
for the selected GeoBaR as you would for a mosaic. See “EDIT 
MOSAICS” ON PAGE 438

• You can use Compute Statistics command to generate the 
statistics for a mosaic attribute layer, and output them to an 
ASCII file or to image. See “COMPUTE SURFACE STATISTICS” ON 
PAGE 232.
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Interpolate Mosaic 
The Interpolate Surface command eliminates small holes that 
appear in areas of sparse data, for example, in the outside edges 
of surveyed areas where there is little or no overlapping 
coverage.
This command examines each node in the mosaic surface to 
determine if it contains a pixel value. If the node does not 
contain a value, the neighbouring pixels are examined to 
determine if enough of them contain pixel values to justify 
interpolating a value for the hole. This limits the interpolation to 
holes in the mosaic surface and prevents it from expanding the 
mosaic outward from the survey area. A copy of the mosaic 
surface, with these gaps filled, is then created.
In the following example, in a 3 x 3 surface node area, five nodes 
have pixel values (shown in red). 

This means if you select five or less as the value for the Number of 
Neighbours, a pixel value is created for the node without a value 
from the neighbouring nodes. 
1. Right-click on the mosaic in the Layers tab.

2. Select the Interpolate command.

The Interpolate Surface dialog box is displayed.
 

This node does not 
contain a pixel value.

This node does contain a 
pixel value and can be 
used to interpolate a value 
for nodes without a pixel 
value.

Po
p-

up Interpolate 
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The Destination Surface field displays the file name of the copy 
that is created from the original Surface. The default name is 
the original Surface name with _Interp appended to it. You can 
change the name, if necessary.
3. [Optional] Type a new name in the Destination Surface field.

The Matrix Size determines the number of nodes closest to the 
node that can be used to interpolate a pixel value.
4. Select either the 3 x 3 or the 5 x 5 option.

The Number of Neighbours field is a threshold level used to 
determine the minimum pixels in the matrix area that must be 
present to interpolate a new pixel value. The matrix size 
determines the maximum and minimum values for the 
neighbours field. For example, if you select 3 x 3 for the matrix 
size, then the possible maximum number of neighbouring nodes 
with pixels is 9 and the minimum number is 3.
5. Type the number of neighbouring nodes used to interpolate pixels.

6. Click OK.

The interpolated mosaic is created and displayed with an 
_Interp extension, in the data tree in the Layers tab. 
As you continue to re-interpolate the mosaic surface, the effects 
accumulate to remove any remaining gaps. To interpolate again:
1. Select the interpolated mosaic in the Layers tab.

2. Select the Interpolate command. 

The second interpolation is applied to the selected mosaic layer. 
It does not create a new layer. 
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Conflict Resolution 
The Resolve Conflict dialog box can appear in any operation 
where there are multiple GeoBaRs for a line, but only one 
GeoBaR can be used for the operation. (For example, when 
loading a GeoBar on a line that has more than one GeoBaR 
created, or when creating a mosaic where multiple GeoBaRs 
have been created for the lines.) 
Use the Resolve Conflict dialog box to choose a GeoBaR, based 
on attributes such as resolution or source type, as well as the 
option to select a GeoBaR manually from a list. 

The title bar of the Resolve Conflict dialog box shows you the 
number of the current conflict and the number of conflicts there 
are for the line. 
The line is identified, and options to resolve the conflict are 
listed in the Method field. These options vary with the task you 
are performing. If there is more than one conflict on a line, you 
can use the Apply to all option to apply the same method of 
resolution to all conflicts. 
The dialog box also has three buttons: Apply, Skip, and Cancel. 
All these buttons close the dialog box. 
• Apply uses the current settings to resolve this conflict. 
• Skip will not resolve this conflict but will allow you to 

continue with any other conflicts. 
• Cancel will stop the process regardless of how many conflicts 

are remaining.

total 
number
of conflicts

current
conflict 
number

line
name
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Ways to Resolve Conflict
To resolve a conflict when loading a single GeoBaR: 
1. Select either 

• Newest GeoBaR (the most recently created) or 
• Finest Resolution (e.g. in a group of GeoBaRs with resolution 

ranging from 1m to 10 metres, the GeoBaR with resolution of 1m 
will be selected), or

• Manual (select the GeoBaR by name from a drop-down list of the 
conflicted GeoBaRs).

Selecting a GeoBaR To resolve a conflict when you want to select a loaded GeoBaR 
and there is more than one GeoBaR loaded for the line, you can 
select by the specific source type of the GeoBaR. If more than one 
available GeoBaR is of the specified type, then a new Resolve 
Conflict dialog box is displayed containing only the GeoBaRs 
that share the source type in conflict. 
1. Select either:

• Newest GeoBaR 
• Finest Resolution, or
• Manual, or
• Source Type. 

If you select Source Type as the method then
2. Select either Side Scan, Beam Average, or Time Series from drop 

down list. 

Selecting Component 
GeoBaRs 

If you are editing a mosaic, and there are a number of GeoBaRs 
loaded, (any of which could have contributed to the mosaic), the 
Resolve Conflict dialog will show the option to select the specific 
GeoBaR used to create the mosaic. 
1. Select Component from the Method list to select the GeoBaR which 

contributed to the mosaic.
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Sediment Analysis
Use the Sediment Analysis tool in Mosaic Editor to determine 
sediment type, by analyzing the angular responses of data 
processed in the Geocoder engine. 
When a GeoBaR is created using the Geocoder engine, a binary 
sediment analysis file is also created for the line. Sediment 
analysis is performed over a certain number of pings, controlled 
by the Patch Size in the Sediment Analysis Options dialog box. 
(See “SET SEDIMENT ANALYSIS OPTIONS” ON PAGE 446.)

Data is analysed with respect to the sediment angular response 
models in order to determine an average grain size. This average 
grain size is then cross-referenced to the customizable look-up 
table in order to provide a textual response. (See “GRAIN SIZE TABLE” 
ON PAGE 451.) 
The sediment analysis results are displayed on the Analysis tab. 
They can also be seen in the Sediment Analysis Graph window 
that displays the average angular response for a given range of 
data. (See “SEDIMENT ANALYSIS GRAPH” ON PAGE 453.) Sediment analysis 
results can also be exported to ASCII. (See “SEDIMENT ANALYSIS TO 
ASCII” ON PAGE 539.)

Set Sediment Analysis options
1. Select the Analysis tab in Mosaic Editor.

Patch

Results for selected 
patch GeoBaR 

Trackline
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2. Select the Sediment Analysis Options command.

The Sediment Analysis Options dialog box is displayed. 

3. Set the number of pings in the Patch Size over which the sediment 
analysis will be performed.

By default, a sediment analysis file is created every time a new 
GeoBaR is created for that line. This new sediment analysis file 
will overwrite any previous file for the line. However, you can 
change this option so that a sediment analysis file is never 
created, or so that the file is only generated once per line
4. Set the File Creation Option by selecting Never, Once or Always.

Use the View Sediment Parameter Overlay option to overlay 
certain sediment analysis parameter data on a selected GeoBaR. 
5. Set View Sediment Parameter Overlay to display representations of the 

sediment analysis data. (See “VIEW SEDIMENT ANALYSIS OVERLAY” ON 
PAGE 455 for more information.

Auto Analyze
The Auto Analyze function will analyze sediment data for entire 
lines for which GeoBaRs have been created. This automated 
process can replace the labour-intensive process of analyzing 
each patch individually.
1. Select the layer named “GeoBaRs”.

2. In the Properties window, set the Show All Sediment Analysis Patches 
to “True”, and set Auto Adjust Histogram to “False”. See also “GEOBAR 
LAYERS” ON PAGE 24

3. Activate the Analysis tab of the Mosaic Editor tab in the Control 
window.

4. Select one or more lines displaying open GeoBaRs.

M
en

u
Tools > Mosaic Editor 
> Sediment Analysis 
Options

To
ol

 



448 CARIS HIPS and SIPS User Guide

Process Imagery Data: Sediment Analysis

All sediment analysis patches available on the lines will be 
highlighted. In the image below the sediment patches are in red; 
one selected patch shows in port and starboard colours.
 

5. Select the Auto Analyze Sediment Data command.

A dialog box will appear confirming that the analysis is taking 
place. The Status bar will show the progress of the analysis. 
When the process is complete the outcome is reported in the 
Output window. Results displayed on the Analysis tab. 

Analyze selected patch
1. Select the layer named “GeoBaRs”.

2. Set the Show All Sediment Analysis Patches option in the Properties 
window.

3. Select the Analysis tab of the Mosaic Editor tab in the Control window.

4. Select one or more lines displaying open GeoBaRs.

5. Select a patch from the patches highlighted. 

The port and starboard sides of the selected patch will be 
highlighted.
6. Open the Sediment Analysis graph.

7. Select Standard from the Display field drop-down list.

8. Click Analyze. 

The graph window will draw the lines resulting from the 
analysis. The Results section of the Analysis tab will display the 
sediment class and confidence level of the analysis.

M
en

u Tools > Mosaic Editor 
> Auto Analyze 
Sediment Data 

To
ol

 

M
en

u Tools > Mosaic Editor 
> Sediment Analysis 
Graph

To
ol
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The results are displayed as the type of sediment, based on the 
values set in the Grain Size table. (See “GRAIN SIZE TABLE” ON 
PAGE 451.) Also shown is the confidence level in the result (the 
smaller the value, the higher the confidence level). 
Auto Analysis of sediment data can be done in either Standard 
or Advanced mode.

Sediment 
class

Confidence 
level
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Advanced Mode
The Advanced mode on the Analysis tab is an extension of the 
Standard mode and displays more parameters. This analysis 
compares the grain size from the data to the values on a 
customizeable lookup table. (See “GRAIN SIZE TABLE” ON PAGE 451.)
(The Advanced Mode is likely to be of more interest to users 
doing scientific research rather than a processing workflow.)
1. Highlight a sediment analysis patch. 

2. Select Advanced from the Display field.

3. Select Sediment Data from the Source field on the Analysis tab.

4. Click Analyze. 

The sediment analysis results for that patch are displayed in the 
Results field. The input parameters for the results are shown in 
the Parameters fields. These values are read-only.
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Grain Size table
The classes of sediment which is displayed by the sediment 
analysis are based on values in the Grain Size table. This table 
can be customized while in Advanced mode only. 
1. Select the Analysis tab.

2. Select Advanced.

3. Click Edit to open the Grain Size table.

Grain size values and their descriptions can be edited using the 
Modify button. 
New classes can be added using the Insert button, and removed 
from the table using Delete. Use Reset to restore the default 
values.

Model Parameters
The Model Parameters mode enables the specialized user to 
define the backscatter curve for their own purposes by 
manipulating parameter values for port and starboard data or 
applying a Biot model. 
1. Highlight a sediment analysis patch. 

2. Select Model Parameters from the Source field on the Analysis tab.

The Parameters list box is activated.
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You can modify values in the list using the slider below it. 
3. Select a parameter, e.g., porosity, from the list.

4. Use the slider below the list to adjust the value of that parameter. 

The values for the parameter automatically update as you move 
the slider. The range of possible values varies with the 
parameter selected.
Alternatively, you can manually update each parameter as you 
adjust the value. 
5. Click Update to set the new value in the list.
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Sediment Analysis Graph 
You can view the results of sediment analysis graphically in the 
Sediment Analysis Graph window. This graphs the Interface, 
Volume and Kirchhoff backscatter intensity values to angle of 
nadir in degrees. 
To open this window:
1. Click open the Analysis tab, and select Advanced mode from the 

Display drop-down list. 

2. Select Sediment Data from the Source drop-down list.

3. Select a survey line.

4. Select the Open Sediment Analysis graph command. 

The graph is displayed.

 

The graph can display three kinds of backscatter, or the total 
backscatter or all four, colour coded as follows:
• Light green line is Interface Backscatter: occurring at the sea 

floor/water interface, this is the main component of the 
initially returned acoustic energy. 

• Light red line is Volume Backscatter: secondary in time, this 
is sound energy returned or scattered from within the 
sediment. The less homogeneous the sediment, the more the 
sound wave is disturbed. 

M
en

u Tools > Mosaic 
Editor > Sediment 
Analysis Graph

To
ol
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• Yellow line is Kirchhoff Backscatter: This model accounts for 
the roughness of the sea floor particularly for grazing angles 
close to 90 degrees. 

• Blue line is Total Backscatter: the combined backscatter from 
the three backscatter sources. This is analyzed to determine 
approximate grain size.

The line colours can be changed from these defaults in Tools > 
Options > Display > Mosaic Editor dialog box. 
Also shown are port and starboard lines in their traditional 
colours. 

Graph options To set which backscatter forms will be displayed in the graph 
window:
5. Select Advanced from the Display field on the Analysis tab.

6. Click the Graph Options button at the bottom of the Analysis tab.

The Sediment Analysis Graph Options dialog box is displayed.
 

7. Select the check boxes for the types you wish to display. Click OK.

Close graph To close the graph window: 
8. Toggle the Open Sediment Analysis graph command off, or click the 

toolbar button again.

View Sediment Patches
This option displays the patches as a vector overlay on the main 
display.
To locate a specific patch along a line: 
1. Select the GeoBaR layer. 

2. In the Properties window, set Show All Sediment Analysis Patches to 
True.

3. Click open the Sediment Analysis tab.

4. Click on the line in the Display window at the point at which you want to 
see the sediment values.

The patch for that part of the line will be highlighted. 
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View Sediment Analysis Overlay 
Use this feature to overlay certain sediment analysis parameter 
data on a selected GeoBaR. 

Four data points are shown per patch, per side. Starting from 
nadir and going outward they are: Grain size (or phi), roughness, 
volume, and impedance. The data points are shown in 256 
shades of blue, green, red and yellow respectively. 
The data is scaled against absolute minimums and maximums 
for each parameter type (rather than relative to the line's max/
min for each). This makes comparisons between different lines' 
data meaningful. 
The data will be displayed for any patch that was analyzed prior 
to selecting the line, meaning that if you change the data 
through further analysis while the line is selected, the overlay 
will not be refreshed. 
At this time, this overlay feature is only available for one 
selected line/GeoBaR at a time, and does not work with multiple 
lines or Mosaics. 
1. Open Mosaic Editor.

2. Set the View Sediment Analysis Overlay option in the Sediment 
Analysis options dialog box.

3. Click the Analysis tab in the Control window.

4. Select a line.

The overlay for the line is displayed.
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Since the overlay is created from the sedimentAnalysis.xml file 
it can be displayed even when GeoBaRs are not loaded.
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Contacts
Contacts are representations of object and feature on the sea 
floor, such as wrecks or other shoal features, that are visible in 
the sonar data. 
In Side Scan Editor you can georeference contacts and attach 
attributes attached to them using the Add Point or Add Line 
Contacts tools. Contacts are placed directly in the waterfall 
view. A contact record is created for each contact, stored in the 
contact file for the survey line. A contact record includes 
sufficient information to be subsequently exported to a CARIS 
map or to a database application.
Contact are described in “CONTACTS” ON PAGE 81 in the Side Scan 
Editor section of the Editors Guide. 
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Process Water Column Data

Water column data can be viewed, selected and queried in Subset and 
Swath Editor. the data can also be imported into Additional Bathymetry. 

The display of water column data can be manipulated in the editors, and 
bathymetry derived from water column imagery can be added to an 
existing project. 

In this chapter...
WATER COLUMN DATA IN HIPS .................................. 460
WATER COLUMN DATA IN SWATH EDITOR...................... 462
WCI CONTROLS IN SWATH EDITOR .............................. 466
ADD WC BATHYMETRY TO PROJECT............................. 468
WCI DATA IN SUBSET EDITOR..................................... 469
ADDITIONAL BATHYMETRY............................................ 473
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Water Column Data in HIPS
Water column data can be integrated into existing bathymetry 
workflows. Water column image (WCI) data can be displayed in 
both Swath Editor and Subset Editor, and its bathymetry data 
added to a project. In Swath Editor water column data is 
displayed as a curtain image. In Subset Editor it is displayed in 
3D. 
Currently, water column imagery data from Teledyne Reson 7K 
(.s7k) and Simrad (.all, .wcd) sonars is supported in HIPS and 
SIPS. 
“WATER COLUMN DATA IN SWATH EDITOR” ON PAGE 462

“WCI DATA IN SUBSET EDITOR” ON PAGE 469

Projects 
Projects containing water column data are organized in the same 
Project-Vessel-Day-Line hierarchy as other sonar projects. 
When data is converted to HIPS there is the option of copying 
the original data files to the Processed folders. By default, raw 
data files are not carried over. 
When opening water column data, HIPS will look for WCI data 
in the line directory. If the data is not found there, HIPS looks in the 
location of the raw data files as recorded during conversion. If the 
raw data no longer exists in its original location, you will be 
prompted to have HIPS search for it, or to search for it yourself. 
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Processing Workflow for Water Column Data 
Open a project to which the water column data will be added.
Open WCI data in Swath Editor (Across and Along track and 
Stacked views)

• Filter based on intensity
• Overlay Bottom Detection
• Assign Colour Map

• Line editing - Query /Reject/Accept bathymetry
• Select and data to add to project bathymetry 
• Re-evaluate intensity filter range 
Open data in Subset Editor (2D and 3D views)
• Filter by intensity ranges determined in Swath Editor
• Query/ Reject /Accept bathymetry data 
• Designate critical soundings
• Select and add points to additional bathymetry layers. 

Working with Additional 
Bathymetry Layers

Toggle views between WCI, project bathymetry and additional 
bathymetry layers. 
Compute TPU for additional bathymetry.
If required, undo all processing of Additional Bathymetry, with 
Restart Cleaning command on pop-up menu. 
Regenerate additional bathymetry layers if project data has new 
corrections and new merge applied. 
Add additional bathymetry to BASE surfaces.
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Water Column Data in Swath Editor 
In Swath Editor. water column imagery is displayed in two 
windows: 
• Across track: the water column data as viewed from the stern 

of the survey vessel. There is an across track image for each 
selected profile (ping). (Also referred to as a profile view, polar 
intensity plot or swath profile.) 

• Along track: displays the water column data viewed from the 
starboard side of the vessel. This could also be referred to as a 
side view or vertical profile. The along track image is made up 
of the beams which point to nadir for the selected profiles. 

Stacked view WCI can also be displayed in a “stacked” view, to give an idea of 
what may be in the water column based on multiple profiles and 
beams. In the across track view all the profiles represented in 
the Plan view are stacked one on top of another. 
In the along track view the beams within a profile are stacked 
with the highest intensity beams showing through. See “STACKED 
VIEW” ON PAGE 466.

Bottom detections Bottom detections can be plotted on top of the water column 
image in the across track view. This can be used to view how the 
existing bathymetry compares to that which is present in the 
water column data. This display can be toggled on and off from 
the toolbar. See “WATER COLUMN TOOLBAR” ON PAGE 465.
Basic filtering is also present so the WCI data can be filtered 
based on intensity values. 
All existing Swath Editor options and functionality, where 
relevant, have been connected within the WCI views, to keep 
work flows consistent and familiar.

Alo
ng

 tra
ck

Across track
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Display water column data 
To view WCI data in Swath Editor:
1. Select a survey line in the Display Window. 

2. Select the Open Swath Editor command.

If the selected line contains WCI data:
• the data will be loaded into the Along and Across track 

windows,
• the Water Column Editor toolbar will be displayed, 
• and the WCI tab will be displayed in the Swath Editor 

Control page. 
The example below shows WCI data displayed in the across and 
along track windows, and bathymetry in the Display window 
(shown as a BASE surface). 1 

3. Select a profile, for example, in the Plan View.

The related WCI data is displayed in the water column windows

M
en

u Tools > Swath Editor  
> Open

To
ol

Po
p-

up Tools > Swath Editor

1. Image courtesy of John Hughes Clarke, Ocean Mapping Group, University of New 
Brunswick. 
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Scroll through the Plan view using the arrow keys, or scroll 
buttons, to see the water column image in the across and along 
track views.
To highlight a WCI profile in the Swath Editor views:
4. Click the middle mouse button in the Along track window.

As each profile is highlighted, the display in the Swath Editor 
windows is automatically refreshed.
As well, there is a slider bar in the Across track window, similar 
to that of the Profile window, which you can use to scroll through 
the data. 

Automatic scrolling 
As well as viewing WCI data profile by profile, you can view the 
data in sequence using the playback controls on the Water 
Column toolbar. (These work in a similar fashion to the playback 
controls in the Side Scan Editor.)
To scroll automatically through the data: 
1. Click on the Plan View window.

2. Click First Profile on the Water Column Data toolbar to select the first 
profile visible in the Plan View. 

 3. Click Start playback to start scrolling the data.

HIPS will move up the track line, profile by profile, changing the 
view of the water column data, until it reaches the last profile 
loaded in the Plan View. 
4. Click Reverse playback to scroll back down the track line.

5. Click Stop playback to pause the scrolling. 

6. Click Last Profile to reset the view to the last profile loaded in the [plan 
View. 

Playback is not available when data is stacked. 
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Water Column Toolbar 
The Water Column toolbar contains the controls to open and 
close the Across track and Along track windows, to display the 
bottom detection and to control the play back of the imagery. 
 

The Display across track and Display along track tool buttons open 
and close their respective windows. 
The Bottom Detection button toggles the bottom detection on and 
off. In the across track it will indicates the current swath 
bathymetry and in the along track, the centre beam bathymetry 
If activated when Stacked View is enabled, the bottom 
detections are also stacked. 
Head 1 data and Head 2 data are used when there is data from 
both heads of a dual head multibeam configuration. You can 
toggle between the heads to determine which data should be 
plotted on top: Head1 (port data) or Head 2 (starboard data).
The Select button enables you to select water column data in the 
across track or along track windows, for example, to add data to 
the Additional Bathymetry layer.

Stop 
playback

Toggle along track 
view window

Display Head 2 
data

Display Head 1 dataToggle display of 
bottom detections 

Toggle across 
track view 
window

Go to first 
profile

Reverse 
playback

Go to last 
profile

Start 
playback

Select water 
column data
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WCI Controls in Swath Editor
When there is water column data open in Swath Editor, the 
Control window tab will include a WCI tab containing options 
for displaying water column data. 
 

Use the Colour controls set the colour of the data displayed in the 
Across track and Along track windows.
7. Select a colour from the Colour map field.

8. Click Reverse to change the current colours to their inverse. 

Water column data can be filtered by intensity values, so that 
only data within the set range is displayed. To filter the data: 
9. Use the sliders to set a filter range between -64 dB and zero.

These intensity settings are retained so that the same filter 
range can be applied when the data is loaded into Subset Editor.

Stacked view
Use the Enable Stacked View option to see all the across track 
views layered on top of each other in the Across track window. 
1. Make a selection of profiles in the Plan view window. 

2. Select the Enable Stacked View check box.

The Across track view will display the stacked images.
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3. Use the scroll bar on the Plan View, or your middle mouse button, to 
move the selection to other profiles. 

The stacked view will be refreshed with the new data.  

You cannot use playback when the data is in Stacked mode. 
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Add WC Bathymetry to Project
Viewing WCI data in Swath Editor enables you to determine 
critical data that can then be selected and added as bathymetry 
in the project. As well, you can then use the editing tools to 
Reject, Accept and Designate the new additional bathymetry 
data
To select data in the Across or Along track windows:
1. Click the Select button on the Water Column toolbar. 

2. Use Select by Range or Select By Lasso to select data.

3. Right-click on the selected data and select Query from the pop-up 
menu to view in the Selection tab.

To add selected data to the project as additional bathymetry:
4. Right-click on the selected data and select Add to Additional 

Bathymetry.

The data will now appear as “additionalBathymetry” layers in 
the Layers tab. 

As well, the Output tab will report the number of WCI samples 
exported to the bathymetry layer.

To
ol

Po
p-

up Add selection to 
Additional Bathymetry
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WCI Data in Subset Editor
In Subset Editor, WCI data is loaded as a temporary 3D point 
cloud. Data can be filtered by intensity as well as by a minimum 
slant range at nadir. WCI data in Subset Editor can also be 
added the the Additional Bathymetry layer and processed in the 
standard bathymetry workflow. 
To open water column data in Subset Editor:
1. Define and load a subset of the data. (For information on loading a 

subset see, “OPEN SUBSET EDITOR AND LOAD DATA” ON PAGE 111.)

2. In the Control window, select the Subset Editor tab. 

3. In the Data tree, select the Water Column layer.

The tab is refreshed to display the controls for loading and 
unloading WCI data, filtering by depth, slant range, and 
intensity.
 

4. [Optional] Set a range of depths to load using the Minimum and 
Maximum Depth fields. 

Applying a minimum slant range filter will load only the strong 
echoes and minimize background noise. Background noise 
within the minimum slant range has a backscatter strength of 
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lower than -50dB. Therefore it is logical to load only those data 
points which have a stronger echo than - 50 dB. 
This option is turned off by default. To set slant range filtering:
5. Select the Filter by Minimum Slant Range check box.

Water column data can be filtered by intensity values, so that 
only data within the set range is displayed. This filter is the 
same as in Swath Editor. Settings are retained so that the same 
filter range can be applied in both editors.
To filter the data: 
6. Use the sliders to set a filter range between -64 dB and zero.

7. Click Load.

The face of the Load button shows the loading progress. Loading 
can be cancelled by clicking the Cancel button.
When the data is loaded, the button label is changed to Open. 
8. Click Open to display the data in the Subset Editor windows. 

The image below shows WCI data displayed in the Subset Editor 
3D view:
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Display options
You can set the size of the displayed data points, their 
transparency and colour them by attribute. 

The default setting for the size of points is set in the HIPS Data 
layer, where the size can be set from 1(smallest) to 10 (largest). 
You can override this default setting for the WCI data. To have 
stronger returns display as larger points, and weaker returns as 
smaller points, (while other points in the subset are not resized):
1. Select the Water Column layer in the Data tree.

2. Clear the Fixed Sized Points check box.

If you want the WCI points to be displayed at a constant size:
3. Select the Fixed Sized Points check box.

You can toggle this display option on and off while data is 
loaded. 
Attributes of the WCI data can be displayed one layer at a time. 
Each attribute (except Bottom Detection) has its own colour 
map. You can change the assigned colour mapping. 
The attributes include:

• Intensity
• Depth
• Line 
• Day
• Vessel
• Project

To view the data of a particular attribute:
4. Select the attribute from the drop-down list. 

5. Select a colour map from Colour Map drop-down list. 

Two colour settings for “Bottom Detection” indicate whether a 
point is detected bottom or not. You can change the colours of 
these flag settings also using the colour picker.
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Survey lines
The Survey Lines field in the lower part of the Control window 
shows a data tree in the familiar P/V/D/L layers. 

Use the check boxes beside each layer to turn on and off the WCI 
data associated with individual lines.
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Additional Bathymetry
In both Swath Editor and Subset Editor additional bathymetry 
data can be queried and edited. As well critical soundings can be 
Designated, and others flagged as Outstanding or Examined. 

Restart Cleaning If you want to reverse the editing of additional bathymetry:
1. Right-click on the additional bathymetry layer, and 

2. Select Restart Cleaning from the pop-up menu. 

This will restore the status of the data to Accepted.
Show Rejected The additionalBathymetry (parent) layer has similar properties 

to those of a BASE surface: extents, identification, creation date, 
etc. See “VIEW SURFACE PROPERTIES” ON PAGE 204.
As with BASE surface parent layers, there are few editable 
fields, however, for the additionalBathymetry layer there is the 
option to display any additional bathymetry data that has been 
rejected in an editor.
1. Set Show Rejected Points to True to show rejected data. 

2. Set the option to False to hide rejected points.

The attribute (child) layers have the same properties options as 
do BASE surface attribute layers. See “ATTRIBUTE LAYER PROPERTIES” 
ON PAGE 206. 

Compute TPU TPU can be applied to the additionalBathymetry layer. This will 
add two child layers to the additionalBathymetry attributes: 
DepthTPU and PositionTPU. See “COMPUTE TPU” ON PAGE 156.

Regenerate If corrections such as tide, SVP etc., have been applied to project 
data during processing, requiring that Merge be re-applied, the 
additional bathymetry is not updated.
To update the additional bathymetry:
1. Right-click on the additionalBathymetry layer. 

2. Select Regenerate from the pop-up menu.
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Use Plot Composer to publish HIPS and SIPS products to PDF or paper. 

In this chapter...
PLOT COMPOSER....................................................... 476
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Plot Composer
HIPS and SIPS data can be formatted for printing to paper or to 
Portable Document Format (PDF) using CARIS Plot Composer. 
Plot Composer is a plotting utility provided with various CARIS 
applications to produce paper products containing raster and 
vector geo-spatial information.
Plot Composer can use data from other CARIS products such as 
Bathy DataBASE, in formats such as GeoTIFF, BSB, JPEG 
2000, S-57, Shapefiles, AutoCAD, as well as HIPS and SIPS 
data, to produce paper products.
Some of Plot Composer’s key functions are to:
• Capture data views from HIPS and SIPS in the scale 

displayed 
• Configure data and add raster and vector data formats 

supported by CARIS applications 
• Display geo-referenced in the CARIS supported formats
• Add geographic or projection grids, borders and scale bars 
• Configure data views to be north-up or rotated
• Set coordinate system
• Add OLE objects, images and text blocks
• Output to PostScript or TIFF file.
Open Plot Composer from the Start > Programs > CARIS > 
Utilities folder, (which also contains the Plot Composer Users 
Guide). 
The following is an example of a BASE surface and background 
data being formatted in Plot Composer. 
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Export Data

Sounding and contour layers can be exported to S-57 format, or to DXF. 
Surface metatdata can be exported to an XML file. Surface data can also 
be exported to BAG.

As well, data products can be exported in various formats with the Export 
Wizard. 

In this chapter...
EXPORT TO S-57 ...................................................... 480
EXPORT SURFACE METADATA ...................................... 481
EXPORT SURFACE TO BAG......................................... 482
EXPORT SURFACE TO ESRI ASCII GRID ..................... 486
EXPORT SELECTION TO DXF....................................... 487
EXPORT SELECTION TO FORMATTED ASCII ................... 489
EXPORT SELECTION TO GML ...................................... 490
List of FORMATS EXPORTED ....................................... 492
EXPORT WIZARD ....................................................... 494
COORDINATE SYSTEM................................................. 541
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Export to S-57
You can export contour and sounding features to an S-57 file.
To export to S-57:
1. Open a project and field sheet containing a contour layer and/or a 

sounding layer.

2. Select the field sheet layer in the Layers tab.

3. Select Export to S-57 from the File menu.

The Export to S-57 dialog box opens.
 

4. Select a data layer to export from the list of available layers. 

5. Type the full path or click Browse… to enter the full path to the data. 

6. Choose a Navigational Purpose layer from the drop-down list of chart 
types.

7. Type a 5-character data set name for the file. This name will be 
appended to the characters displayed to the right of the field (1C1 in 
this example). 

8. Click OK. 

M
en

u

File > Export
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Export Surface Metadata
Save the metadata from a CSAR surface to a 19115 / 19139 
compliant metadata file. Metadata can be viewed in the 
Properties tab for the selected surface.
See “VIEW SURFACE PROPERTIES” ON PAGE 204.
The metadata file is saved in XML format. 
1. Select the surface in the Layers tab.

2. Select File> Export > Surface Metadata command.

The Save As dialog box is displayed.
A default file name is displayed, created from the name of the 
selected surface with the word “metadata” appended to it, as in:
BASE421_metadata.xml. 

3. [Optional] Type a name for the metadata file.

The default location for the exported file is CARIS > HIPS > 
version > Session. 

M
en

u File > Export > 
Surface Metadata
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Export Surface to BAG 
Export a BASE Surface to a BAG (Bathymetric Attributed Grid) 
file. You can save your export settings to a template file that can 
be loaded and applied when exporting to BAG again. 
1. Select the surface in the Layers tab.

2. Select the Export Surface to BAG command.

The Export to BAG dialog box displays the fields for General and 
Metadata settings for the export.

3. Enter the export settings, or load a previously saved template file.

See “EXPORT SETTINGS” ON PAGE 483.
See “SAVE AND LOAD TEMPLATES” ON PAGE 484. 
4. Click OK to perform the export.

The surface is exported using the selected settings. The Output 
tab shows the status of the export. 

M
en

u File > Export > 
Surface to BAG
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Export Settings
You can view the export settings fields in two ways. In Category 
view the fields are listed under headings. In Alphabetical view 
the fields are listed in A to Z order. Toggle between these views 
using the buttons at the top right of the of dialog box. 

Field Function

General (define the input and output settings fro the export)

Band Name Select the surface layer to be exported. 

Compression

Output Type Export the selected BASE surface to a single Output File, or 
as a tile set to multiple files in an Output Folder

Output File 
(single file)

Click Browse to save the name and location for the 
exported file. Name appears in the field.

Output Folder 
(multiple files)

Click Browse to locate the destination folder for the 
exported tile set

Tile Width Define width of the multiple tiled files. The units are those set 
in Tools > Options > Display > Units.

Tile Height Define height of the multiple tiled files. The units are those 
set in Tools > Options > Display > Units.

Tile Prefix Type a prefix for exported tile files. 

The files will have a tile number appended to the file name, 
based on the location of the tile in the surface. The tile 
number is in the format RxC where R and C are the row and 
column index for the current tile. With a prefix such as RTFM, 
tiles would be numbered RTFM_1x1, RTFM_2x2 etc.

NOTE: Attempting to export a large surface to a single file may cause 
an out-of-memory error if there is limited memory allotted to the 
application. For larger surfaces, it’s recommend that you export a tile 
set. 

Metadata (provide metadata for the exported files)

General

Abstract Type a brief description of the data being exported.

Category Alphabetical 
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Save and Load Templates
Some field values are entered automatically when the dialog box 
is displayed. To automatically populate all fields automatically, 
you can create a template, by setting options for all the fields  
manually and then saving the settings to an XML file. 
This XML template file can then be loaded, so that the fields 
populated from the settings in the template are applied to 
another export.
To save export settings as a template: 
1. Enter fields settings.

2. Click Save to create a template of the export settings.

Status [Optional] Identify the status of the data at the time of export. 
Select from the drop-down menu:
• completed
• historicalArchive
• obsolete
• onGoing
• planned
• required
• underDevelopment

Vertical Datum Values above the vertical datum are positive.

Responsible 
Party

identifying information

Name Identify person responsible for the data

Position Position title for the responsible person

Organization Organization of the responsible person.

Role User role(s) assigned to the responsible party with regard to 
this data.

Constraints

Legal Specify whether the file is legally restricted from being 
copied, altered, or referenced without permission from the 
responsible party. Set the constraint from the drop-down list. 

If you select otherRestrictions, enter details in the Other field.

Other Type details of legal constraints on the data. 

Security Identify restrictions on access to the exported data by setting 
its security classification level from the drop-down list.

Notes Additional information about security constraints.

Field Function
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3. In the Save dialog box, define a name and location for the template file 
and click Save.

To load a saved template:
1. Select the surface in the Layers tab.

2. Select the Export Surface to BAG command.

3. Click Load, select the desired template and click Open.

The fields are populated with the saved settings.
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Export Surface to ESRI ASCII Grid 
Save a BASE surface layer to an ESRI ASCII grid. This export 
creates three output files: 
• an *.asc file containing the grid data (this can be opened as a 

background file in HIPS), 
• a *.prj file, which contains coordinate system information, 
• and an *.asc.aux.xml file containing metadata.
These files can be viewed in a text editor. 
1. Select the BASE surface parent layer in the Layers tab. 

2. Select the Export to ESRI grid command. 

The Export to ESRI ASCII Grid dialog box is displayed.

Use the Decimal Precision for elevation values field to define the number 
of decimal places to apply to the elevation values in the output 
files. The maximum number of decimal places is12. 
3. Select the value for Decimal Precision for elevation values that will be 

applied to the output data.

4. Select a surface Attribute to export, e.g., Depth or Density, from the 
drop-down list.

5. Click Browse (...) in the Output surface field and define a name and 
destination for the exported surface.

6. Click OK.

An ESRI ASCII Grid file is created.  

M
en

u File > Export > Surface 
to ESRI ASCII Grid

ESRI ASCII and Binary grid formats can be opened in HIPS 
as “Surfaces” with the Open Background Data cmmand from 
the File menu.
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Export Selection to DXF
Export a selection of data to a DXF (AutoCAD) file. Contours, 
soundings, lines and bounding polygons can be exported to DXF 
format.
Data is saved in two files: 
• The DXF file contains the exported data. 
• The DXF_RXL file contains the coordinate system, unit type 

and unit scale of the data.
These files can then be opened in CAD applications or viewed in 
HIPS and SIPS as background data. 

Export contours, 
soundings or bounding 
polygon

To export from HIPS to DXF:
1. Open the field sheet containing the contours, soundings or bounding 

polygon to be exported.

2. In the Layers tab, highlight the specific layer, for example, Contours or 
Depth.

3. In the Display window, select the the data to be exported.

4. Select the Export to DSF command.

A Save As dialog box is displayed.
5. Enter a file name and browse to the folder where you will save the 

exported file.

6. Click Save.

The Output window will report the progress of the export and 
the number of objects exported. The data is saved to the specified 
folder.

Export Lines or Critical 
Soundings

To export selected lines or selected critical soundings to DXF:
1. In the Layers tab, highlight the Ship Track Lines or Critical Soundings 

layer. 

2. In the Display window, select the the lines or soundings to be exported.

3. Select the Export to DXF command.

A Save As dialog box is displayed.
4. Enter a file name and browse to the folder where you will save the 

exported file.

5. Click Save.

The data is saved to the specified folder.

M
en

u File > Export > 
Selection to DXF

M
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u File > Export > 
Selection to DXF
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DXF files can be opened in HIPS and SIPS as background data. 
The opened file is listed in the Layers tab, as illustrated below.

DXF layers
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Export Selection to Formatted ASCII 
Export selected soundings and lines to formatted ASCII. The 
exported files will have the extension *.WKT ( well-known text). 
To export a selection, for example, of lines to a formatted ASCII 
file: 
1. Select the lines.

2. Select Export > Selection to Formatted ASCII command.
 3. In the Save As dialog box, select the folder to export to, and type a file 

name.

4. Click Save.

The selected data is exported to the named WKT file. 

M
en

u File > Export > 
Selection to 
Formatted ASCII 
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Export Selection to GML
Export information about selected features ( lines soundings, 
contacts) to a GML (Geography Markup Language) file. 
To export to a GML: 
1. Select the features to be converted.

2. Select the Export Selection to GML command.
 3. In the Save As dialog box, type a name and select a location for the file.

4. [Optional] Select the Run System command after export check box and 
enter command parameters in the Command field. This system 
command will then be applied to the new GML file when it is created.

5. Click Save.

The Advanced Options dialog box is displayed

Feature mapping There are no default GML mapping files in HIPS. If you want to 
use a mapping file you must create it before using the Feature 
Mapping option.
To map the selected HIPS features to GML:
6. Click the check box to enable the Feature Mapping option. 

7. From the Rule File drop-down list, select a file to use for mapping 
features .

M
en

u File > Export > 
Selection to GML 
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Apply features To apply a custom shift to the depths or height:
8. Click the check box to enable the Apply Shifts option.

9. Enter values in Depth and Height fields.

Convert Units To convert Depth, Ground, Height or Positional Accuracy units 
to another unit of measure:
10.Click the Convert Units check box to enable the option.

11.Select a new unit of measure from the drop-down list for each type you 
want to change.

12.Click OK.
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Formats Exported
The HIPS Export Wizard is a separate application launched 
from the HIPS and SIPS interface. TheExport Wizard converts 
HIPS data products (soundings, BASE Surfaces, mosaics, etc.) to 
the following formats:
• ASCII text file
• CARIS map
• Bathymetric Attributed Grid (BAG)
• (FAU)
• Generic Sensor Format (GSF) files
• Hydrographic Object Binary (HOB) file
• Hydrographic Transfer Format (HTF) files
• TIFF image
• Unified Sonar Imaging Processing System (UNISIPS) format
See the table below to view export options.

Export Formats

Format Description Refer to...

BAG to ASCII Export data in Bathymetric Attributed Grid format 
to ASCII format 

“BAG TO ASCII” ON PAGE 497

BASE Surface to 
ASCII

Export BASE Surface position and attribute data 
to a text file.

“BASE SURFACE TO ASCII” ON 
PAGE 498

BASE Surface to 
Image

Export BASE Surface attribute data as a 
georeferenced image for further processing in a 
CARIS product or other application.

“SURFACE TO IMAGE” ON PAGE 501

Contacts Export contacts to a CARIS map, an ASCII file, 
and/or a TIFF image.

“CONTACTS” ON PAGE 504

GeoBaR to ASCII Export one or more open GeoBaRs to ASCII 
format files.

“GEOBAR TO ASCII” ON PAGE 507

GeoBaR to Image Export one or more open GeoBaRs to Image 
files.

“SURFACE TO IMAGE” ON PAGE 501

GSF to CARIS map Export soundings and track lines from one or 
more Generic Sensor Format (GSF) files to a 
CARIS map. The GSF data does not have to be 
converted to HIPS format prior to using this utility.

“GSF TO CARIS MAP” ON PAGE 511

GSF to HOB Export GSF data to a Hydrographic Object Binary 
(HOB) file that stores feature objects and 
associated attribute data. The HOB file can 
contain links to CARIS spatial objects. 

“GSF TO HOB” ON PAGE 514

HIPS Tide to ASCII Export tide data from track lines to text format. “HIPS TIDE TO ASCII” ON PAGE 516
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HIPS to ASCII  Export HIPS data to a customized text listing of 
soundings that you can load into other software 
systems.

“HIPS TO ASCII” ON PAGE 517

HIPS to CARIS map  Export HIPS data to a CARIS map. This option 
contains three modes of exporting data: 
soundings, track lines and swaths.

“HIPS TO CARIS MAP” ON 
PAGE 523

HIPS to FAU Export HIPS data to FAU files. “HIPS TO FAU” ON PAGE 527

HIPS to GSF Export processed HIPS data to GSF format. A 
new GSF file is created for each trackline that is 
exported from HIPS. Conversely, when HIPS 
data is created from GSF data, a copy of the 
original GSF file is maintained inside the HIPS 
directory structure. The Export to GSF function 
updates these GSF files.

“HIPS TO GSF” ON PAGE 528

HIPS to HOB Export HIPS data to HOB files that store feature 
objects and associated attribute data. The HOB 
file can contain links to CARIS spatial objects. 
This option contains three modes of exporting 
data: soundings, track lines and swaths.

“HIPS TO HOB” ON PAGE 529

HIPS to HTF Export data to a Hydrographic Transfer Format 
(HTF) file. The HTF is a text file that contains a 
header section and a sounding record. The 
Export wizard can save a header section so it can 
be loaded into multiple HTF files.

“HIPS TO HTF” ON PAGE 531

Mosaic to ASCII Export mosaic layers to an ASCII file. “MOSAIC TO ASCII” ON PAGE 535

Mosaic to Image Export a mosaic as a TIFF image for further 
processing in a CARIS product or other 
application.

“SURFACE TO IMAGE” ON PAGE 501

Sediment Analysis to 
ASCII

Export the results of Sediment Analysis done in 
Mosaic Editor.

“SEDIMENT ANALYSIS TO ASCII” ON 
PAGE 539

SIPS to UNISIPS Export SIPS data to a Unified Sonar Imaging 
Processing System (UNISIPS) format.

“SIPS TO UNISIPS” ON PAGE 540

Format Description Refer to...
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Export Wizard
The first step to exporting data with the Export Wizard is to 
select the file format to be exported. The number of dialog boxes 
displayed in the subsequent steps depends on the export format 
selected in the Step 1 dialog box. 
To use the HIPS Export Wizard: 
1. Select the Export command.

The Export Wizard is displayed.

Step 1: Select Format
The Select Format dialog box lists all the formats available for 
exporting data.
 

1. Select an export format.

2. Click Next to select data to export.

M
en

u

File > Export

To
ol
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Step 2: Select Files 
Depending on the format being exported, this dialog box will 
display either available field sheet layers or a project tree. For 
example, when exporting a BASE surface, available layers are 
displayed; when exporting HIPS data, the Project/Vessel/Day/
Line tree for all available project files is displayed. 

Export a surface If you select a BASE Surface, a mosaic, a GeoBaR (or multiple 
GeoBaRs) to export, the Select Layer to Export dialog box will 
display the open files of that type below the associated field 
sheet. 
 

1. Expand the file tree and select the layer you want to export. 

You can export multiple GeoBaRs to ASCII or to Image.
2. Hold down the <Ctrl> key while selecting the GeoBaRs to export 

specific GeoBaRs.

3. To export all the listed GeoBaRs, hold down the <Shift> key and select 
the first and last in the list.

If you are exporting line data, for example, HIPS to ASCII or HIPS 
to HOB, you can select specific track lines before you activate the 
Export Wizard. You can also adjust this selection in the Step 2 
dialog box.
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Export contacts or line 
data 

For these file formats the dialog box displays the existing 
projects, organized in a Project/Vessel/Day/Line structure. 
.

1. Expand the file tree to select the trackl ines to export.

If you have selected lines to export before opening the Export 
Wizard, they will be selected here. 
To add lines to this selection:
2. Hold down the <Ctrl> key and select additional lines.
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BAG to ASCII 
Data from a Bathymetric Attributed Grid (BAG) file can be 
exported using the BASE Surface to ASCII options. 
1. Open the Export Wizard.

2. Select BASE Surface to ASCII from the list in the Step 1 dialog box.

3. Click Next.
4. Select the BAG surface from the layer tree at Step 2. 

5. Click Next .

See “BASE SURFACE TO ASCII” ON PAGE 498.
To export metadata for the BAG surface: 
1. Open the BAG file as background data.

2. Select the BAG layer.

3. Select the Export Surface Metadata command.

The Save As dialog box will auto-fill the File name field with the 
name of the BAG file with _metadata added to the file name. 
You can type an alternate name. 
4. Click Save.

M
en

u File > Export > 
Surface Metadata
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BASE Surface To ASCII
Export BASE Surface attributes to an ASCII text file.

BASE Surface to ASCII (Step 3)

1. Type the path and file name for the output file , or Browse to the 
destination folder. 

2. Type the file name and click Save. 

3. Select the Position Units for data from the drop-down list:
• Ground (East, North): position displayed as Easting, Northing to the 

precision defined (for example:360425.000, 4770355.000)
• Geographic (DMS): position displayed as Latitude, Longitude in 

degrees, minutes, seconds to the precision defined (for example: 
43-04-23.03N, 070-42-51.89W 

• Geographic (Unformatted DMS): displays the position without using 
hyphens or direction indicators, for example, 43 04 23.03, -070 
42 51.89.

• Geographic (Decimal Degrees): position displayed as Latitude, 
Longitude, in decimal degrees to the precision set, for example, 
43.073 -070.714.

• Geographic ( Degree Minutes): position displayed as Latitude, 
Longitude, in degrees and minutes, to the precision set, for 
example, 34-23.610N,119-52.585W. 

Note that for positions in the northern hemisphere, longitude 
West values are negative; in the southern hemisphere, the South 
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latitude values are negative. For example, a position near 
Portsmouth NH, USA is 43 04 23.03, -070 42 51.89. A 
position near Sydney Australia is -33 51 00.84 151 11 43.7

4. Specify the precision for the display of position units, by using the 
Precision up or down arrow button to set the number of digits to be 
displayed to the right of the decimal point. 

5. Select the check boxes for the Surface Attributes values to be recorded 
in the ASCII file. 

6. Click Up and Down to move the attributes into the order you wish them 
to appear in the file.
• All attributes checked in the list will be included in the ASCII output. 

7. [Optional] Select Include Headers in Output to have the appropriate 
column headers included in the ASCII file. 

8. Select either Space, Comma, or Tab from the list to use these 
characters to separate fields in the output file. If you select Other, type 
a character to use a delimiter. 

9. Set the Attribute Precision value (number of digits to the right of decimal 
point) for the selected attributes. 

The example below shows a comma-delimited ASCII file for the 
Depth attribute of a BASE surface with the positions in decimal 
degrees, and column headers turned on.

10.Click Next.
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Select Export Units 
This dialog box sets the unit type for recording data. The fields 
that are active in this dialog are determined by the attributes 
selected in the previous dialog box.
 

Available units are:
• metres and kilometres
• fathoms (US and international)
• feet (US and international)
• yards (US and international)
• miles (US, international, and nautical)

1. In the Vertical Length field, select units for depth and uncertainty values.

The Horizontal Length field is only active if you selected Ground in 
the Position Units field in the previous dialog box. 
2. Select the units for position data. 

To apply a static vertical shift to data during export:
3. Select the Vertical Shift check box and type the value for the shift (in 

metres). 

4. The shift will be applied to any layer of the surface containing vertical 
data.

5. Click Next to continue setting export parameters. “EXPORT” ON PAGE 542 

 

If you are exporting attribute data from a BASE Surface 
created prior to HIPS and SIPS 6.1, this dialog box is not 
displayed because the default measurement unit is metres.
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Surface To Image
Export a BASE Surface, a mosaic, or one or more GeoBaRs to an 
image file. 

Attribute and Image Options 

Attribute Options If the selected attribute layer has a legend associated with it, 
you can include this legend in the exported image. The legend 
will be overlaid on the surface, in the position and with labels as 
set in the Properties for the selected attribute layer. 
1. From the Active Attribute field, select the layer to display as a geo-

referenced image.

2. Select Display Raster Legend to include the raster legend for the selected 
attribute layer in the exported image.

Select Expand cover to fit the raster legend to expand the area of the 
image so that the legend does not overlay the surface.

Image Options Image format options can help reduce file sizes: 
3. Select a colour format for the image.

• 24 Bit (16 million colours)
• 8 Bit (256 colours)

4. Select Compress TIFF to decrease the file size of the TIFF during export.
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Georeference Format Selecting the TFW / TIFF check box will generate two ASCII 
files in addition to the TIFF image. One, with file extension 
CSPRPOJ, contains Coordinate system information for the 
image. The other, with extension TFW, contains the ground 
coordinates. These can be read using a text file reader.
5. Select TFW/TIFF as to produce additional files. 

6. Click Next.

Image Output Options 
You can export a BASE surface layer, a single GeoBaR layer, or 
a Mosaic layer to a TIFF image file, or to a tiled set of images, or 
to both formats at the same time. 
More than one GeoBaR can be exported at a time, in which case 
the TIFF files are saved either to a single folder, or to folders 
which follow the PVDL (Project/Vessel/Day/Line) structure. 

Image Output 1. Click Browse, and set the Output file path. 

2. Type a name for the file name and click Save. 

If you are exporting multiple GeoBaRs:
3. Click Browse to select the folder where the exported files will be 

saved. (The TIFF files in the output folder will have the same names as 
the GeoBaRs they were created from.) 

Select Maintain PVDL Hierarchy to save each TIFF file within its 
Project/Vessel/Day/Line structure in the folder you designate. 
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Tiled image output Some attribute layers may be too large to view effectively as one 
image. In this case, you can export the layer divided into a set of 
tiled images, with set dimensions. 
These files are given a prefix, to which a tile number is 
appended. The tile number is in the format “RxC” where “R” and 
“C” are the row and column index for the current tile. 
For example, with prefix RTFM, the first row of tiles would be 
numbered RTFM_1x1, the second RTFM_1x2 etc., as illustrated 
below.
 

The tiled sets of TIFF images are all saved to the folder selected 
in the Tile Set Output field.
4. Click Browse, and select the path to the Output Folder for the tile 

images.

5. Set the Tile Dimensions to specify the size of each tile. The units used 
here are those set for Horizontal Length in Tools > Options > Display > 
Units.

6. Type a prefix for the exported tile files. 

7. Click Next. 

“EXPORT” ON PAGE 542
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Contacts
Export contact data for your entire project to a CARIS map and/
or an ASCII text file. The ASCII files are structured to be easily 
imported into a relational database. You can also export contact 
snapshot images to TIFF files.
If you select ASCII, you will have to browse to a folder location 
and type a file name. This name is used as the first component 
name of four files that will be created to store the contact 
information:
• filename_ContactLine.txt contains information identifying 

the survey line and indexes to the other files.
• filename_ContactSingle.txt contains all the information for 

single point contacts.
• filename_ContactMulti.txt contains all information for line 

contacts.
• filename_ContactMultiPoints.txt contains all location 

information for multipoint contacts.
For information on the structure of exported contact files, see 
CONTACT FILE FORMATS ON PAGE 139 OF THE HIPS AND SIPS REFERENCE GUIDE

Contacts (Step 3)
  

1. Select the Export Image check box to export the contact(s) in TIFF 
image format.

2. If you select Export Image, select from the following image formats:
• Mosaic: This option creates a georeferenced TIFF image from 

contact data.
• Speed Corrected: This option calculates the distance between profile 

lines in the contact and corrects for vessel speed.
• Uncorrected: This option does not correct for vessel speed and 

renders a one-to-one correspondence between the side scan image 
and the contact.

3. To export the colour map that was selected in the Side Scan Editor, 
select the Use Colour Map Specified in Contact File.

4. To export the contact with a new colour map, select the 
Use Other Colour Map option and select the map from the drop-down list.

The selected colour map is displayed in the Preview field.
5. Select the directory location for the contact. You can select from two 

options:
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• Save Images in the Line Directory: This option saves the contact data 
to the line file in the HIPS/SIPS Project/Vessel/Day directory 
structure that you selected in the second dialog box.

• Save Images in User Defined Directory: This option saves the contact 
data in another directory. Click Browse to select the folder where 
you want to save the data.

6. Click Next.

Contacts (Step 4)
This dialog box contains options for exporting contact data to an 
ASCII or CARIS file. 

1. Select either the Export to CARIS Map or Export to ASCII check boxes. 
Both can be selected at the same time.

2. Type a file name and path to store the contact data after export, or click 
Browse to select the file path (both CARIS data and ASCII text files are 
typically stored in ..\Hips\CARIS_Files).

3. Type a layer number for the contact data in the Theme Number field.

4. Type a symbol size for the contact data in the Symbol Size field.

5. Click Next. 

“EXPORT” ON PAGE 542
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GeoBaR to ASCII
Export GeoBaR attributes to an ASCII text file.

GeoBaR to ASCII Output Options

Output file location If you are exporting one GeoBaR: 
1. Type the path and file name for the output, or click Browse to go to the 

destination folder. 

2. Type the file name and click Save. 

If you are exporting multiple GeoBaRs:
3. Click Browse to select the folder where the exported files will be 

saved. (The ASCII files in the output folder will have the same names 
as the GeoBaR they were created from.) 

4. Select Maintain PVDL Hierarchy to save each ASCII file within its Project/
Vessel/Day/Line structure in the folder you designate. (The files will 
have the same names as the GeoBaR they were created from.)

Position units 5. Select the Position Units for data from the drop-down list:
• Ground (East, North): position displayed as Easting, Northing to the 

precision defined (for example:360425.000, 4770355.000)
• Geographic (DMS): position displayed as Latitude, Longitude in 

degrees, minutes, seconds to the precision defined (for example: 
43-04-23.03N, 070-42-51.89W 
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• Geographic (Unformatted DMS): displays the position without using 
hyphens or direction indicators, for example, 43 04 23.03, -070 
42 51.89.

• Geographic (Decimal Degrees): position displayed as Latitude, 
Longitude, in decimal degrees to the precision set, for example, 
43.073 -070.714.

• Geographic ( Degree Minutes): position displayed as Latitude, 
Longitude, in degrees and minutes, to the precision set, for 
example, 34-23.610N,119-52.585W. 

Note that for positions in the northern hemisphere, longitude 
West values are negative; in the southern hemisphere, the South 
latitude values are negative. For example, a position near 
Portsmouth NH, USA is 43 04 23.03, -070 42 51.89. A 
position near Sydney Australia is -33 51 00.84 151 11 43.7
6. Specify the precision for the display of position values, by using the 

Precision up or down arrow buttons to set the number of digits to be 
displayed to the right of the decimal point. 

7. Select the BASE Surface attribute values to be recorded in the ASCII 
file by selecting the attribute in the Available column and clicking Add to 
move it to the Active column.

8. To remove an attribute, select the attribute from the Active column and 
click Remove to move it back to the Available column.

9. Choose a Attribute Precision value (number of digits to the right of 
decimal point) for an attribute in the Active column by selecting an 
attribute and clicking the up or down arrow buttons.

10.Select the Headers check box to print attribute names at the top of the 
attribute rows in the output file.

11.Select either Space, Comma, or Tab from the list to use these 
characters to separate fields in the output file. If you select Other, type 
a character to use a delimiter. 

Click Next.

Select Export Units 
This dialog box sets the unit type for recording data. The fields 
that are active in this dialog are determined by the attributes 
selected in the previous dialog box.
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Available units are:
• metres and kilometres
• fathoms (US and international)
• feet (US and international)
• yards (US and international)
• miles (US, international, and nautical)

1. In the Vertical Length field, select the units for depth and uncertainty 
values.

The Horizontal Length field is only active if you selected Ground in 
the Position Units field in the previous dialog box. 
2. Select the units for position data. 

3. Click Next.

“EXPORT” ON PAGE 542
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GeoBaR to Image
Please see“SURFACE TO IMAGE” ON PAGE 501 for the description of this 
export process. 
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GSF to CARIS Map 
The Generic Sensor Format (GSF) to CARIS function loads 
soundings and track lines from one or more GSF files into a 
CARIS map. GSF data does not have to be converted to HIPS 
data prior to using this utility. For exporting to HOB, see “GSF TO 
HOB” ON PAGE 514. 

Select GSF Files 

In this dialog box you can list the file path to the GSF file(s) you 
want to export.
1. Click Select to choose the GSF files to be exported.

2. Hold the <Ctrl> key while selecting to add more than one file to the list.

3. To remove a file from the list, highlight the file and click Remove.

4. Click Next.

Export Soundings and Track lines 

Data can be exported either in the form of soundings or track 
lines:
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• Soundings. Export all soundings that fit within the 
boundaries of the work file (subject to the HIPS Sounding 
Status and Data Thinning settings).

• Track Lines. Export a line that connects the centre of each 
swath for each survey line, thus showing the track of the 
vessel along each survey line. It is not necessary to export 
soundings to use this option.

1. Select either Export Soundings or Export track lines or both.

2. If you selected Export Soundings, complete any or all of the following 
fields:
• Attributes: Select Basic or Advanced from the drop-down list. 

The Basic Attributes option creates mandatory CARIS feature 
attributes for the map file, such as feature code, user number and 
source ID. 
The Advanced Attributes option creates additional CARIS feature 
attributes for soundings such as time stamps, launch identifier and 
tidal correction.

• Status: Select soundings flagged as Selected, Accepted or 
Accepted and Rejected.

• Feature Code: Select a feature code for the soundings from the drop-
down list.

• User Number: Type a number value for layering data in the CARIS 
map or HOB file.

• Group By Beam: Load soundings into user numbers according to 
sonar beam number. For example, all soundings from beam 37 are 
loaded to user number 37 in the CARIS map file or HOB file

3. If you selected Export Tracklines, complete any or all of the following 
fields.
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• Feature Code: Select a feature code for the track lines object from 
the drop-down list.

• User Number: Type a number value for layering data in the CARIS 
map.

4. Select the Include Offline Data check box to include data recorded 
during turns between track lines.

5. Click Next.

CARIS Map Options 

Use this dialog box to set the destination of the exported data.
1. Click the Browse button […] to select CARIS map (*.des file) for data 

export, or to create a new map file.

The map file path and name are displayed in the CARIS Map field.
The CARIS Source ID is a 12-character alphanumeric attribute in 
CARIS maps. The ID can be the first or last 12 characters in a 
GSF project name.
2. Choose either the first 12 characters or the last 12 characters for the 

CARIS Source ID from the drop-down list.

3. Click Next to select the projection for the exported data. 
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GSF to HOB
The Generic Sensor Format (GSF) to CARIS function loads 
soundings and track lines from one or more GSF files into a 
HOB file. GSF data does not have to be converted to HIPS data 
prior to using this utility. For information on converting GSF to 
CARIS map, see “GSF TO CARIS MAP” ON PAGE 511.

GSF Files to Export 
In this dialog box you can list the file path to the GSF file(s) you 
want to export.
1. Click Select to choose the GSF files to be exported.

2. Hold the <Ctrl> key while selecting to add more than one file to the list.

3. To remove a file from the list, highlight the file and click Remove.

4. Click Next.

Export Soundings and Track lines 

Data can be exported either in the form of soundings or track 
lines:
• Soundings. Export all soundings that fit within the 

boundaries of the work file (subject to the HIPS Sounding 
Status and Data Thinning settings).
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• Track Lines. Export a line that connects the centre of each 
swath for each survey line, thus showing the track of the 
vessel along each survey line. It is not necessary to export 
soundings to use this option.

1. Select either Export Soundings or Export track lines or both.

2. If you selected Export Soundings, complete any or all of the following 
fields:
• Attributes: Select Basic or Advanced from the drop-down list. 

The Basic Attributes option creates mandatory CARIS feature 
attributes for the map file, such as feature code, user number and 
source ID. 
The Advanced Attributes option creates additional CARIS feature 
attributes for soundings such as time stamps, launch identifier and 
tidal correction.

• Status: Select soundings flagged as Selected, Accepted or 
Accepted and Rejected.

• Feature Code: Select a feature code for the soundings from the drop-
down list. 

• User Number: Type a number value for layering data in the CARIS 
map or HOB file.

• Group By Beam: Load soundings into user numbers according to 
sonar beam number. For example, all soundings from beam 37 are 
loaded to user number 37 in the CARIS map file or HOB file

3. If you selected Export Tracklines, complete any or all of the following 
fields.
• Feature Code: Select a feature code for the track lines object from 

the drop-down list.
• User Number: Type a number value for layering data in the CARIS 

map.

4. Select the Include Offline Data check box to include data recorded 
during turns between track lines.

5. Click Next.

GSF to HOB (Step 4)
Use this dialog box to set the location of HOB file to contain the 
exported GSF data. 
1. Click the Browse button […] to select the HOB file for data export, or to 

create a new file.

The file path and name are displayed in the HOB file field.
2. Click Next.

“EXPORT” ON PAGE 542
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HIPS Tide to ASCII
Export HIPS tide data from selected track lines to a TID file. 
You can create TID files from single or multiple track lines in a 
project. TID files can be viewed in a text editor.

HIPS Tide to ASCII (Step 3)
The Output Options dialog box creates the output tide file.

1. Click Browse and use the standard Windows Open dialog box to select 
a path and name for the output TID file.

The path and name of the tide file is displayed in the Output File 
Name field.
2. Select the Include Rejected Records check box to include tide records 

that have been rejected.

3. Select GPS Tide to use tides calculated from a GPS ellipsoid height.

4. Select Smooth data to use tide data that has been smoothed for 
localized variability.

“EXPORT” ON PAGE 542
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HIPS To ASCII
The HIPS to ASCII function creates a customized text listing of 
soundings that you can load into other software systems.

HIPS to ASCII (Step 3)
This dialog box lists the attributes that can be exported to the 
ASCII file and the delimiters used to separate data in the file.

The attributes that are available to export will vary with the 
type of data being exported, for example, if single beam data is 
being exported, Primary Depth and Secondary Depth are listed 
with other attributes in the Available list. 
1. Select the sounding attributes to be included in the ASCII file.

• To add an attribute, select the attribute in the Available list and click 
Add to move it to the Active list.

• To remove an attribute, select the attribute in the Active list and click 
Remove to move it to the Available list.

2. To change the order that attributes are exported, select the attribute in 
the Active list and click the up or down arrow buttons.

3. Select the Headers check box to create print attribute names at the top 
of the attribute rows.
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4. Select either the Space, Comma, or Tab check boxes to use these 
characters as delimiters, or select the Other check box and type a 
character to use as a delimiter.

You can define the boundaries of the ASCII map data from the 
boundaries of an existing CARIS map. If you do not select this 
option, this is defined from the ASCII data.
5. Select the Clip to CARIS Map check box to use a CARIS map to define 

the boundaries of the ASCII map data.

6. Click Browse to select an existing CARIS map.

7. To use the coordinate system from the selected CARIS map for the 
ASCII data, click the check box.

If you selected the Use Coordinate System From CARIS Map option, the 
next dialog box prompts you to export the data. If you did not 
select this option, the next dialog box prompts you to select a 
coordinate system.
8. Click Next. 
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Select Export Units 
This dialog box sets the unit type for recording data. The fields 
that are active in this dialog are determined by the attributes 
selected in the previous dialog box.
 

Available units are:
• metres and kilometres
• fathoms (US and international)
• feet (US and international)
• yards (US and international)
• miles (US, international, and nautical)

1. In the Vertical Length field, select the units for depth and uncertainty 
values.

The Horizontal Length field is only active if you selected Ground in 
the Position Units field in the previous dialog box. 
2. Select the units for position data.

To apply a static vertical shift to data during export:
3. Select the Vertical Shift check box and type the value for the shift (in 

metres). 

4. The shift will be applied to the depth value (also to the primary and 
secondary depths for single beam data). 

5. Click Next to set the coordinate system for the data.
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Coordinate System
All sounding data is stored in HIPS and SIPS as un-projected 
longitude and latitude. This dialog selects the appropriate 
coordinate system to reference the soundings. All soundings will 
be transformed to this coordinate system as they are exported.

1. Choose a coordinate system by selecting a Projection Group from the 
list.

2. Select a Zone associated with the Projection Group (the Key field is 
filled when the Zone is selected).

Click Next. 
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HIPS to ASCII - Step 6

Each sounding in a cleaned HIPS data set are stored with bits 
that determine the status of that sounding. You can choose to 
restrict the export process to soundings with specific status 
flags.
1. To export soundings with a specific status flag, select the appropriate 

Sounding Status check boxes.

2. To apply a data thinning function, select the Data Binning check box.

The Data Binning option divides the survey area into a grid and 
selects either the shoal- or deep-biased soundings from each cell 
for export. The Bin Size option sets the size of the grid cells.
3. Type the size for the grid cell in the Bin Size field. The units used here 

can be changed in the Tools > Options > Display >Units dialog box. 

4. Select either the Shoal-Biased or Deep-Biased options to export only 
the shoalest or deepest soundings, respectively, to the ASCII file.

5. Select the By Area option to export one sounding per bin. 

6. Select the By Line option to process each line, and export a sounding 
for each line per bin. Where line data overlaps this method can give 
multiple soundings per bin. 

7. Select an output location for the data. Select One File to export all data 
to a single file or select Multiple Files to export data to separate files for 
each survey line. 
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• If you select One File, type a name and file path for the ASCII file, or 
click Browse to select a location and name for the file.

• If you select Multiple Files, click Browse to select a folder to save the 
files. The files are automatically named according to 
Project_Vessel_Date_SurveyLine.

8. Click Next.

“EXPORT” ON PAGE 542
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HIPS To CARIS Map
Export data to a CARIS map.

HIPS to CARIS Map (Step 3)
You can select which soundings are to be exported and how they 
will be stored in the CARIS map.

The Export Soundings option exports all soundings (subject to the 
sounding status and data binning settings).
1. Select the Export Soundings check box if you want to export soundings 

to a CARIS map. (See the next dialog box for the Export Tracklines and 
Export Swaths options).

There are four methods for exporting sounding attributes to a 
CARIS map.
• Basic: The basic sounding attributes in the CARIS map. These 

include user number, feature code, and source ID. This 
information is adequate to generate products such as 
sounding plots, contour plots, and DTMs. 

• Extended. Basic attributes plus time stamps, launch identifier 
(first four letters of the vessel name), and tidal correction.

• Extended with Key: The extended attributes set, plus the profile 
number and beam number as the CARIS Key. The profile 
number and the beam number, in addition to the other 
attributes, allow each sounding to be identified uniquely with 
respect to the original data set.
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• Extended with Unique Key: The extended attributes set, plus every 
object is given a unique key.

This additional information allows more flexibility for 
visualizing and manipulating CARIS files. For example, if time 
stamps are associated with each sounding, you can limit the 
display of soundings based on a time range.
However, each extra attribute adds to the storage requirements. 
More disk space is required to store the work file, and any HIPS 
program that processes the file must do more work and use more 
time and CPU resources.
2. Select from the four options in the Attributes drop-down list.

3. Select a new Feature Code for the soundings, if needed.

The Group by Beam Number option layers soundings according to a 
beam number in the CARIS file. Soundings belonging to a beam 
are assigned to the same user number in the map. User numbers 
in CARIS file are similar to layering. This option is used when 
exporting soundings from checklines into a separate checkline 
map so that a Quality Control Report can be generated. If you do 
not select this option, then a single user number will be used to 
hold all the exported soundings.
4. Select the Group by Beam Number check box to layer soundings 

according to beam numbers in the CARIS map.

The User Number option is available only if you do not select the 
Group by Beam Number option.
5. [Optional] Type a User Number to which all soundings are to be 

assigned.

The Sounding Status option enables you to export only 
soundings with a specific status flag.
6. To export soundings with a specific status flag, select any of the 

Sounding Status check boxes.

The Data Binning option divides the survey area into a grid for 
sounding selection. The Bin Size sets the size of the grid cells.
7. To apply a data binning function on export, select the Data Binning 

check box.

8. Type the size for the grid cell in the Bin Size field and select either 
Metres or Feet.

9. Select either Shoal-Biased or Deep-Biased to export only the shoalest 
or deepest soundings from each cell, respectively, to the CARIS file.

Soundings can be selected for export from the total survey area 
or by processing each track line in sequence.
10.Select either the By Area or By Line options.

11.Click Next.
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HIPS to CARIS Map (Step 4)
This dialog box sets the track line and swath export options.

The Export Track Lines option connects a line along the centre of 
each swath, thus showing the track of the vessel along each 
survey line. It is not necessary to import soundings to use this 
option.
The Export Swaths command connects a set of lines (one per swath) 
along the outermost port and starboard beams, thus showing the 
coverage of each ping. It is not necessary to import soundings to 
use this option. 
1. Select the Export Track Lines check box to export a line representing the 

track of the vessel along the survey area.

2. Type a new feature code for the vessel, if needed.

3. Type a User Number for the vessel so it is distinguished from other 
vessels in the same CARIS map.

4. Select a new Towfish Feature Code, if needed.

5. Type a User Number for the towfish so it is distinguished from other 
vessels in the same CARIS map.

6. Select the Exclude Rejected Record(s) check box to not include this data.

7. Select the Export Swaths check box to export a set of lines that 
represents the swaths along the survey.

8. Type a User Number for the swath so it is distinguished from other 
swaths in the same CARIS map.

9. Click Next.
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HIPS to CARIS Map - Options
1. Click Browse to select a CARIS map for data export, or type the name 

of a new map.

The map file path and name are displayed in the CARIS Map field.
The Source ID is a 12-character alphanumeric attribute in 
CARIS maps. The ID can be the first or last 12 characters in a 
project name or line name.
2. Select either Project Name or Line Name to use as a Source ID.

3. Choose either the first 12 characters or the last 12 characters for the 
Source ID.

The Clip to CARIS Map option cuts the HIPS data at the boundaries 
of an existing CARIS map. If this option is not selected, the 
geographic extent of the map are extended to accommodate the 
HIPS data.
4. Select the Clip to CARIS Map check box to implement this option.

5. Click Next.

If you created a new CARIS map in Step 1, a dialog box for 
selecting a projection is displayed. Otherwise you can begin 
export of the data in the next dialog box.
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HIPS to FAU
Export processed HIPS data, with optional heave/pitch/roll/
quality/amplitude attributes, to the FAU format. The process 
will create multiple files with the extension *.fauTC designating 
the data as “tide corrected”. The names of the output files will 
match the HIPS line names. 
After you have selected the track lines to export, the next step is 
to designate an output folder. 

1. Type a path and name for the output file, or click the Browse button (...) 
to select a folder and then type the file name. 

2. Select Maintain PVD Hierarchy to create output directories that 
correspond to the HIPS data being exported.

3. Click Next to set the coordinate system. 

“COORDINATE SYSTEM” ON PAGE 541

“EXPORT” ON PAGE 542
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HIPS To GSF
The HIPS to GSF function exports processed HIPS data to a 
GSF format. A new GSF file is created for each track line that is 
exported from HIPS. 
Conversely, when HIPS data is created from GSF data, a copy of 
the original GSF file is maintained inside the HIPS directory 
structure. The Export to GSF function updates these GSF files.

Output Folder

1. Click the Browse button (…) to select a location for exported GSF 
files.

The Browse for Folder dialog box is displayed. The stored file 
will have the same name as the track line. 
2. To export entire projects and maintain the HIPS Project/Vessel/Day/

Line structure in the output, click the Maintain PVD Hierarchy check box. 

3. Select the Ignore Disabled Beams option to exclude any soundings which 
have been rejected (because of disabled beams) from your export file. 

4. Click Next.

“EXPORT” ON PAGE 542
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HIPS To HOB
The Hydrographic Object Binary (HOB) file stores feature 
objects and associated attribute data. The HOB file can contain 
links to CARIS spatial objects.

HIPS to HOB (Step 3)

The Export Soundings option exports all soundings (subject to the 
sounding status and data binning settings).
1. Select the Export Soundings check box to export soundings to a 

CARIS map. 

2. ATTRIBUTES

3. FEATURE CODE

4. USER NUMBER

5. To export soundings with a specific status flag, select any of the 
Sounding Status check boxes.

The Data Binning option divides the survey area into a grid for 
sounding selection. The Bin Size sets the size of the grid cells.
6. To apply data binning, select the Data Binning check box.

7. Type the size for the grid cell in the Bin Size field and select either 
Metres or Feet.
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8. Select either Shoal- or Deep-Biased to export only the shoalest or 
deepest soundings, respectively, to the CARIS file.

Soundings can be selected for export from the total survey area 
or by processing each track line in sequence.
9. Select either the By Area or By Line options.

The Export Track Lines option connects a line along the centre of 
each swath, thus showing the track of the vessel along each 
survey line. It is not necessary to export soundings to use this 
option.
The Export Swaths command connects a set of lines (one per swath) 
along outermost port and starboard beams, thus showing the 
coverage of each ping. It is not necessary to export soundings to 
use this option. 
10.Select the Export Track Lines and Export Swaths options.

11.Click Next.

HIPS to HOB (Step 4)
1. Click the Browse button to select a location for the HOB files.

The Browse for Folder dialog box is displayed.
2. Select a directory to store the HOB data and click OK to close the 

dialog box.

The file path is displayed in the Output File field.
3. Click Next.

“EXPORT” ON PAGE 542



CARIS HIPS and SIPS User Guide 531

Export Data: HIPS To HTF

HIPS To HTF
The HIPS and SIPS Export Wizard converts field sheet layer 
data and soundings to a Hydrographic Transfer Format (HTF) 
file.

Hydrographic Transfer 
Format

The HTF file is an ASCII file that can be opened in any text 
editor (such as Notepad). It consists of two sections: a header 
section and a sounding data record.
• The header contains general information about the survey.
• The sounding data record contains the depths and other 

relevant information.
The total number of fields generated in the sounding data record 
depends on the survey. At the start of the sounding data record 
is a Field Population Key that gives each field a 1 bit to show 
that a field is included, or a 0 bit to show if a field is not 
included.
For example: [0000111110000000000]
In the above Field Population Key, fields 5 to 9 contain data 
(hence the 1 bits), while fields 1 to 4 and 10 to 20 contain no data 
(hence the 0 bits). Fields without data are not written to the 
HTF file when it is generated. There are a total of 20 HTF fields 
in the sounding data record. Two additional fields are added by 
the Export Wizard for beam and profile number. Extra fields can 
be added, if needed. The HTF export automatically exports 
TPU depth and TPU position values if these are included in the 
track line.
The HTF file contains an ordered list of all possible fields and a 
description of each field.

Hydrographic Transfer 
Format Template

Sometimes the same header information can be used for 
multiple HTF files. The export wizard gives you the option of 
saving a header for use in another file. Headers are saved as 
HTFT files (Hydrographic Transfer Format Template). The file 
is in XML format that can be viewed in a text editor or an XML-
compliant Internet browser.

Select Input Data 
When exporting HIPS to HTF the Input Options dialog box 
displays either a list of projects and associated field sheets or the 
Project/Vessel/Day/Line data structure depending on which 
export option you select.
1. Select the Field Sheet Product option and select a product layer 

associated with a field sheet, 

or
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2. Select the BASE surface option and select one or more BASE 
surfaces, 

or 

3. Select the Raw Data option to export sounding data. 

This will refresh the file tree to a Project/Vessel/Day/Line 
directory structure.
4. Open a project or session file tree and select a layer or trackline data.

If you select the Raw Data option, the Include Rejected option is 
active. This option includes rejected soundings in the export 
process.
5. [Optional] Select the Include Rejected option to export rejected data.

Click Next.

HIPS to HTF - Output options 

Enter the necessary header information. You can directly enter 
the data or load it from an HTFT (Hydrographic Transfer 
Format Template) file.
If you are exporting soundings, you can export all data to a 
single file or export data from each survey line to its own file. 
This option is not available for field sheet products.
1. Select an output location for the HTF file(s).

• If you choose Export to One File, type a name and file path for the 
HTF file, or click Browse to select a location and name for the file.

• If you choose Export to Multiple Files, click Browse to select a folder 
to save the HTF files. The files are automatically named according 
to Project_Vessel_Date_SurveyLine.
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2. To enter new information, for example, the number of depth sounders 
or tidal stations, click in the Value field next to the appropriate HTF 
Header Field and type the data, or 

3. [Optional] Click Load to open data from an existing HTFT file into the 
Value fields.

4. Click Clear to remove data from all fields, if needed.

5. Click Next.

HIPS to HTF - Output options page 2

1. Select the Include Survey Line Name check box to include this 
information in the HTF file.

2. Select the Include Beam and Profile Information check box to include the 
beam and profile numbers in the HTF file.

If you entered values in the depth sounder, positioning system, 
and tidal station fields in the previous dialog box then the 
respective fields in these tabs are enabled. If you did not enter 
values, click Back to fill in these fields.
The Positioning Systems tab is for entering navigation systems 
information.
3. Type the name and model (and/or any additional information) of the 

system in the Name field.

4. Type the system used on the survey (GPS, DGPS, etc.).

The Depth Sounders tab is for entering sonar information.
5. Type the name and model of the sonar system used on the survey.

6. Type the mode of sonar (multibeam, single beam, multi transducer).
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The Tidal Stations tab is for entering tide information.
7. Type the name of a tidal station.

8. Type the location.

9. Type the method used to acquire data (predicted, observed, etc.)

10.Click Save to save information to a new or existing HTFT file.

11.Click Next.

HIPS to HTF - Attributes Options
 

If you are exporting a BASE surface you must map at least one 
BASE surface attributes to a HTF attribute.
1. Click in a surface attribute field to access a drop-down box listing all the 

attributes available in the data file. 

2. Select an attribute from the list.

3. Click Clear to remove all values from the Surface Attributes fields.

4. Click Next.

“EXPORT” ON PAGE 542
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Mosaic to ASCII
Export Mosaic attributes to an ASCII text file.

Mosaic to ASCII Output Options

1. Type a path and name for the output file, or click Browse to select a 
folder and then type the file name.

2. Select the Position Units for data from the drop-down list:
• Ground (East, North): position displayed as Easting, Northing to the 

precision defined (for example:360425.000, 4770355.000)
• Geographic (DMS): position displayed as Latitude, Longitude in 

degrees, minutes, seconds to the precision defined (for example: 
43-04-23.03N, 070-42-51.89W 

• Geographic (Unformatted DMS): displays the position without using 
hyphens or direction indicators, for example, 43 04 23.03, -070 
42 51.89.

• Geographic (Decimal Degrees): position displayed as Latitude, 
Longitude, in decimal degrees to the precision set, for example, 
43.073 -070.714.

• Geographic ( Degree Minutes): position displayed as Latitude, 
Longitude, in degrees and minutes, to the precision set, for 
example, 34-23.610N,119-52.585W. 

• Note that for positions in the northern hemisphere, 
longitude West values are negative; in the southern 
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hemisphere, the South latitude values are negative. For 
example, a position near Portsmouth NH, USA is 43 04 
23.03, -070 42 51.89. A position near Sydney Australia 
is -33 51 00.84 151 11 43.7

3. Specify the precision for the display of position values, by using the 
Precision up or down arrow buttons to set the number of digits to be 
displayed to the right of the decimal point. 

4. Select the BASE Surface attribute values to be recorded in the ASCII 
file by selecting the attribute in the Available column and clicking Add to 
move it to the Active column.

5. To remove an attribute, select the attribute from the Active column and 
click Remove to move it back to the Available column.

6. Choose a Attribute Precision value (number of digits to the right of 
decimal point) for an attribute in the Active column by selecting an 
attribute and clicking the up or down arrow buttons.

7. Select the Headers check box to print attribute names at the top of the 
attribute rows in the output file.

8. Select either Space, Comma, or Tab from the list to use these 
characters to separate fields in the output file. If you select Other, type 
a character to use a delimiter.

9. Click Next.

Select Export Units 
This dialog box sets the unit type for recording data. The fields 
that are active in this dialog are determined by the attributes 
selected in the previous dialog box.
 

Available units are:
• metres and kilometres
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• fathoms (US and international)
• feet (US and international)
• yards (US and international)
• miles (US, international, and nautical)

1. In the Vertical Length field, select the units for depth and uncertainty 
values.

The Horizontal Length field is only active if you selected Ground in 
the Position Units field in the previous dialog box. 
2. Select the units for position data. 

3. Click Next.

“EXPORT” ON PAGE 542
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Mosaic To Image
Please see“SURFACE TO IMAGE” ON PAGE 501 for the description of this 
export process. 
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Sediment Analysis to ASCII 
Export the results of Sediment Analysis done in Mosaic Editor. 
You can select which parameters to export, and the order they 
will be displayed, as well the type of delimiter to be used in the 
ASCII file. Results can be exported for one line or for multiple 
lines. 
 

1. To include a parameter in the ASCII output, select its check box in the 
Analysis Parameters list. You can select more than one parameter at a 
time.

2. Use the Move Up and Move Down buttons to change the order in 
which the data will be shown in the output file.

3. If you want to include the parameter names as column headers in your 
output file, select the Include Headers in Output check box.

4. Select the type of delimiter you want to use to space the data in your 
output file. If you select Other, type the character you want to use.

If you are exporting the sediment analysis data from more than 
one line you can export the data to a single file or to a file for 
each line.
5. Select One file or Multiple files. 

6. Click Browse […] and select the destination folder for the output 
file(s).

7. Type the name of the file if output is going to a single file. 

8. Click Next. 

“EXPORT” ON PAGE 542
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SIPS To UNISIPS
Export SIPS data to a Unified Sonar Imaging Processing System 
(UNISIPS) format. 

SIPS TO UNISIPS (Step 3)
Select the location to store the output data.

1. Click Browse to select a location for the UNISIPS files.

The Browse for Folder dialog box is displayed.
2. Select a directory to store the UNISIPS data and click OK to close the 

dialog box. (The UNISIPS file will have the same name as the track line 
with an .u file extension.)

3. Type a Sensor Name in the field (up to 10 characters).

The file path is displayed in the Output File field.
4. Click Next.

“EXPORT” ON PAGE 542
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Coordinate System
All sounding data is stored in HIPS and SIPS as un-projected 
longitude and latitude. This dialog selects the appropriate 
coordinate system to reference the soundings. All soundings will 
be transformed to this coordinate system as they are exported.
 

By default, the Select UTM Zone Automatically option is selected. To 
set the projection manually: 
1. Select a projection from the Group list.

2. Select a Zone associated with the projection group. 

3. Click Next.
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Export
At this step you execute the export of the data with the settings 
you have chosen. If a large amount of data is being exported, the 
dialog box will display the percentage of data exported and the 
status of the export process.

1. Click Back to review your settings.

2. Click Export to export the data with the settings you’ve selected.

3. Click Cancel to call off the process.

A progress indicator shows the percentage of files converted to 
the selected format. 
When the export is completed, the Restart button is displayed to 
enable you to go back and export another file.
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...select data  495
...select format  494
...soundings to HOB  529
...surface to image  501
...to DXF  487
...urface to BAG  482
export
...contacts  504
...multiple GeoBaRs  495
Export a surface
...select  495
Export contacts or line data
...select  496
Export GSF to CARIS map  511
Export HIPS
...to FAU  527
...to GSF  528
...to HOB  529
...to HTF  531
Export Histogram to Image  234
export profile  377
export SIPS to UNISIPS  540
Export surface metadata  481
Export to DXF
...contours, soundings or bounding polygon  487
...lines or Critical Soundings  487
Export Wizard
...open  494

F
field sheet
...active  180
...contour to  364
...create  174
...open  179
...projection grid  182
...properties, viewing  181
...set as active  179
...turn off  180
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field sheets
...overview  173
file formats exported  492
filter
...BASE surface attribute display  209
Filter Slice  353
filtering
...Benthos  128
...by Special Order  159
...QINSy  128
...run TPU filter  161
filtering S-44  159
filters
...attitude data  285– 288
...protect crtitical soundings  304
...swath  325
...Total Propagated Uncertainty  159
finalized surface  224
Find
...search for sounding  328
Find and Designate  342
find soundings  328
fixed size points
...WCI data  471
flag
...designated soundings  333
flag shoalest soundings  342
formatting tags for GeoBaR names  418
Full Blend
...use to resolve overlapping GeoBaRs  436

G
Generalized layer  359
Generic Data Parser  24
GeoBaR  412
...acronym explained  412
...conflict resolution methods when selecting  445
...create  417
...define  412
...delete  433
...edit  429
...export many  502
...naming  418
...remove from mosaic  441
...using variables to name  418
GeoBaR conflict  444
GeoBar layer
...statistics  441
GeoBaR to Image, see Surface to Image  510
GeoBaRs, export multiple  495
Geocoder
...workflow for multibeam data  415
Geocoder engine  414
...default options in GeoBaR creation  419
grain size  446
Grain Size table  451
graph, sediment analysis  453

grid
...projection grid in field sheet  182
grid lines
...in projection grid  182
Group surfaces  242
GSF
...export to CARIS map  511
...export to HOB  514
GSF (Generic Sensor Format)  511, 514
...conversion options for  107
...export HIPS data to  528
gyro sensor data in vessel file  43

H
Hawkeye converter options  108
heave sensor data in vessel file  43
height source
...used in profile  368
HIPS tide
...export to ASCII  516
HOB (Hydrographic Object Binary) files
...export GSF to  514
...export to  529
HOB file, contour to  365
holiday (data gaps)
...identify in BASE surface  238
holiday layer
...create in surface  238
holiday search radius  238, 240
HTF (Hydrographic Transfer Format), export layer
data to  531
HVF
...create new vessel file  27
...edit sensor configuration  38
...location  26
...sections  26
HVF (HIPS Vessel File)  26
HVF location  28
Hypack format, conversion options for  109
hypothesis editing  259
HzTPU  156

I
image classification  431
Image Export
...of BASEsurface statistics  234
...of profile  380
image, export surface to  501
Imagenex, conversion options for  112
imagery processing workflow  413
Import Profile  373
Index Contours  363
initialization, in CUBE surface creation  248
Intensity  417
intensity options
...creating mosaic  437
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Interpolate mosaic  442
Interpolate surface, of mosaic  442
interpolation
...in Refraction Editor  336
...set for navigation data  283
interpolation methods, Navigation Editor  282

L
label contours  365
LADS format, conversion options for  113
LAS data format, conversion options for  114
layback
...convert  131
lidar
...LADS conversion options  113
...Shoals conversion options  122, 122
Line Report  275
Load
...Delta Draft  172
Load Attitude/Navigation Data  291
Load Delayed Heave  289
Load Tide  144
...tide applied  145
load tide
...from multiple tide stations  144
load ZDF  144
Lock aspect ratio
...in profile graph  372

M
manual blending of GeoBaRs in edit  441
Manual cleaning
...in Swath Editor  328
map BASE surface attributes to S-57  391
MarineSonics data format, conversion options for  114
masking contour lines  366
Merge
...process description  168
metadata
...surface export  481
Mosaic
...export to image  538
mosaic  437
...add GeoBaR to  441
...create  434
...edit  438
...image classification  431
...interpolate surface  442
...open early version  438
...remove GeoBaR from  441
...select for edit  438
...unique filename  435
mosaic components
...edit  440
Mosaic Editor
...GrainSize table  451

...open  416

...sediment analysis  446

...Sediment Analysis Graph  453

...workflow diagram  413

...workflow overview  412
Mosaic Editor, conflict resolution  444
mosaic statistics  441
mtions sensors, in HVF  32
Multibeam Filtering, in XTF conversion  128
multibeam workflow  17
multiple data paths
...connect to  64
multi-transducer
...settings in HVF  30

N
name
...mosaic  435
naming GeoBaRs  418
Navigation
...interpolation methods  282
navigation
...antenna data in vessel file  42
...bezier interpolation  281
...linear interpolation  281
...load Applanix files  291
...reject-break interpolation  281
...reject-with interpolation  281
...reset rejected data  305
...set interpolation  283
...speed jumps  279
...time jumps  279
...view rejected soundings  295
navigation time overlap  84
Navitronics data format, conversion options for  114
new data respository  64
new project, create  58
nominate hypotheses  263

O
offsets for sensors
...set reference point  35
Open
...Attitude Editor  285
...BASE surface  218
...BASE surface in Subset Editor  350
...Export Wizard  494
...field sheet  179
...Mosaic Editor  416
...Plot Composer  476
...project  64
...Refraction Editor  334
...session  21
...Vessel Editor  27
open legacy mosaic  438
Open project with shortcut  66
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Options
...sediment analysis  447
original intensity  417
Outdated line  171, 294
output soundings to CARIS map  388
overlap time stamp  84
overlapping GeoBaRs in mosiac  436
Overplot Removal, sounding selection  385, 387
Overwrite
...use to resolve overlapping GeoBaRs  436

P
Patch Size, set in sediemtn analysis  447
patch test, for beam pattern correction  426
PDS2000 data  118
PFree Heave  289
pitch data in vessel file  44
playback WCI  464
Plot Composer  476, 476
primary sounding. start point for tiling  401
product surface  356
product surface, create  358
profile
...edit line  375
...export  377
...import  373
...line colour  370
...options  370
...remove  377
...resize window  373
Profile by Digitizing  367
Profile by Superselection  369
profile line
...digitize  368
profile settings  367
profiles
...overview  367
Project
...create new  58
project
...archive  74
...open  64
project, Connect To  59, 86
projection grid, field sheet  182
projects
...convert raw data  78
...rename folders  73
...session files  21
Properties
...project  67
properties
...BASE Surface  204
...field sheets  181
...tiles  404
...tiles display options  346
...track lines  71
protect critical soundings  304

protective radius
...use in surface cleaning  316

Q
QC report  307
...template file  307
Qmips format, conversion options for  115
QPS  128
QTC tiles  397
quality report for BASE surface  238
Query
...critical soundings  303
Query command  285
query data  273
Query data in editors  274
Query Line  275
query SVC  140
query tiles, see View tile attributes  406

R
Radius, sounding selection  385, 385
range weight  190
raster legend properties  208
RECDAT  391
Recompute BASE surface  221
Reference Point
...set in vessel file  35
Reference Point for sensor equipment  53
Reference Surface properties, Subset Editor  350
refraction artifacts  334
Refraction Editor  334
regenerate critical soundings layer  303
reject hypothesis  266
Reject Line  294
rejected soundings, view  295
rejecting hypotheses  266
remove a GeoBaR from a mosaic  441
remove profile  377
remove rejected soundings from backscatter  332
rename folders  73
residual in surface cleaning  321
resolution
...set in new mosaic  436
Reson data
...convert hidden or non-logged  118
Reson PDS format, conversion options for  116
restart cleaning  305
reverse colours  395
roll data in vessel file  45

S
S-44
...quality control  307
...TPU filtering  159
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S-44 filtering  159
S-57
...export to  480
S7K data
...convert  118
save a session  21
SBET loaded?  165
SDF format, conversion options for  120
Seabeam format, conversion options for  103, 121
Seafalcon format, conversion options for  121
search by beam or profile  328
search by depth profile or beam number  328
Search directories for files with temporal overlap  85
Search for files with temporal overlap  84
search for sounding  328
sediment analysis  446
...auto analyze  447
...export to ASCII  539
...graph  453
...set patch size  448
Sediment analysis options  447
sediment analysis overlay
...view in Mosaic Editor  455
select contacts or line data to export  496
Select files to export  495
Select Format to export  494
select surface to export  495
selected soundings  383
...display  388
...output  388
Selection tab
...view tile attributes  406
sensor configuration  38
sensor data in vessel file  38
session files  21
Set Interpolation  283
set line classification  293
set vessel measurements  35
settings
...bottom detection colour  471
settings to create profile  367
Shine through
...use to resolve overlapping GeoBaRs  436
Ship Navigation data source in conversion  126
shoal-biased product surface  356
Shoalest Depth True Position
...about  191
shoalest soundings, flag  342
SHOALS format, conversion options for  122
shortcut to project  66
Show Alternative Hypotheses  263
Show Rejected  330, 330, 339
Side Scan Editor
...open in Mosaic Editor  416
Simrad format, conversion options for  122
single beam data
...restart cleaning  305
...view rejected soundings  295
SIPS engine  414

slant range filter
...in water column data  469
slanted soundings  388
smooth
...profile line  371
Smooth data, with attitude filter  286
SORIND  391
sound velocity correction
...nearest in distance option  134
...nearest in time option  134
...previous in time option  134
Sound Velocity Corrections
...parameters in HVF  33
sound velocity profile options  134
sounding radius table  386
sounding selection
...conflict resolution  385
...criteria  384
...filter  390
...new layer  383
Sounding Selection Template  385
soundings
...Designated  297
...export to HOB  529
...set radius for critical  304
...set status in Subset Editor  339
Special order  159
Stacked view of WCI  462
Starting Level Tile Set  312, 315
Status Flag
...LADS conversion to HIPS  113
...Reject Line  294
Status Flags
...Navigation data  281
...used in BASE surface  197, 199
subset
...defined  338
Subset Editor
...accept data  340
...designate shoal soundings  342
...examined status flag  340
...outstanding status flag  340
...query  340
...reference surface  350
...reject data  339
...set sounding status  339
...subset tiles  343
...subset tiles flagged  349
...track cleaning status  349
...tracking layer options  347
...workflow  338
Subset tile properties  345
Subset tiles
...attribute status  345
subsets
...and BASE surfaces  350
...CUBE Surfaces  259
...designated soundings  350
...reset rejected data  305



8

...surface filtering  350, 352

...view rejected soundings  295
sun
...position  210
superselect area for beam pattern correction  427
surface cleaning
...histogram  319
...overview  312
...use tiles  315
surface statistics, compute  232
SVC
...query line  140
SVP
...display by colour  140
...display location of profile  140
...open file  140
...pole offsets in the vessel file  47
swath angle weight  190
swath cleaning  325
Swath Editor
...accept data  330
...across-track WCI view  462
...along-track view WCI  462
...auto cursor mode  328
...query data  331
...Refraction Editor  334
...reject data  330
...reject swaths  330
...reset rejected data  305
...view rejected soundings  295
...view water column data  462
swath filters  325
swath transducer location in vessel file  41
Swath, clean manually  328
SWATHPlus format, conversion options for  124
sweep transducer location in vessel file  48
symbology, track line  71
synchronize reference time stamps  84

T
Teledyne  124
template file for QC report  307
tide
... see also Tide Editor
...GPS tide  149
...load tide  144
...weighted average option  148
Tide stations  148
Tide Zone files  146
tile by depth range interval  399
Tile Display Query  407
Tile Overlap
...Subset tiles  348
Tiled image output, example  503
tiles
...binning  397
...close  404

...create QTC  402

...display options  405

...display properties  404

...new tile layer  397

...open  404

...view attributes  406
tiles display options  346
tiles, QTC  397
tiling  399
...by density  315
...by size in surface cleaning  315
...in Surface Cleaning  315
...primary sounding  401
...same size for all tiles  398
...tile by depth range file  400
...tile by depth tolerance  399
tiling a field sheet  396
Tiling Wizard  397
Time Correction  40
time stamp  39
time stamp overlap  84
title
...of raster legend  208
Total Propagated Uncertainty  154
tow cable
...convert  131
towed sensors location data in vessel file  49
TPE, see TPU  154
TPU  159
...apply filter  161
...compute  154
...filter  159
TPU (Total Propagated Uncertainty)
...vessel file values  51
TPU status
...field in sensor configuration  49
track lines
...classify lines  293
...colour  71
...opening a single line  66
...properties  71
...symbology  71
tracking cleaning in subsets  349
tracking layer options
...Subset Editor  347
Transducer Status, in vessel file  48
TrueHeave  289
...apply in SVC  138

U
UNB  124
UNB (Reson) format, conversion options for  124
Underlay
...use to resolve overlapping GeoBaRs  436
UNISIPS, export data to  540
units, for export  500
Unmask contours  366
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update backscatter imagery, after swath cleaning  332
Update Coverage  205
Update existing survey lines  83
UTC, no distinction made for  39, 39, 39

V
VCF (Vessel Configuration File), see HVF  26
vertical axis
...in profile  370
Vertical Reference System Editor  215
vertical uncertainty  224
Vessel Configuration file  26
Vessel Editor
...coordinate system  53
...dynamic draft  46
...ellipsoid  55
...gyro  43
...heave  43
...navigation  42
...pitch  44
...reference position  53
...roll  45
...swath transducer location  41
...sweep transducers location  48
...time error  40
...time stamp  39
...towed sensors location  49
...TPU  51
...vessel outline  35
...waterline data  50
vessel file
...create new  27
...location  28
...motion sensors  32
...multibeam settings  29
...multi-transducer settings  30
vessel measurements  35
Vessel Properties  70
vessel shape  35
View
...sediment analysis overlay  455
view critical soundings
...in an Editor  301
...in Display window  302
view data  272
View Sediment Patches  454
view WCI data  463

W
Water Column Data in HIPS  460
water column data in Swath Editor  462
Water Column Data toolbar  465
water column imagery  459
water column imagery in stacked view  462
waterfall view
...in Mosaic Editor  416

waterline data in vessel file  50
WCI
...apply slant range filter  469
...bottom detection  471
...colour attributes  471
...display options  471
...size of points  471
...view across-track  462
...view along-track  462
...view stacked  462
WCI controls
...in Subset Editor  469
...in Swath Editor  466
WCI playback  464
WCI, see water column imagery  459
Windows shortcut to link to data  66
Winfrog format, conversion options for  124
Wireframe Hypotheses  261
workflow
...data cleaning in Subset Editor  338
...imagery processing  413
...to create vessel file  27
workflow diagram  16
workflow, multibeam  17
workflow, side scan data  412

X
XTF format
...conversion options for  126
...ship navigation source  126

Z
ZDF, load  144
zerotide  146
Zone Definition File  147
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